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Introduction

n’oject management probably started back when a few cave dwellers got
together and figured out how to work as a team to bag a wooly mam-
moth for their Sunday dinner. Some fellow — I'll call him Ogg — probably
took the lead as the very first project manager. He drew things in the dirt
with a stick to help his team members understand the strategy of the hunt,
and communicated with them in ughs and grunts. Unlike you, he had no boss
to report to, no budget, and no deadlines (lucky Ogg), but the fundamental
spirit of a project was there.

Over the years, project management has evolved as a discipline that involves
sophisticated analyses and techniques, projections, tracking of time and
money, and reporting. Project management software — which has been
around only about 25 years or so — has brought a new face and functionality
to project management that would have left our friend Ogg ughless.

About This Book

Microsoft Office Project 2010, the most recent incarnation of the world’s
most popular project management software, offers a tremendous wealth of
functionality to users. However, it’s probably not like any other software
you've ever used, so mastering it can seem a daunting process. One trick is
to understand how its features relate to what you do every day as a project
manager. Another is to get someone like me to tell you all about its features
and how to use them.

In Microsoft Office Project 2010 For Dummies, my goal is to help you explore
all that Project offers, providing information on relevant project manage-
ment concepts while also offering specific procedures to build and track your
Project plans. But more importantly, I offer advice on how to make all these
features and procedures mesh with what you already know as a project man-
ager to make the transition easier.

Foolish Assumptions

I've made some assumptions about you, gentle reader. I figure that you
are computer literate and know how to use a mouse, a keyboard, software
menus, and toolbars. | assume that you know how to use most common
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Windows functions (such as the Clipboard) as well as many basic software
functions (such as selecting text and dragging and dropping things with your
mouse).

[ do not assume that you've used Project or any other project management
software before. If you're new to Project, you'll find what you need to get

up to speed, including information on how Project works, finding your way
around Project’s interface, and building your first Project plan. If you've used
an earlier version of Project, you'll find out about Project 2010 and all the
new features it provides.

Conventions Used in This Book

[ should explain a few odds and ends to make using this book easier:

1 Web site addresses, known as URLs, are shown in monofont, like this:
www.microsoft.com.

v Ribbon commands are given in the order in which you select the tab and
command (without the group), for example, “Choose Project=>Project
Information.” (For more on Project’s new Ribbon, see Chapter 2.)

v Options in dialog boxes use initial caps even if they aren’t capitalized on
your screen to make it easier to identify them in sentences. For example,
what appears as Show summary tasks in the Options dialog box will
appear as Show Summary Tasks in this book.

How This Book Is Organized

This book is designed to help you begin to use Microsoft Office Project 2010
to plan, build, and track progress on projects, keeping in mind tried-and-true
project management practices and principles. I divided the book into logical
parts that follow the process of building and tracking a typical project plan.

Part I: Setting the Stage for Project

Part I explains what Project 2010 can do for you as well as what types of
input you have to provide to use it successfully on your projects. You'll get
your first glimpse of Project views and discover how to navigate around
them. You'll begin to build Project plans by making calendar settings, build-
ing a task outline, and then entering timing and timing relationships for those
tasks.
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Part II: People Who Need People

Part Il is the Project resources section: You discover all you need to know
about creating and assigning work resources, material resources, and fixed
costs to tasks in a project. You also discover how using resources on your
project relates to the costs you accrue over time.

Part I11: Well, It Looks Good on Paper . . .

Up to now, you’ve been mapping out your project plan. Now it’s time to see
whether that plan meets your needs in terms of budget and timing. Project
offers a whole toolbox to help you modify resource assignments and task
timing to trim your costs and meet your deadlines so that you can finalize
your plan. You also get briefed on how to modify the format of items in your
project to make your plan look as polished as possible, both on-screen and in
print.

Part IU: Avoiding Disaster:
Staying on Track

As any experienced project manager knows, projects just about never
happen the way you thought they would. In this part, you save a picture of
your plan — a baseline — and then begin to track actual activity against your
plan. You also take a look at methods of reporting your progress, and how to
get back on track when you find yourself derailed. In the final chapter, I pro-
vide advice on how to use what you glean from your projects to make better
planning choices going forward.

Part U: Working with Enterprise Projects

With all that Project Professional has to offer the enterprise via its Project
Server and Project Web App (also called Project Web Application; formerly
called Project Web Access) functionalities and SharePoint online services,
you can share documents online with your project team, have team members
report their work time, and even integrate Project information with Outlook.
This part shows you the basics of what Project Server can do, and how to use
Project Web App from both the managers’ and users’ perspective.
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Part Ul: The Part of Tens

Ten seems to be a handy number of items for humans to put into lists, so
this part gives you two such lists: Ten Golden Rules of Project Management
and Ten Project Management Software Products to Explore. The first of these
chapters tells you about some dos and don’ts that can save you a lot of grief
when you’re using Project for the first time (or the fifth time, for that matter).
The second offers a look at some add-on products and complementary soft-
ware products that bring even more functionality to Microsoft Office Project.

What Vou're Not to Read

First, you don’t have to read this book from front to back unless you really
want to. If you want to just get information about a certain topic, you can
open this book to any chapter and get the information you need.

That said, I have structured the book to move from some basic concepts that
equip you to understand how Project works through the steps involved in
building a typical project. If you have an overpowering need to find out the
whole shebang, you can start at the beginning and work your way through
the book to build your first Project plan.

Icons Used in This Book

NBER
\‘&
&

W

One picture is worth . . . well, you know. That’s why For Dummies books use
icons to give you a visual clue as to what’s going on. Essentially, icons call
your attention to bits of special information that may very well make your life
easier. Following are the icons used in this book.

Remember icons signal either a pertinent fact that relates to what you're read-
ing at the time (but is also mentioned elsewhere in the book) or a reiteration
of a particularly important piece of information that’s, well, worth repeating.

Tips are the advice columns of computer books: They offer sage advice, a bit
more information about a topic under discussion that may be of interest, or
ways to do things a bit more efficiently.
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\NG/
v‘*‘“ Warning icons spell trouble with a capital 7: When you see a warning, read it.

If you’re not careful, you might do something at this point that could cause
disaster.

Where to Go from Here

It’s time to take what you’ve learned in the project management school of
hard knocks and jump into the world of Microsoft Office Project 2010. When
you do, you'll be rewarded with a wealth of tools and information that help
you to manage your projects much more efficiently.

Here’s where you step out of the world of cave-dweller project management
and into the brave, new world of Microsoft Office Project 2010.

This book is accompanied by a companion Web site filled with project man-
agement goodies, including links to project management add-on software
and some example Microsoft Project files that you can experiment with. To
access this book’s Web site, point your Web browser to www . dummies.com/
go/project2010.
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Part |

Setting the Stage
for Project

The 5th Wave By Rich Tennant
CRATER T

“Look ygou’ve got Pro JeC'l'; Manager, Acct.

Manager, and Opportunity Manager, but

Sucking Up tothe Manager yust isn’t a
field the program comes with.”
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In this part . . .

p art | explains the types of input you have to give
Project to make the best use of its capabilities. You

get a briefing on using Project views, using calendar and
scheduling settings to build Project plans, creating task
outlines, and then specifying the timing and relationships
that organize your project’s tasks.
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Project Management: What It s,
and Why You Should Care

In This Chapter

Discovering how traditional project management makes the move to software
Understanding what elements of a project are managed in Project
Understanding the project manager’s role

Exploring the role of the Internet in project management

Using a template to start a new project

Saving a project file

Finding help in Project

Welcome to the world of computerized project management with
Microsoft Project. If you've never used project management software,

you're entering a brave, new world. It’s like walking from the office of 25
years ago — with no fax, voicemail, or e-mail — into the office of today with
its wealth of high-tech devices.

Everything you used to do with handwritten to-do lists, word processors, and
spreadsheets all magically comes together in Project. However, this transi-
tion won’t come in a moment, and you need a basic understanding of what
project management software can do to get you up to speed. If you've used
previous versions of Project, this little overview can help you refresh your
memory as well as ease you into a few of the new features of Project 2010.

So, even if you're a seasoned project manager, take a minute to review this

chapter. It provides the foundation for how you’ll work with Project from
here on.
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The ABCs of Project Management

You probably handle projects day in and day out. Some are obvious, because
your boss named them so that any fool would know that they’re projects:

the Acme Drilling Project or the Network Expansion IT Project, for exam-

ple. Others are less obvious, such as that speech thing you have to do on
Saturday for your professional association or washing the dog.

If you need to organize a company holiday party, it’s a project. If you were
handed a three-year Earth-exploration initiative to find oil in lowa, coordinate
subcontractors and government permits, and work with a team of 300 people,
that’s definitely a project. Yes, even that speech you have to present is a
project because it has certain characteristics.

Understanding what your projects, large or small, have in common is the
basis of understanding what Project can do for you. All projects have

v An overall goal and unique deliverables

v A project manager

v Individual tasks to be performed between a specific starting point and
ending point

v Timing for those tasks to be completed (such as three hours, three days,
or three months)

v Timing relationships between those tasks (for example, you can’t put a
new manufacturing process in place until you train people in how to use
the process)

v Resources (people, equipment, facilities, and supplies, for example) to
accomplish the work

v A budget (the costs associated with those people, equipment, facilities,
and supplies)

Project management is simply the process of managing all the elements of a
project, whether that project is large or small.

The three Ts: Tasks, timing, and
dependencies (well, two Ts and a D)

As Lewis Carroll said, “If you don’t know where you're going, any road will
get you there.” So, first things first: You have to understand the goal of your
project so that you can begin to build the tasks that have to be performed to
get you there.
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A task is simply one of those items you used to scribble on your handwritten
to-do lists, such as Write final report or Apply for permits. Tasks are typically
organized into phases (appropriate stages) in Project, arranged in an outline-
like structure, as you can see in the project shown in Figure 1-1. Because
timing is essential in any project, Project helps you set up and view the
timing relationships among tasks.
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Becoming a task master

A task can be as broad or as detailed as you like. For example, you can create
a single task to research your competition, or you can create a project phase
that consists of a summary task and subtasks below it. For example, the sum-
mary task may be Competitive Research, with the subtasks Researching
Online Business Databases, Assembling Company Annual Reports, and
Reviewing Competitive Product Lines.

Adding tasks to a Project file doesn’t cost you a thing (except a nanobit of
memory), so a project can have as many tasks and as many phases as you like.
You simply use the outlining structure in Project to indent various levels of
tasks. The more deeply indented in an outline a task is, the more detailed the
task.
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One handy thing about this outlining structure is that you can roll up all the
timing and cost data from the subtasks within your phases into summary-
level tasks. Three sequential subtasks that take a day each to complete and
cost you $200 apiece result in a summary task that spans three days and
costs $600. You can view your project at various levels of detail or get auto-
matic tallies of timing and costs if you prefer to simply view the summary
level of tasks.

For more about defining and creating tasks, check out Chapter 4.

All in the timing

They say that timing is everything: Rome wasn’t built in a day, a stitch in time
saves nine, and don’t even ask me about how long it takes to get to retire-
ment. The importance of timing applies to Project tasks, too. Almost all tasks
have timing — referred to as duration — which is the amount of time needed
to complete the task.

The only tasks without duration are milestones. A milestone — in most

cases — is a task of zero duration. In essence, it simply marks a moment in
time that must be reflected in your Project outline. Typical milestones are the
approval of a brochure design and flipping the switch to start up an assembly
line. Such tasks don’t involve any real work or effort, but they must be com-
pleted for the project to move ahead.

Project doesn’t provide magic formulas for duration: You assign duration
based on your own experience and judgment. Does designing a product pack-
age take three days or three weeks? Will obtaining a building permit happen
in a day or a month? (Remember that you're dealing with city hall, so think
before you answer!) Project isn’t an oracle: You have to provide facts, figures,
and educated guesses to build your Project schedule. After that information is
entered, though, Project can do some wonderful things to help you maintain
your schedule and monitor your progress.

Task dependencies

The final piece in the puzzle of how long your project will take is the concept
of dependencies, or the timing relationships among tasks. If you have a sched-
ule that includes ten tasks that all begin at the same time, your entire project
will take as long as the longest task (see Figure 1-2).

After you define and implement timing relationships among tasks, your
schedule can stretch over time like a long rubber band. For example, one
task may begin only after another is finished. Another task can start halfway
through the preceding task. The second task cannot start until a week after
the first task is finished. Only after you start to assign these relationships can
you begin to see a project’s timing as related to not just each task’s duration
but also the specific ways in which the tasks relate to each other.
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Here are some examples of dependencies:

»* You can’t begin to use a new piece of equipment until you install it.

»* You must wait for a freshly poured concrete foundation to dry before
you can begin to build on it.

»* You can’t start to ship a new drug product until the FDA approves it.

Figure 1-3 shows a project plan where each task’s duration and the depen-
dencies among tasks have been established, enabling Project to calculate the
resulting overall timing of the project.

One other brief note about the timing of tasks: In addition to applying depen-
dencies to tasks, you can apply constraints. For example, say that you don’t
want to start shipping your new cake flavor until you get the ad for it in your
holiday catalog, so you set a dependency between those two events. You can
also set a constraint that says that you must start producing the cakes no
later than November 3. In this case, if you don’t make the catalog deadline,
the product will still ship on November 3; that task will not be allowed to slip
its constraint because of this dependency relationship.
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Figure 1-3:
This sched-
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tasks with
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and depen-
dencies.
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You can find out more about constraints in Chapter 4 and about the fine art
of managing dependencies in Chapter 6.

Lining up your resources

When people first use Project, some get a bit confused about resources.
Resources aren’t just people: A resource can be a piece of equipment you
rent, a meeting room that you have to pay an hourly fee to use, or a box of
nails or a software program you have to buy.

Project allows three kinds of resources: work resources, material resources,
and cost resources. A work resource is charged by how many hours or days
the resource (often human) works on a task. A material resource, such as
sewing supplies or steel, is charged by a per-use cost or by a unit of measure-
ment (such as square yards or linear feet or tons). A cost resource has a spe-
cific cost each time you use it. That may vary from task to task. For example,
a professional conference pass for one event may be $250, and a pass for the
next conference may be $500. This cost doesn’t vary by how much time you
spend at the conference, but it may vary depending on other external factors.
So you can create a resource named Conference Pass and assign it to differ-
ent tasks at different amounts.
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Some resources, such as people, perform their work according to a working
calendar. If a person works an 8-hour day and you assign him to a task that
takes 24 hours to complete, that person has to put in three workdays to com-
plete the task. In comparison, someone with a 12-hour workday takes only
two days to complete the same task. In addition, you can set working and
nonworking days for your human resources, which accommodates variations
such as 4-day weeks or shift work.

You can set different rates for resources, such as a standard hourly rate.
Project applies the appropriate rate based on each resource’s calendar and
work assigned. For more about resources and costs, see Chapter 7.

Several views in Project let you see information about resources and how
their assignments to tasks have an effect on project costs. Figure 1-4 shows
you the Resource sheet, which has columns of information about resources
and their costs.
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Here’s one other important thing you should know about resources: They
tend to have conflicts. No, 'm not talking about conference room brawls
(although that happens). These conflicts have to do with assigned resources
that become overallocated for their available work time. For example, if you
assign one poor soul to three 8-hour tasks that must all happen on the same
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day — and in the same eight hours — Project has features that do everything
but jump up on your desk and set off an alarm to warn you of the conflict.
(Luckily, Project also provides tools that help you resolve those conflicts.)

Spreading the news

I'm one of those people who need instant gratification. One of the first things
[ ask about learning how to use any new software product is, “What’s in it for
me?” Until now, I've told you about the type of information you have to put
into Project: information about tasks, task dependencies, and resources. But
isn’t it about time you got something back from Project? Of course it is.

You finally reached one of the big payoffs for entering all that information:
reporting. After you enter your information, Project offers a wealth of viewing
and reporting options to help you review your project and communicate your
progress to your project team, clients, and management.

You can generate predesigned reports based on information in your sched-
ule or simply print any of the views you can display in Project. Project 2010
offers a set of basic reports and visual reports. Figures 1-5 and 1-6 show you
just two of the reporting options available in Project.
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Planning to keep things on track

Projects aren’t frozen in amber like some organizational mosquito: They go
through more changes than a politician’s platform in a campaign year. That’s
where Project’s capability to make changes to your project data comes in
handy.

After you build all your tasks, give them durations and dependencies, and
assign all your resources and costs, you set a baseline. A baseline is a snap-
shot of your project at the moment you feel your plan is final, you’'ve gotten
all the required approvals, and you're ready to proceed with the project.
After you set a baseline, you record some activity on your tasks. Then you
can compare that actual activity with your baseline because Project saves
both sets of data in your schedule.

Tracking activity in your project involves recording the actual timing of tasks
and recording the time that your resources have spent on those tasks, as well
as recording actual costs. You can then display Project views that show you
how far off you are at any time (compared with your baseline) in terms of the
actual timing of tasks and the cost of your project.
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Whether you have good news or bad, you can use reports to show your boss
how things are going compared with how you thought they would go. Then,
after you peel your boss off the ceiling, you can use many more Project tools
to make adjustments to get everything back on track.

The Role of the Project Manager

Although understanding the role (let alone the usefulness) of some manag-
ers isn’t always easy, it’s always easy to spot the value of a project manager.
This person creates the master plan for a project and tries to ensure that it
gets implemented successfully. Along the way, this key person uses skills and
methods that have evolved over time, always seeking to manage how things
get done and generally keeping schedules on track.

<® A real pro project manager may have a degree in project management or
a professional certification. For example, if you see the initials PMP beside
someone’s name, that person has achieved the Project Management
Professional certification from the Project Management Institute, the leading
global organization establishing project management standards and creden-
tials and offering educational and other resources in the field.

What exactly does a project manager do?

A project manager isn’t always the highest authority in a project; often that
role belongs to whomever manages the project manager, up to and including
members of senior management. Rather, the project manager is the person
on the front lines who makes sure that the parts of the project come together
< and assumes hands-on responsibility for successes as well as failures.
In project management parlance, the person who champions (and has the ulti-
mate responsibility for) a project is the project sponsor.

A project manager manages these essential pieces of a project:

1 The project plan or schedule: This is what you create with Microsoft
Project. It includes the estimated steps and associated timing and costs
involved in reaching the project goal.

1 Resources: Managing resources involves resolving resource conflicts
and building consensus as well as assigning resources and tracking their
activities on the project. This part of the job also involves managing
nonhuman resources, such as materials and equipment.

1 Communication with the project team, management, and customers:
Communicating the project’s status to everyone who has a legitimate
stake in its success (stakeholders) is a key responsibility.
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Although a project manager may work for a project sponsor, the project often
also has a customer for whom the end product is produced. That customer can
be outside the project manager’s own company, or within.

Understanding the dreaded
triple constraint

You've seen the signs at the copy store or the auto repair place: You can
have it fast, cheap, or done well; pick two. That, my friend, is the triple con-
straint of project management in a nutshell.

In a project, you have timing, resources (which are essentially costs),

and quality of the product or service produced at the end of the project.
Microsoft Project helps you manage the resources and timing of your project.
The quality of your project is often affected directly by how well you manage
them. If you add time, costs increase because resources are working longer
hours at a certain wage. If you take away resources, you save money, but this
can affect quality — and so on.

Coming to a logical balance of time, money, and quality is at the core of what
a good project manager does throughout the life of a project.

Applying tried-and-true methodologies

Microsoft Project incorporates some scheduling and tracking tools that are
the result of many years of developing project management methods. A few
of these are worth noting:

v The Gantt chart (shown in Gantt Chart view of Figure 1-7), which is the
main view of Project, shows you a spreadsheet with columns of data along
with a graphical representation of the tasks in the project arranged along
a horizontal timeline. By reviewing the data in the columns (such as task
name, start date, finish date, and resources assigned to tasks), you can
understand the parameters of each task and see its timing in the graphical
area. Being able to view all this information on one page helps you under-
stand what’s happening in your project in terms of time and costs.

1 The Network Diagram (also called a logic diagram), shown in Figure
1-8, is essentially the Microsoft version of a PERT chart. PERT (Program
Evaluation and Review Technique) was developed during the construc-
tion of the Polaris submarine in the 1950s. This mostly graphical represen-
tation of the tasks in your project reflects the flow of work in your project
rather than the literal timing of tasks. This view helps you to see how
one task flows into another and to get a sense of where you are — not so
much in time, but rather in terms of the work you have to accomplish.
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+ Risk management is a central part of project management because,

frankly, projects are chock-full of risk. You run the risk that your
resources won’t perform, that materials will arrive late, that your cus-
tomer will change all the parameters of the project halfway through —
well, you get the picture.

Risk management is the art of anticipating risks, ranking them from most
to least likely, and determining strategies to prevent the most likely ones
from occurring. Project helps you with risk management by allowing

you to try out what-if scenarios: You can change the start date or length
of a task or phase of tasks (for example) and see just what that change
does to your schedule, such as the delays, cost overruns, and resource
conflicts that might occur in such a scenario, down to the last hour and
penny. Having this kind of information at your fingertips makes risk man-
agement easier and (almost) painless.

1 Resource management consists of using resources wisely. A good project

manager finds the right resource for the job, assigns that person a reason-
able workload, stays alert for shifts in the schedule that cause that resource
to be overbooked, and during the life of the project makes adjustments that
keep all resources most productive. In Project, tools are available, such as
a resource graph (traditionally called a histogram) and the resource usage
chart (shown in Figure 1-9), which reflects resource workload.
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This icon indicates a resource that needs help
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Figure 1-9 also shows an exclamation point icon (indicator) that tells you
that one resource needs help, which might involve using resource level-
ing, a calculation that automatically reschedules resources to resolve
overbooking. Resource leveling can enable you to manage resources
much more effectively. You can see how overbooked the PR Manager is
on two dates.

You can use codes for resources that designate skill levels or abilities so that
finding the right resource for each job is as simple as performing a search.

From To-Do List to Hard Drive

If you're reading from start to finish in this chapter, you’re probably shaking
your head and saying, “Boy, handwritten to-do lists look pretty good right
now. Beats creating hundreds of tasks, assigning them durations, establishing
dependencies among them, creating resources, entering resource calendar
and rate information, assigning resources and costs to tasks, entering activity
performed on tasks . ..” and so on.

Well, you're right and wrong about that. You do have to enter a lot of infor-
mation into Project to get the benefit of its features. But you can also get a lot
out of Project.

Getting up to speed with Project

Take a moment to look at some of the wonderful things Project can do for
you. This list describes why you (or your company) bought it and why you’re
investing your time to read this book.

With Project, you enjoy the following benefits:

v Project automatically calculates costs and timing for you based on your
input. You can quickly recalculate what-if scenarios to solve resource
conflicts, get your costs within budget, or meet your final deadline.

v Project offers views and reports that, with the click of a button, make a
wealth of information available to you and those you report to. You no
longer have to manually build a report on total costs to date to meet a
last-minute request from your boss. If she wants to know total costs to
date, you can just print your Tracking Gantt view with the Cost table dis-
played or print the Budget report. See Chapter 16 for information about
reporting.
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» You can use built-in templates to get a head start on your project.
Project templates are prebuilt plans for a typical business project, such
as commercial construction, an engineering project, a new product roll-
out, software development, or an office move. See the section “Starting
with templates,” later in this chapter, for more about this time-saving
feature.

You likely do similar types of projects all the time. After you create one
project, you use it as a template for future projects.

» You can create resources for your project according to information you
already created in your Outlook Address Book. You can even create
one set of company resources and give access to every project manager
in the company (see Chapters 18 and 19 for how to set up centralized
enterprise resources).

v A number of tools in Project use complex algorithms (that you couldn’t
even begin to figure out) to do such tasks as level resource assignments
to solve resource conflicts, filter tasks by various criteria, model what-if
scenarios, and calculate in dollars the value of work performed to date.

Collaborating with your
project team online

You can take advantage of all the Internet has to offer by using Project
features to collaborate with others. In fact, Project is part of the world of
Enterprise Project Management (EPM), where easily sharing ideas, informa-
tion, and documents across your enterprise becomes possible.

For example, Project allows you to e-mail a project plan to team members
and others, either as a Project file or as PDF document. You can post docu-
ments to online server locations and ask for team input.

The Professional version of Project offers the ability to work with Project
Server and Project Web App (also called Project Web Application; formerly
known as Project Web Access), which enhance workgroup collaboration.
You can take advantage of an online project center and resource center with
areas for discussions, progress tracking, document exchange, and more.

Part V of this book, “Working with Enterprise Projects,” looks at how to

take advantage of the enterprise-wide features of Project Server and Project
Web App.
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Getting Started
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As Shakespeare said, “In delay there lies no plenty.” I don’t know about
you, but I need all the plenty I can get, so it’s time to jump in and start using
Project.

You have two choices when starting a new project. You can build a project
from scratch by entering individual task and resource details, or you can use
a project template that already contains data related to your industry or the
type of project you’re doing.

Starting from scratch

When you open Project 2010, you see a blank project file on-screen. You can
start building your new project directly in this blank schedule. Starting to
create a new project usually involves entering some general project informa-
tion and then adding some task information.

You can open a new, blank project schedule at any time by choosing File=>
New, clicking the Blank Project icon under Available Templates, and then
clicking Create. (The File tab is located in the upper-left corner of the Project
screen.)

You need to enter much more information in addition to general project infor-
mation and tasks to build a complete project, as you discover in the next few
chapters. Entering general project information and task information is your
usual starting point, however.

Tell Project about your project

With a blank project open, a logical first step is to enter some general project
information, such as the project start date. To do so, click the Project tab on
the Ribbon and click Project Information in the Properties group. (You find
out more about the Ribbon in the next chapter.) The Project Information
dialog box appears, as shown in Figure 1-10.

Here’s what you can do in this dialog box:

1 Set the start date for the project. Good project managers always plan in
advance. If you're not sure when the project will start, set the start date
about a month from today. Then, after you build some tasks and have
a better handle on the entire length of your project, you can come back
and set a real start date. Project automatically recalculates dates for all
tasks with dependencies when you do.
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Project Information for 'Projectd” ==

Skart date: - Current date:  Fri9f11/09 -

Einish date: Wed 107039 Status date: MA -
Schedule fram:  Project Start Date -  Calendar: Standard -

Al tasks begin as soon as possible, Priarity: e
Enterprise Custom Fields

Department:

3

Custom Field Mame Yalue [

1~ Set the finish date for the project. Especially if you have a drop-dead
date (an attention-getting term!) beyond which the project cannot
wander and still reach on-time completion, you can set the finish date. In
such a case, be sure to look at the next setting in this list — and change
it accordingly.

v Schedule from the start or finish of the project. Most projects work
forward from the start date. However, if you have an absolute drop-
dead date for the end of your project (for example, if you're organizing
a sports event that must occur on New Year’s Day next year), you may
want to set the finish date and then work backward to fit all your tasks
into the allotted length of time. (Because under certain circumstances
this method schedules tasks as late as possible, it can be tricky to use
it and get an accurate schedule.) If you change this setting to Project
Finish Date, the Finish Date field becomes available.

1~ Set the current date. Project can fill in the current date according to
your computer calendar. Or, you can choose another date if you like,
but that usually doesn’t make much sense unless you're in a different
time zone from where the project will occur.

1~ Set a status date. By default, no status date is set for the project. You
use a status date when you’re tracking the progress of your project at
regular intervals. If you set a status date, your computer assumes that
any activity you record in your project is being tracked as of this date.
(This is particularly important to ensure Project accurately calculates
some values, such as the ultra-wonky earned value, a statistic I explain
to you in Chapter 14.) You can find out more about this feature in
Chapters 12, 13, and 14.

www.it-ebooks.info


http://www.it-ebooks.info/

Part |: Setting the Stage for Project

\NG/
S

\\3

Figure 1-11:
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1 Set the working calendar for your project. You have three default
choices: Standard, Night Shift, and 24 Hours. Base your choice on the
working habits of your organization. For example, if your company uses
resources in three shifts per day — a total of 24 hours of straight work-
ing time — and all those shifts would contribute work to your project,
choose 24 Hours. If you use a day shift and a night shift, choose Night
Shift. If you work a standard 8-hour day, choose Standard. (Most proj-
ects use a standard calendar with a typical 8-hour workday.)

Calendars can get a little confusing. A project calendar that you set in
this dialog box indicates what the usual workday is like in your com-
pany, but you can set up individual calendars for each resource you
create. You can then more easily accommodate both shift workers
and nine-to-fivers in the same schedule. See Chapter 3 for more about
resource calendars.

1~ Assign a priority to your project. Assigning a priority (such as 500
for high priority or 100 for a lower priority) can be especially useful if
you use the same resources across several projects. With your priori-
ties set on all projects, Project tools can then automatically reallocate
resources.

You can also create custom project information fields for your organization in
the Enterprise Custom Fields section of this dialog box. For example, you may
want a field that explains which department in the company is running the
project.

Clicking the Statistics button in this dialog box presents an overview of your
project, as shown in Figure 1-11.

Project Statistics for 'New Fitness Center Location Remodel Plan" =

Start Finish
Current Thu 771710 Fri 10/1/10
Baseline Thu 71710 Fri 10/1/10
Actual MA e
Variance od od
Duration wiork Cost

Current 66.25d 2,654h $279,990.00
Baseline 66.25d 2,654h $279,990.00
Actual od ah $0.00
Remaining 66.25d 2,654h $279,990.00
Percent complete:

Duration: 0% Work: 0%

Perusing the project schedule

After you choose settings in the Project Information dialog box and then click
the OK button, you're faced with a blank Project schedule, as shown in Figure
1-12. As a writer, I can tell you that nothing is as daunting — or as inspiring —
as facing a blank page. It’s the canvas on which you create your Project plan.
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Figure 1-12:
Begin with a
new Project
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|
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Ready | 5 New Tasks | Manually Scheduled |

IEEEES) e

Sheet Chart area

In Figure 1-12, you see Gantt Chart view. You discover more about various
views in Chapter 2. For now, note the following:

v File tab, Ribbon, and Timeline: These tools are part of the new inter-
face for Project 2010. You find out more about using them in Chapter 2.

1~ Sheet: The left side of the view is the sheet or sheet pane. You can use

this spreadsheet interface to enter, edit, and view information about
your project.

v Chart area: The chart area on the right reflects your task information
graphically as soon as you begin to add tasks:

¢ Gantt bars in this area indicate the duration and timing of tasks in
addition to the progress you record on them.

e The timescale — the indications of time increments across the top
of the chart area — helps you interpret the timing of each task bar.
You can adjust the increments to show your project in larger or

smaller increments of time. Figure 1-12, for example, shows incre-
ments in days.
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You start building a project by entering tasks. Simply click a cell in the Task
Name column of the sheet section and then type the name. You can enter and
edit details of a task by entering information directly into various columns
(which you can display in many views) or by double-clicking the task name

in the sheet to access the Task Information dialog box (see Figure 1-13). I get
into more detail about entering task information in Chapter 2.

Task Information ==
[Generdl!| predecessars | Resources | Advancedl HMotes | Custom Fie\ds.‘

Mame: | ¥isit locations Duration: | 5days | Estimated
Percent complete: | 0% : Priority: | 500

Schedule Mode: Manually Scheduled Inactive

@ Auto Schedule
Dates
Start:  Thu 78810 » Finish:  Wed 7/14/10 -
Display on Timeline

Starting with templates

Reinventing the wheel has never been one of my favorite sports, so I'm grate-
ful that Microsoft provides some convenient project templates through the
online site Office.com. These include projects by type, for example, an engi-
neering project or office move. Templates already have many tasks appropri-
ate to the task type created for you.

Templates typically contain sample tasks broken into logical phases, with
task durations and dependencies in place. The templates from Microsoft
often include resources, but you can create your own resources as well as
use, edit, or delete the ones provided.

You can open a template from the Backstage view, a new location in Project
2010 where you create and manage Project files. To do so, follow these steps:

1. Choose Filez>New.
The Available Templates screen appears, as shown in Figure 1-14.

2. Click the a category icon in the Office.com Templates section, then
click a category icon if necessary. Or, click More Templates and
then click a category.

The templates in that category appear.
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3. Click a template to display a preview.
As shown in Figure 1-15, a preview of the selected template appears at
the far right.
4. When you find the template you want to use, click Download.

The template opens in Project template format (MPT). You can then use
the Save As command on the File tab to save the file as a regular Project
file (the correct type will be selected automatically) with a new name.
From there, you can delete tasks, move tasks around, or add tasks as
necessary for your project.

After opening a template, be sure to check its project information
(choose Project>Project Information) to make sure that the Start Date
and Calendar options are set as you want.

If you modify a file and think that you might use that set of tasks again for
future projects, consider saving the file as a custom template. Just choose
Filem>Save As, and then select Project Template in the Save as Type list.

Note that after you download a template, you can select it without download-
ing it again. To do so, choose FilecwNew, click My Templates at the top of

the Available Templates screen, and then double-click the template in the
Personal Templates tab of the New dialog box.
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Saving a Project for Posterity

Saving Project files works just as saving does in most other software you’'ve
used. Here’s a reminder.

To save a Project file that you haven’t saved before, follow these steps:

1. Choose File>Save As.

You can choose Save instead if you created the project from scratch
rather than from a template.

2. Use the navigation pane at the left (Windows 7 and Vista) or the Save
In list (Windows XP) to locate the folder where you want to save the
file; then click to select it.

3. In the File Name text box, type a name for the project.
4. Click the Save button.
<P It’s good organizational practice to create a folder for your project where you
save in one place not only your Project files but also supporting documents,

e-mails, and other items. You can create a new folder from within the Save As
dialog box by clicking the New Folder button.
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Getting Help from Project

If you can get to work without mishap and turn on your computer, you
probably know how to use a help system in software, too. Table 1-1 offers a
rundown of the types of help you can find in Project 2010 when you click the
Help button just above the right end of the Ribbon or when you press F1.

Tabhle 1-1

Project Help Features

Help Feature

How to Use It

Browse Project Help

The main part of the Project Help window displays
a list of overall help categories. Click a category,
and then browse to a subcategory if needed before
clicking the topic to view.

Back, Forward, Stop, and
Refresh buttons

These buttons on the Project Help window toolbar
enable you to move between screens and stop and
refresh downloaded help as needed.

Home button

Redisplays the initial Help contents.

Print button

Prints the current document.

Change Font Size button

Enables you to change the size of the text in the
Project Help window.

Show/Hide Table of
Contents button

Enables you to display (or hide) a Table of Contents
pane at the left so you can drill down a “tree” of help
contents.

Keep On Top/Not On Top Enables you to specify whether or not the Project

button Help window should stay open in front of other
windows.

Search Enter a term or phrase to search for in the text box

and then click the magnifying glass to perform the
search. To control what locations are searched,
click the arrow at the right side of the word Search
and click a selection.

Offline/Connected to
Office.com button

Click this button in the lower-right corner of the
Project Help window and then click a choice in
the menu to control whether you are viewing help
installed on your computer or the online help from
Office.com.

As you can see, you could spend a year just working your way through all the
help topics in Project. Don’t worry; they’re there when you need them.
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Chapter 2

The Best-Laid Plans

In This Chapter

Exploring the benefits of Project’s new interface
Finding your way around Project
Exploring Project views

Personalizing views for your needs

H omer (not Simpson — the other one) once said, “The evil plan is most
harmful to the planner.” In the interest of helping you avoid the evils of
bad planning, take a moment to get comfortable with various aspects of con-
trolling Project and moving around in your Project plan.

The file that you create in Project is called a Project plan, or schedule. This
plan is like a multidimensional chess game from Star Trek, with a plethora of
data about various aspects of your project as well as graphical representa-
tions of that information.

To see that information, Project provides more views than the Grand Canyon.
These views help you observe the structure of your plan and see the prog-
ress in your project. Project also offers many ways to move around and dis-
play different information in your views. Navigating Project and displaying
(and modifying) its views are the topics covered in this chapter.

Project 2010’s New Interface

When Microsoft updated the navigation structure in the 2007 editions of
the core Office apps like Word and Excel, it left Project stuck with drab old
menus. With the 2010 version, Project finally gets the makeover it was wait-
ing for. The following sections describe how to “work it” when you need to
choose commands and work with files.
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Using the Ribbon

The Ribbon dresses up the top of Project’s screen with a colorful collection
of buttons for commands and settings, as shown in Figure 2-1. The Ribbon
improves on the old menu system because you can see a variety of com-
mands on-screen at once and make many selections with a single click.

Quick Access Toolbar  Tabs Minimize the Ribbon button
= [Gantecha Projectl - Microsoft Project r ¢ =
Task | Resource  Project  Wiew Farmat | (7 Nl
& Calibri - eEmoes 7 Mark an Track = TP Inspect - - ] i =] :L:} G4 -
I3 - . _, "FRespectlinks = 2-
gy BIU DA | @ 8¢5 - B viode - Task Infarmstien — tg:;:;\k -
Clipboard Font S(heldu\e Taka Insert Properties Editing
File tab Groups

The Ribbon includes fabs that organize commands based on a particular
activity. If you want to work with resource information, chances are you’ll
find the command or setting you want on the Resource tab. Some tabs come
and go as needed. For example, the Gantt Chart Tools Format tab shown in
Figure 2-1 appears only when Gantt Chart view is displayed. Each tab places
related choices together in groups. Say you wanted to format a cell on the
sheet. Chances are you’d find the format choice you need in the Font group
shown in Figure 2-1.

When a button on the Ribbon has a down arrow beside or below it, clicking
that arrow opens a menu with additional choices. In most cases, you can
click either the button itself to give the command directly, or click the down
arrow to check out your other options.

Throughout the book, I use the = symbol to point you to the right command
or choice on the Ribbon. For example, “Choose Project=>Visual Reports”
means “Click the Project tab on the Ribbon, and then click Visual Reports.”

If you can’t make it through the day without using the keyboard to give com-
mands, no worries. Press the Alt key, and KeyTips appear on the Ribbon.
Press the letter key for the tab you need, and then press the key for the
desired choice on the tab. If a KeyTip contains two characters, as in T1, press
the key for the first character and then the one for the second character.
Press the Esc key to back up anytime.

Press Ctrl+F1 or click the Minimize the Ribbon button (Figure 2-1) to hide and
redisplay the Ribbon.
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Above and to the left of the Ribbon is a small toolbar called the Quick Access
Toolbar. It appears on-screen at all times and initially contains the Save,
Undo, and Redo buttons. To add more buttons, click the down arrow at the
right end of the toolbar and click a button to hide or display in the menu.
Don’t see the command you want? Click More Commands near the bottom of
the menu to discover the other commands you can add.

The Backstage view

The stylish green button at the left end of the Ribbon is called the File tab.
Clicking it opens the Backstage view, where you find the choices for working
with files and changing options in Project. As shown in Figure 2-2, the main
choices in the Backstage view are listed along the left. Clicking some of the
choices, such as Open, displays a dialog box or performs an action immedi-
ately. In other cases, selecting a command in the Backstage view gives you
a list of additional choices or a graphical screen for completing the action
you want. Clicking Recent displays a list of recently used files you may want
to reopen. Clicking Print displays a screen where you can choose settings to
preview the printout (Figure 2-2).
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Use the Exit command at the bottom of the list to shut down Project. If you
display the Backstage view and want to return to working with your project,
click the File tab again or one of the other Ribbon tabs.

Finding commonly used commands

Want to see what you can do right now with any item on the screen? Right-
click the item and Project displays both a shortcut menu and a mini-toolbar.
They present only the commands and choices for working on what you
clicked, so you don’t have to bother with the Ribbon. When I click on a Gantt
bar, for example, the choices shown in Figure 2-3 appear. The choices for
clicking a cell on the sheet would be different. You can either use one of the
commands that appear or press Esc or click elsewhere to bail out.
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Navigating Project

For each project plan file you create, Project essentially builds an extensive
database of information. The different views in Project enable you to zero in
on different combinations of the data you need. Having a lot of views from
which to observe your project information is great, but all those views don’t
do you any good if you don’t know how to get from one to the other or how
to move around in a view after you find it.

Changing views

You can move from one view to another in Project by using the Task and
View tabs on the Ribbon. Clicking the bottom part (with the down arrow) of
the Gantt Chart button at the left of the Task tab displays a menu of Project’s
13 most used views, as shown in Figure 2-4, as well as any custom views you
create. Simply click any view listed to display that view. In case it’s not obvi-
ous, clicking the top part of the Gantt Chart button redisplays Gantt Chart
view.
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Clicking the View tab on the Ribbon gives you alternate choices for selecting
a view and more, as shown in Figure 2-5. The Task Views group at the far left
enables you to select Gantt Chart, Task Usage, Network Diagram, Calendar,
and Timeline views. The Resource Views group enables you to select the
Team Planner, Resource Usage, Resource Sheet, or other resource views.
The other groups on the tab offer choices for adjusting the view and the data
shown. You can zoom a view to see it better or sort the data shown in the
view, for starters.
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The lower-right corner of the Project window includes buttons for jumping
directly to Gantt Chart, Task Usage, Team Planner, and Resource Sheet views.
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In addition to the views you can display via the Task or View tabs, you may
need to use one of the dozen or so other views as you work through your
project. To display views not directly available via the Ribbon, follow these
steps:

1. Click either the Task or View tab on the Ribbon.

2. Click the bottom part of the Gantt Chart button.

3. Click More Views at the bottom of the menu.

The More Views dialog box appears, as shown in Figure 2-6.

More Views =
Yiews:
Bar Rollup - M.
Calendar —
Descriptive Netwaork Diagram = Edit
Dietail Gantt 3 =
Gankt Chart
Gantt with Timeline Copy...
Leveling Gantt
Milestone Cate Rollup Qrganizet. ..
Milestone Rollup
Multiple Baselines Gantt
Metwork Diagram T

4. Use the scroll bar to locate the view you want.

5. Select the view you want and click the Apply button.

If you liked the View bar that was available in earlier versions of Project, you
can still use it. Right-click the gray bar at the left side of Project and choose
View Bar to display it. Right-click the View bar and choose View Bar to hide it
again.

Scrolling around

The simplest views, such as Calendar view, have a single pane, with horizon-
tal and vertical scroll bars. Other views, such as Resource Usage view (see
Figure 2-7), have two panes. In that case, each pane has its own horizontal
scroll bar; they share the vertical scroll bar, so the panes move up and down
together.

In most views with two panes, the pane to the left is called the sheet, which is
a spreadsheet-like interface with columns of information. To the right of this
view is the chart. The chart uses bars, symbols, and lines to represent each
task in your project and the dependency relationships among them.
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Figure 2-7:
Multiple
panes of

information
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many views.
|
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At the top of the chart area is the timescale. This tool is used as a scale
against which you can interpret the timing of the taskbars. To see your plan
in greater or lesser timing detail, you can modify the time units used in the
timescale. For example, you can look at your tasks in detail over days or in a
broader overview in months. Figure 2-8 shows a two-pane view with a sheet,
chart, and timescale.

See the “Changing the timescale” section, later in this chapter, to find out how
to change the time increments displayed in the timescale.

By using the horizontal scroll bars in each pane, you can view additional
columns or additional time periods in any pane with a timescale. Timescale
panes cover the life of the project; in longer projects, you can scroll through
years of time.

Use these different methods to work with scroll bars:

v Drag the scroll box on a scroll bar until you reach the location in the
pane that you want to look at. When you drag the scroll box to move
through a timescale display, the date display indicates where you are at
any time in your scrolling calendar. Release the mouse button when the
date display matches the date you want to view.
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v Click to the left or right of the horizontal scroll box to move one page
at a time. Note that a page in this instance is controlled to some extent
by how you resize a given pane. For example, with a timescale pane
and a timescale set to weeks, you move one week at a time. In a sheet
pane that displays three columns, you move to the next (or preceding)

column.

v Click the right or left arrow at either end of a scroll bar to move in
smaller increments. With a sheet pane, you move about one-half column
per click. In a timescale view with weeks displayed, you move about one

day at a time.

Getting to a specific spot in your plan

To reach a particular area of your Project plan, you can also use the Go To
feature, which you use by pressing the F5 key. With Go To, you can enter
either of two items in the Go To dialog box when you want to find a task:

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 2: The Best-Laid Plans

WMBER
@&
&

v A date from a drop-down calendar
v AtaskID
You can also click the Scroll to Task button on the Task tab of the Ribbon (or

press Ctrl+Shift+F5) to scroll the chart pane of the view to show the taskbar
for a selected task in the sheet pane.

The task ID is assigned automatically when you create tasks; this number pro-
vides a unique identifier for tasks in the plan.

A Project with a View

A\

Views organize information so that you can get to it in logical ways. Because
of the complexity of information in a typical Project plan, Project offers many
views for slicing and dicing the information. If an average word processing
document is as complex as a cookie, your average Project plan is more like a
five-tier wedding cake adorned with intricate flowers and garlands in delicate
swirls of sugary icing.

A Project plan holds information about the following:

” Resources: The resource name, resource type, rate per hour, overtime
rate, department, cost per use, and more

v~ Tasks: The task name, duration, start and finish dates, assigned
resources, costs, constraints, and dependencies, for example

v Assignments: The information about which resources will be completing
which tasks, including hours of work, units of effort, and remaining work

1 Project timing and progress: Several types of calendars, project start
and finish dates, percentage of tasks completed, resource hours spent,
baseline information, critical path information, and more

v Financial information: Earned value, time and cost variance, and pro-
jected costs for uncompleted work, for example

Want to get closer? In every view, you can use the Zoom command on the
View tab to see more or less detail in your schedule. Read more about using
the Zoom button in the sidebar “Zooming in and out,” later in this chapter.

Finding out how to use the many Project views to enter, edit, look at, and ana-
lyze Project data is important. Don’t worry that you’ll be overwhelmed: After
a while, using all those views is . . . well, a piece of cake.

For more about modifying the format of elements displayed in a view, see
Chapter 11.
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Figure 2-9:
Gantt Chart
view can
display any
combination
of columns
of data that
you want.
|

Home base: Gantt Chart view

Gantt Chart view is like a favorite room in your house, the place where most
people end up. It’s the view that appears first when you open a new project.
This view, shown in Figure 2-9, is a combination of spreadsheet data and a
graphical representation of tasks; it offers a wealth of information in one place.
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Gantt Chart view has two major sections: the sheet pane on the left and

the chart pane on the right. This view is an electronic version of the origi-
nal Gantt chart, developed by engineer Henry L. Gantt in 1917 to deal with
production-control projects in manufacturing. (See? Invent a project manage-
ment tool, and you too can become immortal.)

In Gantt Chart view (and any view with a sheet pane), you can change what
information is shown in the sheet by using tables. Tables are preset combi-
nations of columns (fields) of data that you can easily display by choosing
Vieww>Tables and then choosing a table (such as Entry or Cost) from the
menu that appears.

You can also customize the column display for any table by displaying or

hiding individual columns of data one by one. (See the section “Displaying dif-
ferent columns,” later in this chapter, for information about this procedure.)
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The resourceful views: Resource
Sheet and Team Planner

Resource Sheet view, shown in Figure 2-10, is where you add the resources
that will be handling the work for your project. Because this simple view con-
tains only a sheet, you should feel right at home in it. You can type entries

in cells and use the Tab and arrow keys to move around. Chapter 7 digs in

to what each of the fields of this view is for, and how to set up your resource
and cost info the right way.
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Even though it’s tough to avoid overbooking resources when you have a
project jamming too much to do in too little time, the Professional Edition

of Project 2010 adds even more help for dealing with that issue. New Team
Planner view, shown in Figure 2-11, shows you what each team member is
scheduled to work on, and when. You can change an assignment simply by
dragging it from one resource to another. Voila! Assignment problems solved.
You find out more about this view in Chapter 9.
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Getting your timing down
with the Timeline

Your manager and the project’s client may not want to see every detail in

your grand plan. If you need to share project information with a person whose
eyes glaze over easily, meet your new best friend — the Project 2010 Timeline.
The Timeline appears in its own small pane by default with some of the other
views. It gives a simplified picture of the entire schedule. When used with a
view like the Gantt Chart, as shown in Figure 2-12, the portions of the schedule
that aren’t visible in the chart pane are shaded. You can also display individual
tasks on the Timeline as needed, and more. Chapter 16 delves in to how to
work with the Timeline and use it as a communication tool.

Going with the flow: Network
Diagram view

Another view that you’re likely to use often is Network Diagram view, which
is shown in Figure 2-13. The organization of information represents the
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Figure 2-12:
Timeline
view covers
the whole
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workflow in your project, with a series of task boxes. The boxes include
dependency lines running between them to reflect the sequence of tasks (see
Chapter 6 for more about dependency relationships). You read this view
from left to right, with the earlier tasks on the left flowing into later tasks and
subtasks to the right. Tasks that happen in the same time frame are aligned
vertically above each other. Tasks with an X through them have been marked
as complete.
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Traditionally called a PERT chart, this method of diagramming workflow was
developed by the United States Navy in the 1950s for use in building the
Polaris submarine.

Network Diagram view has no timescale because the view isn’t used to see
specific timing but rather to see the general order of tasks in a plan. However,
each task box holds specific timing information about each task, such as the
start date, finish date, and duration. (You can customize the information in
the task boxes, as described in the section “Customizing Views,” later in this
chapter.) Timeline view, by default, appears along the top of this view.
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Figure 2-13:
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Calling up Calendar view

Who can conceive of creating a schedule without opening a calendar? This
familiar view of time is one of the many views offered in Project. Calendar
view, as shown in Figure 2-14, looks like a monthly wall calendar, with boxes
that represent days on a calendar in rows that represent the days in a week.

You can modify Calendar view to display as many weeks as you need by
clicking the Custom button and changing the Number of Weeks setting in
the Zoom dialog box. Calendar view also includes a timescale that you can
modify to show a 7-day or 5-day week and shading to indicate working and
‘x‘g\l\BER nonworking days based on a selected base or resource calendar.

& More than two dozen views are built in to Project. You encounter many more
as you work through specific elements of Project in this book.
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Figure 2-14:
The familiar
calendar
interface
shows you
how one
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straddle
several days
(or even
weeks).
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Customizing Uiew's

Just when you thought you were starting to get a handle on the two dozen or
so views available in Project, I dazzle you with even more possibilities: Every
one of those views can be customized to show different information. Now the
possible view variations become astronomical.

You can customize every view in Project to show different information; for
example, you can choose to show different columns of information in spread-
sheets, different labels in Network Diagram boxes or taskbars, or different
sets of data in graph views. You can modify the size of panes of information
and adjust the timescale.

Why all this flexibility with what you see on-screen? At various times in

a project, you need to focus on different aspects of your tasks. Having a
problem with costs? Take a look at Resource Usage view and insert several
columns of cost information, such as resource rates and total actual costs.
Is your plan taking longer than the Hundred Years’ War? You may want to
display Tracking Gantt view and look at a bunch of columns with timing and
dependency data or examine the project’s critical path in the chart pane.
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Figure 2-15:
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Need to display more of the sheet area so that you can read those columns
without having to scroll? You can do that, too. In the following sections, you
find out how to do all the things you need to do to show a variety of informa-
tion in each view.

Working with view panes

In addition to Gantt Chart view, several other views have two panes, such as
Task Usage, Tracking Gantt, and Resource Usage. When the Timeline appears
with a view, it appears in a third horizontal pane at the top. You can modify the
information that you see in the sheet pane as well as the scale for timing in the
chart pane. You can also display information near taskbars in the chart pane.

Resizing a pane

In views that show more than one pane, you can reduce or enlarge each
pane. This capability helps you see more information in one area, depending
on your focus at the time.

The overall area taken up by the panes is constant, so when you enlarge one
pane, you reduce the size of the other.

Follow these steps to change the size of a pane in a view:

1. Place your mouse pointer over the edge of a pane.

2. When you see a pointer that’s a line with two arrows (one pointing left
and one pointing right, as shown in Figure 2-15), drag:

* Dragging to the left enlarges the pane on the right.
¢ Dragging to the right enlarges the pane on the left.

¢ Dragging up or down changes the size of the Timeline pane versus
the area available for the rest of the view.

b
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Figure 2-16:
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3. Release the mouse button.

The panes are resized.

Changing the timescale

[ wish I could tell you that Project actually lets you change time and give your
project lots more of it, but it doesn’t. What it does allow you to do is modify
the timescale to display your plan in larger or smaller time increments.

A timescale consists of a possible total of three tiers, as you can see in Figure
2-16. You can use the tiers to display different time increments. For example,
the top tier can mark off months, while the middle tier marks off weeks and
the bottom tier marks off days. This variety of detail lets you easily observe
overall task length as well as points in time during the life of the task. You
can use all three tiers, only the middle tier, or the middle and bottom tiers.

Timescale
Top Tier Middle Tier | Bottom Tier ‘ Mon-working kime: |
Middle tier Formatting

Units:  Weeks - Label:  Jan 25,'09 - | Use Fiscal year

Count: |1 = align:  Left - | Tick lines

Timescale options

Show:  Two tiers {Middle, Bottom;) - Size: | 100 A /| Scale separator

Preview

11 [Fek13,"11 [Fek 20,11 Feb 27,11 War &, 11 |
T[T IF[s[STMIT IWIT[F[S[sTMIT AT [FIS[S M7 WIT[F [S[SIM[TW]T [F]S]

Help Cancel

You can modify the units of time and the alignment of each tier and also
include tick lines to mark the beginning of each increment on the timescale.
You also have the option to include or not include nonworking time on the
timescale. For example, if you include an indication of nonworking time on a
project for which weekends are nonworking, Saturdays and Sundays are indi-
cated by a shaded area in the display, which can make a useful visual divider
between weeks.

You can also display text labels near taskbars and change what data is
included. Labels can be placed above, below, inside, or to the left or right of
the taskbars. Especially in projects where you display many columns of data
and a lengthy schedule, a taskbar can be placed far to the right of the sheet
pane data. You can then include information, such as task name or start date,
alongside the taskbar to help you read your plan more easily.
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To modify the timescale, follow these steps:

1.

Right-click the timescale in any view that contains one and then
choose Timescale.

The Timescale dialog box appears. (Refer to Figure 2-16.)

2. Click a tier tab and select a style for Units, Label, and Align.

3. Set the count.

For example, if your Units choice is weeks and you change the Count
option to 2, the timescale appears in two-week increments.

. If you don’t want to display a certain tier, select One Tiers or Two

Tiers from the Show drop-down list (in the Timescale Options section).

. If you want Project to use fiscal year notation in the timescale, select

the Use Fiscal Year check box.

For example, if your 2010 fiscal year begins July 1, 2010, 2011 is used on
all months in the fiscal year. The fiscal year is set in the Options dialog
box on the Calendar tab.

. To show marks at the beginning of each unit of time, select the Tick

Lines check box.

7. Repeat Steps 2-6 for each tier you want to modify.

8. Click the Non-working Time tab.

9. In the Draw options, select the one you prefer.

10.

11.

12.

Your choices are to have the shaded area for nonworking time appear
behind taskbars or in front of them, or just not appear.

In the Color or Pattern list, select different options for the shading
format.

Click the Calendar setting and select a different calendar to base the
timescale on.

You can find out more about calendar choices in Chapter 3.

Click the OK button to save your new settings, which apply only to the
timescale for the currently displayed view.

You can use the Size setting on the three tier tabs to shrink the display pro-
portionately to get more information on your screen or the printed page.
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Zooming in and out

One way to modify your display for any Project
view is to use the Zoom menu on the View tab
of the Ribbon. This feature shows you a longer
or shorter period of time in your project without
you needing to change the timescale settings
manually. When you need to see several years
at a time in your project, for example, click
Zoom and then Zoom Out several times until you

view. You can also choose Zoom at the bottom
of the menu and specify periods of time to dis-
play in the Zoom dialog box, or even choose
to have the entire project appear on-screen.
Another quick but less precise way to zoom is
to use the Zoom slider at the lower-right corner
of the Project window. Drag it left to zoom out
and right to zoom in.

51

fit as many months or years as you like in the

Displaying different columns

Each spreadsheet view has certain default columns of data that are stored

in tables. Gantt Chart view with the Tracking table displayed, for example,
has data related to the progress of tasks. The Resource sheet contains many
columns of data about resources that can be useful for entering new resource
information. In addition to displaying predefined tables of columns, you can
modify any spreadsheet table to display any columns you like.

Follow this procedure to show selected columns of data:
1. Scroll the table to the right, and click the Add New Column column
heading.
A list of available columns appears, as shown in Figure 2-17.

2. In the list, select the field that contains the information you want to
include. (Typing the first letter of the field name scrolls the list more
quickly.)

3. If you want to enter a different title for the field, right-click and
choose Field Settings. Type the name in the Title box and click the OK
button.

The title in the current view appears in the column heading for this field.
4. Move the mouse pointer over the column heading, and drag the
column to the left to the position you want in the table.

To hide a column, right-click its heading in the sheet pane and then choose
Hide Column. Or, to insert a column at a particular location, right-click the
column heading that’s currently at that location and choose Insert Column.
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Figure 2-17:
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You can also display preset tables of sheet data, such as Tracking for record-
ing activity on tasks or Entry for entering new task information. You do this
by simply choosing Viewr>Tables and then clicking the name of the table you
want to display.

Modifying the contents of the
Network Diagram boxes

When you first display Network Diagram view, you see boxes of various
types, one for each task in your project. You can change the information con-
tained in those boxes and change the box formatting.

By default, a typical subtask contains the task name, task ID, start date, finish
date, duration, and resource names. For a milestone, you get only the mile-
stone date, milestone name, and task ID number.

See Chapter 4 for more about adding information about tasks and milestones.
Different categories of tasks (such as critical or noncritical) can contain differ-

ent information, and you can change the information contained in any indi-
vidual box or category of boxes.
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Figure 2-18:
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Changing what’s in the box

Sometimes you want to see information about task timing; other times, you
focus on other issues, such as resources. To accommodate these various
information needs, Network Diagram view allows you to use various tem-
plates for what’s contained in the diagram boxes.

To modify the information included in these boxes, follow these steps:

1. Right-click anywhere in Network Diagram view outside any box and
then choose Box Styles.

The Box Styles dialog box appears, as shown in Figure 2-18.

Box Styles ==

Style settings For: Preview:

Critical

Noncritical

Critical Milestone
RNoncritical Milestone

Critical Summary [Hame]

Monicritical Summary start [$tart] 10 [ID]

ritical Inserted Project

Toncritical Inserked Project Finish: [Finish] Dur: [Duration]
Critical Marked Res: [Resource Hames]

Noncritical Marked

Critical External
RMoncritical External

Set highlight Filker style Shows data From bask [D: =
Data template
Standard - Mare Templates. ..
EBorder
Shape: [ — v coor: [N - width: -
| Show horizontal gridiines Show vertical aridiines
Background
olor: ~ earern: [ ~
b e

2. In the Style Settings For list, select a task category.

3. To modify the data included in the task boxes, select a different tem-
plate from the Data Template list.

You can choose additional templates (and edit any template to include
whatever data you like) by clicking the More Templates button.

A preview of the data included in the template appears in the Preview
area.

4. Click the OK button to save the new template.
You can also apply different templates to each box separately by right-clicking
a box (rather than clicking outside a box), choosing Format Box, selecting a

different template from the Data Template drop-down list, and then clicking
the OK button.

www.it-ebooks.info


http://www.it-ebooks.info/

54

Part |: Setting the Stage for Project

&

@&

WBER

A\

Making boxes pretty

Are you the creative type? Don’t like the shape or color of the boxes in the
Network Diagram boxes? Want to add shading to the background of the
boxes? Project lets you do all that and more.

Follow these steps to modify the format of Network Diagram boxes:

1.

7.

Right-click anywhere in Network Diagram view outside any box and
then choose Box Styles.

The Box Styles dialog box appears (refer to Figure 2-18).

. Click the Shape drop-down list and select a different shape from the

list that appears.

. Click the Color drop-down list in the Border section and select a dif-

ferent color from the list of colors.

Note: This choice specifies the color of the line that forms the box, not a
background color. For that, see Step 5 of this list.

. Click the Width drop-down list and select a line width from those

displayed.

. Click the Color drop-down list in the Background section and select a

color for the background that fills the inside of each box.

. Click the Pattern drop-down list and select a pattern of lines to fill the

interior of each box.

Combinations of some patterns and colors in backgrounds can make the
text in the box difficult to read, so look at the preview in this dialog box
to be sure that the combination works.

Click the OK button to save the new settings.

You can also format individual boxes by right-clicking a box, choosing Format
Box, and then making the settings outlined in this set of steps.

Resetting the view

Most changes you make in a view hang around as long as you want them to.
But if you’'ve made so many changes that the view is kind of a mess, you can
reset it at any time. Click the Task tab on the Ribbon, click the bottom of the
Gantt Chart button, and click Reset to Default. Now the view will revert to the
default view.
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In This Chapter

Exploring the Base, Project, Resource, and Task calendars
Understanding how calendars work together

Setting calendar options, working times

Choosing the Project calendar

Working with Task calendars

Using Resource calendars

Creating your own calendar templates

Copying calendars to another project

M ost people live their lives based on clocks and calendars. Think about
it: You wake up, and your first thoughts are about what day it is, what
time it is, and whether it’s a working day.

You have a familiar definition for what your typical workday is, whether
you're a 9-to-5 kind of person or your particular job calls for you to work
from midnight to 8 a.m. You also vary from that routine now and then by put-
ting in a 12-hour marathon in a crunch or slipping away after half a day to go
fishing on a nice summer day.

Project 2010 calendars are sort of like your life in that they set some stan-

dards for a typical working time and then allow for variation. Unlike you,
Project 2010 has several types of calendars to account for.

Mastering Base, Project, Resource,
and Task Calendars

Bear with me because [ won’t kid you: Mastering the four calendars in Project
2010 can be tricky. Understanding how calendars work in Project 2010,
however, is essential to mastering the software. Tasks are scheduled and
resources are assigned based on the calendar settings that you make. Thus,
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the costs accumulated by resource work hours won’t be accurate if you don’t
understand your calendar settings from the get-go.

Because the use of the term project can get confusing as it refers to the soft-
ware, your project plan, and one of the calendar types (the Project calendar),
I need to explain the terminology I use in this chapter. I use Project 2010 when
referring to the software itself, Project calendar when referring to the calendar,
and just plain project when talking about your project plan.

How calendars work

Here’s the lowdown on the role of each of the four calendars in Project 2010
(with more in the next section about how they interact with each other):

1 Base calendar: This is the calendar template that all other calendars are
built on top of. Three Base calendars are available: Standard, 24 Hours,
and Night Shift. (You read more about them shortly.)

1 Project calendar: This is the default calendar for scheduling. This is
where you choose which Base calendar template this particular project
should use.

1 Resource calendar: This combines the Base calendar settings with any
exceptions (nonworking times) that you set for a particular resource.

v~ Task calendar: This is where you can set exceptions for a particular
task.

When you create tasks and assign resources to work on them, Project 2010

has to base that work on a timing standard. For example, if you say that a

task should be completed in one workday, Project 2010 knows that a workday
means 8 hours (or 12 hours or whatever) because that’s how you set up a
standard workday in your Project calendar. Likewise, suppose that you assign
aresource to put in two weeks of work on a task in a company that uses a stan-
dard five-day workweek. If that resource’s own calendar is set for a standard
four-day workweek, the two weeks of work put in by that resource defer to the
timing of the Resource calendar for a total of only eight workdays.

The nature of a task can have an effect on resource time. A two-week, effort-
driven task isn’t complete until its resources have put in two weeks (accord-
ing to the Project or Task calendar) of effort. Find out more about effort-driven
tasks in Chapter 4.

Not everyone in a company works the same schedule, and not every task can
be performed in the same eight-hour workday. To deal with the variations in
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schedules that occur in most workforces, Project 2010 offers various calen-
dar settings. As [ mention earlier in this chapter, Project, Resource, and Task
calendars can be set to use one of three Base calendar templates built into
Project 2010. The three Base calendar templates are as follows:

v~ Standard: The default setting. Sets a working day as 8 a.m.-5 p.m. with
an hour for lunch and a five-day, Monday-Friday workweek.
v 24 Hours: Allows work to go on around the clock every day of the week.

v Night Shift: Sets the working time as 11 p.m.-8 a.m. with an hour for
dinner and a six-night, Monday-Saturday workweek. Working times for a

Night Shift calendar are shown in Figure 3-1.

Check out the explanation at the right in Figure 3-1; it explains the different

hours of work available for the selected date.
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You can modify the three Base calendar templates and create new templates
from them. See the section “Do It Yourself: Creating a Custom Calendar

Template,” later in this chapter.
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How one calendar relates to another

All calendars in your project are controlled, by default, by the Project cal-
endar setting. Here’s the tricky part, though: When you change a Task or
Resource calendar (this type of change is referred to as an exception), you
have to understand which setting takes precedence.

Here’s how this precedence thing works:

v With no other settings made, the Base calendar template you select for
the Project calendar when you first create the project controls the work-
ing times and days of all tasks and resources.

v If you make changes in the working hours for a resource, those settings
take precedence over the Project calendar for that resource when you
assign it to a task. Likewise, if you assign a different Base calendar for a
task, that calendar takes precedence over the Project calendar for that
task.

v~ If you apply one calendar to a resource and a different calendar to a task
that the resource is assigned to, Project 2010 uses only common hours
to schedule the resource. For example, if the Task calendar allows work
from 8 a.m. to 5 p.m. and the Resource calendar allows work from 6 a.m.
to 2 p.m., the resource works from 8 a.m. to 2 p.m., which is the only
period the calendars have in common.

» You can set a task to ignore Resource calendar settings by opening the
Task Information dialog box (double-click the task name in Gantt Chart
view) and selecting the Scheduling Ignores Resource Calendars check
box on the Advanced tab. (This setting isn’t available if the Task cal-
endar is set to None.) You might make this setting if you know that all
resources are required to be involved in a task (such as a quarterly com-
pany meeting), regardless of their usual work hours.

Calendar Options and Working Times

Just when you thought that you were out of the woods, I'll throw two more
timing elements at you — calendar options and working times.

Calendar options are used to change the standards for a working day, week,
and year. If you set a Project calendar to Standard (by default, 8 a.m. to 5 p.m.,
five days a week), for example, the Calendar tab of the Options dialog box

is where you can designate which five days are working days or modify the
working hours to 9 a.m.—6 p.m.
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Working time is used to adjust the time available for work on a particular date
or days. Suppose that you make a change to the calendar options so that

you have 8-hour days and 32-hour workweeks. You should also check your
working time and be sure that you specify three days of the seven-day week
should be nonworking to jibe with the 32-hour week. If you want to set a cer-
tain date as nonworking for your project, such as your company offsite meet-
ing day, you can do that with the working time settings.

If you use Project Server for enterprise-wide project management, you can
make settings in the Enterprise Global Template, which sets the working time
for all projects across your company. See Chapter 18 for more about enter-
prise settings.

It is best to change all calendar options and make working time changes before
you add any tasks to your project. This ensures that the project will be sched-
uled accurately from the get-go. Also, you have to change the calendar options
and calendar settings for every new project file you create.

Setting calendar options

When you make changes to a Resource or Task calendar, you simply adjust
the times that a resource is available to work or the time during which a task
occurs. You don’t change the length of a typical workday for the project. A
day is still eight hours long if that’s the Project calendar setting, even if you
say that a task that takes place on that day uses the 24-hour Base calendar
template.

If you want to change the length of a typical workday to ten hours rather
than eight, for example, you must do so on the Calendar tab of the Options
dialog box.

Follow these steps to modify the calendar options:

1. Choose File=>Options.
The Project Options dialog box appears.
2. Click Schedule, as shown in Figure 3-2.

You can also display these settings by clicking the Options button in the
Change Working Time dialog box. Read about the settings there in the
following section.

3. From the Week Starts On drop-down list, choose a day.

4. To modify the start of your fiscal year, select the month you want from
the Fiscal Year Starts In drop-down list.
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5. To change the working hours for a typical day, type new times in the
Default Start Time and Default End Time fields.

If you change the default start or end time setting, you should also
change the corresponding working times. See the following section to
discover how to do this.

6. Modify the Hours Per Day, Hours Per Week, and Days Per Month
fields as needed.

7. Click the OK button to save the settings.
If your company uses these settings for most projects, you can click the Set as

Default button on the Calendar tab of the Options dialog box to make your set-
tings the default settings for any new project you create.

Setting exceptions to working times

If you want to change the available working hours for a particular day (such
as December 24), you use the working time settings. For example, if you want
the day before Christmas to be a half day, you can modify the working time
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settings for that day; then any resources assigned to a task on this date put in
only one-half day of work. You also use these settings to specify global work-
ing and nonworking days to match the calendar options settings.

Here’s how to change working times:

1. Choose Project=>Change Working Time.

The Change Working Time dialog box appears, as shown in Figure 3-3.

Change Working Time
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2. In the Click on a Day to See Its Working Times calendar section, click
the day you want to change.

3. Click the Exceptions tab to display it; then click the Name cell in a
blank row, type a name for the exception, and press Enter.

4. Click the exception name you just entered, and then click the Details

button.

The Details box for this exception appears (see Figure 3-4).

5. Select either the Nonworking or Working Times radio button.
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6. Enter a time range in the From and To fields.

\4 . .
<~ If you want to set nonconsecutive hours (for example, to build in a lunch

break), you have to put two or more sets of numbers here (such as 8 to
12 and 1 to 5).

7. Select a recurrence pattern and then set an interval in the Recur
Every x time period field.

For example, if you select Weekly and click the arrows to set the interval
field to 3, this pattern recurs every three weeks.

8. Set the range of recurrence.

You can do this step by entering Start and End By dates or by selecting
the End After radio button and setting the number of occurrences there.

9. Click the OK button twice to close the dialog boxes and save your
changes.
N The Nondefault Work Week legend item that you find in the Change Working
Time dialog box (refer to Figure 3-3) designates working time that isn’t part of
the working time established by the Base calendar template for this calendar.

Setting the Project Calendar and Other
Essential Project Information

The first calendar that you should specify for your project is the Project
calendar. You set the Project calendar in the Project Information dialog
box (shown in Figure 3-5), which you can display at any time by choosing
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Project>Project Information. At a minimum, you also should specify the start
date for the project in this dialog box. Project assumes you’re planning your
project in advance — as any good project manager does — so you need to
tell it the date from which it should start scheduling the project’s tasks.
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Skart date: Tue 2f1f11 - Current date:  Sun 5/13j09

Einish date: Fri 2j25/11 Status date: A

Schedule from: Project Stark Date - Calendar: Standard :

all tasks begin as soon as possible. - 24 Hours
Brioriy: Might Shift
I | Enterprise Custom Fields Standard

Figure 3.5 | Department:
Your choice
of calendars
includes
one of these
three Base
calendar

templates.

Here are the settings that you can make in the Project Information dialog box:

v Calendar: Select the Base calendar template to use for the Project calen-
dar from this drop-down list. I list this setting first because it’s the only
one you have to deal with when you start a new project.

v Start Date and Finish Date: For a project scheduled forward from the
start date (see the next bullet), enter only the start date. Or, if you
schedule backward from the finish date, enter a finish date. See more
about these settings in Chapter 4.

+* Schedule From: You can choose to have tasks scheduled backward from
the finish date or forward from the start date. Most folks go forward
from the start date.

v Current Date: By default, this setting matches your computer clock
setting. However, you can change this so that it does not match your
computer clock setting. Changing this date is useful for looking at what-if
scenarios or for tracking progress as of a certain date in the past.

v Status Date: You typically set this to the current date to track the prog-
ress on your project. When tracking, you usually want to see the status
of your project as of now, so you don'’t really need to deal with this
setting. However, if you want to track as of the end of a fiscal period or

another time frame, you can change this to track the status of your tasks
as of any other date.
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v Priority: This field is useful if your organization has many projects and
you create links among them. If you use a tool such as resource leveling
(see Chapter 10 for more about this topic) to resolve conflicts, it can
consider this project priority setting when making its calculations about
what to delay and what to keep on track.

Modifying Task Calendars

You can set a Task calendar to use a different Base calendar template than
the one you selected for the Project calendar. Doing so takes precedence
over the Project calendar for that task. Suppose that you select the Standard
calendar template for a project and a 24 Hours Task calendar template. If
you then specify that the task has a duration of one day, it’s one 24-hour day
(assuming that the resources assigned also use a calendar allowing for a
24-hour schedule).

To modify the settings for a Task calendar, follow these steps:

1. Double-click the task name.
The Task Information dialog box appears.
2. Click the Advanced tab.

3. From the Calendar drop-down list, choose a different Base calendar,
as shown in Figure 3-6.

Task Information =
General | Predecessors | Resources  Advanced | Hotes | Custom Fields ‘
Mame: | Plumbing rough in Durstion: | 3 days | = Estimated
Constrain task.
Deadline: Ma -
|
Figure 3-6: Constraint bype: As Soon As Possible ~ Constraint date: M4 -
YOU can Task type: Fixed Units - Effort driven
a p p ly a ny Calendar: Mone t] Scheduling ignores resource calendars

ofthe three | wescods:
24 Hours
calendar Earned value method RN
None
typeS to Mark task as mileste standard
tasks in your

proleCt Help Cancel

4. Click the OK button to save your new calendar setting.
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If a resource assigned to this task has a modified calendar, that resource
works only during the specific hours that the Task calendar and Resource cal-
endar have in common.

Making Resource Calendar Settings

WING/
&

Even the most resourceful resources have only so many hours in a day to
work. When you have to deal with variations in resource schedules, consider
modifying the Resource calendars.

Which resources get calendars?

Projects can have three types of resource: work, material, and cost. You can
read more about these in Chapter 7. For now, you should know that only one
resource type — the work resource — has its own calendar. That’s because
material resources are charged not by time worked but rather by units used,
and a cost resource gets assigned a set cost that also doesn’t relate to any
time worked on a task.

You can change the Base calendar template for each work resource and set
specific dates as working or nonworking. These exceptions take precedence
over your Project and Task calendars, and control when a specific resource
can work.

[ have one word of caution about modifying Resource calendars: Unless a
resource truly has a unique working schedule, don’t change its Base calendar
template. For example, if a resource usually works a day shift but works a
night shift for only a few days during the life of the project, don’t change that
resource’s Base calendar template to Night Shift. If one person works from

10 a.m. to 7 p.m. because the company allows him to, you probably don’t
have to vary his schedule from the typical 8-to-5 work schedule that’s set in
the Project calendar because he puts in eight hours a day like everyone else.
Unless your project deals with the most detailed level of time, where hours
and not days are the typical units of measure for tasks, making these types of
changes is more work than it’s worth.

Making the change to a
resource’s calendar

To modify a resource’s calendar settings, follow these steps:

1. Display a view that includes a resource column, such as the Resource
Sheet view.
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Just select the view from the drop-down list that appears when you click
the bottom of the Gantt Chart button on the Task tab of the Ribbon.
Chapter 1 covers how to display different views.

2. Double-click a resource name.
The Resource Information dialog box appears.

3. Click the Change Working Time button on the General tab to display
the Change Working Time dialog box, shown in Figure 3-7.

& The Exceptions and Work Weeks tabs have settings that are identical to
the ones in the Change Working Time dialog box I discuss for tasks, but
changes made here affect this resource rather than the task.

Change Working Time =]
Resource calendar For ‘PR Manager":

Base calendar:  Standard -

Click on a day ko see its working times:
Ockober 2010 - ‘Working times For October 1, 2010;

L d:

orking

S m T [wlmh[F]s
— +5:00 AM to 12:00 M
rworking + L300 M £0 5:00 PM
dited working CIN IR N LT R B
-4 hours 10 |11 |12 |15 [14 |15 |18

On this calendar: Based on:

17 |18 |19 |20 |21 |22 (23
Default work week on calendar ‘Standard',

24 |25 |26 |27 |28 |28 |30

31

Exceplions | work Weeks

Mame Start Finish - Details. ..

Delete

Figure 3-7:
Making
changes
here

affects this
resource.
|

o -

4. In the Click on a Day to See Its Working Times calendar section, click
the day that you want to change.

5. Click the Work Weeks tab to display it; then click a blank row, enter a
name for the exception, and press Enter.

If you want to edit the default work week for all weeks of the year, leave
[Default] selected instead. If you want to mark a single holiday, use the
Exceptions tab instead.
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6. Click back on the exception you just created, and click the Details

button.

The Details dialog box for this exception appears (see Figure 3-8).

Details for "Short Fridays® =

Set working time For this work week.

Sglect day(s): @ Use times from default work week for these days.

Monday Set day(s) to these specific working times:
Tuesday

Wednesday

Thursday

Friday [ ]
Saturday
= ]

Set days to nonwarking time.

7. Select the day(s) to modify in the Select Day(s) list at the left.

12.

You can click the first day and then Shift+click to select a range of adja-
cent days. Or, Ctrl+click to select nonadjacent days.

. Select either the Set Days to Nonworking Time or the Set Day(s) to

These Specific Working Times radio button.

. If you chose the latter option in Step 8, enter a time range in the From

and To fields.

To delete a row in the From and To area, click the row number and
press Delete.

If you want to set nonconsecutive hours (for example, to build in a lunch
break), you have to put two or more sets of numbers here (such as 8 to
12 and 1 to 5).

. Click the OK button.

. Set the range of recurrence.

You can do this by changing the start and finish dates on the row for the
exception, pressing Tab to finish each entry.

Click the OK button to close the Change Working Time dialog box and
save your changes.

Can resources work overtime even if their calendars say that they’re 9-to-
5’ers? Yes, but you have to tell Project 2010 to schedule overtime work. You
can also set a different rate to be charged for overtime work for that resource.
To find out more about overtime, see Chapter 8.
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Do It Yourself: Creating a Custom
Calendar Template

If you ever wanted to make your own time, here’s your chance. Although
Project 2010’s three Base calendar templates probably cover most work-
ing situations, you might want to create your own calendar template. For
example, if your project involves a telemarketing initiative and most proj-
ect resources work six hours, from 4 p.m. to 10 p.m. (that’s when they

all call mel), it may be useful to create a new calendar template named
Telemarketing. Another reason to create a custom template is that Project’s
three calendars have no holidays specified. At a minimum, you may need

to ensure that company holidays are indicated in the calendar you use to
ensure that Project accurately schedules around those dates.

If you want to save some time when creating a template (and time is what
this chapter is all about), start with an existing Base calendar template that
most closely fits your needs. Then, modify it as you like by making changes
to the working times and calendar options (see the section “Calendar Options
and Working Times,” earlier in this chapter) to make sure that they’re in
agreement. After you create a new calendar template, it’s available for you to
apply in all three calendars: Project, Task, and Resource.

Q‘\gN\BEB Because the Project calendar is the basis of your entire project, it should
& represent the most common working schedule in your project. If only some
resources in your project work odd hours, change the Resource calendars and
not the Project calendar.
Follow these steps to create a new calendar template:
1. Choose Project=>Change Working Time.
The Change Working Time dialog box appears.
2. Click the Create New Calendar button.
The Create New Base Calendar dialog box appears, as shown in Figure 3-9.
__ Create New Base Calendar (==
Flgure 3-9: Mame: | Copy of Standard
Sta rt your Create new base calendar
new Ca|en_ @ Make acopy of  Standard * calendar
dar here. [ Cancel
|

3. In the Name box, type a unique name for the new calendar.
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4. Select either the Create New Base Calendar or the Make a Copy of x
Calendar radio button. Then select an existing Base calendar from the
list to base your calendar template on.

If you choose Create New Base Calendar, Project creates a copy of the
Standard calendar with a new name. If you choose Make a Copy Of
and select 24 Hours or Night Shift, your new calendar is based on that
choice. Whichever you choose, it’s your starting point, and you can
make changes to make the calendar unique after making this choice.

5. Click the OK button to return to the Change Working Time dialog box.

Now you make changes to the working time for the new calendar
template.

6. Click the OK button to save the new calendar settings.
If you haven’t already done so, be sure to change the calendar options to

match the working times of the custom calendar you created. You can do this
from the Change Working Time dialog box using its Options button.

Sharing Copies of Calendars

<\P

You can make a calendar available for all projects by using the Organizer.
The Organizer serves as the control center for custom items such as calen-
dars that you create in your project files. With the Organizer, you can copy
a custom calendar from one project file into another. Or, you can copy a
custom calendar into Global .MPT, the behind-the-scenes template that pro-
vides default settings to every new, blank project file you create.

You can use regular Windows file copying methods to copy the Global.

MPT file from one user’s system to another’s. Then, all the custom items, like
custom calendars stored in Global .MPT, become available to the other user.
This method is especially useful when you want the project managers in your
company to be using a consistent calendar.

To copy a calendar from one project to another, follow this procedure:
1. Open the project to which you want to copy a calendar and the project
file that holds the custom calendar to copy.
2. Choose File~>Info.
The Backstage view opens.
3. Click the Organizer button.
The Organizer dialog box appears.

4. Click the Calendars tab, as shown in Figure 3-10.
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Organizer
views | Reports | Modules | Tables | Fiters Calendars | Maps | Fields | Groups
|
Figure 3-10: EEE/;E;%&::;?:?;?:{TFIHG: - — !::};::\:ss Center Location PR Plan’:
You can
copy your p—
calendar to Dol
other - e
p roj ects. | caendars avaiablein: Saendrs avalatle
New Fitness Center Staffing - =0

5. From the Calendars Available In drop-down list (lower left), select the
Project 2010 file that contains the calendar you want to copy.

6. In the Calendars Available In drop-down list (lower right), choose
whether you want to make the calendar available in another currently
open project (by selecting that project) or the Global template (by
selecting Global . MPT).

7. In the list on the left, click the calendar you want to copy and then
click the Copy button.

The calendar is copied to the current project.

8. If you want to give the calendar a different name, make sure that it is
selected in the list, click the Rename button, type a new name in the
Rename dialog box that appears, and then click the OK button.

9. Close the Organizer by clicking the Close button (the X) in the upper-

3 right corner.

Here are a few pointers about copying calendars from project to project:

1 Make sure that the name you give the calendar is descriptive.
Providing an appropriate name helps you remember the calendar’s gen-
eral parameters.

v If your company has standard calendars, try having one resource
create and disseminate them. If ten versions of a management calendar
float around and you grab the wrong one, it can cause problems.

1 Put the project manager’s initials in each calendar template name you
create. That way, you know which ones you created.
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A Tisket, a Task Kit

In This Chapter

Selecting the task mode for scheduling
Creating and importing tasks
Establishing task types and durations
Creating recurring tasks

Defining effort-driven tasks

Setting task constraints

Making a task inactive

Entering task notes

Saving a project

A project manager is, by necessity, a taskmaster because tasks form

the to-do list of your project. Tasks incorporate the What, When, Who,
and Where information of your plan. Resources work on a project by getting
assigned to tasks. The timing of tasks and the relationships between them
form the schedule for your project. By tracking the activity on tasks, you can
see the progress of your project over time.

You can create tasks in a few different ways: by typing information in the
sheet area of Gantt Chart view (or any other view that displays information
in columns) or by using the Task Information dialog box. You can also import
tasks from Outlook or Excel.

You have to make some choices when you create tasks. For example, you
have to determine and specify settings for a task that control its timing and
its priority, as well as certain constraints regarding how its timing may or
may not shift during the life of your project.

In this chapter, you find out all about tasks and the various settings that give
each task its own, unique personality.
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User-Controlled Scheduling:
Manual versus Automatic

|
Figure 4-1:
Manually
and autos-
cheduled
tasks.
|

One of the most valuable aspects offered by Project has traditionally been

its ability to recalculate task schedules when you change the project start

or a change to one task’s schedule affects one or more dependent (linked)
tasks. This powerful behavior saves the project manager — a.k.a. you — from
having to rethink and reenter dates to rescheduled tasks throughout your
project.

But flipsides to the benefits of automation always exist, and in the case of
project scheduling, straight-up automation can lead to unwanted schedule
changes based on machine thinking and not human expertise.

To keep the great things about automation that makes scheduling less time
consuming while allowing project managers to retain schedule control when
needed, Project 2010 introduces user-controlled scheduling.

With user-controlled scheduling, you can select a scheduling mode for each
task:

v With automatically scheduled or autoscheduled tasks, Project continues
to use its old method of calculating task schedules for you based on the
project start date and task dependencies.

v With manually scheduled tasks, Project enables you to skip entering the
duration and dates and specify them at a later time. You can alternately
enter information about the duration or dates, as in the example shown
in Figure 4-1. When you do enter the duration and dates, Project fixes
the schedule for the task and does not move it unless you do so manu-
ally. (The manually scheduled tasks will move if you reschedule the
entire project, in most cases.) The Gantt bars for manually scheduled
tasks also differ in appearance from those for automatically scheduled
tasks.

Icon for manually scheduled task

a Task | . |Task Name . Duratior Start - Fi Feb 25, '10
I odef F _
1 =9 =l Feld Preparation 2 days? Mon3/1/10 T =y
2 5 Turnover field 1 1 day —_—
3 E Turnover field 2 1 day Pending weath
4 3 Turnover field 3 1 day Pending v bim—]
H B Turnover field 4 1 day Pending weath
6 - Turnaver raisedbed 1 2 days Man 3/1/10 T -
7 :_> Turnover raised bed 2 2 days Mon 3/1/10 T =
Icon for automatically scheduled task Text or no entries

rather than dates
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One difference between the current version’s autoscheduling and the default
scheduling used in previous versions of Project is that effort-driven schedul-

ing is now turned off by default for new tasks. You find out more about effort-
driven scheduling in the section “1 + 1 = 12: Effort-Driven Tasks,” later in this

chapter.

Your project file can have all manually scheduled tasks, all autoscheduled
tasks, or any mix of the two. By default, all tasks you create will use the man-
ually scheduled mode.

You can either change the task mode for the project overall, or for any indi-
vidual task, as follows:

v To change the mode for all new tasks, choose Task, click Mode in the
Tasks group, and then click Auto Schedule or Manually Schedule on the
menu, as shown in Figure 4-2. Or, you can click New Tasks at the left end
of the status bar at the bottom of the project.

“Tz}lnspect - —. .

Lo
=]
> =

Informa

;j -
I_‘> ,‘¢| Mowe *
Manually|  Suto = Task
Schedule|Schedule |2 Mode = -
Tasks | piew Tasks Created H
@ Auto Schedule
Mews tasks are
automatically scheduled,
Manually Schedule

Mewr tasks are manually [
scheduled,

Jan 24,'10
3 T

v To change the task mode for an individual new task or a task that
you’ve previously entered into the schedule, click the Task tab on the
Ribbon and then click either Manually Schedule or Auto Schedule in
the Schedule group. Or, in the sheet, click the Task Mode cell for the
task, click the drop-down arrow that appears, and click either Manually
Scheduled or Auto Scheduled in the drop-down list.

From there, work with information for the task as described in the rest of this
chapter. Chapter 6 also provides more of the scoop on how manually sched-
uled tasks with dependencies behave.

If Ribbon buttons that you need for a particular action such as choosing the
task mode are disabled, you're probably in the wrong view. For example,
many task-related buttons become disabled if you change to a view that’s pri-
marily for working with resource information. If a button you need for a task-
related activity is inactive, try switching back to Gantt Chart view.
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You will need to balance the desires of your inner control freak versus your
need to be an efficient project manager in determining how often to use
manual scheduling. While manual scheduling prevents Project from moving
tasks that you want to stay put in the schedule, it also means you have the
potential to need to edit the schedules for dozens of dependent tasks in a long
or complicated project. The best balance — particularly for beginning project
managers — may be to use manual scheduling sparingly.

Tackling Your First Task
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The first step in creating tasks is to identify the individual action items in
your project. Then you can create each of those steps as individual tasks in
Project.

After you create some tasks, you begin to build some structure to your to-do
list by creating phases that consist of summary tasks with subtasks below
them in an outline structure. For example, you may have a summary task
named Permits with two subtasks: Submit Application and Pay Fees.

You can find out how to organize tasks into outlines in Chapter 5. All you have
to focus on in the following sections is making the settings that are required to
simply create tasks.

Identifying what makes up a task

Determining all the settings that characterize a task is a bit more complicated
than writing an item on a to-do list. Think of each task in your project as a
record — like a database record that lists a person’s name, address, birth-
day, and shoe size. In a similar way, a task in Project contains data about that
task: not only a task name but also other vital data about how that task fits
into your project.

To create a task, you enter information such as the following:

v Task name
v Task duration
v Task type
v Task priority
v Constraints for scheduling the task
Some settings, such as task type (fixed units) and priority (none), can often

be left at the default settings. Others, such as task duration, almost always
require some input from you.
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Pretty much everything that you enter about a task (except the task name
and resources assigned to the task) involves how the task timing is con-
trolled. Several of these settings work in combination, with Project perform-
ing complex algorithms to set the timing of the task according to the value
of each setting. Other elements, such as the task finish date, don’t determine
timing but rather cause Project to display a symbol in the Indicator column
(the column to the right of the task number column with a small blue circle
containing an 7 at the top) to alert you when a task has moved beyond its
estimated deadline.

You can also specify a unique Task calendar in the Task Information dialog
box; calendars are covered in Chapter 3.

Creating a task

You can create a task, on the simplest level, by entering a name for it. You
can fill in the details of task duration and task type, for example, at the same
time or later.

You can enter task names in three ways:

v Enter names in a Gantt Chart task sheet pane.
v Enter names in a Task Information dialog box via Gantt Chart view.

v Import tasks from Excel or Outlook.

Generating tasks in Gantt Chart view

Many people who work on lengthy projects find that entering all task names
in the sheet pane of Gantt Chart view is the quickest and easiest way to go.
You can simply enter one task name in the Task Name column, press the
Enter or down arrow on your keyboard to move to the next blank row, enter
another task, and so on.

Follow these simple steps to enter a task in Gantt Chart view, after choosing
the task scheduling method, if applicable:

1. In the Task Name column, click a blank cell.

2. Type a task name (see Figure 4-3).

You can edit what you type by pressing the Delete or Backspace key to
clear characters.

3. Press the down arrow to move to the next cell in the column and then
type the next task name.

When you move to the next task cell, Project automatically assigns a
sequential task number in the far-left column. This number, called the
task ID number, is a handy way to identify tasks in larger schedules.
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4. Repeat Step 3 until you enter all task names.

5. Use the Task Mode column to change the task scheduling mode for
any task that won’t be using the default method.

You can display whatever columns you like in Gantt Chart view to enter
additional task information, such as the task type. To display additional
columns, use the Add New Column column at the far right of the sheet,
as [ describe in Chapter 2.

The Gantt Chart view’s default Entry table offers the most common task
information columns. To work with task information in other tables,
choose View=>Tables and then click the desired table name.

Producing tasks via the Task Information dialog box

If dialog boxes provide the kind of centralized information form that fits

the way you like to work, consider using the Task Information dialog box to
enter, well, task information. The series of tabs in this dialog box contain all
the information about a task.

Follow these steps to create a task via the Task Information dialog box:

1. In the Task Name column, double-click a blank cell.

The Task Information dialog box appears, as shown in Figure 4-4. The
General and Advanced tabs in this dialog box contain various timing set-
tings for the task.

2. In the Name field, type a task name.
3. Click the OK button to save the new task.
The task name appears in Gantt Chart view in the cell you clicked in Step 1.

4. Press the down arrow key to move to the next cell.

5. Repeat Steps 1-4 to add as many tasks as you like.
As you name tasks, try to the keep task names in your project both descrip-
tive and unique. However, if you can’t make all the names unique (for exam-
ple, you have three tasks named Hire Staff), you can use the automatically

assigned task number or the work breakdown structure (WBS) code (see
Chapter 5) to identify tasks; these numbers are always unique for each task.
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To insert a task anywhere within the list of tasks in Project, click a task name

cell where you want the new task to appear, and press the Insert key on the
keyboard.

Importing tasks from Outlook

After you get started thinking about what has to be accomplished in your
project, tasks are like rabbits breeding. What might start as a series of simple
to-do tasks in Outlook often becomes a full-fledged project with hundreds

of tasks. When that happens, you’ll be glad to know that Microsoft provides

an easy-to-use import feature that puts the tasks you create in Outlook into
Project.

Although the Project import-mapping feature allows you to map fields in a file
created in another application to fields in Project to import data, the process
can be tedious. The Import Outlook Tasks feature is essentially an import
map that’s preset to work with Outlook task fields.

Follow these steps to import Outlook tasks into Project:
1. Open the plan that you want to insert tasks into, or open a new project

(choose Filem>New, click Blank Project, and click Create).

2. Click the Task tab of the Ribbon, click the bottom part (with the
down arrow) of the Task button in the Insert group, and click Import
Outlook Tasks.

3. If a Microsoft Outlook warning message box appears, click Allow.
The Import Outlook Tasks dialog box appears, as shown in Figure 4-5.

4. Select the check box beside each task you want to import, or click the
Select All button to import all Outlook tasks.
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By default, Outlook keeps tasks in a Tasks folder. Selecting the check
box for the Folder: Tasks item is another way to select all tasks in
Outlook.

5. Click the OK button.

The tasks are imported and appear at the end of your list of tasks with
change highlighting applied.

When you import tasks from Outlook, the task name, any task duration, and
any task notes are brought over. If a task in Outlook has no duration and you
have set autoschedule as the project task mode, Project creates the task with
an estimated one-day time frame.

Project 2010 enhances Outlook integration that goes way beyond importing
tasks. See Chapter 19 for more information.

Importing an Excel task list

[ am a firm believer that you should make things easy on yourself. If you like
to noodle around with your task list for a project in Excel, you shouldn’t have
to retype everything into Project to build a Project plan. For that reason,
Microsoft has provided a Microsoft Project Task List Import Template in
Excel. This template can be opened from the selection of sample templates in
Backstage view in Excel 2010.

The template provides two Excel worksheets, as shown in Figure 4-6, in
which you can enter tasks and assigned resources (the second sheet pres-
ents template help) and then export that data from Excel to Project. (A more
complex template also available in the Excel sample templates, Microsoft
Project Plan Import Export Template, has three sheets where you can enter
data plus a fourth info sheet.)
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Follow these steps to use this template:
1. In Excel 2010, open the template called Microsoft Project Task List
Import Template.

In Excel, you click the File tab and click New, click Sample Templates
under Available Templates, and then double-click the icon for the task
list template.

2. Fill in information about Tasks, Resources, and Dates in the appropri-
ate columns, and then save the file.

3. Open Project and choose File=>Open.
The Open dialog box appears.

4. Choose Excel Workbook from the file type list to the right of the File
Name box.

5. Locate the Excel file you just saved from the template, click it, and
then click Open.

The Import Wizard appears.
6. Click the Next button to begin the wizard.

7. Choose the Use Existing Map radio button, and then click the Next
button.
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8. On the next wizard screen, choose Default Task Information in the
Choose a Map for Your Data list, and then click the Next button.

9. On the next wizard screen, choose the method for importing the file
and then click the Next button.

You can import the file As a New Project, to Append the Data to the
Active Project, or to Merge the Data into the Active Project. If you
choose the third option, you have to create a merge key that delineates
how the data should merge with existing tasks.

10. On the next wizard screen, leave the suggested settings for Tasks and
Import Includes Headers selected and then click the Next button.

11. Open the Source Worksheet Name list at the top, and click Task_
Table, the name of the worksheet that holds the data.

12. Review the mapping on the next wizard screen, and fix any issues by
selecting the appropriate fields in the From and To columns.

13. Click the Finish button.

The project appears with whatever tasks, resources, and assignment
information you entered in a project plan format.

Linking to tasks that live somewhere else

You can insert hyperlinks in a project outline, which provides a handy way to
quickly open another project (or any other type of file you link to, such as a
Word file).

If desired, you can insert a hyperlink and create a task that you can use to
represent the timing or costs of another project or subproject in your plan.
However, you have to enter timing and cost information yourself — it isn’t
brought over from the hyperlinked project. (Hyperlinks are more often
used to link to documentation for an existing task, so consider whether this
approach is the best practice for your needs.)

To insert a hyperlink to another Project file in your project, follow these
steps:
1. Type the name for the new task in a blank task name cell.

2. Right-click the new task name cell for which you want the hyperlinked
task to appear.

3. Choose Hyperlink.
The Insert Hyperlink dialog box appears, as shown in Figure 4-7.

4. In the Text to Display box, type the text that you want to appear for
the hyperlink.

Make sure that this text makes clear what information is being
summarized.
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5. In the Link To area, click the Existing File or Web Page icon.
You can link to a document of any type or to a Web page.

6. In the Look In list, locate and select the file to which you want to
insert a hyperlink.

7. Click the OK button.

The link text is inserted, and a hyperlink symbol appears in the Indicator
field. You can simply click that link symbol to open the other file.

Inserting one project into another

You can also insert tasks from one project into another. You accomplish this
by inserting an entire, existing project into another project. The project that is
inserted is known as a subproject. This method is useful when various project
team members manage different phases of a larger project. The capability to
assemble subprojects in one place allows you to create a master schedule from
which you can view, all in one place, all the pieces of a larger, more complex
project. If you use this procedure, it’s best to create a pool of resources that
you make available to all the subprojects for resource assignment consistency.

Follow these steps to insert another Project file into your plan:

1. In Gantt Chart view, select the task in your task list above which you
want the other project to be inserted.

2. Choose Project->Subproject.

The Subproject command is in the Insert group. The Insert Project
dialog box appears, as shown in Figure 4-8.

3. Using the navigation pane and file list, locate the file that you want to
insert and click it to select it.

4. If you want to link to the other file so that any updates to it are
reflected in the copy of the project you're inserting, make sure that
the Link to Project check box is selected.
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5. Click the Insert button to insert the file.

The inserted project appears above the task you selected when you
began the insert process.

The inserted project’s highest-level task appears at the level of the task you
selected when you inserted the project, with all other tasks below it in outline
order. If you need to, use the Indent and Outdent tools on the Formatting tool-
bar (arrows pointing to the left and right, respectively) to place the inserted
tasks at the appropriate level in your project. You can find out more about
how to organize tasks into outlines in Chapter 5.

Vou're in It for the Duration

In projects, as in life, timing is everything. Timing in your projects starts with
the durations that you assign to tasks. Although Project helps you see the
effect of the timing of your tasks on the overall length of your plan, it can’t
tell you how much time each task will take; that’s up to you.

Estimating the duration of tasks isn’t always easy; it has to be based on your

experience with similar tasks and your knowledge of the specifics of your
project.
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If you often do projects with similar tasks, consider saving a copy of your
schedule as a template that you can use in the future, thereby saving yourself
the effort of reestimating durations every time you start a similar project. Find
out about saving templates in Chapter 17.

Tasks come in all flavors:
Identifying task types

Before you begin to enter task durations, you need to be aware of the three
task types. These types have an effect on how Project schedules the work
of a task using the automatic scheduling mode after you begin assigning
resources.

Essentially, your choice of task type determines which element of the task
doesn’t vary when you make changes to the task:

v+ Fixed Duration: This task type takes a set amount of time to complete,
no matter how many resources you add to the mix. For example, a test
on a substance that requires that you leave the test running for 24 hours
has a fixed duration, even if you add 20 scientists to oversee the test.

v Fixed Units: This is the default task type. With this task type, when you
assign resources to a task with a certain number of units (hours of work
expressed as a percentage of their working day), the resources’ assign-
ments don’t change, even if you change the duration of the task and the
work amount.

v Fixed Work: The number of resource hours assigned to the task deter-
mines its length. If you set the duration of a Fixed Work task at 40 hours,
for example, and assign two resources to work 20 hours each (simulta-
neously) at units of 100 percent, the task will be completed in 20 hours.
If you take away one of those resources, the single resource must put
in 40 hours at units of 100 percent to complete the task. Understanding
how the choice of task type causes your task timing or resource assign-
ments to fluctuate is an important part of creating an efficient project.

Follow these steps to set the task type:

1. Double-click a task.
The Task Information dialog box appears.
2. Click the Advanced tab, if necessary, to display it (see Figure 4-9).

3. Choose one of the three options from the Task Type list (see the pre-
ceding list of choices).

4. Click the OK button.
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You can also display the Type column in a Gantt Chart sheet and make this
setting there.
Setting task duration
Most tasks in a project have a duration, whether it’s ten minutes or a year or
something in between. (For milestone tasks, which generally have no dura-
tion, see the next section.) Deciding how finely to break down your tasks can
affect how efficiently you track progress on those tasks: Tasks that wander
on for a year are usually too broad, and tasks that take ten minutes are too
narrow. Whatever your best guess at task duration is, Project can accommo-
date you.
QNING/ If your project is to run a one-day event, getting to the level of ten-minute
Ry tasks might make sense. In most projects, however, such finely detailed timing

doesn’t make sense because it defeats the point of all the tracking and report-
ing features of Project. (That’s true unless you have people tracking their
progress minute by minute, but in that case, what else would they have time
to do?) On the flip side, creating a 12-month-long task suggests that you may
be defining your project too broadly to accurately keep track of all that can
happen in a year.

As with all task information, you can enter a duration in a Gantt Chart sheet
(see the section “Generating tasks in Gantt Chart view,” earlier in this chap-
ter) or in the Task Information dialog box. Follow these steps to enter a dura-
tion by using the dialog box:

1. Double-click a task to display the Task Information dialog box.

2. If necessary, click the General tab to display it (refer to Figure 4-4).
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3. In the Duration box, use the spinner arrows to increase or decrease
the duration.

4. If the current duration units aren’t appropriate (for example, days
when you want hours), type a new duration in the Duration box.

New tasks are created with an estimated duration of one day unless you
change the duration. You can use the following abbreviations for various
time units:

e m: Minutes
® h: Hours

¢ d: Days

* w: Weeks

* mo. Months

Don’t assume that changing the start and finish dates of a task changes
its duration — it doesn’t. You have to manually change the duration; if
you don’t, your project plan will not be what you intend it to be.

5. Click the OK button to accept the duration setting.

If you aren’t sure about the timing of a particular task and want to alert people
to your lack of certainty or if you need a way to find such tasks and enter more
solid timing when you have better information, select the Estimated check box
(on the General tab) when you enter the duration. Then apply a filter for tasks

with estimated durations (see Chapter 15 for more about using filters).

Setting tasks with no duration: Milestones

I mention in the preceding section that almost all tasks have durations; the
exception is a milestone — a task with no duration. (Now, that’s the type |
like to be assigned to.) In fact, milestones are less like tasks than they are
like signposts that mark moments in time. Examples of milestones are the
approval of a prototype (although the deliberations to make that decision
might have taken months) and the completion of a phase of tests.

Some people include tasks such as Design Complete or Testing Complete at
the end of each phase of their project. They can then create timing relation-
ships to the moment of completion — for example, allowing the production
of a drug to proceed after the testing and approval is complete. Such mile-
stones also alert you and your team members to a moment of progress in
your project that can help to keep the team motivated.
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@‘& a duration. To create a milestone, you indicate that the task has zero duration.
The quickest way to do that is to simply type 0 in the Duration column in
Gantt Chart view. Or, you can click the Advanced tab of the Task Information
dialog box (refer to Figure 4-9) and select the Mark Task as Milestone check
box. When you do, the milestone is designated in Gantt Chart view with a
black diamond shape rather than a task bar. Use this latter method for any
milestone that does have a duration but that you want to mark as a milestone
anyway; its milestone marker will be charted at the end of the duration period
on the Gantt chart.
Showing up again and again:
Recurring tasks
Some tasks occur repeatedly in projects. For example, attending a monthly
project debriefing or generating a quarterly project report is considered a
recurring task.
No one wants to create all the tasks for the monthly debriefing in a project
that will take a year to complete. Instead, you can designate the recurrence,
and Project automatically creates the 12 tasks for you.
Here’s how you create a recurring task:
1. Click the Task tab on the Ribbon, click the bottom part of the Task
button (with the down arrow) in the Insert group, and then click
Recurring Task.
The Recurring Task Information dialog box appears, as shown in
Figure 4-10.
— Recurring Task Information ==l
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2. In the Task Name box, type a name for the task.
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3. In the Duration box, click the spinner arrows to set a duration or type
a duration, such as 10d for 10 days. Edit the abbreviation to specify a
<P different time unit, if needed.

You can read about the abbreviations you can use for units of duration —
such as h for hours — in the earlier section “Setting task duration.”

4. Select a recurrence pattern by selecting the Daily, Weekly, Monthly,
or Yearly option.

What you select here provides different options for the rest of the recur-
rence pattern.

5. Depending on the selections offered to you, make choices for the rest
of the pattern.

For example, if you select the Weekly option, you must choose a Recur
Every x Week(s) On setting and then choose a day such as Friday. Or, if
you select Monthly, you must specify which day of every month the task
is to recur.

6. In the Range of Recurrence area, type a date in the Start box. Then
select and fill in either the End After or End By option.

For example, you might start on January 1 and end after 12 occurrences
to create a task that occurs every month for a year.

7. Click the OK button to save the recurring task.

If your settings cause a task to fall on a nonworking day (for example, if you
choose to meet on the eighth day of every month and the eighth day is a
Sunday in one of those months), a dialog box appears, asking you how to
handle this situation. You can choose not to create the task, or you can let
Project adjust the day to the next working day in that period.

<P To assign resources to a recurring task, you have to assign the resources to
the individual recurrences, not the “summary” recurring task. If you assign
resources to the summary recurring task, Project will not calculate the hours
of work correctly.

Starting and Pausing Tasks

When most people start using Project, one of the first things they try to

do is enter a start date for every task in their project. After all, you always
include dates when you write a to-do list, right? Well, for one thing, you're
jumping the gun — and missing out on one of the great strengths of project
management software: the capability to schedule tasks for you according to
sometimes-complex combinations of factors, such as dependencies between
tasks and task constraints. By allowing Project to determine the start date of
a task, you allow it to make adjustments automatically when changes occur.
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If you enter a task duration and don’t enter a start date for an automatically
scheduled task, that task starts by default as soon as possible after the proj-
ect start date you set in the Project Information dialog box, based on any
dependencies you set up between tasks. For manually scheduled tasks, you
do eventually have to specify a start date to set the beginning schedule for
the task.

Typically, to establish a task’s start date, you look for something in the proj-
ect that would dictate its timing. For example, if you don’t want construction
to begin until you obtain permits, set a dependency between the permits task
and the construction task in such a way that construction can’t start before
the permit task ends.

Certain tasks, however, must start on a specific date. Examples are a holiday,
an annual meeting, or the start of the fishing season.

Project sets the finish date of a task based on when that task starts as well as
the task duration. If a task must finish on a certain date, however, you can set
a finish date and let Project determine the start date.

Entering the task start date

Setting a start date or a finish date for a task applies a kind of constraint on
it that can override dependency relationships or other timing factors. Task
constraints, discussed in the upcoming “Controlling Timing with Constraints
section, are the preferred way to force a task to start or end on a certain day.
If you determine, however, that a particular task must begin or end on a set
date no matter what, you can enter a specific start or finish date. Setting the
start or finish date is simple.

”

To enter a start or finish date for a task, simply follow these steps:

1. Double-click a task.

The Task Information dialog box appears.
2. Click the General tab if it’s not already displayed; refer to Figure 4-4.
3. Click the arrow on the Start or Finish box.

A calendar appears.

4. Click a date to select it, or click the forward or backward arrow to
move to a different month and select a date.

If the current date is the date you want, use the shortcut of clicking the
Today button on the drop-down calendar.

5. Click the OK button.
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Setting a start date isn’t quite as strong a factor in how Project determines
timing as applying the Must Start On constraint. You can find out more about
how constraints work in the “Controlling Timing with Constraints” section,
later in this chapter.

Taking a break: Splitting tasks

Did you ever start something — your taxes, for example — and find that you
just had to drop everything before you were done and go do something else?
(In the case of taxes, [ usually need a break for a good cry.)

It’s the same in projects. Sometimes tasks start and then you have to put
them on hold before they can start again later — for example, if you experi-
ence a work shutdown due to labor negotiations. Or, perhaps you can antici-
pate a delay in the course of a task and want to structure it that way when
you create it. In that case, you can use a Project feature to split a task so that
a second or third portion starts at a later date, with no activity between. You
can place as many splits in a task as you like.

Follow these steps to split a task:

1. Click the Split Task button in the Schedule group on the Task tab of
the Ribbon.

A box appears, as shown in Figure 4-11. The box provides a readout to
guide you as you set the start date for the continuation of the task.

2. Move the mouse pointer over the task bar on the Gantt chart and
adjust the pointer’s position until the box displays the date where you
want to start the split for the task, and then drag right until the box
contains the date on which you want the task to begin again.

3. Release the mouse button.

The task is split.

You can rejoin a split task by placing your mouse over the taskbar until the
move cursor appears and then dragging the split taskbar back to join with the
other portion of the taskbar.

Don’t use the split-task approach to put an artificial hold on a task until some
other task is complete. Suppose that you start testing a product but then have
to wait for final approval before finalizing the test results. In that case, you
should create a Testing task, a Final Approval milestone, and a Finalize Test
Results task — and then create dependency relationships among them. That
way, if one task runs late, your final task shifts along with it instead of being
set in stone (as a split task can be).
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1 + 1 = 1/2: Effort-Driven Tasks

When you hear the word effort in Project, you can think work. For a task

that is automatically scheduled, you also can set it up to be effort driven,
which means that if you adjust resource assignments, the duration might
change but the number of hours of effort (work) resources needed to put in
to complete the task stays the same. (Effort-driven scheduling is not avail-
able at all for manually scheduled tasks.) When you add or delete a resource
assignment on an effort-driven task, work is spread around equally among
resources.

Here’s how an effort-driven task works. Suppose that you have a two-day task
to set up a computer network in a new office. You assign one resource to the
task, working 8 hours a day, so it will take 16 hours to complete the work
(two 8-hour days). If you then assign a second resource, the task no longer
takes two days because the hours of effort required will be completed more
quickly by the two people working simultaneously — in this case, in one
8-hour period.

Behind the scenes, effort-driven scheduling uses the formula D=W/U (dura-
tion equals work divided by units) to work this “magic.” After you make the
first assignment, any time you add or remove more people (units), Project
recalculates the duration accordingly.
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If you assign multiple resources at once when you make the first assignment
to the task, Project does not adjust the task duration, even when effort-driven
scheduling is enabled for the task. Effort-driven scheduling only kicks in when
you add additional resources after assigning the first one(s).

An example of a task that is not effort driven is attending a daylong seminar.
No matter how many people attend or how many people are present, the
seminar takes one day to complete.

Effort Driven is a simple check box choice on the Advanced tab in the Task
Information dialog box (refer to Figure 4-9). Select this check box to enable
or disable the Effort Driven setting; it’s not selected by default. When you
clear this setting, the same task that you set to run two days takes two days,
no matter how much effort your resources put in. In other words, adding
resources doesn’t cause the task to be completed sooner.

Controlling Timing with Constraints

WING/

A constraint is more than something you’re forced to live with, such as dan-
druff or noisy neighbors. In Project, constraints are timing conditions that
control an automatically scheduled task. You tell Project what, if anything,
to constrain for each task. Because manually scheduled tasks must follow
the start and finish dates you specify for them, they are already de facto
constrained.

Understanding how constraints work

When you create a task and set it to be automatically scheduled, the As Soon
As Possible constraint is selected by default. In other words, the task starts
as soon as the project starts, assuming that no dependencies with other
tasks exist that would delay its start.

Task start and finish dates — working with dependencies, the task type, the
Effort Driven setting, and constraints — set the timing of each task. However,
when Project performs calculations to try to save you time in a project that’s
running late, it considers constraints to be the most sacred timing settings.
For example, if you set a constraint that a task must finish on a certain date,
Project shifts around almost any other task in a schedule in recalculating
timing before it suggests that that task might finish on another date.

Here’s a word to the wise: Use constraints only when you absolutely need to
force a task’s timing.

Table 4-1 lists all the constraints and shows an explanation of their effects on
your task’s timing.
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Table 4-1 Task Constraints

Constraint Effect

As Soon As Possible The default setting; the task starts as early in the sched-
ule as possible based on dependencies and the project
start date.

As Late As Possible The task occurs as late as possible in your schedule,

based on dependencies and the project finish date.

Finish No Earlier Than The end of the task cannot occur any earlier than the
date you specify.

Finish No Later Than The end of the task cannot occur any later than the date
you specify.

Must Finish On The task must finish on an absolute date.

Must Start On The task must start on an absolute date.

Start No Earlier Than The task cannot start any earlier than the date you
specify.

Start No Later Than The task cannot start any later than the date you specify.

Establishing constraints

You can set only one constraint for a task. Setting a constraint involves
selecting the type of constraint you want in the Task Information dialog box.
Some constraints work together with a date you choose. For example, if you
want a task to start no later than a certain date, you need to select a date by
which the task must start. Other settings, such as As Soon As Possible, work
off a different date — in this case, the start date you set for the whole project
or any dependency relationships you set up with other tasks. (See Chapter 6
for more about dependency relationships.)

To set a task constraint, follow these steps:

1. Double-click a task.
The Task Information dialog box appears.
2. Click the Advanced tab; refer to Figure 4-9.
3. Select a constraint from the Constraint Type list.

4. If the constraint requires a date, select one from the Constraint Date
list.

5. Click the OK button to save the settings.
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Setting a deadline

[ don’t know about you, but sometimes I think deadlines were made to be
overlooked. Project agrees because, strictly speaking, deadlines aren’t con-
straints (although the setting for the deadline is in the Constraint Task area
of the Task Information dialog box, on the Advanced tab). Deadlines aren’t
the same as constraints because they don’t force the timing of your task
schedules. If you set a deadline, it simply causes Project to display a symbol
in the Indicator column if the task has run past the deadline to alert you so
that you can panic (I mean, take action) appropriately.

To set a deadline, follow these steps:

1. Double-click a task.
The Task Information dialog box appears.
2. Click the Advanced tab; refer to Figure 4-9.

3. Click the arrow in the Deadline field to display a calendar, and then
select a date.

If necessary, use the forward or backward arrow to move to a different
month.

4. Click the OK button to save the deadline setting.
You can also display a deadline column in your Gantt Chart sheet pane to

enter the deadline or to show yourself and others what your targeted deadline
date is.

Deleting Tasks and Using Inactive Tasks

\NG/
V?‘“

If your style is to go into a lot of planning detail for everything you do, you
may tend to overanalyze and add more tasks than you really need to track in
a project plan. In such cases, when you're refining the project plan, you may
decide that you need to delete a task or two to tighten up the plan. To delete
a task, click its row (Task ID) number at the left side of the sheet and press
Delete.

Project doesn’t display a warning or ask you to confirm deleting a task, so
make sure that you really mean it when you press Delete. If you screw up,
press Ctrl+Z immediately to reinstate the deleted task. Also, be sure to check
that any task dependencies (links) adjust as needed after you delete the task.
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The Professional Edition of Project 2010 includes a new twist on deleting a
task. You can instead mark a task as inactive. Doing this leaves the task vis-
ible in the plan, but strikes it out in the task sheet and on the Gantt chart, as
shown in Figure 4-12. If any automatically scheduled tasks were dependent
on the inactive task, Project ignores the now-inactive task when calculating
the schedules for those other tasks. Leaving an inactive task in the schedule
provides another opportunity to track and document what happened. For
example, you can add a note explaining why the task was removed, such as
if the deliverables for the project were reduced, eliminating the need for cer-
tain tasks.

Follow these steps to mark a task as inactive:

1. In Gantt Chart view, select the task to make inactive.

2. Click the Inactivate button in the Schedule group on the Task tab of
the Ribbon.

Project immediately reformats the task as inactive.

Inactive button
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Making a Task Note

Figure 4-13:
Enter useful
information
about the
task here.

Despite the wealth of information that you can enter about a task and its
timing, not everything can be said with settings. That’s why every task
includes an area to enter notes. You may use this feature, for example,
to enter some background information about changes in timing or other

changes that occur during the schedule, or to list vendor contact information
relevant to the task.

To enter task notes, do the following:

1. Double-click a task.
The Task Information dialog box appears.

2. Click to select the Notes tab (as shown in Figure 4-13).

Task Information

General | Predecessors | Resources | Advanced  Motes | Custom Fields |

Mame: | Hire general contractor Duration: | 4 days | Estimated
Motes:

BEEEEE

Four contractors were interviewed

Three provided estimates.

Johnson General selected based on competitive pricing and positive reference comments.

3. In the Notes area, type any information you like.

You can enter contact information, notes about resources, or other
useful information about the task.

4. Format the note.

Click the buttons at the top of the Notes area to change the font. You
can also

¢ Left-align, center, or right-align text
¢ Format text as a bulleted list
¢ Insert an object

5. Click the OK button to save the note(s).

www.it-ebooks.info


http://www.it-ebooks.info/

90

Part |: Setting the Stage for Project

Saving Vour Project — and Your Tasks

Figure 4-14:
Save your
project with
a new name
here.
|

After you have some tasks in your project, don’t lose ’em! It’s a good idea to
save your project regularly.

You save a Project file by using the same process you’ve used hundreds of
times to save files in other software applications.

If you've previously saved and named the file, just click the Save button on
the Quick Access toolbar or choose Filer>Save. No muss, no fuss — your
changes are preserved.

If you want to save changes to a previously saved Project file by using a dif-

ferent filename or file format (for example saving as an Excel spreadsheet or
a Project template), choose Filer>Save As and provide a new filename or file
type at the bottom of the Save As dialog box.

To save a Project file under a new name, follow these steps:

1. Choose Filec>Save.

The Save As dialog box appears, as shown in Figure 4-14. If you use other
software, you've probably seen this dialog box about 2 million times.

|B| Save As ==
U\_/’ ‘ | » Libraties » Documents » v|&y|| Search Dacuments p‘
Organize = Mew folder Bz - -@3
- -
[B] Microsaft Office Pr Documents library .
Arrange by: Folder =
Includes: 2 locations
4 Favorites - - — e
ame ate mi
Bl Desktop
4 Downloads E microsoft 4201
=l Recent Places Mty Data Sources 157201
Outlook Files 157201
i Libraries Shagit 117202
| Documents [E] Bailey House 1072772
@' Music
“ - IE_] Fireweorks Event 1072772
= Pictures
B videos |E_] Fitness Center Direct Marketing Campaign 9726520
(B Fitnace renter Bacaurce Brnl Aneeesn T
- 4 T 3
-
File name: Organic Farm Planting Schedule -
Save as type: ‘Prnje(t V‘
ODBC...
= Hide Faldets Tools = Save ] | Cancel |

2. From the navigation pane, locate the folder in which you want to save
the file.
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3. In the File Name box, type a name.
4. Click the Save button.
o If you want to share your file with others and you have Project Server set up in

your organization, you can do so by using Project Web App to publish the file
online. See Chapter 19 for the lowdown on this useful collaborative tool.

Task Information in Action: Planning
Vour Next Space Launch

If you want to tie together all the task-setting information covered in this
chapter, you can look at it in the context of a specific project. Suppose that
you’re managing a space shuttle launch and you have these main tasks:

v Train personnel
v Launch public relations

v Check equipment

v Launch operation
Under the public relations task, suppose that you have three subtasks:

v Write press releases
v Hold press conference

v Set up interviews with astronauts

Your first step is to choose a task mode for each task. You can decide which
tasks should be scheduled manually and which need to be scheduled
automatically.

Next, set durations for each task. They’re determined to a great extent by
your experience with similar projects, but suppose that you determine that
writing press releases will take two days, a press conference will take two
hours, and setting up interviews will take three days. You enter these dura-
tions in one of two locations: in the Durations column or in each individual
Task Information dialog box.

Moving on, you have to determine the task types. Write Press Releases is an
effort-driven, fixed-work task. (If you get somebody to help you, it takes less
time to complete the work.) Hold Press Conference, on the other hand, has a
fixed timing (after two hours, you cut off the press); in this case, it’s a fixed-
duration task. Finally, Set Up Interviews with Astronauts could be a fixed-
units task: It takes a certain number of hours to make all the phone calls and
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arrangements, but when the arrangements are done, you may still want the
resources available for confirmations or to deal with changes. With a fixed-
units task (which is the Project default), completing the number of units of
work doesn’t change the resource hours you assigned.

Finally, what constraints may you apply to these tasks? Although I'm not a
fan of applying too many constraints to any project, here are a couple of
possibilities:

v The press conference might take place no later than the task to launch
the shuttle. After the shuttle has left Earth, the press conference to brief
the press on the mission must already have been completed.

» You could set the interviews with astronauts so that they must start on
the day before the launch — when the members of the media hold the
most interest in the event and the astronauts are still available.

If, in the end, the entire launch is scrubbed because of unexpected weather
or a faulty hatch door, won’t you be glad that you used the Project depen-
dency structure to cause all tasks to move out when you change the start
date for the project for the sixth time?
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Getting Your Outline in Line

In This Chapter

Understanding the summary task/subtask structure
Creating a project summary task

Building a plan manually from the top down
Promoting and demoting tasks

Displaying and hiding outline levels

Working with WBS codes

‘ ertain things bring order to the universe: clocks, stop signs, and out-
lines, to name just a few. Whereas clocks bring order to time and stop
signs bring order to rush hour, outlines bring order to information by impos-
ing a hierarchy. An outline breaks down one idea or topic or category of

information into smaller units with some logical sequence.

Project uses an outline structure to organize tasks in your project, as well
as tools and functionality to help you build, reorganize, and view the outline
structure. Learning how to create an outline is something you did back in
Mrs. Plotkin’s fourth-grade English class, and now, showing you how to use
an outline to organize the many tasks in your project is my job. Welcome to
Outlining 101.

Summary Tasks and Subtasks

When you take a look at a project outline, such as the one shown in Figure
5-1, you see that it organizes tasks into levels; each level represents a phase
of your project. A task that has other tasks indented below it in this outline
structure is a parent task, or summary task. The tasks indented below it are
child tasks, or subtasks. Summary tasks are indicated in bold in your Project
outline. You can tell when a summary task has a family of subtasks clinging to
its skirts: When a subtask is hidden, a little plus-sign symbol is displayed next
to its summary task. When you click the plus sign, the task expands to show
its whole clan of subtasks.
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Figure 5-1:

A project
outlineis a
collection
of subtasks
nested
within sum-
mary tasks.
|
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You can build several of these little families of tasks to represent project
phases in your outline. Think of a project outline as a set of little wooden
nesting dolls, with each successively smaller doll representing a deeper level
of detail. The highest-level task is the outer doll, which is the biggest of the
bunch. The next doll in the group is a little smaller, just as the next level of
tasks in an outline reflects a little narrower level of detail, and so on, right
down to the littlest baby doll. The largest task in a project may be Build New
Plant, and the smallest detailed task may be Empty Dumpster, with a whole
lot of tasks in between.

Project phases

All information about a family of tasks (that is, a phase of your project) is
rolled up into its highest-level summary task. Therefore, any task with sub-
tasks has no timing or cost information of its own: It usually gets its total
duration and cost from the sum of its parts.

You can, though, assign resources and costs to a summary task; for example,

you might assign a project manager for an entire phase of tasks. However, a
summary task also includes the total of the costs of any tasks below it.
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This roll-up functionality is cumulative: The lowest-level task rolls up to its
parent, which might roll up into another summary task, which rolls up (for
example) into a project summary task. Any task with tasks below it gets
its duration and cost information from its subtasks, no matter how deeply
nested it may be in the hierarchy.
o The structure of phases in an outline is also useful when you need to reorga-
nize an outline: When you move a summary task, all its subtasks come right
along for the ride!

If a summary task is manually scheduled, the roll-up functionality doesn’t
work, and Project will display warnings telling you so. The Gantt bar for the
summary task will have a red warning bar that shows you the calculated
duration for the subtasks when they don’t match up with the summary task’s
duration. The summary task’s Finish field entry will also have a red squiggly
underline to indicate a potential scheduling problem. To deal with this situa-
tion, you can change the summary task to use auto scheduling, in which case
it will calculate roll-up data correctly. If you want the summary task to con-
tinue to be manually scheduled, you can edit its finish date or use the Task
Inspector as described in Chapter 10 to fix the summary task schedule.

How many levels can you go?

You have no practical limit on how many levels of tasks you can create in an
outline. Project enables you to indent to more levels of detail than you'll need
for all but the most complex schedules. Remember, though: At some point,
you have to deal with assigning timing and resources to each of these tasks —
and then track their progress. Too much detail can make your project plan
difficult to manage. For example, if your project is a few months long, you
don’t want to be tracking to a level where activities last only minutes or (in
most cases) hours.

Also, if you find that you build in three, four, or five levels of detail through-
out your plan, consider that you might really be building several projects at a
time. Having too many levels suggests that a few of these project phases may
be more manageable if you break them off and make them projects on their
own — with their own project managers. Unless you want the maintenance of
your Project plan to become a project in and of itself, don’t overdo the level
of detail in your outline; two or three levels are usually sufficient.

The One-and-Only Project Summary Task

Just as a ship has only one captain, only one task summarizes all other tasks
in each project. I strongly suggest that you display the project summary task,
which represents the highest (least detailed) level of information and is often
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Figure 5-2:
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simply the title of the project, such as New Product Rollout or Space Shuttle
Launch. When you tell Project to display the project summary task, every
task in the project falls under it in the outline, as shown in Figure 5-2. You can
see in the figure that task 0, New Fitness Center Staffing, is the project sum-
mary task. Notice that the bar for the project summary task on the chart is
gray, while the bars for regular summary tasks are black.

When you think about it, an upper-level headline in an outline is the sum of
its parts; the headline reflects the overall topic for all the items below it. The
project summary task takes this concept a step further: This task rolls up all
the actual data from other tasks into one line item. Thus, the project summary
task’s duration reflects the duration of the entire project. From a monetary
angle, the project summary task’s total cost reflects the total costs for the
entire project. Figures like these can be handy to have at your fingertips —
and that’s one value of a summary task.

If you're confused about the length of your summary task, remember that the
summary task duration is the difference between the earliest task start date
and latest task end date. However, nonworking days aren’t counted in the
summary task duration. The length of the summary task, therefore, equals the
number of days of work over the course of the subtasks, not the number of
calendar days between the start of the first task and end of the last.
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Not everyone uses project summary tasks. You can simply create, at the
highest level of your outline, tasks that represent major project phases —
with subphases and subtasks below them — and not create one task that’s
higher in the order than all others. However, my advice is to always have a
project summary task, for two reasons:

+* You can quickly view totals for the project at a glance in the columns
of data in Gantt Chart view and other views.

* You can place a link to your project summary task in another project
so that all data for one project is reflected in another. For example,
if you create five schedules for new product launches in your com-
pany, you can easily create a master schedule for all company product
launches by linking to the project summary tasks in each of the projects.
(Neat, huh?)

As you build your project, you can easily create a project summary task
yourself (indent other tasks beneath it) or use a Project feature to generate
one automatically at any time — even after you build all the phases of your
project. To have Project automatically display a project summary task, follow
these steps:

1. Choose File=>Options.
The Project Options dialog box appears.
2. Click Advanced in the list at the left to display the advanced options.

3. Scroll down until you can see the Display Options for This Project
section.

4. Select the Show Project Summary Task option.
5. Click the OK button to display the upper-level task.

N You also can use the Ribbon to display or hide the project summary task. In
Gantt Chart view, click the Gantt Chart Tools Format contextual tab. Then, in

the Show/Hide group, click the Project Summary Task check box.

Structuring the Project’s OQutline

If you already read the first few pages of this chapter, your tantalizing
glimpse of how outlines work in Project has doubtlessly left you eager to
start building your own, but project outlines take a little up-front thought.
You have to settle two important matters about your project before you start
building a logical project outline:

www.it-ebooks.info


http://www.it-ebooks.info/

7 04 Part |: Setting the Stage for Project

\\3

v The goal: What do you want to achieve at the completion of your proj-
ect? Is your goal to manage an entire space shuttle mission? Then you
need as many tasks as it takes to get from here to splashdown. If your
goal is only to launch the space shuttle, however, your focus is nar-
rower, and the level of detail of certain tasks will probably be different.

v The scope: Scope is a little more specific than the goal. Do you want
to build a new warehouse from scratch, outfit it with equipment and
furniture, and deal with moving people into their offices by December 1
within a budget of $20 million? Or, is the scope of your project to hook
up the computer network by November 1 within a budget of $50,000?
Understanding what your overall deliverables are helps you further
define where to start and stop your project.

To help you to sketch the early draft of your project, Project lets you create a
proposal schedule with major deliverables and no specific tasks. See Chapter
6 for more about deliverables and proposals.

Look around your own office: You’ll be surprised to find that many projects
that go off track never had a clear goal. In fact, entering project data into
project management software is a waste of time if you don’t know what your
mission is. Go ahead: Ask three people working on the same project in your
company to state the goal of the project. I would bet the farm that you get
three different answers. For an IT project, for example, the IT director might
tell you the goal is to reduce tech support calls, the project manager might
say the goal is to upgrade all server software to the latest version, and the
technician might specify that the goal is to get all the software installed by
next Thursday. (Sound familiar?)

To define a goal and scope for your project, answer these questions:

v For a goal:
e What will be different when the project is complete?

e What will the project achieve or deliver? Will a building be built, a
workforce trained, or a space shuttle launched?

v For the scope:
e What will the project cost?
¢ How many people will be involved?

e Whom does the project affect: A workgroup, division, company, or
clients?

e What deadlines does the project have?
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Everything but the kitchen
sink: What to include

After you have a clear picture of your project goal and the scope of the work
to be done, you can begin to think about what your outline should contain.
For example, here’s the first of three approaches to an outline of tasks for
planning a company party:

I. Send invitations

II. Reserve Conference Room B

IIl. Order food
Perhaps a little more detail would be helpful:

I. Company Christmas party

A. Invitations
1. Design invitations
2. Mail invitations
B. Location
1. Reserve Conference Room B
2. Order extra chairs
3. Decorate space
C Food
1. Hire caterer
2. Clean up

Or, you can take a really detailed approach:

[. Company events

A. Company Christmas party

1. Planning
a. Set party date
b. Invitations
1 Design
2) Send out
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C. Budget
1 Research costs
2) Create budget
3) Obtain budget approval

2. Location and furniture

a. Location
1D Reserve Conference Room B
2) Arrange for carpet cleaning
3) Pick decoration theme
4) Decorate space

b. Furniture
1)) Order extra chairs
2) Arrange for serving table

3 Food

a. Research caterers

b. Set food budget

c. Hire caterer

d. Provide kitchen access to caterers

e. Assign clean-up committee

f. Clean up

B. Halloween party

1. Andsoon...

Which one of these outlines is best for this project? That depends on how
complex these arrangements are — and on how narrowly you define the
project. Are you planning the entire year of company events or only one
party? How many people will perform the tasks and over what period of time?
Will one person research, budget, and hire the caterers in a single hour? If

so, a single task — Hire Caterer — may be enough. Will one person do the
research, another set the budget, and another hire the caterer — and might
these tasks be separated by days (or even weeks)? If so, having several tasks
may be the way to go.

If one task must happen before another can start, you may have to break
down the tasks to reflect the causality between certain events. For example,
if you can’t begin a new manufacturing process before people are trained, it’s
probably not prudent to lump training and the implementation of the new
process into a single task.
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QgN\BEH Too little detail may let some tasks slip through the cracks, while too much

5y detail may cause your project team to be inefficient, spending more time
reporting progress and breaking down activities than doing the work. Here’s
the bottom line: When you understand the scope of your project and the rela-
tionship of each task as you create your project outline, you're likely to build
in the right level of detail.

Building the outline

People approach building a project outline in different ways. Some create all
the tasks they can think of in random order and then promote and demote
tasks to different levels and move them around to appear in the correct
order. Other people create upper-level tasks first and then go back and fill in
details below each task. Still other people work one phase at a time, by creat-
ing one upper-level task and filling in every possible task underneath it. Then
they go on to the next phase and create every task under that, and so on.

The approach that you use depends to some extent on how you think. Some
people think chronologically, and others group like information. You eventu-
ally have to deal with all levels of structure in your final outline, but which
level you tackle first is up to you.

Moving Tasks All around Your Outline

You discover how to create tasks in Chapter 4. In the following sections, you
move those tasks around to create the outline structure. If you use any word
processing outlining feature, this stuff is pretty easy. If this is new turf for
you, it’s still easy!

The outdent-and-indent shuffle

Outdenting and indenting are the functions that you use to move tasks to
higher or lower levels of detail in your outline. In some software programs,
these terms are promoting and demoting, respectively:

v+ Outdenting a task moves it up a level in the outline (literally shifting it
to the left in the outline). When outdented, a task is moved to a higher
level of detail; in other words, it’s less detailed. Because the top-level
tasks are already at the highest level, you can’t outdent them.

v Indenting a task moves it down a level in the outline (literally indenting
the task to the right in the outline) and puts it at a deeper level of detail.
Whenever you indent one or more tasks, the task above becomes the
summary task.
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You use tools in the Schedule group of the Task tab of the Ribbon (shown in
Figure 5-3) to outdent and indent tasks in a project outline. The Outdent Task
tool has is a left-facing arrow; the Indent Task tool has a right-facing arrow.

You can outdent and indent tasks from several different views, even Network
Diagram view. However, seeing the effect in Network Diagram view is tricky,
and I recommend using Gantt Chart view when manipulating tasks in an out-
line structure.

If you use an outlining feature in other software, you may be tempted to press
Tab to indent a task in an outline and Shift+Tab to outdent a task. In Project,
though, don’t use these methods. It doesn’t cause disaster, but it doesn’t do
you much good either. It only moves your cursor from one column to the
other in a columnar view (like Gantt Chart view). And in Network Diagram
view, it moves the cursor from field to field in a single task box.

To outdent or indent a task, follow these steps:
1. Make sure that the task that will become the summary task (the task

above any task you indent) is set to be automatically scheduled if
that’s what you want.

Outdent Task and Indent Task tools
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See the section “Using a Manually Scheduled Summary Task to Plan from
the Top Down,” later in this chapter, to find out more about why this
makes a difference.

2. Click a task in a columnar view to select it.

3. Click the Outdent Tasks or Indent Tasks button according to what
action you want to take.

If the tasks you are indenting are autoscheduled, Project may convert
the summary task above to be an autoscheduled task if it was previously
manually scheduled. Always check to ensure that the summary task
behaves as you wanted and expected when you indent tasks.

You can build the outline even faster by indenting multiple tasks at once.
Drag to select multiple task IDs and then indent them. You can also use the
standard Shift+click and Ctrl+click selection methods to select multiple tasks
in a Project outline. Shift+click the task IDs to select contiguous tasks, and use
Ctrl+click to select discrete tasks.

Moving tasks up and down

A maxim of project management says that things change: Tasks that you
thought you could do early on can’t happen yet because the people, materi-
als, or money are in short supply. Or, a task that you thought you couldn’t
start until next July gets bumped up in priority when your customer changes
his mind (again) about deliverables. Because of this changeability, when you
enter tasks in a project outline, odds are that you'll need to move those tasks
around at some point. You can move subtasks to other phases of the outline
by simply dragging them.

You should understand that moving a task can change its outline level. A task
retains its level in the outline only when you move the task to follow a task

at the same level. (Okay, there’s an exception, which I get to in a minute.)
Comparatively, if you move a lower-level task to a section of tasks at a higher
level — for example, move a third-level task to a section of second-level tasks —
the moved task takes on the level of the task preceding it. And the converse
is true when you move a higher-level task to follow a lower-level task.

The exception I hinted at happens when you move a lower-level task to follow
a summary task. For example, a second-level task that you move to immedi-
ately follow a summary task stays at the second level rather than taking on
the summary task level of the task that now precedes it because there’s only
one summary task.
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|
Figure 5-4:
This gray
line shows
you where
the task will
appear if
you release
the mouse
button.
|

Using the drag-and-drop method

If you ask me, drag-and-drop is to computing what the remote control is to
television. It’s a quick, no-brainer method of moving stuff around in software
that just makes life simpler. Here’s an example: The quickest way to move a
task in an outline is to use the drag-and-drop method.

To move a task up and down with the drag-and-drop method, follow these

steps:

1. Display a columnar view, such as Gantt Chart view.

2. Select a task by clicking its task ID number.

3. Drag the task to where you want it to appear in the outline.

A gray line appears, indicating the new task position, as shown in

Figure 5-4.

4. When the gray line is located where you want to insert the task,
release the mouse button.

The task appears in its new location. If you want the task to be at a dif-
ferent level of the outline, you can now indent or outdent it as needed.

Gray line
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As for indenting tasks, you can select multiple tasks and then move or copy
them.

Using the cut-and-paste (or copy-and-paste) method

Dragging and dropping works fine in most cases, but in very large projects —
with a few hundred or more tasks, for example — this method can be like
dragging a peanut to Tibet: It’s not the process; it’s the distance you have to
travel.

In a larger outline, simply use the cut-and-paste method to move tasks:

1. Select a task by clicking its task ID number.
2. Click the Cut button in the Clipboard group on the Task tab.

The task is removed from its current location and placed on the
Windows Clipboard.

3. Scroll to display the location where you want the task to appear.
4. Click the task after which you want to insert the task.

5. Click the top part of the Paste button, also on the Task tab.

If you want to insert a copy of a task in a project outline, you can follow the

" preceding steps and click Copy rather than Cut.

<
If you're cutting and copying only a single cell and not a whole task, click in
the cell rather than clicking the task ID number.

Using a Manually Scheduled Summary
Task to Plan from the Top Down

It’s the nature of the beast when you're a project manager to be put on the
spot, starting from the beginning of the planning process. Stakeholders often
want to see the plan in advance, but you often haven’t yet had the opportu-
nity to flesh out how hundreds of tasks are going to flow. And you don’t want
to put bad information out there and be held accountable for it later.

Under the automatic method of scheduling, which as you may know is the
only method available in previous Project versions, Project calculates each
summary task schedule based on the schedules for its subtasks. Sure, you
can fudge it and create a schedule with tasks representing summary tasks
and durations, but you have to be pretty careful in reworking such a file to
ensure that it matches with the timings you originally presented.
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Figure 5-5:
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Project 2010’s new manual scheduling method, which I introduce in Chapter
4, enables you to sketch out a project from the top down by selecting when
you want each summary task to occur. You can then add in subtasks as
needed under a summary task, and the manual scheduling prevents the sum-
mary task from moving. You don’t have to add all the subtasks at once. Just
add them as the details become available.

And, as shown in Figure 5-5, subtasks like the “Kick off meeting” task even can
be outside the overall schedule for the summary task, something that isn’t
possible with autoscheduling. The lower rollup bar for the summary task
extends to the left of the black summary bar to show that a subtask is outside
the summary task schedule. Only three subtasks have been added so far for
the first summary task in Figure 5-5. The other four summary tasks, numbers
5 through 8, have been scheduled but don’t yet have subtasks added.

Creating manually scheduled summary tasks is just a variation of basic task-
creation techniques. Follow these steps:

1. Create the task that you want to be the summary task, leaving it set as
a manually scheduled task.

2. Enter the duration for the summary task.
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3. Set the start for the summary task, either by entering a date in the
Start column or by dragging its bar to the right on the chart to move it
to the desired time frame.

Repeat Steps 1-3 as needed to create other summary tasks. Continue
with the remaining steps for adding subtasks either now or at any later
time.

4. Add tasks below the summary task, setting their scheduling method
and duration as desired.

5. Select and indent the subtasks.

The manually scheduled summary task’s Gantt bar changes to a sum-
mary bar, and the rollup bar appears to reflect the current subtasks.

N To insert a task, such as a task between two manually scheduled summary
tasks, click the location where you want the new task to appear and press
Insert.
QNING/ In Chapter 4, | recommend that beginning project managers consider stick-
Y ing with autoscheduling to take advantage of Project’s powerful scheduling

capabilities and to reduce the degree to which individual tasks need to be
rescheduled manually when the schedule changes. The same gentle reminder
applies here. When you’re deciding whether to use automatically scheduled
summary tasks or manually scheduled summary tasks, keep your longer-term
management and tracking needs in mind. Manually scheduled summary tasks
don’t reschedule if their subtasks change, meaning that you may have to edit
summary tasks to match. It’s perfectly appropriate to use manually scheduled
summary tasks only when needed, and lean toward using mostly autosched-
uled summary tasks.

Now Vou See It, Now Vou Don’t:
Collapsing and Expanding Tasks

Since caveman days (or whenever the first fourth-grade teacher taught the
first set of kids how to outline their book reports), outlines have allowed you
to focus on different levels of detail. Outlines do this on paper by essentially
ordering information so that you can more easily focus on the level of infor-
mation you need and ignore the rest.

With the invention of computer outlining, the capability to focus on only cer-
tain portions of an outline comes into its own because you can easily open
and close an outline to show or hide different levels of information — or
entire sections of your outline. The minus symbol (=) next to the “Prepare
Print Materials” summary task shown in Figure 5-6 indicates that all subtasks
below it are displayed.
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This capability means that you can hide all but the upper level of tasks in

a project to give your manager an overview of progress. Or, you can close
every phase of your project except the one in progress so that your team
can focus on just those tasks in a status meeting. Or, you can close most of
your outline so that jumping to a late phase of a very large schedule doesn’t
involve more scroll work than a Baroque fireplace.

A summary task with all tasks displayed has a minus sign to its left. A sum-
mary task with hidden subtasks sports a plus sign to its left. All summary
tasks are indicated in bold in the project outline. When a summary task has
a minus sign next to it, you can select the summary task and do one of three
things:

<MBER
ég“

v Click the minus sign to hide all subtasks.

v Click the View tab on the Ribbon, click the Show Outline button in the
Data group, and then click Hide Subtasks.

v Click the View tab on the Ribbon, click the Outline button in the Data
group, and then click the level of detail you want to leave open in the
entire outline, as shown in Figure 5-7. (For example, you can click
Outline Level 1 for only the highest level in the outline to show the
fewest details.)
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When a summary task has a plus sign next to it, you can select the summary
task and do one of three things:

v Click the plus sign to display one level of subtasks.

v Click the View tab on the Ribbon, click the Show Outline button in the
Data group, and then click Show Subtasks.

v Click the View tab on the Ribbon, click the Show Outline button in the
Data group, and click the level of the outline you want to reveal for the
entire outline.

To quickly reveal all subtasks in a project, click the Show Outline button and
then click All Subtasks.

Cracking the WBS Code

Some codes are used for disguising things (think of The DaVinci Code). In
Project 2010, however, codes are used to make the elements of a project
easier to identify. These codes — work breakdown structure (WBS) codes —
can be generated automatically to give a unique identity to each task in your
project by its order in the project outline.
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If you use the Enterprise Global template, you
can make use of the RBS (resource break-
down structure)field, which is a way of ranking
resources in your organization. RBS represents
the organizational structure for resources.
RBS codes assigned by the project manager
or enterprise administrator can help you to
streamline the process of granting permissions

RBS: Kind of like WBS, but for people

Resource Substitution Wizard also makes use
of RBS levels in their calculations. You can
also use the Group feature to group tasks by
the resource hierarchy of assignments. After
an administrator with the ability to modify the
Enterprise Global template sets the RBS field,
everybody and their brother (in your enterprise)
can view it. All these tasks require Project

to access online data or to filter for resources
at a certain level in your organization. The

Server, so see Chapter 18 for more about RBS.

For example, say the third phase of a project has nine subtasks, and the
ninth subtask also has subtasks. The WBS code for its third subtask is 3.9.3.
This code helps you identify all tasks that belong to Phase 3, no matter at
what level of the outline they might lie, as shown in Figure 5-8. Quite simply,
assigning a WBS code to an outline helps you to identify the location of indi-
vidual tasks in the outline so that people can find and reference them easily.
This concept is similar to how page numbers in a book’s table of contents
help you go right to a specific page.
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The United States government often requires that subcontractors use this
type of code, so companies doing business with the government should find
this automatic application of a WBS code useful.

Standard WBS code uses numbers for each level of the code. You can also
create custom codes that provide a few options for how the code is defined.
Read how in the upcoming section “Customizing the code.”

Displaying a WBS code
Here’s the good news: You don’t really have to create a WBS code per se
because the very structure of your outline creates the code. All you have to
do is display it. To do that, follow these steps:
1. Click the Gantt Chart button on the Task tab of the Ribbon.
Gantt Chart view appears.
2. Right-click any column heading and then choose Insert Column.
The list of available fields appears.
3. Type a W to scroll down the list, and then click WBS.

The WBS column is displayed. If you add a task, or move, promote, or
demote a task in your project outline, the WBS code is updated
automatically.

Customizing the code

For the fourth task under the second phase of the first phase in the project,
the WBS code would look like this, by default:

1.24

Such off-the-rack WBS code often works just fine for projects. For those
times when you want to make changes, however, Project 2010 allows you to
modify the code to use a prefix — the name of your project, a client ID, or
your department number, for example — and to vary the use of numerals or
letters to indicate the various levels of your code structure. An example of a
customized code is shown in Figure 5-9.

The elements used to make up the code are code masks. You can specify the
following choices for WBS code masks:

1 Project Code Prefix enables you to add a project identifier that appears
at the beginning of each of the codes.
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v Numbers (Ordered) uses a numerical code.

1~ Uppercase Letters (Ordered) uses letter codes (such as A, B, and C
to correspond to the first, second, and third phases of a project) with
uppercase formatting.

1 Lowercase Letters (Ordered) also uses letters but with lowercase
formatting.

v Characters (Unordered) is used for combinations of letters and num-
bers. This choice generates an asterisk; you can replace the asterisk
with whatever characters you like in a columnar view.

To customize a WBS code, follow these steps:

1. Choose Project->WBS~>Define Code.
‘x‘gN\BEI? The WBS Code Definition dialog box appears, as shown in Figure 5-10.
<

Project offers a Code Preview field so that you can see what your
changes will do as you make them.

2. In the Project Code Prefix box, type a prefix.

3. Click at the top of the Sequence column and then select a mask for the
first level.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 5: Getting Your Outline in Line 1 ’ 9

WBS Code Definition in 'Fitness Center Direct Marketi... [&=)
Code preview: | 2011141 |
Project Code Prefix: | 2011
I Code mask (excluding prefiz):
Figure 5'10: Levell Sequence Length Separator =
The Code 1 |Mumbers (ordered) Ayl
. 2 |Uppercase Letters (ordered) Any .
PreVleW 3 |Mumbers {ordered) Any::E
field lets
you pre- 2
. /| Generate WES code For new task
view yOUr /| ¥erify uniqueness of new WES codes
Changes' Help Cancel
|
4. Click the Length column and then select a length for the mask
sequence that corresponds to the number of tasks you expect to have
at that level.
Each number represents a single character. If you choose 4, for example,
your first task at this level is numbered 0001. If you aren’t sure, leave the
default choice of Any, which allows any length.
5. Click under the Separator column and then select a separator.
The choices are a period, hyphen, plus sign, or forward slash.
6. To define WBS code elements for additional levels of your outline,
repeat Steps 3-5.
7. When you’re finished, click the OK button to save the new code.
QNING/ The essential point of a WBS code is to provide a unique identifier for each
Yy task in your project. The WBS Code Definition dialog box offers the Verify

Uniqueness of New WBS Codes option, which is active by default. If you turn
off this option, you aren’t alerted if you insert, for example, a subproject that
contains duplicate WBS numbers.

<P If you don’t want Project 2010 to automatically add a custom WBS code when
you insert new tasks, deselect the Generate WBS Code for New Task check
box in the WBS Code Definition dialog box. If you later want to renumber all
tasks to accommodate new tasks, changes, and subprojects you've inserted,
choose Project>WBS=>Renumber. This technique can be useful if you want to
try what-if scenarios and don’t want all your tasks to change.
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Chapter 6
Timing Is Everything

In This Chapter

Discovering how dependency links affect timing

Reviewing the different kinds of dependency relationships
Allowing for lag and lead time

Creating dependency links

Reflecting the timing of external tasks in your project
Examining workflow in Gantt Chart and Network Diagram views

magine this: If you create a hundred tasks and leave their default con-

straints so that they start as soon as possible and have no dependencies,
all those tasks start on the project start date and occur simultaneously. The
project consisting of a hundred tasks takes exactly as long to complete as the
longest task.

Wander back over here to reality for a moment. When was the last time that
every task in your project could be performed at the same time? When did
you last have enough resources to even begin to make that feasible? When
did you ever have a set of tasks in which not a single task had to be com-
pleted before another could start? Imagine what would happen if you poured
a building’s foundation before you got the building permit. Or, consider the
chaos if you tried to train your employees to use a new piece of equipment
before the equipment even arrived.

The reality is that tasks in a project don’t all start at the same time. To reflect
that reality in a Project plan, you have to build in a timing logic. That logic
consists of setting dependency links between tasks. Dependencies are timing
relationships between tasks — for example, when one task depends on the
completion of another. Dependencies are caused by either

+” The nature of the tasks: You can’t frame a house, for example, until its
concrete foundation is dry; otherwise, the building will sink.

v A lack of available resources: Your operations manager can’t attend
two plant inspections simultaneously.
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How Tasks Become Codependent

A\

In Chapter 4,  mention that you shouldn’t set task start dates very often
because projects are fluid — they change and grow faster than bad guys
come at you in the average computer game. If you build in timing logic rather
than assign specific dates to tasks, Project can reflect changes by adjusting
your project based on that logic.

If the task of getting materials in-house is delayed by a week, for example,

the dependent task of starting the manufacturing process moves out a week
automatically. You can note the change when you're tracking activity in your
plan, and Project makes adjustments accordingly. The alternative is to go in
and change the start date of just about every task in your schedule every time
a task is running late — you don’t even want to think about doing that!

Dependent tasks: Which comes first?

As with human relationships, every dependency relationship involves roles:
Every task is either a predecessor or a successor. Any two tasks with a timing
relationship can be a predecessor-successor pair, even if the timing of the
two tasks overlaps or they’re set to happen concurrently. The important
point to remember is that the predecessor task’s schedule has an impact on
when the successor task is scheduled, particularly under the autoscheduling
method.

Figure 6-1 shows you how the taskbars in Gantt Chart view graphically depict
the predecessors and successors in dependency relationships between tasks.
Notice how taskbars represent the relationship when a task starts after (or
during the life of) another task. Also notice the lines drawn between tasks:
These lines indicate dependency links.

Here’s some important advice about dependencies, so listen up: You can have
more than one dependency link to a task, but don’t overdo it. Many people
who are new to Project make the mistake of building every logical timing
relationship that could exist. If things change and the dependencies have to
be deleted or changed (for example, to shorten a schedule), the web of depen-
dencies starts to get convoluted — and can easily create a nightmare.

For example, you must complete the tasks of obtaining a permit and pouring
a foundation for a building before you can start framing it. However, if you set
up a dependency between obtaining the permit and pouring the foundation,
setting a dependency from foundation to framing is sufficient to establish the
correct timing. Because you can’t start pouring the foundation until you have
a permit and you can’t frame until you pour the foundation, framing cannot
start before you have a permit.
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Figure 6-1:
In this view,
dependency
relation-
ships are
shown by
the lines
between
taskbars.
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You don’t have to use dependencies to prevent resources from working on
two tasks simultaneously. When you set the availability for resources and

assign them to two tasks happening at the same time, you can use tools such
as the new Team Planner view (see Chapter 9) and resource leveling (dis-
cussed in Chapter 10) rather than establish a dependency that forces one task
to happen after another. This feature delays tasks whose scheduling causes a
resource overallocation. See Chapters 9 and 10 for more about how resource
assignments affect task timing.

Dependency types

You can establish four types of dependency links: finish-to-start, start-to-
finish, start-to-start, and finish-to-finish. Using these types efficiently can
mean the difference between a project that finishes on time and one that is
still limping along long after you retire.

In Chapter 4, I cover task constraints and priorities. These settings work in

concert with dependencies to determine the ultimate timing of tasks in your
project.
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|
Figure 6-2:
Where one
task ends,
the taskbar
for the other
begins.
|

Here’s how the four dependency types work:

v+~ Finish-to-start: A finish-to-start dependency is the most common type of

dependency link. In this relationship, the predecessor task must be com-
pleted before the successor task can start. When you create a depen-
dency, the default setting is finish-to-start.

An example of a finish-to-start dependency is when you must complete
the Calculate Quantities task before you can begin the Order Supplies
task. Figure 6-2 shows those two tasks (and others) with the finish-to-
start relationship indicated by a successor taskbar that starts where the
predecessor taskbar leaves off.

v~ Start-to-finish: In a start-to-finish dependency, the successor task can

finish only after the predecessor task has started. If the predecessor is
delayed, the successor task can’t finish.

Suppose that you're planning the building of a new cruise ship. You may
start selling tickets for the ship’s maiden voyage while the ship is being
built, and you don’t want to stop selling tickets until the ship is ready

to leave. So, the predecessor task is Ship Ready for First Voyage (a mile-
stone), and the successor is Sell Tickets for Maiden Voyage. If the ship
isn’t ready, you can keep selling tickets. When the ship is ready to go,
the ticket windows close, and that task can finish. Bon voyage!
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|
Figure 6-3:
The start-
to-start
relationship
between
two tasks.
|

v~ Start-to-start: Start-to-start means what it says: Two tasks can start
simultaneously. For example, if you are preparing to install a walkway,
determining the pattern in which you want to lay pavers may affect the
quantity of pavers ordered.

Figure 6-3 accordingly shows the start-to-start relationship between the
Calculate Quantities and Determine Pattern tasks.

v+ Finish-to-finish: Finish-to-finish has nothing to do with warm relations
between citizens of Finland. Finish-to-finish means that (you guessed it)
two tasks must finish at the same time.

Suppose that you're preparing an annual report for your adventure-
travel company. You have to obtain photographs of travel destinations
and have the brochure copy laid out. You need both items in hand
before you can forward the report to the printer. If you set a finish-to-
finish dependency between these two tasks, you allow both tasks the
greatest length of time to be completed. (Why have the photos sitting
around for four weeks, for example, when the copy isn’t ready?)
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Allowing for Murphy'’s Law:
Lag and lead time

Dependencies can get a little more complex than simply applying the four
types of dependency links I describe in the preceding section. You can use
lag time or lead time to fine-tune your timing relationships:

v Lag time occurs when you add time to the start or finish of a predeces-
sor task; lag time causes a gap in timing. For example, you almost always
have a period of time between when you order supplies for a project
and when you receive them. Figure 6-4 shows the lag time scheduled
between the Order Supplies and Receive Supplies tasks.

1 Lead time is created when you subtract time from the start or finish of
the predecessor; lead time causes an overlap between two tasks.
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Here are a couple of additional examples:

» You want to launch a new toy product into the market and set up a
start-to-start dependency relationship between the Begin Print Media
Advertising predecessor task and the Begin TV and Radio Advertising
successor task in your project. In a simple start-to-start relationship,
both tasks start at the same time. If you want the TV and radio ads to
come out a week after the print ads begin, though, you build in a week
of lag time to the start-to-start relationship where Begin Print Media
Advertising is the predecessor and Begin TV and Radio Advertising is
the successor. TV and Radio ads will now start one week after print ads
begin to appear.

v In a project to train a new set of volunteer docents to give tours of a
historic mansion, suppose that you create a finish-to-start relationship
between the two tasks Locate Recruits and Train Recruits. However, to
save time in your project, you decide to incorporate two days of lead
time — that is, allow the training of the earliest hires to start before all
the recruits are hired. In that case, you essentially deduct time from
the finish-to-start relationship that allows you to start training two days
before the finish of the Locate Recruits predecessor.

Making the Dependency Connection

Making dependency relationships is simple. You simply create a dependency,
make settings to select the dependency type, and build in any lag or lead
time. The tricky part comes in understanding how each type of dependency
affects your plan when your project goes live and you start to record actual
activity that resources perform on tasks.

Adding the missing (dependency) link

When you create a dependency, by default, it’s a finish-to-start relationship:
One task must finish before another can start. If that’s just the kind of depen-
dency you want, that’s all there is to it. If not, after you create this link, you
can edit it to change the dependency type or to build in lag or lead time.

To establish a simple finish-to-start link, follow these steps:

1. Display Gantt Chart view and make sure that the two tasks you want
to link are visible.

You may have to collapse some tasks in your project or use the Zoom
button on the View tab to fit more tasks on your screen.
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Figure 6-5:
This box

lets you
know when
the mouse
pointer is
resting over
the task to
which you
want to link.
|

2. Click the predecessor taskbar and drag your mouse pointer to the suc-

cessor taskbar.

As you drag, a box appears, as shown in Figure 6-5, and the mouse
pointer changes to the shape of a little chain link.

3. When the readout indicates the task numb
release your mouse button.

er you want to link to,

You can also establish a finish-to-start relationship by clicking the predeces-
sor, pressing Ctrl, and then clicking the successor task; then just click the

Link Tasks button in the Schedule group of the T

ask tab.

It’s best practice to link only subtasks, which represent the actual work per-
formed, not the summary tasks. The Ctrl+click method is helpful for skipping
over summary tasks when selecting tasks for linking. Also, whether you use
the mouse to drag between tasks or the Link Tasks button, the task selected

first always becomes the predecessor.

Reference this box when linking tasks
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|
Figure 6-6:
Build
dependency
relation-
ships here.
|

To establish a link in the Task Information dialog box or modify an existing
relationship, make note of the task ID number of the predecessor task and
then follow these steps:
1. Double-click the successor task.
The Task Information dialog box appears.
2. Click the Predecessors tab, as shown in Figure 6-6.

On this tab, you can build as many dependency relationships as you

like.
Task Information =
General Predecessors | Resources | advanced | Motes | Custom Fle\ds.‘
Mame: | Grade Durstion: | 2 days | = Estimated
Predecessors:
21 -
)5} Task Mame Type Lag
mmamove nieeded veqgetation Finish-to-Start (FS1 0d

3. In the ID field, type a task ID number for the predecessor task.

Alternately, you can select the task from the Task Name drop-down list.
To display this list, click the next blank Task Name cell, and then click
the drop-down list arrow that appears.

4. Press Tab.

The task name and the default finish-to-start dependency type with 0d
(no days, the default unit of time) of lag time are entered automatically.

5. Click the Type field and click the arrow that appears to display the
dependency types, and then click the appropriate dependency for
your situation.

6. If you want to add lag or lead time, click the Lag field and use the
spinner arrows that appear to set the amount of time.

Click up to a positive number for lag time or down to a negative number
for lead time.

7. Repeat Steps 3-6 to establish additional dependency relationships.
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Figure 6-7:
The more
complex the
project and
its timing
relation-
ships, the
more lines
you see.
|

8. When you’re finished, click the OK button to save the dependencies.

The Gantt chart displays your dependencies with lines and arrows, as
shown in the project displayed in Figure 6-7.

Most dependency links are between tasks that are reasonably close to each
other in the Project outline. However, if you have to link tasks that don’t fit on
a single screen of information, the dragging method can be tricky. In that case,
use the successor Task Information dialog box to create the relationship by
entering the predecessor task ID number or name.
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Extending your reach with
external dependencies

No person is an island — and no project exists in isolation. Many times,

another project you're managing or another project going on somewhere else
in your organization affects your project. Perhaps resources or facilities are
shared, or perhaps the timing of tasks in other projects affects the timing of
tasks in yours. For example, if your project is to plan the opening of a new
store, you may have to create a dependency from your Begin Move-In task to
the Final Building Inspection Complete task in someone else’s construction
project.
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If you want to set up important project dates
and set up dependencies among them but you
don’t want those dates to cause any delay in
your project (as a linked task might do), try
using deliverables. First introduced in Project
Professional 2007, deliverables are important
dates in your project that you can use to build
a proposal for your project before you even
begin to add tasks. You can publish deliverables

When linked dependencies don’t do a thing

and report on them. They offer an alternative
way to audit changes among several projects.
Deliverables, which are essentially a Windows
SharePoint Server list accessed through
Project Web App, provide a tool that you can
use to control the effect of dependencies on
your schedule. See Chapters 18 and 19 for more
about Project Web App.

To deal with this balancing act, you can create a linked task that represents
the timing of the other project (or of a particular task in it). This is also called
creating a cross-project link. Make sure that both the file with the predeces-
sor task and the file with the successor task are open. Identify the filename
and task ID (row) number for the predecessor task. Then, switch to the file
with the successor task and open the Task Information dialog box for the
successor task, as just described. Click in the ID column on a blank row. Type
the predecessor filename, a backslash, and then the predecessor task ID
number, as in Annual Report Project\4. Then press Tab to complete the entry.
The linked task from the other file shows up in the list as shown in Figure 6-8.
In the Gantt chart, that external successor appears in gray, so you know that
it doesn’t really “live” in the current schedule file.

Task Information

Mame: | Demo
Predecessors:
Bailey House'4
jio] Task Name
Eailey HAExternal Task

General Predecessars | Resources | Advanced | Motes | Custom Fields |

=l

Duration: | 4 days | = Estimated
Type Lag
External Task External Task

Figure 6-8:

The task

ID refers to

an external
task.
|

| Help

[ coen |

\\3

You can also insert an entire project and add a link to it so that updates to the
other file are reflected in your plan automatically.
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Figure 6-9:
You can

use this tab
to create
and delete
dependency
links.
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Understanding that things change:
Deleting dependencies

Just like the latest trend in fashion, dependencies in a project can suddenly
change. For example, sometimes they’re no longer needed because of a shift
in resources or overall project timing. When you need to get rid of a depen-
dency, you can undo what you did in either the Gantt Chart or the Task
Information dialog box.

With Gantt Chart view displayed, follow these steps:

1. Select the two tasks whose dependency you want to delete.
¢ For two adjacent tasks: Drag to select their ID numbers.

¢ For nonadjacent tasks: Click one task, press and hold Ctrl, and
then click a nonadjacent task.

2. Click the Unlink Tasks button in the Tasks group of the Task tab.
Be careful when you use this method: If you click only one task and then click

the Unlink Tasks button, you get a somewhat drastic result: All dependency
relationships for that task are removed.

To remove dependency relationships in the Task Information dialog box,
here’s the drill:
1. Double-click a successor task name.
The Task Information dialog box appears.
2. Click the Predecessors tab to display it.
3. Click the Type box for the dependency that you want to delete.

A list of dependency types appears, as shown in Figure 6-9.

Task Information =
General Predecessors | Resources | advanced | Motes | Custom Fle\ds.‘
Mame: | Set edging Duration: | 4 hrs Estimated
Predecessors:
A|o1| Finish-to-Start (F3) -
I Task Mame Type |Lag
14 Determine pattern Finish-to-Start (FS Ud
7 Receive supplies 40
Finish-to-Start (FS)
Start-to-Start (35)
Finish-to-Finish (FF)
Start-to-Finish (S5F)
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4. Choose None.
5. Click the OK button to save the change.

The dependency line on the Gantt chart is gone; the next time you open
that Task Information dialog box, the dependency is gone, too.

Change Highlighting clearly shows the effect on your schedule of making
dependency and other schedule changes. Any tasks affected by adding or
deleting a dependency now have either their start or finish date columns high-
lighted in the sheet pane, depending on which date the change affected.

Taking a Look at the Task Dependencies

WMBER
@"&
&

A\

Project provides several ways to view dependencies in your project. The
method you choose probably relates to how you visualize data, so there’s no
absolute right or wrong way here!

You may have already seen the dependency link lines that appear in the
Gantt chart (refer to Figure 6-7). Another great way to see the flow of depen-
dencies is in Network Diagram view. This workflow view uses similar lines
and arrows to reveal dependency relationships, but it allows you to get a dif-
ferent perspective on them.

You can display the Task Inspector pane (click Inspect in the Tasks group
of the Task tab) to see a list of everything in the schedule that’s driving the
timing of a selected task, including predecessors. For more about the Task
Inspector feature, see Chapter 10.

Figure 6-10 shows Network Diagram view of a landscaping project. Notice
that each task has a node containing its vital statistics. Between the nodes
are lines that reveal dependency relationships among tasks. Although you
can’t see the effect in this black-and-white image, any task dependency links
on the critical path are displayed in red by default, and noncritical tasks are
displayed in blue. (Critical-path tasks have no slack: They can’t be delayed
without delaying the entire project.)

A neat trick in Network Diagram view is to edit the layout to show link labels.
(Right-click outside any task nodes, choose Layout, and then select the Show
Link Labels check box.) A code, such as FS for finish-to-start, is displayed to
explain the type of dependency that each dependency line represents, as
shown in Figure 6-10.
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You can also display columns that itemize, by task ID number, successors
or predecessors for each task in any view with a sheet area, such as Gantt
Chart view. Figure 6-11 shows Gantt Chart view for a project with successor
and predecessor columns displayed. These columns also display a notation
of any type of dependency other than the default finish-to-start type and any
lead or lag time using percentages or lengths of time. For example, 6FS+7
days is a finish-to-start link to task 6, with lag time set so that the successor
begins 7 days after the predecessor task finishes. Successors and predeces-
sors without added notations represent default finish-to-start links with no

lead or lag time.
aA\\J &

You can also edit the contents of Network Diagram nodes to include predeces-

sor and successor data.
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Of course,
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task number
is which
before you
can use the
information
in these
columns!
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Part Il

People Who Need
People

The Sth Wave By Rich Tennant

“You ever get the feeling this project
could just up and die at any moment?”
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In this part . . .

ere’s where you get to know Project resources —

human and otherwise — and understand how to
orchestrate people, material, and other assets most effec-
tively to dispatch your project’s tasks. This part also
shows you how resources drive most project costs and
how to use new and old tools to make resource assign-
ments most effectively.
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Optimizing Your Resources

In This Chapter
Understanding work and material resources
Creating resources to get your project done
Using resource groups and shared resources

Dealing with resource calendar settings

projects are like giant water coolers — they’re gathering places for
people. Projects also utilize equipment and materials. Those people,
equipment, and materials are your project resources.

Unlike water coolers (you can take an analogy only so far), resources are also
the means by which Project tallies up costs in your plan. Assign a resource
to work for ten hours on a task, give that resource an hourly rate of $20,

and you've just added a $200 cost to your project. Create a resource called
cement, give it a unit cost of $200, and assign ten units (for example, ten tons
of cement), and you’ve added a whopping $2,000 to the bottom line.

Using resources wisely in Project doesn’t involve only assigning them a cost.
Rather, it’s a delicate art of combining the right resource with the right skills
and assigning that resource to put in the right amount of time (or units) for
tasks. And you have to do this all without overbooking anyone at any point in
your schedule.

Because they affect timing and costs, resources are a big deal in Project. For that
reason, many tools are available to help you create resources, make settings for
how and when they’ll work, assign them to tasks, manage costs, and manipulate
their workload. The first step in working with resources is to create them and
enter certain information about them. That’s what this chapter is all about.

Resources: People, Places, and Things

Many people hear the word resources and think of people. Well, people are
indeed a frequently used project resource, but they’re not the whole story.
Resources can also be equipment that you rent or buy as well as materials,
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such as paper clips or scrap iron. You can even create resources that repre-
sent facilities you have to rent by the hour, such as a laboratory or a meet-
ing space, or costs that aren’t necessarily consistent. For example, you can
create a resource named Plant Visit and assign it a cost of $400, which covers
the airfare, hotel, and rental car charges for the visit.

Here are some typical and not-so-typical project resources:

v Engineers

v Trade-show fee

v Office supplies

v Hotel ballroom

v Administrative assistants
1 Rocket fuel

v Speaker fees

v Furniture

v Computer software
v Printing services
v Graphic designers
v Prototype design

You get the picture. Resources can be practically anything or anyone that
you use to complete your project.

Becoming Resource-Full

After you create and organize the tasks in your project, the next typical step
is to create resources. You can also borrow resources that have been cre-
ated by others and assign them to your project. Before you start creating
resources willy-nilly, though, you must understand how they affect your
project.

Understanding resources

The key to understanding resources is to realize that resources in Project
equal costs. If you want to account for costs in your project — such as a
person putting in hours working on a task, computers that you have to buy,
or fees for services — you must create resources and assign them to one or
more tasks. When you do, you can see the resulting costs in the Total Cost
column of the Cost table in Gantt Chart view, as shown in Figure 7-1.
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total costs
in the Total
Cost column
of the Cost
table.
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One other way to add costs to a project is to use a fixed cost. Fixed costs

are not assigned through resources because they don’t accumulate costs by
hours of work, units used, or on another frequent basis. Instead, a fixed cost is
a set cost applied directly to an individual task, such as a contract fee for an
outside vendor. (For more on fixed costs, see Chapter 8.)

If a cost is not task-specific — such as a flat $10,000 consulting fee to a firm
that’s advising you on an overall project — you can create and assign a
resource or fixed cost to the project summary task.

After you create the resources that Project uses to tally your project costs,
you need to manage the workflow for any resource that has limited time
availability for your project. You create resources that are available so many
hours per day and so many days per week. For example, one person may be
available 50 percent of the time, or 20 hours in a 40-hour workweek, while
another may be available full time (40 hours). When you assign those kinds

of resources to your project, you can use various views, reports, and tools to
see whether any resource is overbooked at any point during your project. You
can also see whether people are sitting around twiddling their thumbs when
they may be available to help out on another task. You can even account for
resources that work on multiple projects across your organization and make
sure that they’re being used efficiently. Views such as Resource Usage view
(as shown in Figure 7-2) help you visualize resource working time in your proj-
ect. (In Chapter 9, you discover another view — Team Planner — that helps
you visualize and work with assignments in a more fluid and easy way.)
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Finally, you need to understand that the number of resources you assign

to work on a task will usually have an effect on the duration of that task. In
other words, if you have a certain amount of work to perform but few people
to do that work, a typical task takes longer to finish than if you had scads of
folks.

The task type determines whether a task’s duration changes based on the
number of resources assigned to it. Take a look at Chapter 4 for more about
task types.

Resource types: Work, material, and cost

Although people and things come in all shapes and sizes, only three types
of resources exist as far as Project is concerned: work resources, material
resources, and cost resources:

v Work resources are typically (but not always) people. They can’t be
depleted but can be reassigned. Their costs are generally associated
with the amount of work time they put in, usually at an hourly rate. A
work resource also can have a cost per use (Cost/Use), which is a cost
added on each time you assign the resource. For example, a plumber
may charge a travel fee (the cost/use) plus an hourly rate. Work
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resources are assigned to tasks based on a Working Time calendar (as
shown in Figure 7-3), where you specify their working and nonworking
hours. You can select one of three base calendars or a custom calendar
that you've created and then modify specific working hours.

Change Working Time =

Resource calendar For 'PR Manager':

Base calendar:

Standard

24 Hours
- Fitness Center Holidays

see its working kimes:
er 2009 -

Th|F| S
1123

working times for October 5, 2009:

+ 8:00 AM ko 12:00 PM
+ 1300 PM to 5:00 PM

g |2 (10

15 |16 (17
Based on:

22|28 |24 Default waork week on calendar 'Standard',

29 |30 (31

Exceptions | Wark Weeks

Marne Start Finish o Ceetalls, .,

Delete

1 Material resources have a unit cost, and they also do not consume
working hours. For that reason, this type of resource has no calendar,
and you make no settings for working and nonworking time.

1 Cost resources have no cost associated with them initially. This type of
resource gives you the flexibility to specify the applicable cost each time
you use the resource. Calendars and units of work or unit costs have
nothing to do with the amount such resources add to the bottom line of
your project.

A typical work resource is a person working eight hours a day at a standard
rate of $20 per hour and an overtime rate of $30 per hour. Another example
of a work resource is a meeting facility available only eight hours a day at an
hourly rate. Even though it’s not a person, the meeting facility would proba-
bly be created as a working resource because it has limited “working” hours.

The three kinds of calendars are Project, Task, and Resource. Calendars, their

settings, and how those settings interact are discussed at some length in
Chapter 3.
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Enterprise or local?

If your organization has you choose resources
from an organization-wide group, you can
assign enterprise resources to your project. To
assign resources created for your enterprise
when connected to Project Server with Project
Professional 2010, you use the Build Team from
Enterprise command, which you can find by
clicking the Add Resources button in the Insert

command is available to you only if you are
nicely set up on a network with Project Server
in place. (See Chapter 18 for more about Project
Server.)

To set up so-called /ocal or nonenterprise
resources, you simply create your own
resource list in your projects; these resources
are not available to other project managers.

group of the Resource tab on the Ribbon. This

A typical material resource is any material — such as steel, rubber, paper or
books, chairs, and shoes — assigned to a task with an associated unit cost.
For example, a resource called Books with a unit price of $12.95, assigned to
a task called Computer Training at ten units, accrues a cost of $129.50 to the
task.

An example of a cost resource is a Bike Messenger resource, whose fee may
be $25 for one delivery task and $35 for another. Other common examples of
resources that would fall into the cost resource category include air travel,
hotel costs, or cab fare. Another example of a cost resource is anyone who
performs a service for a fee where working time is not an issue. A speaker
who presents at a conference for a fee of $1,000 but whose working calendar
and time are not your concern may be created as a material resource with a
unit cost of $1,000, or simply added as a fixed cost to the project.

Deciding which resource type to use when adding an external vendor or
equipment resource to the project can be tricky. If you do not want to add
hours of work to the project when that resource is being used, do not set the
resource up as a work resource. Use a cost resource or fixed-cost approach
instead.

WMBER
@&
&

How resources affect task timing

Under Project 2010’s new defaults, effort-driven scheduling is turned off

for both manually and autoscheduled tasks. So, no matter how many work
resources you assign, the task duration stays the same, and Project piles on
more hours of work for the task, to reflect more effort.
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However, there are cases where, for a fixed-unit or fixed-work task type, you
want the addition or removal of resources assigned to the task to have an
impact on the time it takes to complete the task. In essence, the old saying
that “two heads are better than one” may be modified to “two heads are
faster than one.”

Here’s an example: Suppose that one person is assigned to the Dig Ditch task,
which should take four hours of effort. Two people assigned to the Dig Ditch
task will finish the job in two hours because two hours are being worked

by each resource simultaneously, which achieves four hours of effort in

half the time. To make scheduling for a task work this way, you have to first
change the task to an autoscheduled task using the Auto Schedule button in
the Schedule group of the Task tab. Then, you have to turn on effort-driven
scheduling by double-clicking the task, clicking the Advance tab in the Task
Information dialog box, selecting the Effort Driven check box, and then click-
ing the OK button.

One BIG word of warning here: Assigning additional people to tasks doesn’t
always cut work time down proportionately, even though that’s how Project
calculates it. When you have more people, you have more meetings, memos,
duplicated effort, conflicts, and so on. If you add more resources to a task, you
may consider upping the amount of effort required to complete that task to
account for inevitable workgroup inefficiencies.

Estimating resource requirements

You usually know how many material resources it takes to complete a task: In
most cases, you can calculate the number of pounds, tons, yards, and so on
with a standard formula. But how do you know how much effort it will take
on the part of work resources to complete the tasks in your project?

As with many aspects of information you put into a Project plan, this judg-
ment rests to a great degree on your own experience with similar tasks and
resources. Still, remember these guidelines:

v~ SKill counts. A less skilled or experienced resource is likely to take more
time to finish something.

v~ History repeats itself. Look at previous projects and tasks. If you've
tracked people’s time, you can probably see how much effort was
required to complete various types of tasks on other projects and draw
parallels to your project.

v~ Ask and you shall receive. Ask the resources themselves how long they
think it will take. Then add 10 percent to that time to cover yourself!
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Committed versus proposed resources

If you've ever asked somebody to work on your project and gotten a half-
hearted, “Well, maybe, if | have time, if my manager says it’s okay, if it falls on
aleap year ...” in response, you may well ask: So is that resource available
or not? It’s not always easy to tell. How can Project help? One feature is the
capability to designate a resource as either proposed or committed. You can
use the Booking Type field on the General tab in the Resource Information
dialog box to make this setting. To open the Resource Information dialog
box, go to Resource Sheet view and double-click the resource. Or, click the
Resource tab and click Resource Information in the Properties group.

What does this setting do? Well, if you're not quite sure about a resource’s
commitment to your project, you call that resource proposed. Then you can
display the Booking Type column in a resource view (such as the Resource
Sheet) and keep track of resources you may have to firm up as you get closer
to finalizing your project plan.

The Birth of a Resource

A\\S

When a person is born, someone fills out a birth certificate. Creating
aresource in Project involves filling out a form, too. On the Resource
Information form, you enter information, such as the resource name, rate per
hour or cost per use, and availability. You can also enter optional informa-
tion, such as the group (company workgroup) the resource belongs to or the
resource’s e-mail address.

You can create a resource as a single person or thing, a generic resource
(that is, a skill set with no person attached, such as Assistant or Engineer), or
even a group of several resources that work together.

Creating one at a time

On the simplest level, you create a resource — whether it’s a person, a piece
of equipment, or a material — as a single entity. In this case, you’re thinking
of a particular person, or meeting room, or piece of equipment. You create
the resource by entering information in the Resource Information dialog box.

Another method for entering resource information is to display Resource
Sheet view and enter information in the columns included there. This is often
a faster way to create several resources at once, and you can even paste
resources copied from another source such as an Excel spreadsheet into this
view.
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When you create a resource, you must at a minimum type the resource name,
but you can also include as much information as you want. Some people
prefer to create all the resources first and deal with contact and cost informa-
tion at a later stage.

A\
[ show you how to add the cost information for resources in more detail in
Chapter 8.
To create a resource, follow these steps:
1. Click the bottom of the Gantt Chart button on the Task tab of the
Ribbon, and click Resource Sheet.
2. Double-click a blank Resource Name cell.
The Resource Information dialog box appears, as shown in Figure 7-4.
Resource Information =
General | costs | Nakes | Custom Fislds |
Resource name: Initials:
GEroup:
Windows Account... Code:
Booking type: v Iype hd
|
Figure 7_4: Genetic Budget
These Inactive
four tabs fwsiable From  |évaisblz T |Units : hargelvorknollmsF]
can hold a
wealth of
information
about any -
resource. | —p gtk o]
|

3. In the Resource Name box, type a name.
4. From the Type box, choose Work, Material, or Cost.

The settings available to you differ slightly depending on what you
choose. For example, a material resource won’t have the Email box avail-
able, and a work or cost resource won’t have the Material Label box
available.

5. For a material resource, enter a description of the units in the Material
Label box.

For example, you might enter pounds for a Flour resource or tons for a
Steel resource.
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6. In the Initials box, type an abbreviation or initials for the resource.

If you don’t enter anything here, the first letter of the resource name is
inserted when you save the resource.

7. Continue to enter any information you want to include for the
resource.

That information may include an e-mail address, the group (a depart-
ment, division, or workgroup, for example), Booking Type (Proposed or
Committed), or Code (such as a cost center code).

If you enter information in the Group box, you can then use the Filter,
Sort, and Group By features to look at sets of resources. See Chapter 10
for more about filtering and working with groups.

8. Click the OK button to save the new resource.

Identifying resources before
you know their names

In the planning stages of a project, you’ll often find that all your resources
aren’t assembled. Sometimes even well into the project, you don’t know what
resource you’ll be using; you know only that you need a resource with a cer-
tain skill set to complete upcoming tasks. In that case, you may be better off
creating some resources as generic resources.

If you want to create a generic resource, you should give it a name that
describes its skill, such as Engineer, Designer, or even Meeting Space (as
opposed to a specific resource named Conference Room B). Then, in the
Resource Information dialog box, be sure to select the Generic check box.

You can then display a Yes/No column titled Generic to identify these
resources, and you can create a resource filter to filter for a Yes or No entry
in the Generic column to filter resources by this characteristic.

No formula takes the Generic setting into account in recalculating your sched-
ule based on resource availability. However, many people find this setting
useful in long-range planning and in situations where they aren’t responsible
for specific resource assignments (for example, assigning a temporary worker
to a task when the specific worker will be chosen by the temp agency).

You can replace a generic resource name with the name of the actual
resource added to your project. For example, if you entered Engineer 1 as a
resource, you could replace it with Jim Taylor, the engineer you snagged for
the work. To make the switch, go to Resource Sheet view, click the Resource
Name field cell for the resource, type the new name, and press Enter. Don’t
worry if you've already assigned the generic resource to tasks in the project.
Project will update all the assignments with the new name.
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P When working with generic resources and Project Server, you may need to do

a little more work, such as specifying unique custom fields required by your
organization. Specify such information on the Custom Fields tab of the
Resource Information dialog box.

Throwing more warm bodies at a task

Although you’ll probably have little use for chain gangs in your project, they
exemplify the principle of a resource that represents multiple resources.
Rather than assigning people one by one to some tasks, you’ll want to assign
a group of people who typically work together. Being able to make one
assignment of a consolidated resource rather than several separate resources
and assignments can be a timesaver in larger projects.

Here’s an example of a consolidated resource: Suppose that you’re man-
aging a project to get a new Web site up and running. You have four Web
designers of equal skill at your disposal, so you create a resource named
Web Designers. You can assign Web Designers to a task at 400 percent and
have all four designers working at once. Or, you can assign the Web Designer
resource to work on a task at 100 percent, thereby assigning one resource to
it. The percentage of an assignment is its units setting.

No special setting is used to designate a multiple resource. However, you

may want to include some indication of the number of resources in the

resource name. For example, you can name your designer resource Four

Web Designers (if you know the Web design group consists of four people) or

Web Design Group. What really defines this type of resource is the maximum

e assignment units; 400 percent would indicate four resources in the group.
Assigning a resource at less than 100 percent units creates a part-time
assignment.

Sharing Resources

Many organizations have lots of projects going on at the same time. Some,
such as a project to organize an office move, are the only project of its type
happening in a company. Others, such as a building design project in an
architectural firm, will happen simultaneously with several other similar
projects and draw on many of the same resources, such as architects and
draftspeople.

When an organization has projects of a similar nature going on at the same
time, creating centralized resources is useful. This can save you time because
you don’t have to create resources when they already exist. It can also help
to track resources across projects.
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Another timesaving Project feature allows you to pull existing resources from
a company address book or your own Address Book in Outlook.

In the swim: Drawing on resource pools

If you use Project throughout your company, it can be beneficial to create a
centralized repository of common resources and allow project managers to
assign those resources to their various projects. This collection of resources
is a resource pool. By using a resource pool, you can get a more realistic idea
of how busy resources are across all projects at any point in time.

Don’t confuse a resource pool with enterprise resources, which require that
you have Project 2010 Professional, Project Server 2010, and Microsoft Office
Project Web App set up. With all this in place (see Chapters 18 and 19 for
more about enterprise projects), you can track and assign resources across
an entire enterprise. A resource pool, on the other hand, is simply a Project
file that contains only a list of resources in the Resource Sheet view, and that
is saved on a shared network drive for your workgroup or on your company
server. Anyone with access to the resource pool file can assign the resources
it contains to projects. A resource pool saves everybody the trouble of repeat-
edly creating these resources in their individual projects.

Both individual resources and generic resources can be created in a blank
project as a resource pool and saved to an accessible location on your com-
pany network. Then, any project manager can call on those resources for
his or her own projects; those projects are then referred to as sharer files
because they share resources from the resource pool. For example, if you
have a pool of maintenance people that everyone in your manufacturing
company assigns to projects, create a Project file called Resource Pools and
then create all the resources to share in the Resource Sheet view. Or, you
can create a resource pool file called CEO and let all the people managing
projects that require the CEO’s involvement assign him or her from that cen-
tral location. Then use the resource-sharing tools in Project to assign these
resources to your plan.

You also can use the View tab to change to Resource Sheet view. On that tab,
click the Resource Sheet button in the Resource Views group.

When anyone makes resource assignments in a sharer file, that information is
also saved in the resource pool file. Then, anyone can use that file to look at
resource allocations across all projects in the organization.

To access a resource that’s available to your entire organization, follow this
procedure:

1. Open the resource pool file, and then open the file that will be the
sharer file.
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2. Working in the sharer file, choose Resource->Resource Pool~>Share
Resources.

The Share Resources dialog box appears.
3. Specify the resources for the project.

If you want to specify that a project will use only its own resources (the
default), select the Use Own Resources option. If you want to share
resources, select the Use Resources option (see Figure 7-5) and then
choose a project in the From list.

Share Resources ==

Resources For 'Fitness Center Direct Marketing Campaign’
Use own resources

@ Use resources (requires at least one open resource pool)

From:  Fitness Center Resource Pool -

On conflict with calendar or resource information
@ Pool takes precedence
Sharer takes precedence

‘ Help OF ] | Cancel

4. Specify what Project should do when a conflicting resource setting,
such as the resource base calendar, exists.

If your project’s setting will take precedence, select the Sharer Takes
Precedence option. If you want the pool setting to rule, select Pool
Takes Precedence.

5. Click the OK button to complete the process.

All resources in the specified resource pool are added to your own proj-
ect’s resource list, ready to be assigned to tasks.

After you add a shared resource to your project, you can update shared
resource information. You would want to do this in case the person who
maintains those shared resources has made a change, such as upping
the resource’s rate per hour. To do this, choose Resourcer>Resource
Sharingr>Refresh Resource Pool.

If you combine separate projects into one master project at any point, Project
allows you to have duplicated resources. If you link the combined projects
and then delete a duplicate resource in the master project, it’s deleted in the
subproject as well. A better practice is to have all the separate projects share
resources from a resource pool so that no duplicate resources exist when you
create the master project file.
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Drowning in the resource pool

Drawing resources from resource pools saves
you time because you don't have to re-create
those resources again and again. However,
should you track your resource’s time in the
resource pool file to see whether the resource
is overbooked? Most projects in the real world
use resources that are not solely dedicated to
a single project. New users of Project often get
confused because almost every person work-
ing on their projects puts in time on other work,
from general communication with coworkers
and clients to efforts put in on other projects.
Should they build resource pools to account
for time shared among several projects at one
time?

Generally speaking, it would be chaos to try to
track every minute of all your resources’ days

to see whether they're working 100 percent or
50 percent on your tasks or are being shared
among multiple projects. Ask yourself this ques-
tion: When this resource works on a task in your
project, “Will he or she put his entire focus on
that task at that time?” If so, you may not need
to fool around with tracking shared resources
across many projects. Especially on shorter
tasks, not trying to micromanage the efforts
of your resources outside of your own project
usually works just fine. If, on the other hand, you
have resources who work only half time or split
their time between two projects routinely, con-
sider using shared resource tools to keep track
of those resources across projects.

Importing resources from Outlook

If you're like I am, you've spent months or years building your list of e-mail
contacts in Outlook. You might as well have a way to leverage all that work:
Project supplies this in its capability to pull resources from Outlook.

You must have Outlook specified as your default e-mail program for this to
work. Do that by opening Outlook; when you're asked whether you want it to

be your default program, say yes.

When you insert one or more Outlook resources in your project, they’re
added to your project list, taking the resource name and e-mail address as
they exist in the Outlook Address Book. The default first-letter initial and
work type is also preassigned. You can then add any details you like to the

resource.

To insert resources from your Outlook Address Book, display Resource Sheet
view and then follow these steps:

1. Choose Resource->Add Resources->Address Book.
The Select Resources dialog box appears.

2. Click the desired resource in the Name list.
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3. Click Add to place the selected name in the Resources list.

4. Repeat Steps 2 and 3 to add all the resource names that you want to
import to your project.

5. When you're finished, click the OK button.

The names now appear in your project resource list, ready for you to add
additional information.

Say, When Do These Guys Work?

In Chapter 3, you can read all about calendars, including Project, Task, and
Resource calendars. Now that you’re working with resources, it’s worth a
closer look at how Resource calendars work.

At first, the resources use the calendar that you assigned to the project:
Standard, Night Shift, or 24 Hours. (You can also create custom calendars.)

v~ Standard is a typical 9-to-5 workday and a five-day workweek.

v~ Night Shift is an eight-hour work day, scheduled between 11 p.m. and 8
a.m., with an hour off for a meal, from Monday through Friday.

v The 24 Hours base calendar shows just what it says: 24 hours per day, 7
days per week.

Later on, you can change the schedule for your Resource calendar. For exam-
ple, you can specify working hours, such as 9 a.m. to 12 p.m. and 1 p.m. to 5
p.m. for a standard eight-hour day, or 8 a.m. to 12 p.m. and 1 p.m. to 4 p.m.
for a variation on that eight-hour day. Finally, you can select specific days
when a resource is not available (for example, when someone will be on vaca-
tion, at an offsite seminar, or busy with another commitment) and mark them
as nonworking.

QNING/ Avoid micromanaging nonworking time for your resources because it can
Y leave you no time to manage anything. For example, if someone is taking
off half a day to go to a doctor’s appointment, it’s probably not necessary
to block a day off. However, if a resource is taking a two-week vacation or a
three-month sabbatical, it’s probably useful to modify that resource’s
calendar.

To make all these settings, double-click the resource in Resource Sheet
view to open its Resource Information dialog box and then click the Change
Working Time button on the General tab (refer to Figure 7-4). The Change
Working Time dialog box opens, as shown in Figure 7-6.
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To make changes to a resource’s calendar, follow these steps:

1. Display the Resource Sheet view.

2. Double-click a resource name.

The Resource Information dialog box appears.

3. Click the Change Working Time button on the General tab.

The Change Working Time dialog box opens.

4. In the Base Calendar box, select a different base calendar, if needed.

5. If there will be an exception to the default base calendar hours, click

the Work Weeks tab.

6. Click the [Default] entry in the list, and then click Details.

The Details for [Default] dialog box opens, as shown in Figure 7-7.

7. Drag over the workdays to reset in the Select Day(s) list.

8. Click the Set Day(s) to These Specific Working Times option, and then
edit the From and To working times as needed.

Note that to build in a break or lunch hour, you must enter two sets of
numbers. You also need to press Tab to complete each entry you add or

edit.
9. Click the OK button.
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Details for ‘[Default]’ ==
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10. To create an exception such as a holiday or vacation day, click the
Exceptions tab.
11. Drag over one or more dates on the calendar.
12. Enter the name for the exception on the Exceptions tab, and then
press Enter.
13. Click back on the exception, and then click the Details button.
The Details for [Exception] dialog box opens (see Figure 7-8).
Details for Vacation' ==
Set working times For these exceptions
@ Monworking
‘warking tirmes:
_—
|
Figure 7-8:
Recurrence patkern
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or hOlIday Start: Tue 9710 ~ (@ Endafter: | 4 = ogcurrences
exception Endby: | Frigjio/n
here' Help Cancel
|
14. Make the desired changes and click the OK button when you’re fin-
ished, and then click OK twice more to close the remaining dialog
boxes.
A\

To find out more about calendars or to create a custom Resource calendar,
see Chapter 3.
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Now That 've Got ’Em, How
Do I Manage ’Em?

Before I leave the topic of resources, I'd be remiss if [ didn’t tell you a bit
about the vital project management skill of resource management. Here, in a
nutshell, is your nickel tour of the art of managing the people who will make
your project happen.

Acquiring the right resources

Just like an award-winning performance in a movie begins with casting the
right actor, resource management starts with finding the right resources for
your tasks. What makes a resource is a combination of factors. The right
resource for a task is somebody who has

v The right skills for the task at hand (or who is trainable, if training is
part of your budget)

v Enough time available to complete the task according to your schedule

v The ability to commit to the project (This sometimes involves getting
another manager’s buy-in, so make sure that you're building a supply of
favor chips as needed.)

v A cost that fits in your budget

Although this list covers the basic requirements, consider other details,

such as whether the resource is set up to work with the project team, and
whether the technology to communicate and share documents is available
(see Chapters 18 and 19 for more about this). Also, give some thought to how
well each resource you choose will work as part of the team, and whether the
resource can be considered dependable.

In Project, you have several ways to flag and find resources, categorizing
them by skill or other criteria:

v Use the Resource Notes tab of the Resource Information dialog box
to record information about a resource’s skills and abilities. Then use
the Find feature to search note fields for words such as highly skilled,
dependable, and trainable.

1 Use the Code field in the Resource Information form to rank resources
by skill, cost, or ability to work well with others.

v Create custom fields for resources to note specific skills and search for
resources by those skills.
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Chapter 7: Optimizing Your Resources

Sometimes it’s worthwhile to consider using a less-experienced, cheaper
resource to save money — just be sure to factor in the time and money
needed for any training required.

Balancing workload

Another important part of resource management is managing the assignment
of resources so that nobody is as overbooked as a CPA at tax time. Although
occasional overtime is expected of most workers, constant overtime causes
burnout and poor work quality. Keep in mind that a less skilled worker will
take longer to do a task than a skilled worker. Take that into account when
scheduling the time that resource might need to complete his or her work.

You get the scoop about making resource assignments in Chapter 9, and you
read more about resolving resource overallocation in Chapter 10.

You can do three main things to stay aware of resource workload when work-
ing with Project:

* Keep an eye on your Project plan. Various tools, such as Resource
Graph view (as shown in Figure 7-9), allow you to spot overbooking on
tasks. Access these and other key resource views either via the bottom
of the Gantt Chart button on the Task tab or in the Resource Views
group of the View tab.

v Track the workload of individual resources. When tracking activity on
tasks, you will receive an accounting from resources (see Chapter 13 for
how to gather this accounting) about the actual time they’re spending
on tasks. Notice the people who have to constantly put in overtime to
keep their heads above water.

v~ Ask people. That’s right. This isn’t a feature of Project, but it’s an old-
fashioned communications device that works amazingly well. Check in
with resources often and ask whether things are going okay — includ-
ing whether your human resources are being run ragged. Then help
those who are overworked by modifying your schedule or adding other
resources to help.

Managing conflict gracefully

Although the fine art of managing people and the conflicts they seem to get
into is beyond the scope of a book on Microsoft Project, this topic is worth a
word to the wise. Conflict resolution is a necessary skill for project managers.
It involves creating an environment of cooperation and respect, building con-
sensus (agreement) among team members, and encouraging honest
communication.
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As a project manager, you can set up well-designed communications tools
(such as frequent status meetings or reports) so that people stay in touch
throughout your project. You can also make a point of staying alert to con-
flict — and nipping it in the bud. (A conflict ignored will only fester and
become something worse.) Try to keep the focus of discussions on the proj-
ect goal, not on personalities.

In Chapter 16, [ tell you all about designing and generating reports in Project
that help you keep your resources in the loop. Chapter 18 provides several
tools to help resources communicate clearly with each other, which can help
you avoid misunderstandings.
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Chapter 8
What's All This Gonna Cost?

In This Chapter
Understanding how costs accrue
Establishing work resource rates
Specifying unit costs
Adding fixed costs
Allowing for overtime
Estimating resource availability
Working with budget resources

l here’s no such thing as a free lunch — and if you use Project to track
costs, there’s no such thing as a free resource because Project uses
resources working on tasks as a way of calculating most of the costs of your
project.

When you set up a resource, you specify a work resource rate (by default,
this rate is tallied up per hour) or a material resource per use cost. You can
also create cost resources, that is, a variable cost that isn’t calculated using
a per-use or hourly rate but may be used several times in a project, such as
travel expenses.

Some other factors come into play as well, such as how many hours a day a
resource is available to work and any overtime rates. At the end of the day,
all these settings come together to put you over — or under — budget.

In this chapter, you explore the relationship between resources and costs
and also find out how to set resource standard and overtime rates, create
fixed costs, and set the availability of resources on individual tasks in your
project.
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Mary, Mary, How Do Your Costs Accrue?

Project helps to account for costs on your various tasks with a combination
of costs per hour, costs per use, costs per unit, fixed costs, and costs for spe-
cific assignments of cost resources. Before you begin to flesh out cost infor-
mation about your resources, you have to understand how these calculations
work.

You’ll have two main pictures of the budget in your project: one at the
moment you freeze your original plan (a baseline plan) and the ongoing
picture of actual costs that comes from the activity and material usage you
record as your project moves along. You record a certain amount of work
effort on tasks, and tasks with resources assigned to them then run up costs
based on the effort expended or units of materials used.

It all adds up

The best way to understand how costs add up in your project is to look at
an example. John Smith (that’s not his real name) is managing a project that
involves the building of a new gourmet ice-cream packaging plant. John has
created a task called Install Ice-Cream Mixers. Here are the costs John antici-
pates for that task:

v About ten person-hours of effort to do the installation

v A cost per use of $500 paid to the mixer manufacturer to oversee the
installation and train workers on the machine

v Twenty pounds of ice-cream ingredients to test the mixers
v $150 in shipping expenses for the mixers and supplies

v A fixed cost of $2,500 for the mixers themselves

The ten hours of effort will be expended by work resources. The total cost
for the ten hours is a calculation: 10 x the resource rate. If the resource rate
is $20, this cost totals $200. If two resources work on the task, one at a rate of
$20 and one at a rate of $30, then (with effort-driven scheduling turned off by
default) Project adds 20 hours of effort between them, and the resulting cost
is $500.

The cost per use of $500 is a fee to the manufacturer, which is also created as
a work resource. This cost won’t change based on the number of resources
or the time involved.

The cost for 20 pounds of ice cream (any flavor you like) is calculated as 20

x the unit cost of the ice-cream ingredients. If the unit cost is $2, this cost
would be $40.
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Shipping the new equipment and ice cream supplies to you will result in a
charge of $150. You created Shipping as a cost resource, because there is no
associated work, and you may have different shipping costs to apply to other
tasks in the project.

Finally, you entered the $2,500 cost for the mixers themselves separately, as
a fixed cost in the Cost table of Gantt Chart view.

And that’s how costs are assigned and how they add up on your projects.

<P You can create and assign resources that have no associated costs. For exam-
ple, if you want your boss to be available to review status reports but your
company doesn’t require that your boss be charged to your project, you can
simply use those resource assignments to remind you about the need for your
boss’s availability on that day or at that time.

When will this hit the bottom line?

In business, you rarely get to choose when you pay your own bills. In Project,
however, you can choose when your costs hit your budget.

Resources can be set to accrue at the start or end of the task that they’re
associated with or to be prorated throughout the life of the task. So, if a
three-month-long task begins April 1, a $90 cost resource could be added

to your actual costs to date on day 1, on day 90, or at a dollar per day until
the end of the task. Use the Accrue At field in Resource Sheet view or on the
Costs tab of the Resource Information dialog box to set the accrual method.

This isn’t exactly a purely realistic reflection of how you have to pay for
costs, because face it: Most bills come due 30 days after they hit your desk.
It’s more a factor of when you want that cost to show up for the purposes of
tracking costs and reporting expenses on your project.

It Alt Adds Up: Specifying
Cost Info in Your Project

Most projects involve a combination of cost types: cost, work, and material.
You have to do your homework before you can enter the information at the
task or resource level. You have to find out the fixed costs as well as the
hourly or unit rates for all your resources.

During the planning stages, you may not be able to anticipate exactly what

a particular cost will be or know every resource’s rates. If you have to, build
the resource or fixed cost with your best estimate. That way, at least some
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cost will be reflected in your plan, and you can go back to enter more accu-
rate information as soon as you know it.

Use a field in your Resource Sheet, such as Code, to designate resources as
having estimated rates or costs so that you can easily go back to those tasks
and update the estimates as your plan progresses.

Vou can’t avoid fixed costs

Maybe it’s that huge fee for the consulting company your boss insisted you
use, even though you knew that the report wouldn’t tell you a thing you
didn’t already know. Or perhaps it’s the $2,000 for a laptop computer you
talked your boss into getting you so that you could manage your project
when you're on the road. Whatever it is, it’s a cost that won’t change no
matter how many hours the task goes on or how many people work on the
task. It has no unit cost or rate per hour, and no actual hours of work will be
tracked. It’s a fixed cost.

You can specify a cost like this by creating a resource with a Cost type. Every
time you assign the resource to a task, you specify the cost associated with it.

You can also simply enter a fixed cost associated with a task without having
to create and assign a cost resource to it. To do so, you can use the Cost
table in the sheet of Gantt Chart view.

Tables are preset column combinations that make entering certain information
in a sheet pane easier.

Follow these steps to enter a fixed cost for a task:

1. Display the project in Gantt Chart view.
2. Choose Viewr>Tables>Cost.
The table of columns appears, as shown in Figure 8-1.

3. Click the Fixed Cost column for the task to which you want to assign
the cost and then enter the amount.

That’s all there is to it, but because you can enter only one fixed-cost amount
for a task, you should also enter a task note where you can itemize fixed
costs if you have more than one. Note also that the default fixed-cost accrual
method is prorated; if you prefer to have your fixed costs hit your budget at
the start or end of a task, use the Fixed Cost Accrual column in this table to
select another option.
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When resources get paid per
hour and tack on fees

Whether it’s minimum wage or the astronomical fees your lawyer charges
you every time you sneeze, most people get paid something per hour. To rep-
resent most people involved in your project, you create work resources and
charge them to your project at an hourly rate. Some resources also charge an
additional flat fee for each use. For example, a plumber may charge a base fee
of $75 and then add the cost per hour. That flat fee is a cost per use, added
each time you assign the resource to a task, no matter how many hours are
involved in completing the task.

After a resource has an hourly rate, when you then enter the estimate of how
many hours that person will work on each task that he’s assigned to, Project
totals his estimated costs in your plan and adds any cost per use. When you

track actual effort expended on tasks, a calculation of actual effort times the

hourly rate plus any cost per use returns actual costs.
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< By comparing estimated costs and actual costs, you get an ongoing picture of
whether your project is on track.

To set resource rates per hour and cost per use for a work resource, follow
these steps:
1. Display Resource Sheet view.

2. Click the Std. Rate column for the resource to which you want to
assign a cost.

3. Type a dollar amount.

If you're entering a rate for a unit other than hours, type a slash (/) and
then the unit (for example, year or month).

4. Press Tab twice to move to the Cost/Use column.
5. Type a dollar amount.

This amount is the flat fee amount that will be added each time you
assign the resource to a task.

6. Press Tab.
The entry is completed.
Note that you can also make cost-rate entries in the Resource Information

dialog box. The Costs tab of this dialog box, which is shown in Figure 8-2,
offers a Standard Rate, an Overtime Rate, and a Per Use Cost column.

Resource Information ==

General CDStSl Motes | Custom Fields |
Resource lame: | pR Assistant

Cost rake tables
For rates, enter a value or a percentage increase or decrease from the previous rate. For
instance, if a resource's Per Use Cost is reduced by 20%, type -20%.
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- %17 50/h
Mo 1/410 18 ,50jh

Figure 8-2:
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In addition, five tabs labeled A through E allow you to enter different rates
for the resource. By using the Effective Date column, a resource could work
for several months at one rate and then start working at a different rate on a
preset date. This helps you account for periodic raises or seasonal shifts in
rates (for example, paying a premium for construction resources in months
with better weather when they are more in demand).

If you use ten gallons at $2 per gallon . . .

This one may feel like a problem from your high school algebra class. (So
many gallons of water in a bathtub with a leak . . .) Well, if you weren’t that
great at algebra, you’ll be glad to hear that Project makes a pretty straightfor-
ward calculation to arrive at the cost for using a material resource.

When you assign a work resource to a task, Project multiplies its standard
hourly rate by the hours of work for the assignment. But material resources
don’t have hours of work. You pay for them by the unit quantity, not by the
hour. So, when you set up a material resource, you specify a standard rate
for a single unit (per yard, or ton, or gallon, for example) and assign so many
units to each task. The cost is tallied by the number of units times the cost
per use. (Technically speaking, you also can assign a cost per use for a mate-
rial resource, but you’ll probably encounter few instances where you need to
do so.)

To assign a standard unit rate for a material resource, follow these steps:

1. Display Resource Sheet view.

2. If you haven’t already done so, click the Material Label column for
that resource and then type a unit name (such as gallon).

3. Click the Std. Rate column for the resource you want to set and then
type a dollar amount (such as the cost per gallon).

4. Press Enter or Tab to finish your entry.
Note that you can also use the Resource Information dialog box to enter up

to five standard unit rates with effective dates to account for fluctuations in
unit cost over the life of your project.

Making allowances for overtime

Overtime is a fact of life: It’s great for people who earn it, albeit hard on the
project manager with a budget. If you have resources that shift into earn-
ing overdrive after so many working hours, you can enter an overtime rate
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for them. The good news is that you as project manager retain control over
whether the overtime rate is used in the project budget. You have to autho-
rize overtime on an assignment-by-assignment basis. | explore that little trick
in Chapter 13.

To enter an overtime rate for a resource, follow this procedure:

1. Display Resource Sheet view.

2. Click the Ovt. Rate column for the resource.
3. Type an amount.

4. Press Enter or Tab.

The entry is completed.

It’s an Availability Thing

Lots of Project features deal with resources — in particular, helping you
spot resource overallocation. Overallocation is a calculation involving the
resource’s calendar and availability.

So, consider Monica Melendez, an engineer who works a standard eight-hour
day based on her calendar. Monica is assigned to the Write Final Report task
at 50 percent of her availability and to the Create Design Specs task — which
occurs at the same time as the report task — at 100 percent of her availabil-

ity. Monica is now working at 150 percent of her availability, or 12 hours per
day. Poor Monica is overbooked.

By default, a resource is assigned to a task at 100-percent availability (or
units), but you can modify that if you know that a resource will be assigned
to several tasks and is likely to put in only part of that person’s time over the
course of a task.

Setting availability

Availability is easier to estimate for some resources than for others. A man-
ager isn’t likely to give an entire day to any single task because he has to deal
with all the people who report to him. Or, she has to sign authorizations, go
to meetings concerning various projects, work on budgets, and so on. With a
production worker, it may be simpler to pin down availability to a single task:
If one manufacturing job is going through the line for three days and one
person is working on the line all that time, it’s closer to the mark to say that
he or she is working on that task full-time.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 8: What's All This Gonna Cost? 1 6 7

One big mistake that new users of Project make is to micro-think availability.
Of course, no one actually spends eight hours every day on a single task in
one project. People spend part of their days reading e-mail about company
holidays, chatting with coworkers, and answering phone calls about non-
project-related stuff (you know — J Lo’s love life, UFOs landing at the U.N.,
the usual). A resource may spend seven hours on a task one day but only
three the next. Don’t get hung up on a day-by-day resource schedule in esti-
mating availability. If over the life of a task, the person is pretty much devoted
to it, 100-percent availability is a good setting. If that person will put in only,
say, five days of work on a ten-day task, that’s 50-percent availability, whether
o \\BER she works four hours per day for ten days or five full days at any point.

S The Units (availability) setting is there to help you spot the overbooking of a
resource who may work on multiple tasks at the same time in a project schedule.

To set default resource units to specify availability, follow these steps:

1. Display Resource Sheet view.
2. Click the Max. (Max. Units) column for the resource.

3. Type a number representing the percentage of the time the resource is
available to work on the project.

For example, type 33 for a resource who’s available one-third of the
time or 400 for a resource who can provide four workers full-time (that
is, entries greater than 100% represent resources that will be provid-
ing a group or team to handle assignments). The most common entry
here (the default entry) is 100 for a single resource working full-time on
assignments in the project.

4. Press Enter or Tab.

The entry is completed.

When a resource comes and goes

In addition to being available only a certain percentage of the time for a proj-
ect, a resource may be available for only a certain period of time during the
life of the project. This commonly happens when you use a resource that
you're borrowing from another department, or when you're working with a
freelancer who has to squeeze your project in between two others. Another
scenario may be a resource who’s available half-time for the first few days

of the project and then full-time for the rest of the project. In that case, you
enter a date range in the Available From and Available To columns of the
Resource Availability area in the Resource Information dialog box (see Figure
8-3) to specify varying availability.
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To specify a limited period of time during which a resource will be available
to work on your project, follow these steps:

1. Display Resource Sheet view.

2. Double-click a resource.

The General tab of the Resource Information dialog box appears (refer
to Figure 8-3).

3. Use the Available From and Available To columns (in the Resource
Availability area) to specify the period of availability.

4. In the Units column on the same row, either click the arrows to
raise or lower the availability in 50-percent increments or type in a
number.

Press Enter to finish the entry.

5. Repeat Steps 3 and 4 to specify additional periods of availability on
subsequent rows in the Resource Availability area.

6. Click the OK button to save the setting.

Adding It Up: How Your Settings
Affect Vour Budget

In Chapter 9, you explore assigning resources to tasks. But to help round out
this discussion of costs, you should know that in addition to a resource cost
per hour and a resource base calendar and availability, you assign resources
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to tasks at certain units (percentages for work resources and quantity con-
sumed to for material resources). All these factors work together in calculat-
ing the cost of the resource when assigned to tasks.

Don’t worry about the calculations — Project does those for you. That’s the
beauty of entering information in Project: After you make settings for your
resources, Project does the work of tallying and showing total costs to you in
views, such as the Cost table of Gantt Chart view shown in Figure 8-4.

For example, suppose that you want to assign a mechanic to a task. Here are
the specifics:

Base calendar: Night Shift (eight hours, six days per week, between 11
p.m. and 8 a.m.)
Cost per hour: $20
Overtime cost: $30
Availability: 100 percent
Assigned to a two-day task: 50 percent
What is the cost of this resource? Here’s how it works: Two days at half-time

availability based on an eight-hour calendar is a total of eight hours (four hours
per day). The resource incurs no overtime, so the cost is 8 x $20, or $160.
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mary-tas Blueprints $0.00 Prarated $6,430.00  $6430.00
i Design finalization 50.00 Prorated 5710.00 §710.00
level give g
= Construction $0.00 Prorated  $171,560.00 $171,560.00
yOu a qulck Hire general contractor $0.00 Prorated §7,200.00  $7,200.00 |ities,Project Manager 1,Project Manager 2
Idea Of yOul’ Secure permits 50,00 Prorated $2,52000  £2,320.00 Project Manager 2, General Contractor, Permit[51,200.00]
total budget Perfarm demolition 30,00 Prorated $1,080.00 $1,080.00 Project Assistant 1,Labor, General Contractor
d ts i Order materials 50.00 Prorated $99,680.00  $99,660.00 — (@ General Contrac!
and costs in Order harduare 30,00 Prorated $15,680.00  $15,680.00 [ Project Manager 2,Project Assista
H Waste disnnsal annn provated 2AnN N 4Ann nn s harsi |
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Change two settings for the same resource, and see what you get:

Assigned to a two-day task: 150 percent

Overtime authorized: 8 hours

Now the resource is working 12 hours per day (150 percent of 8 hours) over
two days. With 16 total hours at the standard rate ($20) and 8 hours of over-
time ($30), this person will cost $560.

Creating a Custom Text Field

The tables Project offers for sheet views often restrict you to particular types
of entries. For example, you have to enter a numerical value in any cost-
related field. Project offers a number of placeholder fields that you can cus-
tomize for your own purposes and add into any task or resource table. There
are text, cost, number, flag, and other types of fields that you can customize.
A neat shortcut is to create a custom field with a lookup table.

A lookup table allows you to create a drop-down list of values in to select
from for a custom field. That is, when you click on a cell in the field, you can
then click the drop-down list arrow that appears an select from one of the
predefined entries. Say that you want to add a field that indicates whether
aresource has completed training. Creating a custom field with the lookup
table offering the possible entries Yes, No, and Partial can make your data
entry faster and also help prevent data-entry mistakes that could occur if the
field had no restrictions. By default, only the entries in the lookup table may
be entered for the field.

To create and use a custom text field with a lookup table, follow these steps:
1. Display the task or resource-oriented view, and then display the table
that you want to customize.

You display tables by choosing View=>Tables and selecting one from the
list that appears.

2. Right-click any field column heading and choose Custom Fields from
the shortcut menu that appears.

The Custom Fields dialog box appears.

3. After selecting another of the placeholder fields in the Field list, if
needed, click Rename.

4. Type a name for the field in the Rename Field dialog box, and click
the OK button.
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Back in the Custom Fields dialog box (see Figure 8-5), click the Lookup
button.

The Edit Lookup Table dialog box appears, as shown in Figure 8-6.

Click this button

Field

Field

Custom Fields ==

Task @) Resource Project Type: Text -

[rraining Cnmp\ete (Textl)

Text
Textd
Textd
Texts
Texth

S [TT

Figure 8_5 Rename... Delete ] Add Field ko Enterprise. Import Field...

You can use | Qustom

the Rename | @¥r © [ tecki. 1] © [ Formus...
button |n Calculation For task and group summary rows

this dialog

Calculation For assignment rows
box to ?

rename a

pla Ceh0|der Yalues to display

fleld |f yOU @) [ata Graphical Indicatars. ..
Ilke' Help Cancel
|

@) MNone Rolup: Use Farmula

@) Mone Rall down unless manually entered

attributes

[=2]

. Enter a the possible value (text for a text field, a dollar amount for a

cost field, and so on) in the Value column.

Optionally, enter a description for each value in the Description column.

7. Repeat Step 6 to enter additional values for this field.

8. To set one of the entries as the default for the field, select the Use a

10.

Value from the Table as the Default Entry for the Field check box,
click the desired value in the list, and click the Set Default button.

. Click the Close button and then click OK to save the list and close all

dialog boxes.
Add the field to the desired location in the table (refer to Chapter 2).

Figure 8-7 shows a custom text field with a lookup table added to
Resource Sheet view in a project.
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Figure 8-6:
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To create a different type of custom field, select the desired field type from the
Type drop-down list of the Custom Fields dialog box after Step 2 of the previ-
ous procedure.

Working with Budgets

|
Figure 8-8:
Creating

a budget
resource.
|

You can specify a resource as a budget resource by selecting the Budget
check box in the Resource Information dialog box (see Figure 8-8). You then
assign these resources to the project’s single summary task (the project sum-
mary task, task 0). Using budget resources, you can display fields that allow
you to compare budgeted work with planned work. (Believe me, you often
see a difference.) For example, you may have $10,000 budgeted for computer
programmer time, and you may have planned to use $11,450 of resource work
for programming. The budget setting can help you compare these amounts
as you add and delete resources from various tasks.

Select this option

Resource Information =

General | Costs | Notes ‘ Custom Fields |
Resource name: Staff Training Manager Initials: S
Group:
Windows Account... Code:

Biooking type: Carnrnitted ~ Iype: Work -

Generic [ Budgel

Inactive

m .
#Available From | Available To Linits Chenge Working Time ...

Help Details. .. Cancel

If you assign a budget resource, you use Task Usage view or Resource Usage

view to enter a work amount for that resource. You can view budgeted work

by displaying the Budget Work field. Note that this field reflects only material
and work resource type costs. You can display and use the Budget Cost field

to view the budgeted amount for cost resource types.

Setting up and using budget information is a lengthy, but worthwhile, pro-

cess. If you want to delve in to the particulars, review the “Create a Budget
for Your Project” topic in Project Help.
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Chapter 9

Assigning Resources
to Get Things Done

In This Chapter

Understanding how assigning resources affects task timing
Making resource assignments

Checking resource availability

Using Team Planner view

Notifying team members of their assignments

ou may have entered a cost per hour (or per use) for every resource in
your project, but those resources won'’t cost you a thing — or, for that
matter, get anything done — until you assign them to tasks.

When you do begin making assignments, several interesting things happen. Not
only will your budget start to swell, but in some cases, your tasks may actually
change duration. You may also start to see evidence of people who are over-
booked on several tasks that happen around the same time. Understanding
how those results occur is key to making intelligent assignments.

However, your work won’t be over even when everything about your assign-
ments looks hunky-dory. That’s when you have to communicate the assign-
ments to your team and make sure that each resource agrees to take them
on. If they don't, it’s back to the assignment drawing board.

In fact, assigning resources is something of an ongoing process throughout

your project. As usual, Project provides the tools to help you manage this
entire process relatively painlessly.
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Vou'd Be Surprised What Assignments
Can Do to Vour Timing

For autoscheduled tasks, the three task types (as I describe in Chapter 4)
are fixed units, fixed work, and fixed duration. Each defines the relationship
that balances a task’s duration, the work required to complete the task, and
resource assignment units.

Your selection of task type — in combination with a setting that determines
whether a task is effort-driven — has an effect on the timing of your tasks
relative to your resource assignments. A formula behind the scenes does all
the calculations for you.

For manually scheduled tasks, you can ignore this whole discussion for the
most part. You can’t work with the task type or effort-driven setting for man-
ually scheduled tasks.

Pinning down your type

Essentially, task types specify what will remain constant in a task when you
add work resources to it or remove work resources from it after making

the initial resource assignment. Although this whole work, duration, and
resource assignment percentage calculation can be complicated, you need to
understand it if you want Project to accurately determine task durations in
your plan according to resource assignments.

The default task type is fixed units. With a fixed-units task, the task dura-
tion you enter and the resource effort (work) assigned to that task jointly
determine the timing of the task. With this task type, the assignment units
you specify for your resources won’t change, even if the number of hours
required to complete the task shrinks or grows.

With a fixed-units task, if you increase the duration of Task A from two to
three days, your resources will continue to work on it at the assigned units
for the specified duration; Project increases the Work amount accordingly.
When you add or take away resources and you've enabled the effort-driven
setting for the task (more on this shortly), Project changes the task duration
accordingly, based on the assignment units you specify.

The fixed-work task type, on the other hand, takes a specified number of
work units to be completed. A one-day task requires eight hours to be com-
pleted (assuming a Standard calendar). This type of task by default is effort-
driven and changes its duration in response to the number of resource units
you assign.
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With a fixed-work task, resource assignments may change in response to a
work change. For example, suppose that Task A takes four days to complete
when one person is assigned; with a fixed-work task, the same task takes only
two days when two people are assigned. Project doesn’t modify the total
hours of work required to complete the task, but it does modify the hours of
work scheduled for each resource, based on assignment units, to complete
that work within the specified time frame. So, if you increase the duration of
Task A, resource assignment units (and thus assigned hours per day) shrink
in response to maintain the same total number of hours. If you reduce the
time to complete Task A, resource assignments increase to complete the
unchanged amount of work hours in less time.

A fixed-duration task does not vary its length, no matter what resource assign-
ments you make.

With a fixed-duration task, Task A will take four days. If you assign additional
resources or remove resources, the task still takes four days. When the task
is not effort driven, more or fewer total hours of work will be added. If you
enable the effort-driven setting, the hours assigned to each resource will
change because the assignment units will change.

Figure 9-1 shows the same autoscheduled task with the three different types
specified and with effort-driven scheduling enabled for two of them. Each
task was created with a four-day duration and one resource at 100 percent.
Then an additional resource was added at 100 percent. Note the resulting
change — or lack of change — with each type and how the hours of work are
assigned. The fixed-duration task didn’t change duration but did add more
hours when not effort driven or reduce resource assignments when effort
driven. The fixed-units task kept resource assignments constant at 100
percent — and reduced the task duration when effort driven. Fixed work
was accomplished faster, and the work (32 hours) stayed constant.

When effort is in the driver’s seat

Project’s complex calculation of work, task duration, and assignment units
involves not only task types but also the effort-driven setting. (In Figure 9-1,
the effort-driven setting is active for some of the tasks.)

With the effort-driven setting turned on, if you add resources to a task,
Project distributes the specified work equally among them and may change
the task duration according to the total resource effort, depending on the
task type.
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For the fixed-duration and fixed-units task types, Project assumes (by default)
that each task is not effort driven. You can turn on the effort-driven setting

if desired if you choose the fixed-duration or fixed-units task type. With the
fixed-work task type selected, the effort-driven setting is turned on automati-
cally and can’t be turned off.

Follow these steps to change the settings for an effort-driven task:

—

. Double-click a task.

The Task Information dialog box appears.

N

. Click the Advanced tab, as shown in Figure 9-2.

w

. To turn off the effort-driven setting, deselect the Effort Driven
check box.

The effort-driven setting is on by default.

4. Click the OK button to save the new setting.
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Suppose Task calendars prevail?
One other setting on the Advanced tab of the Task Information dialog box,
Scheduling Ignores Resource Calendars, has an effect on how resources are
scheduled when you make task assignments. You can instruct Project to
let the Task calendar override any Resource calendar setting for resources
assigned to it. Then, for example, if a task is set to use the Standard calendar
and a resource assigned to it uses a Night Shift calendar, that resource will
work standard hours on that task.
A\

In some situations, certain calendar settings won'’t be available. Chapters 3
and 7 provide details about how all kinds of Resource calendar settings work if
you need a refresher course about this.

Use this setting to provide some timing flexibility in your task: for example, if
someone who normally works the night shift will be called on to attend a two-
day seminar that takes place during standard working hours.

Finding the Right Resource

Sometimes no one in the world can perform a certain task like Albert, and
you'll get Albert to do that job if it kills you. Other times, just about anyone
could handle the work.

If any Tom, Dick, or Mary with a certain skill level (or a certain rate per hour)

will do, you can use Project features to find the right resource and make sure
that he or she has enough time to take on just one more task.
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Needed: One good resource willing to work

You’ve probably used the Find feature in other software to find a word or
phrase or number. That’s child’s play compared with Project’s Find feature,
which can find you a backhoe, a corporate jet, or even a person! You can use
Project’s Find feature to look for resources with certain rates or in a certain
workgroup. You can search for resources by their initials, their maximum
assignment units, their standard or overtime rate, and so on.

For example, you may need to find a resource whose standard rate is less
than $50 per hour. Or, you may want to find someone who can put in extra
work on a task, so you search for any resource whose maximum units are
greater than 100 percent. (In other words, the resource can put in a longer-
than-usual day before he or she is considered overallocated.) Perhaps you
need to find a material resource that is a chemical measured in gallons, but
you can’t remember the exact chemical name. In that case, you can search
for resources whose material label includes the word gallons.

To find resource information, you must be working in a resource-oriented
view. To find task information, you must be working in the task-oriented view.

First display any resource view and then follow these steps to find resources
in Project:

1. On the Task tab, click Find in the Editing group.

The Find dialog box appears, as shown in Figure 9-3.

Find =)

Find what: 50

Lockinfield: @ Selected  Stamdard Rate -
All Wisible
Test: is less than -

Zearch: Down v Match case

Replace... | [ Find Mext ] | Close

2. In the Find What box, type the text you want to find.

For example, type 50 if you want to search for a resource with a stan-
dard rate of $50 per hour or less, or laboratory if you want to find a
resource whose material label contains that word.
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. From the Look in Field list, choose the name of the field that you want

to search in.

For example, to search for resources that have a maximum unit assign-
ment percentage of more than 100 percent, choose the Max Units field
here. Or, choose Standard Rate to search based on the resource’s hourly
rate.

. In the Test box, select a criterion.

For maximum units of more than 100 percent, for example, this choice
would be Is Greater Than. Or, for a rate less than $50 per hour, this
choice would be Is Less Than.

. If you prefer to search backward from your current location (that is,

the currently selected cell in the task list) instead of forward, choose
Up from the Search box.

. If you want to match the case of the text, select the Match Case

check box.

7. To begin the search, click the Find Next button.

8. Continue to click Find Next until you find the instance you’re looking for.

You can also use the Find feature to find and replace an entry. For example,
if your Manufacturing department (MFG) changes its name to Production
(PDTN), you can search the Group field for the code MFG. In the Find dialog

box,

click the Replace button, and type PDTN in the Replace With box, as

shown in Figure 9-4. Then click the Replace button to replace each instance
one by one or click the Replace All button to replace every instance of that
entry in that field, wherever it occurs in your project.

Test:

Search:

Replace =
Find what: MFG
Replace with: | pppy

Lookin field: @) Selected  Group h

Al Visible
containg -

Down - Match case

‘ Replace ‘ |Rep\aceﬁ|\ | [ Find Mext ] | Close
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Custom fields: It’s a skill

When assigning resources, you often need to take a person’s skills into
account. If a person with less skill or experience could work on a particular
task (and save you money because he or she has a lower rate per hour),
wouldn’t it be nice to be able to find such resources easily?

Well, Project doesn’t include a Skill field, but it does allow you to add fields
of your own. You can use these fields for anything, but one great way to use
them is to code your resources by skill level. You can use a rating system
such as A, B, and C, or use terms such as Exp for an experienced worker and
Beg for a beginning-level worker.

Here’s how to add a custom field:

1. Display the Resource Sheet (or whatever sheet you want to view the
custom field in).

2. Scroll to the right, and click the Add New Column column heading.

3. Type a name for the field, and press Enter.

You can enter whatever you like in this column for each resource in your
project. Then you can search for specific entries in that field using the Find
feature, or turn on a filter to display only resources with a certain skill level
in that field. (Read more about filters in Chapter 10.)

The custom field created using the above method actually uses one of the Text
1 through Text 30 placeholder fields available for you to customize. You can
customize other types of placeholder fields, such as cost fields. To access more
custom fields, right-click a field column heading, and click Custom Fields.

Some organizations designate custom fields for certain company information
such as an accounting code or vendor rating. If you have a Project administra-
tor who is in charge of these enterprise-wide standards, check with him or her
before you choose a custom field to designate skill level.

A Useful Assignation

If you understand how task types and effort-driven scheduling can affect your
tasks’ timing, you’ve fought 95 percent of the battle in assigning resources.
The rest is just the software equivalent of paperwork. First, you have to
create resources before you can assign them. (If you haven’t, wander to
Chapters 7 and 8 for a refresher course.) After you create resources, you
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can use a couple of methods to assign them to tasks and also specify the
resource assignment units. These assignment units differ slightly between
work resources and material and cost resources, however, so read on.

Determining work material and cost-
resource assignment units

Work resources, which are typically people, are assigned to a task using a
percentage: for example, 100 percent, 50 percent, or 150 percent. When you
assign a resource at a percentage, the assignment is based on the Resource
calendar. A resource with a Standard calendar will put in eight hours a day if
you assign it at 100-percent assignment units. Theoretically, a resource with
a 24-hour calendar will work a grueling 24 hours a day at 100 percent (and
probably fall right over) or 12 hours at 50 percent.

A material resource is assigned in units, such as gallons, consulting sessions,
yards, or tons. When you assign a material resource to a task, you designate
how many units of that resource will go to that task.

A cost resource is one that incurs a variable cost every time you assign it.
For example, if you create a cost resource called Permit Fee, every time
you assign a permit fee to a task, you can designate the actual cost for that
assignment, whether it’s $25 or $125.

Note that cost and material resource units are not part of the entire work-unit-
duration calculation that can cause work resource assignments to change task
durations.

Making your assignments

You have three main methods of making resource assignments in Project
(although there are other methods you can use working in various views):

v Select resources from the Resources tab of the Task Information
dialog box

v Enter resource information in the Resource column in the Entry table
(displayed in Gantt Chart view)

v Use the Assign Resources dialog box

You need to work in a task-based view, such as Gantt Chart view, to make the
assignments.
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Which method you use depends to some extent on your own preferences, but
generally speaking, here are some parameters for using each method:

» When you use the Resource column, you're assigning at a default 100
percent assignment. If you want to assign a different percentage, don’t
use this method. It’s also harder to use this method if you need to assign
multiple resources.

v Use the Assign Resources dialog box if you may want to replace one
resource with another (there’s a handy Replace feature in this dialog
box) or if you want to filter the list of available resources by a criterion
(for example, resources with a cost of less than a specified amount).
This is very useful for making multiple resource assignments.

v Work in the Task Information dialog box if it’s helpful to have task
details (such as task type or the constraints contained on other tabs of
this dialog box) handy when you make the assignment.

Picking resources from the Resource column

You can use this method to add resources in a resource column, whether

NG/ from Gantt Chart view or Tracking Gantt view.
v““\ l

s Even though it lists tasks in its sheet pane and can even display a Resource
column, Task Usage view cannot be used to add resource assignments.

Follow these steps to assign resources at a default percentage:
1. Display Gantt Chart view by clicking the Gantt Chart button on the
Task or View tab of the Ribbon.
2. Choose Viewr>Tables>Entry.

3. Click in the Resource Names column for the task on which you want to
make a resource assignment.

An arrow appears at the end of the cell.
4. Click the arrow to display a list of resources.
5. Click the resource you want to assign.

The resource name appears in the Resource column, assigned at 100
percent.

\3
P You can always change the assignment units later by opening the Task
Information dialog box and changing the assignment units on the
Resources tab.
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Using the Assign Resources dialog box

To assign a work or material resource to a task, you can select a task and

then use the Assign Resources dialog box to make assignments. This is an
easy method to use for assigning material and cost resources. To use the

Assign Resources dialog box, follow these steps:

1. Click the Assign Resources button in the Assignments group of the
Resource tab on the Ribbon.

The Assign Resources dialog box appears, as shown in Figure 9-5.
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v |Project Manager 2 100%  :$1,120.00 | Replace... |
resource Architect |—|
., Elueprints Graph
you've s
created is Erynalers —
. Electricians ‘
shown in Frih Caperiors [ o |
T Framers h
this list. , :
Hold down Ctrl and dlick to select multiple resources
|

2. Click a task to select it.

The Assign Resources dialog box can remain open while you select tasks
in the task list. This enables you to make assignments to a variety of
tasks without the need to close and reopen the dialog box repeatedly.

3. Click the Units column for the work or material resource you want to
assign. Click the Cost column for the cost resource you want to assign.

4. Specify the assignment units or cost for the resource.

Click the spinner arrows in the box to increase or decrease the setting.
For a work resource, change the percentage units in 50-percent incre-
ments by clicking the arrows; or, simply type a percentage. For a mate-
rial resource, use the spinner arrows in the Units column to increase or
decrease the unit assignment, or type in a number of units. For a cost
resource, type in the expected cost for that particular assignment.

5. Click the Assign button.
6. Repeat Steps 2-5 to add all resources.
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7. If you want to replace one resource with another, click an assigned
resource (indicated with a check mark), click the Replace button,
select another name on the list, set its units, and click OK.

8. Click the Close button to save all the assignments.

Adding assignments in the Task Information dialog box

Finally, you can assign resources on the Resources tab of any Task
Information dialog box by following these steps:

1. Double-click a task name in Gantt Chart view.
The Task Information dialog box appears.
2. Click the Resources tab to display it.

3. Click in a blank Resource Name box and then click the arrow that
appears at the right side of the box.

A drop-down list of resources appears.
4. Click the resource you want to assign.

5. For a work or material resource, click the Units column and use the
spinner arrows to set an assignment percentage. For a cost resource,
click the Cost column and enter the cost.

If you're assigning a material resource, the Units default is a single unit.
(If your units are pounds, the default assignment is 1 1b.) Use the spinner
arrows in the Unit field or type a value there to assign additional mate-
rial units.

6. Repeat Steps 3-5 to assign additional resources.
7. Click the OK button.

ettin e contour that's i or you
Getting th tour that's right for y

When you make a work resource assignment, Project spreads the work out
evenly over the life of the task. However, you can modify the level of work that
goes on during the life of an auto-scheduled task — called a work contour — so
that more work takes place near the beginning, middle, or end of the task.

For example, if you know that the people on a task to install a new computer
network will have to spend some time up front studying the manuals and
reviewing the schematics for the wiring before they can begin to make measur-
able progress on the installation, you may use a late-peaking contour. Or, if you
know that people are likely to put in a lot of work up front on a survey — and
then sit back and wait for the results to come in — you may choose an early-
peaking contour.
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Using a different contour on a particular resource’s task assignment could
free that resource to work on a second task that occurs during the life of the
first task. This can help you resolve a resource conflict.

QNING/ The contour you select will have slightly different effects depending on the
R task type. Trust me: Most project managers don’t even want to try to under-
stand this complex equation. Simply try a different contour and see whether
it solves your problem and doesn’t make too dramatic a change to your task
duration or other resource assignments.

To set a task’s contour, follow these steps:

1. Display Task Usage view.
This view shows resource assignments by task.
2. Double-click a resource assignment.

The Assignment Information dialog box appears, as shown in Figure 9-6.

Assignment Information ==
—- | Tracking | Nates |
Figure 9_6: Hire general contrackor
ThIS |S a Resource: Project Manager 1
work: 32h = Units: 100% =
handy sum- “Work contour:  Flat -
ma ry Of a” Start: Thu 8j12110 - Commitked
information | grish: wed 6/18/10 - £2,240.00
abouta Cost rate table: A -
resource’s
assignment
on a task.
| Cancel
I

3. From the Work Contour box, choose one of the preset patterns.
4. Click the OK button to save the setting.

A symbol for the contour pattern is displayed in the Indicator column
for the resource.

\§
P If none of these patterns fits your situation, you can manually modify a

resource’s work by changing the number of hours the resource puts in
day by day on a task in Task Usage view.

Before you save, make sure that your modifications add up to the number of
hours you want, or you could inadvertently change the resource’s assignment.
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Resource Usage view is useful for reviewing resource assignments at this
stage. This view gives a side-by-side comparison between a single resource’s
workload and all the tasks going on during a particular time period in your

project.

A Helpful Planner

One thing you may notice after making resource assignments is that a little
person icon appears as an indicator beside some tasks in Gantt Chart view.
If you switch to a resource-oriented view, you may see that some resource
names now display in red. These changes are Project’s little way of telling
you that you are starting to overbook resources in the plan.

|
Figure 9-7:
Change
assignments
and task
schedules
by dragging
in Team
Planner
view.
|

The Professional Edition of Project 2010 offers a new view called Team
Planner that you can use to make sure that you’'ve spread the work among
resources in a manageable way. This view enables you to move assignments
among resources, assign tasks that haven’t been assigned, and even schedule
tasks that haven’t been scheduled. Figure 9-7 shows Team Planner view.
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\§ . c . .
P Team Planner view is just one of the tools you can use to deal with over-

booked resources. Chapter 10 presents even more methods for fixing work-
load issues.

As you can see in Figure 9-7, when two tasks assigned to a resource overlap
and cause the resource to be overbooked (or overallocated), thin red bars
appear above and below the overbooked period. The view also shows you
any tasks that are unassigned or don’t have enough schedule information to
be scheduled.

To change to Team Planner view, click the bottom half of the Gantt Chart
button on the Task tab of the Ribbon and then click Team Planner. Or, if
you’re working on the Resource tab, click the Team Planner button at the
far left. To view unassigned tasks, drag the bar at the bottom that shows the
number of unassigned tasks up, dropping it to split the view as desired.

From there, you can drag and drop to correct a number of schedule issues,
and you can use the following techniques in any combination:

v To fix a resource overallocation: Drag one of the overlapping tasks to
the left or right to change its schedule. If you want to reassign the task
to another resource, drag the task up or down to that resource.

+* To assign an unassigned task: Drag the task up to the row for the
resource to which you want to assign the task.

+* To schedule an unscheduled task: Drag the task to the right, onto the
timescale portion of the view, and then drop the task into the desired

“&N\BEI) schedule position.
<

® Dragging horizontally in Team Planner view changes the task schedule, while

dragging vertically from one resource to another changes the task assignment.

Communicating an Assignment
to Your Team

After you work out all your resource assignments on paper, see whether your
ideas will work for your resources’ schedules.

Of course, you should check to see who is available for your project. And
because things can change in the time it takes to work out your plan and

make assignments, make sure that your resources are committed to you

before you commit yourself to a final plan.
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If you use Project Server and Project Web App with Project, you can use col-
laborative tools to publish assignments to a server, where people can review
them and accept or decline. For more on Project Web App, see Chapters 18
and 19.

You can send your entire project plan to resources as an e-mail attachment
or just send selected tasks. You can also generate a resource assignment
report and send that to people so that they can review their assignments in
detail.

It’s in the e-mail

E-mail can be a project manager’s best friend. You can use it to communicate
throughout the life of your project and to send your project plan for review
at various stages. One of those stages is the point at which you want your
resources to commit to their task assignments. You can send your project as
an e-mail attachment so that resources can review the assignments you’ve
mapped out and give you their feedback.

To send a project as an e-mail attachment, follow these steps:

1. Choose Filez>Share=>Send as Attachment=>Send as Attachment.
An e-mail form is displayed, as shown in Figure 9-8.

2. Fill in a subject and write your e-mail message.

3. Click the Send button to send the message.

To help you track e-mails to resources on your project, set your e-mail pro-
gram to provide return receipts when messages are received or read.

Going the Project Web App route

Project Web App allows you to do a lot of com-
municating and interacting with your team
online, including notifying people of assign-
ments, allowing them to see your Project plan
(even if they don’t have Project installed), and
requesting status reports. You can also use
features of Project Web App to view resource
availability, build a resource team from an

enterprise resource pool, and review resource
assignments across projects. Chapters 18 and
19 give you an overview of Project Web App,
which requires that your organization have
Project Server installed. If your organization
decides to implement this enterprise approach
to project management, it can make your life
much easier!
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Figure 9-8:
Create the
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Project file.
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Report your findings

Remember the days when you read a report on paper, instead of on your
computer screen? Those days aren’t gone: In lots of situations, a printed
report is your best bet for clear communication about your project.

You can use several assignment reports to inform your human resources of
their assignments on projects. To help you, the four assignment report types
provide the following information:

+ Who Does What report: Provides a list of tasks organized by resource
with total work hours, number of days delay from the original schedule,
and start and finish dates. It also reflects a total number of work hours
for a resource on all tasks in the project.

v Who Does What When report: Shows a calendar that lists tasks orga-
nized by time period with resource assignment totals.

v+ To-Do List report: Generated for a single resource (not all resources, as
with the other report types) week by week in a project. It lists the task
names, durations, start and finish dates, and predecessor tasks by task
number.

v Overallocated Resources report: Shows resource assignments for
human resources who are overbooked on tasks during the project,
including total hours, unit assignments, total hours of work on each
task, and any delay from the original schedule.
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Follow these steps to generate an assignment report:

1. Choose Project->Reports.
2. Click Assignments and then click Select.
The Assignment Reports dialog box appears, as shown in Figure 9-9.
3. Click one of the four reports.
4. Click the Select button.

A preview of the report appears. Figure 9-10 shows a sample Who Does
What report.

ey | Assignment Reports ==
Figure 9-9: — -

Assignment E T T Edt..
reports Close

deal Wlth who Does What Wwho %Dha;nwhat
resource
assignments
to individual
tasks. To-do List overalocated

Resources
|

i

5. If you need to modify the page setup, click the Additional Page Setup
button.

For example, you may want to modify the margins or set the document
to print landscape or portrait.

6. To print the report, click the large Print button near the top of the

@ center pane in the Backstage view preview of the report.
<

See Chapter 16 for much more about reporting options in Project 2010, includ-
ing the Visual Reports feature.
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Part Il

Well, It Looks
Good on Paper ...

T_he 5th Wave By Rich Tennant
GRICGKTENNANT

y, of course. I'd be very interested in seeing this
new milestone in the project.”
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In this part . . .

hen you’ve charted a course for your project, it’s

time for the critical eye: Does your project plan
pass muster in terms of budget and timing? If not, you
can use the built-in Project tools to tinker with resource
assignments, adjust task timing, trim costs, and meet
deadlines. Result: a better final plan. You also get a look
at modifying how items in your project are formatted,
including calling out the critical tasks in the plan. After
all, a polished presentation, whether on-screen or in
print, is invaluable.
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Chapter 10
Fine-Tuning Your Plan

In This Chapter

Using filters to view timing and resource issues
Determining what’s driving your tasks

Using the Task Inspector pane

Utilizing warnings and suggestions to fix task schedules
Using Multiple Undo to try solutions
Controlling change highlighting

Adding slack to your tasks to plan for change
Making adjustments to shorten your schedule
Reigning in your costs

Resolving resource conflicts

Rescheduling the project

A s they say, the best-laid schemes of mice and project managers go oft
awry (or is that “gang aft agley?”), and your plans are no different. After
you take your best shot at laying out your project plan, creating every task,
and assigning every resource — and you think you're ready to start your
project — think again.

A close look at almost any plan will reveal some issues that you should
resolve before you begin working on your first task. These may include a
schedule that ends a month after your desired finish date, human resources
who are assigned to work 36-hour days, or a budget that exceeds the national
debt. (Details, details . . .)

But even if you don’t see any glaring problems in the areas of time, workload,
or money, you should do a few things to make sure that your project is as
realistic as possible before you commit to it. So take a moment to give your
project the once-over.
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Everything Filters to the Bottom Line

WMBER
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A first step in making sure that your plan is solid is simply looking at it from a
few different perspectives. It’s like walking around a car to see all its features
before you fork over the down payment. Filters help you get that kind of
perspective.

Two major problem areas that filters can help you examine at this stage are
v Overallocated resources: These are resources working more than the

number of hours you specified.

v~ Tasks on a critical path: A critical path consists of the series of tasks in
your project that must happen on time for the project to meet its final
finish date. (Chapter 11 shows you how to format the critical path in
Gantt Chart view.)

Any task that has slack — that is, any length of time that it could be
delayed without delaying the entire project’s timing — is not on the
critical path. If your project has little in the way of slack, any delays that
occur are likely to derail your project.

Predesigned filters

Filters are like the Zoom feature in your word processor: They give you a
closer look at various aspects of your plan and help you spot clues about
problems (such as overallocated resources). You can set a filter to high-
light tasks or resources that meet certain criteria or to remove any tasks or
resources from view that don’t meet such criteria.

Project provides predesigned filters that you can simply turn on for tasks or
resources, using criteria such as the following:

v~ Tasks with a cost greater than a specified amount

v Tasks on the critical path

v Tasks that occur within a certain date range

v Milestone tasks

1 Tasks that use resources in a resource group

v Tasks with overallocated resources
Several filters, such as Slipping Tasks and Overbudget Work, help you spot

problems after you've finalized your plan and are tracking actual progress.
(See Chapter 13 for more about tracking.)
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You can access filters in a couple of ways. When you use the Filter drop-
down list, you choose from a list of built-in filters. The filters act to remove
any tasks from view that don’t meet specified criteria.

To turn on such filters from the View tab of the Ribbon, follow these steps:

1. Display a resource view (such as Resource Sheet view) to filter for
resources or a task view (such as Gantt Chart view) to filter for tasks.

2. Click the Filter list in the Data group of the View tab and then choose
a criterion.

The Filter list is a drop-down list; when no filter is applied, All Tasks

or All Resources appears in the list. If you choose a filter that requires
input, you’ll see a dialog box such as the one shown in Figure 10-1.
Otherwise, the filter is applied immediately and removes from view any
resources or tasks that don’t match your criteria.

|
Figure 10-1:
Some filters | Date Range =
require you Show tasks that start or Finish after:
Man afzf10| -
to enter L)
parameters.
|

3. If a dialog box is displayed, fill in the information and then click the
OK button.

The filter is applied.

To redisplay all tasks or resources, click Filter on the View tab and then click
[No Filter].

Putting AutoFilter to work

Project 2010 has an AutoFilter feature that’s turned on by default for all new
schedule files. Arrows appear at the head of columns in the currently dis-
played sheet. Click the arrow for the Resource Names column (for example),
and the name of every resource assigned to tasks in your project is listed in
alphabetical order, along with other filtering and sorting choices. See Figure
10-2 for an example. In the AutoFilter list for a column, click check boxes to
control which items appear on-screen. Checked items appear, and unchecked
items are hidden by the filter. If you want to display few items, clear the
Select All check box first to deselect all the items and then click the check
boxes for the individual items to show to reselect them.
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Figure 10-2:
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the check
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hide it.
|

Figure 10-3:
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You can also choose the Filters choice from an AutoFilter menu to access
predefined filters or click Custom and create a custom filter. For example,
Figure 10-3 shows the predefined Is Greater Than filter that’s available for the
cost-related fields in the Cost table. In this case, the filter will show any task
with a Cost (Total Cost) greater than $5,000.

Customn AutoFilter =

Show rows where:

- -

Follow these steps to use AutoFilter:

1. Display the view and table that contain the fields (columns) you want
to filter.
Arrows appear at the top of each column.

2. Click the arrow on the column that you want to filter.
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3. Use either the list or the Filters submenu to select a filter.

To use the list, you can first deselect the Select All check box and then
click to reselect individual items to show. If you select Filters, you can
click a predefined filter. For example, if you are filtering for task dura-
tion, in the Duration column, you can choose 1 day or less, Between 1
Day and 1 Week, or 1 Week or Longer; or you can choose another of the
listed filters and then specify filter criteria. The Clear Filter from Field
Name choice removes a previously-applied filter.

4. Click the OK button.
All tasks or resources that don’t meet your criteria disappear.
If you want to apply a highlight to each item that meets your filter criteria

rather than remove nonmatching items from view, use the Highlight list in the
Data group of the View tab.

Do-it-yourself filters

You don’t have to use predesigned filters: You can get creative and design
your own filters. To define a new filter, you specify a field name, a test, and a
value.

For example, the following filters for any task on the critical path:
Critical (field name) Equals (test) Yes (value)

You can also include additional qualifiers to the filter. The following filters for
tasks that are both on the critical path and have a baseline cost of more than
$5,000:

Critical (field name) Equals (test) Yes (value)

and

Baseline Cost (field name) Is Greater Than (test) 5000 (value)

Here’s how to build your own filter definition:

1. Choose Viewr Filter~>More Filters.
The More Filters dialog box appears, as shown in Figure 10-4.

2. Select either the Task or Resource option to specify which list of filters
you want the new filter to be included in.

3. Click the New button.

The Filter Definition dialog box appears.
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4. In the Name field, type a name for the filter.

5. Click the first line of the Field Name column, and then click the down
arrow that appears to display the list of choices, as shown in Figure 10-5.

Click this arrow

Filter Definition in 'New Fitness Center Location Remodel Plan Location 1° ==
Mame: | High Cost Tasks
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1 . o
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Give your E]|
. Constraint Date - H
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. Cost Yariance -
whatit |, <%
does. Cost3 -
HelF o Cancel
| re

6. Click a field name to select it.
7. Repeat Steps 5 and 6 for the Test and Value(s) columns.

e Test is a condition that must be met, such as does not equal or is
greater than.

e Value(s) is either a value you enter (such as a specific date or
cost) or a predetermined value (such as baseline cost).

8. If you want to enter a qualifier, such as a dollar amount, click the

entry box above the column headings and then type the amount at the
end of the filter definition.

For example, if you choose Cost for the field name and Equals for the

test, you may enter the number 5000 at the end of the definition in the
entry box.
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9. If you want to add another condition, choose And or Or from the And/
Or column and then make choices for the next set of Field Name, Test,
and Value(s) boxes.

Note that you can cut and paste rows of settings you’ve made to rear-
range them in the list, or use the Copy Row or Delete Row button to per-
form those actions for filters with several lines of criteria.

10. If you want the new filter to be shown in the list when you click the
Filter list on the View tab, select the Show in Menu check box.

11. Click the Save button to save the new filter and then click Apply to

@ apply the filter to your plan.

A
You can click the Organizer button in the More Filters dialog box to copy fil-
ters you've created in one Project file to another file.

Gathering Info in Groups

Remember those groups you used to hang out with in high school? (I'm sure
you were part of the cool group!) Groups helped you see the underlying order
of your adolescent hierarchy. Project lets you group things, too. The Group
feature essentially allows you to organize information by certain criteria. For
example, you can use the Group feature if you want to see resources orga-
nized by work group, or you may organize tasks by their duration, shortest to
longest.

Organizing tasks or resources in this way may help you spot a potential
problem in your project: for example, if you find that the majority of your
resources at project startup are unskilled or that most of the tasks at the end
of your project are on the critical path. Like filters, groups come predefined,
or you can create custom groups. Groups have an outlining-like functionality
as well. You can collapse and expand groups to better zero in on the tasks or
resources you want to examine more closely.

Applying predefined groups
Predefined groups are quick and easy to apply and cover a host of common
requirements in projects. Follow these steps to apply a predefined group

structure to your project:

1. Display either a resource view (such as Resource Sheet view) to group
resources or a task view (such as Gantt Chart view) to group tasks.
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Figure 10-6:
Organizing
tasks to
show only
tasks in
progress
provides
this view of
your project.
|

2. On the View tab, click the Group By list in the Data group and then
choose a criterion.

The information is organized according to your selection. Figure 10-6
shows an example. In it, Resource Usage view has been grouped by
resource type, and assignments for some of the Work resources have
been collapsed.
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To redisplay all tasks or resources in their original order, click the arrow in
the Group list on the View tab to display the list and click [No Group]. (When
no group is applied, the Group box displays [No Group].)

Devising your own groups

Custom groups include three elements: a field name, a field type, and an
order. For example, you may create a group that shows the field name

(such as Baseline Work) and a field type (such as Tasks, Resources, or
Assignments) in a certain order (Descending or Ascending). A group that
shows Baseline Work for Tasks in Descending order, for example, would list
tasks in order from the most work hours required to the least. Other settings
you can make for groups control the format of the group’s appearance, such
as the font used or a font color applied.
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Follow these steps to create a custom group:

1. Choose Viewr>Group By-=>More Groups.

The More Groups dialog box appears, as shown in Figure 10-7.
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2. Select either Task or Resource to specify in which list of groups you
want the new group to be included.

3. Click the New button.

The Group Definition dialog box appears, as shown in Figure 10-8.
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4. In the Name field, type a name for the group.

5. Click the first line of the Field Name column, click the down arrow

that appears to display the list of choices, and then click a field name
to choose it.
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6.

10.

11.

Repeat Step 5 for the Field Type and Order columns.

Note that if you want the Field Type option of grouping by assign-
ment rather than by resource or task, you must first select the Group
Assignments, Not Tasks check box to make that field available to you.
Otherwise, the Field Type of Task or Resource appears by default.

. If you want to add another sorting criteria, click a Then By row and

make choices for the Field Name, Field Type, and Order columns.

. If you want the new group to be shown in the list when you click the

Group box on the Formatting toolbar, select the Show in Menu
check box.

. Depending on the field name you’ve chosen, you can make settings

for the font, cell background, and pattern to format your group.

For example, the font and color of each duration group heading back in
Figure 10-6 was determined by making choices from these three lists.

If you want to define intervals for the groups to be organized in, click
the Define Group Intervals button.

This displays the Define Group Intervals dialog box; use the settings
here to set a starting time and an interval. For example, if the Group By
criterion is Standard Rate and you select Interval as the Group On set-
ting and enter a Group Interval of 10.00, groupings would be in $10 inter-
vals (those making 0-$10 an hour in one grouping, those making $11-$20
in another, and so on).

Click the Save button to save the new group and then click Apply to
apply the group to your plan.

If you want to make changes to an existing predefined group, choose
Viewr>Group By=>More Groups. In the More Groups dialog box, make sure
that the group is selected and then click the Edit button. The Group Definition
dialog box then appears so that you can edit all those settings for an existing

group.

Figuring Out What's Driving Your Project

With all the things going on in a project — perhaps hundreds of tasks, thou-
sands of dependencies, calendars, and so on — it can be hard to see why
your project plan has turned out the way it has. Four features in Project 2010
can help you to see what’s driving your project and make those all-important
tweaks before you finalize your project plan:

v~ Task Inspector pane is a powerful feature that tells you what is driving

the timing of tasks in your project, as well as identifies problems and
suggests solutions.
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1 Task Warnings and Suggestions help you to identify possible schedule
issues with manually scheduled tasks.

v+ Multiple Undo allows you to try different approaches and then undo
several changes in a row.

1 Change Highlighting helps you see the results of any change you make
to your plan.

Inspecting tasks

When you play a game of golf, several factors affect your game. You may be
getting a cold, the weather could be bad, or you could have been handed a
defective club. (These are the reasons I give myself.) Likewise, the timing of
every task in your project is affected by certain conditions called task driv-
ers. The Task Inspector pane can help you recognize these conditions, which
could include the following:

v Actual Start Date or Assignments: You have entered an actual start
date, or you have made a resource assignment to a task and the
resource is not available.

v Calendars: You have assigned a different calendar to the task, resource,
or both, and the calendar differences are causing a scheduling issue.

v Leveling Delay: If you turned on leveling to deal with resource overallo-
cations, it may have caused a delay on a task.

v~ Constraints: You apply a constraint to a task, such as forcing it to finish
on a certain date.

v Summary Tasks: Summary tasks’ timing are driven by the timing of their
child tasks or subtasks.

+” Dependency Relationships: A predecessor task can cause changes in a
task’s timing.

Even though you specify start and finish dates for manually scheduled tasks,
you can use Task Inspector to check to ensure the task schedule you've
established works in conjunction with other tasks. Project performs behind-
the-scenes calculations to determine when each manually scheduled task

is likely to occur based on predecessors and how long it will take. If Project
detects that the task is likely to get off track, it gives a warning about the
potential problem and suggests a fix.

To display the Task Inspector pane, change to a task-oriented view such as
Gantt Chart view and simply click the Inspect Task button in the Schedule
group of the Task tab. The Task Inspector pane appears. Click the task that
you want to inspect, and the pane explains the various conditions driving the
selected task’s timing (see Figure 10-9). You can click another task to display
its drivers and details. If the Task Inspector pane includes schedule change
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Figure 10-9:
The Task
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options like the two shown in Figure 10-9, you can click the button for a fix to
apply it to the task. Click the Close button in the Task Inspector pane when
you're done.
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Handling task warnings and suggestions

When you work with autoscheduled tasks, Project can reschedule them for
you when you establish task dependencies. Because the start and finish dates
for manually scheduled tasks are “hard wired,” Project loses the very useful
ability to move them around when predecessor task schedules change. Even
though it can’t automatically move manually scheduled tasks, Project per-
forms calculations about when each manually scheduled task should occur
based on its links and other drivers. If Project finds that a potential schedul-
ing problem may occur with a manually scheduled task, it alerts you — even
when the Task Inspector pane isn’t open.

These alerts come in the form of warnings and suggestions. Warnings appear
as red wavy underlines, typically under the task finish date in the Finish
column of the task sheet. Suggestions usually appear as green wavy under-
lines, typically under the task start date in the Start column. While warn-
ings represent real problems that are likely to cause the project to finish off
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schedule, suggestions give you ideas for optimizing the schedule, perhaps
improving on your projected finish date.

Only schedule warnings appear by default. To view suggestions instead, click
the drop-down arrow for the Inspect Task button in the Schedule group of the
Task tab and then choose Show Suggestions.

If you've used Microsoft Word, these wavy underlines will look familiar, and
you work with them just as you do in Word. Right-click the cell with the wavy
underline to display a shortcut menu with options for addressing the potential
schedule problem at the top, as shown in Figure 10-10. If you want to apply a
schedule change option, click it on the shortcut menu. The available schedule
change options for warnings are different than those for suggestions, and they
will also vary depending on whether any overallocated resources are assigned
to the task. Here’s a rundown of the choices you may see:

1 Reschedule to Available Date: If an overallocated resource is assigned
to the task, this choice reschedules all or part of the task to a time frame
when the resource has availability to handle the work.

+* Respect Links: This warning fix moves the task based on the timing of
the predecessor task. In most cases, this fix moves the task later based
on the predecessor task’s schedule.

v Switch to Auto Schedule: This warning fix typically appears for manu-
ally scheduled summary tasks. It also appears as a suggestion fix for
subtasks. Choosing this schedule change causes the summary task to
recalculate based on the rollup values of its subtasks. For subtasks, the
switch typically means that the task can move earlier in the schedule,
potentially improving the schedule for any successor tasks, too.

v Fix in Task Inspector: Clicking this choice opens the Task Inspector
pane so that you can review the drivers and other scheduling factors for
the task before choosing a schedule change.

Task schedule warnings and suggestions typically do not appear unless
you’ve outlined the task list, creating summary tasks. Some of the warning and
schedule calculations are based on summary task information. That’s why it
remains a good practice to organize the schedule via outlining.

Undo, undo, undo

When Microsoft held a prerelease conference announcing new features in
Project 2007, it touted Multiple Undo as the most requested feature and
announced with glee that it had finally arrived.
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Why is this feature such a big deal? Individual changes to anything in your
project plan can have several effects. For that reason, undoing several
actions in a row was a major technology challenge. If you want to try dif-
ferent scenarios that involve several changes to your project, you used to
have to do an action and then undo it, then do the next action and undo it,
and so on. This is time consuming and doesn’t allow you to see cumulative
affects. Project 2010 continues to offer Multiple Undo so that you can try
several changes and then undo the whole list of changes or a portion of them
at once. Because you often want to try several changes when finalizing or
making adjustments to a project — for example, changing the timing of sev-
eral tasks or the hourly rates of several resources — Multiple Undo is very
handy.
<P You have to undo all your changes in order. For example, if you made five

changes and you want to undo the fourth change, you have to undo changes
one through four. To undo a change, click the down arrow of the Undo button
on the Quick Access toolbar and then choose the change you want to undo
(see Figure 10-11). That change and all others you performed subsequent to it
are undone.
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Figure 10-11:
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Highlighting changes

Another useful tool that you can use to see how changes you make to
fine-tune your project schedule have an impact on your project is Change
Highlighting. You can toggle this feature on and off by adding the Change
Highlighting button to a custom Ribbon tab and then clicking it as needed
on that tab. To customize the Ribbon, choose File=>Options. Click Customize
Ribbon in the list at the right side of the Project Options dialog box. Click
the New Tab button below the right list, and then use the Rename button to
rename the New Tab (Custom) and New Group (Custom) items in the list as
desired. Open the Choose Commands From list above the left list, and click
All Commands. Then, drag Change Highlighting from the list of All Commands
onto the custom group on your custom tab in the list at the right. Click the
OK button to apply the change.

You can right-click a custom group in the right list and click Remove to delete
it and its contents.
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With Change Highlighting on — the default setting — each time you take any
action to change your project’s schedule, a highlight appears on every task
that the change has had an impact on (see Figure 10-12).
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Change Highlighting shows you only the results of the last change you made
and works only on scheduling changes.

It’s About Time

We’ve all had this experience: Your boss asks you to commit to getting a
project finished by a certain date. Your palms sweat, you get a sick feeling in
the pit of your stomach, you add a week onto the finish target the boss sug-
gests to cover yourself, and then you promise to deliver the impossible. You
hope you can do it. You want to do it. But can you do it?

Project allows you to feel much more confident about committing to a time

frame because you can see how long all your tasks will take to complete.
Before you go to your boss and make any promises, make sure that you're
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comfortable with two things: the total time it takes to complete the project
and the critical path (the longest series of tasks that must be completed on
time for you to hit the overall project finish date).

The timing data for your project summary task tells you how long the entire
project will take. Just display Gantt Chart view and look at the Duration,
Start, and Finish columns. If your finish date doesn’t work, you’ll have to go
back and modify some tasks.

You should also make sure that you have room for error. You can use filters
and groups to identify the critical path in, for example, Gantt Chart view or
Network Diagram view. If you judge that too many tasks are on the critical
path, it’s wise to add some slack to the plan to allow for inevitable delays.

Giving yourself some slack

How many tasks should be on the critical path in your project, and how many
should have some slack — that is, some time that they could be delayed
without delaying the entire project? I wish I could give you a formula, but
sadly, it’s not a science. Ideally, every task in your project should have slack
because things can come up that you never expected, such as shortages of
vital materials, asteroid strikes, and management turnover that places you

in an entirely different department. If you add slack to every task, however,
your project is probably going to go on into the next millennium. Figure 10-13
shows a more typical scenario, with a mix of noncritical and critical tasks.
(Jump ahead to Chapter 11 if you want to see how to format the critical path
in Gantt Chart view.)

Some tasks have slack naturally because they occur during the life of a longer
task (or a task followed by some lag time) with which they share similar
dependencies. The shorter task could actually be delayed until the end of the
longer task without delaying the project.

Think about this example: You can start installing the plumbing and electrical
elements of a new office building as soon as the framing inspection is com-
plete. The plumbing takes two weeks, and the electrical work takes one week.
The next task, mechanical inspection, can’t happen until both the plumb-

ing and electrical tasks are finished. The shorter of the two (electrical) has

a week of slack because nothing else can happen until the dependent task,
plumbing, is finished. However, if electrical runs one week late, the electri-
cal task becomes critical. Figure 10-14 shows a similar example, where Prep
Work tasks can be finished days in advance of when ordered supplies will
arrive.
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These natural cases of slack occur in any project. In many cases, though, you
have to build in slack. Slack can be added in a few ways.

First, you can simply inflate task durations. Add two days to the duration

of all the tasks in your project, or go in and examine each task to figure out
the risk of delay and pad each duration accordingly. This method is a little
problematic, however, because when changes occur, you may have to go
into many tasks and adjust durations to deal with a schedule that’s ahead or
behind. You also have to keep track of exactly how much slack you built in to
each task.

The second method is to add lag time after a task. Then if the task runs long,
it’s less likely to bump the schedule of its successor tasks. The section called
“Adding the missing (dependency) link” in Chapter 6 includes a step that
shows you where to add lead or lag time for a task.

The final method of building in slack is the one I like best. You build one slack
task or several slack tasks that occur throughout your project — say, one at
the end of each phase of the project.

Now, there’s one must-do here, even if it seems obvious: Don’t call this task
Slack. Nobody in a position of responsibility would be caught dead approving
slack time for anybody. Give slack tasks appropriately respectable names that
reflect useful (but admittedly, somewhat generic) activities — say, Engineering
Analysis, Debriefing, or CYA Meeting. Then give the task a duration that pro-
vides breathing space for the other tasks in that phase. For example, at the
end of a two-month phase of designing a new product package, you may add a
task called Design Debriefing and make it one week long. (That way, if a sudden
mandate for design tweaks comes out of nowhere, you're covered.) Then
create a dependency between that task and the last “real” task in the phase.

I'm not talking dishonesty here — just reality. In the real world, slack is indis-
pensable, because the typical project takes longer and costs more than origi-
nally projected.

As things slide in your project (and they will, trust me), you’ll spot that slack
is being eaten up because the slack task is suddenly ending later than the
date you’d wanted the phase to end. You can change the duration of the
slack task, reflecting the fact that your slack is being used up. The duration
of that task will give you a good indication of how much more time you have
before the entire phase will go critical.

Doing it in less time
If you do your homework and add slack to tasks, you're making your plan

realistic, but the price you pay is that you're adding time (and hourly work
costs) to your project. What happens when your project finish date just
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won’t cut it with the powers-that-be? That’s when you have to try a few tac-
tics to chop your timing down to size.

Check your dependencies

The timing of your plan is determined, to a great extent, by the timing rela-
tionships you build among tasks, that is, by dependencies. So ask yourself,
Did I build all my dependencies in the best way I could? Perhaps you didn’t
start one task until another was finished, but you could actually start the
second task two days before the end of its predecessor. Building in that kind
of overlap can save you time.

Use the Task Inspector pane, covered in the earlier section of this chapter
“Inspecting tasks,” to help you scope out dependencies.

Here’s an example: You created a finish-to-start relationship for the Do
Research and Write Speech tasks, such that you could not start writing the
speech until your research was finished. But is that true? Couldn’t you do
a first draft of the speech starting three-fourths of the way through the
research? Especially when you have two different resources working on
those tasks, getting the second task going before the first is complete can
save you time.

Over the life of a project with hundreds of tasks, adding that kind of overlap
to even a few dozen tasks could save you a month of time or more!

You can take a refresher course in creating and changing dependencies in
Chapter 6.

We could use some help here!

Another factor that drives timing is the availability of resources. Sometimes
you set a dependency relationship where one task can’t start before another
is over simply because the resources aren’t available until the predecessor
task is over. Here are a few things to look for with resource-dependent timing:

v Maybe you delayed the start of a task because a resource wasn'’t avail-
able. But could some other resource do the work? If so, switch resources
and let the task start sooner.

v Project calculates the duration of some autoscheduled tasks (Fixed
Work and Fixed Units with effort-driven scheduling) according to the
number of resources available to do the work. If you add resources to
those tasks, Project shortens their duration.

v If you assign a more skilled resource to some tasks, you may be able
to reduce the hours of work required to complete the task because the
skilled person will finish the work more quickly.
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v Assigning more resources to tasks on the critical path can make those
tasks shorter, which would tend to make the overall project schedule
shorter.

v Could you hire an outside vendor to handle the work? If you have money
“@N\BER but no time or resources, that’s sometimes a viable option.
Y
B

Chapter 9 covers the mechanics of making and changing resource assignments.

Cut to the chase: Deleting some tasks and slashing slack

When all else fails, it’s time to cut some very specific corners. Can you skip
some tasks, such as that final quality check, the one that occurs after the
other three you already built in? Or should you pull back on some of the
slack you've allowed yourself? Can you revisit the project’s goals with stake-
holders and perhaps reduce the project’s scope so that you can jettison
tasks from the schedule?

QNNG/ . . e
Oy Never, I repeat, never get rid of all the slack in your schedule. Otherwise, it will
come back and haunt you like the Ghost of Christmas Past. Just tell your boss
[ said so.

Could you get some other project manager to handle some of your tasks for
you with different sets of resources? If your buddy has a project that involves
writing specs for a new product, could you convince him to also write the
user’s manual, which was your responsibility in designing product packag-
ing? It’s worth a shot.

Getting It for Less

After you assign all your resources to tasks and set all your fixed costs, it’s
time for sticker shock. Project will tally all those costs and show you the proj-
ect’s budget. But what if those numbers just won’t work? Here are some tips
for trimming that bottom line:

v Use cheaper resources. Do you have a high-priced engineer on a task
that could be performed by a junior engineer? Did you assign a high-
priced manager to supervise a task that could be handled by a lower-
priced line supervisor?

v Lower fixed costs. If you allowed for the travel costs associated with
four plant visits, could you manage with only three? Could you book
flights ahead of time and get cheaper airfares? Could you find a cheaper
vendor for that piece of equipment you allocated $4,000 to buy? Or
could you make do with the old equipment for just one more project?
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1 Cut down on the overtime. Are resources that earn overtime overal-
located? Try cutting down their hours or using resources on straight
salary for those 14-hour days.

v Do it in less time. Resource costs are a factor of task durations, hourly
wages, or number of units. If you change tasks so that fewer work hours
are required to complete them, they’ll cost less. However, don’t be unre-
alistic about the time it will really take to get the work done.

The Budget report calculates the total projected costs for the project based
on all the resource, assignment, and cost information you enter. Chapter 16
reports on Project reports.

Your Resource Recourse

Before you finalize your plan, you should consider one final area: resource
workload. As you went about assigning resources to tasks in your project,
you probably created some situations where resources are working around
the clock for days on end. It may look okay on paper, but in reality, it’s just
not going to work.

Your first step is to see how to spot those overallocations. Then you have to
give those poor folks some help!

Checking resource availability

To resolve issues with resource assignments, you have to first figure out
where the problems lie. You can do that by taking a look at a few views that
focus on resource assignments.

You can use some collaboration features of Project Web App to get resource
availability information online. See Chapters 18 and 19 for more about work-
ing with Project Web App.

Resource Usage view (shown in Figure 10-15) and Resource Graph view
(shown in Figure 10-16) are useful in helping you spot overbooked resources.
In Resource Usage view, the overbooked resource appears in red and an
exclamation mark indicator appears. In Resource Graph view, the graph bars
appear in red for any allocation over 100% units (or the units allowed for the
resource).
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First, keep in mind that resources are flagged as overallocated in these
Resource views based on their assignment percentage and calendars. A
resource based on a standard eight-hour-day calendar, assigned at 100
percent to a task, will work eight hours a day on it. If you assign that same
resource at 50 percent to another task that happens at the same time, the
resource will put in 12-hour days (8 plus 4) and be marked as overallocated.

In Resource Graph view, work is summarized in the Peak Units row at the
bottom, and all work in the part of the bar graphic that’s above the 100-
percent mark is highlighted. In Resource Usage view, any overallocated
resource has a yellow diamond with an exclamation point in the Indicator
column. The total hours that the resource is working each day on his or her
combined tasks are summarized on the line that lists the resource’s name.

Deleting or modifying a
resource assignment

So, you discover that poor Henrietta is working 42 hours on Tuesday and 83
hours on Friday. What to do?

You have a few options:

+” Remove Henrietta from a few tasks to free up some time.

1 Change Henrietta’s Resource calendar to allow for a longer workday,
for example, 12 hours. Keep in mind that this means a 100-percent
assignment will have Henrietta working 12 hours on any one task in a
day. If you stretch a resource’s workday, you should probably reduce
the resource’s assignments. For example, if someone frequently puts in
16 hours on two tasks in one day (based on an 8-hour calendar) and two
100-percent assignments, try changing to a 12-hour calendar and 50-
percent assignments (6 hours on each of the two tasks, totaling 12 hours
a day). However, if the person typically works an 8-hour day and 12- or
16-hour days are the exception, you shouldn’t change the resource’s
base calendar because that will have an effect on all assignments for
that resource. And if an overtime pay rate applies, don’t forget to autho-
rize (add) that overtime; see Chapter 13 for more about that!

The two previous options may lengthen the tasks that the resource is
assigned to, regardless of whether you remove the resource or reduce
the resource’s assignment.

1 Change Henrietta’s availability by upping her assignment units to
more than 100 percent in the Resource Information dialog box. For
example, if you enter 150% as her available units, you're saying that it’s
okay for her to work 12 hours a day, and Project will then consider her
fair game and not overallocated until she exceeds that 12 hours.
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1 Use Team Planner view to shuffle some of Henrietta’s tasks to other
resources. When you’re making the switch, Team Planner view gives you
the best visibility about how changes impact the various resources.

1~ Ignore the problem. I don’t mean this facetiously: Sometimes someone
working 14 hours for a day or two during the life of a project is accept-
able, and you don’t need to change the resource’s usual working allo-
cation to make that overwork indicator go away. (However, consider
telling Henrietta it’s okay to order pizza on the company on those long
workdays — and make sure that you don’t let them become the norm.)
And if a resource is scheduled for even a few minutes more than her
calendar allows, it will be flagged as overallocated. It is not worth your
effort as project manager to attempt to resolve tiny overallocations that
will not impact the project schedule in a meaningful way.

Ouick and dirty rescheduling
to beat overallocations

Gantt Chart view also clues you in about overbooked resources. When a task
has an overallocated resource assigned, an overallocation icon that looks like
a little person appears in the Indicator column. To fix the overallocation, you
can right-click the icon and choose Reschedule to Available Date, as shown in
Figure 10-17. This method reschedules all or part of the task to a period when
the resource has availability to fix the overallocation, if possible. You can
always undo the change if you disagree with its impact on the overall project
schedule. This method can'’t fix all overallocations, so if the icon remains
after you choose Reschedule to Available Date, you'll need to look at other
methods to resolve the problem. Right-clicking the icon again and choosing
Fix in Task Inspector enables the Task Inspector to give you ideas for fixing
the overallocation.

Getting some help

When one person is overworked, it’s time to look for help. You can free
resources in several ways.

For starters, you can assign someone to help on a task and thus reduce the
overbooked resource assignment now that he or she is not needed for as
many hours. Reduce the resource’s work assignment on one or more tasks —
say, reducing 100-percent assignments to 50 percent. You do this in the Task
Information dialog box on the Resources tab, as shown in Figure 10-18, or by
selecting the task and clicking the Assign Resources tool to open the Assign
Resources dialog box.
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You'll also find that by adding resources to some tasks, you’ll shorten the
task duration. That means you may free your resource in time to eliminate a
conflict with a later task in the project.

Try changing the work contour for the resource. By default, Project has a
resource work on a task at the same level for the life of the task. You can
modify the work contour, for example, so that a resource puts in the most
effort at the start of a task, which frees the resource’s workload later when a
conflict with another assignment might occur. See Chapter 9 for information
about how to apply a work contour to a resource assignment.

Getting your resources level

Resource leveling sounds something like the St. Valentine’s Day massacre, but
it’s not. It’s a calculation that Project goes through to try to resolve resource
overallocation in your project. The feature works in two ways: by delaying

a task until the overbooked resource frees up or by splitting tasks. Splitting

a task involves (essentially) stopping it at some point, thereby freeing the
resource, and then resuming it at a later time when the resource is available.

You can make such changes yourself or let Project do the calculation. Project
will first delay tasks that involve overallocated resources to use up any avail-
able slack. When no more slack is available on these tasks, Project makes
changes based on any priorities you've entered for tasks, dependency rela-
tionships that are affected, and task constraints (such as a Finish No Later
Than constraint).

But don’t worry: You can turn on leveling to see what changes Project would
make and then clear the leveling to reverse those actions if you don’t like the
results.

To level the resources in your project, follow these steps:

1. Choose Resourcer>Leveling Options.
The Resource Leveling dialog box appears, as shown in Figure 10-19.

2. Make a choice between allowing Project to do automatic or manual
leveling:

e Automatic tells Project to level every time you change your plan.

® Manual requires that you go to the Resource Leveling dialog box
and click the Level All button or use the Level All button on the
Resource tab.

3. If you choose to level automatically, be sure to select the Clear
Leveling Values before Leveling check box, if you want previous level-
ing actions to be reversed before you level the next time.
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4. Set the leveling range to one of the following:

e Level Entire Project.

e Level <a date range>. Then fill in a date range by making choices in

the From and To boxes.

5. From the Leveling Order drop-down list, click the down arrow and

make a choice:

e Standard considers slack, dependencies, priorities, and

constraints.

¢ ID Only delays or splits the task with the highest ID number, in

other words, the last task in the project.

e Priority, Standard uses task priority as the first criterion in making
choices to delay or split tasks (rather than using up slack).
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6. Select any of the five check boxes at the bottom to control how Project
will level:

¢ Level only within available slack: No critical tasks are delayed, and
your current finish date for the project is retained.

¢ Leveling can adjust individual assignments on a task: This allows
Project to remove or change assignments.

® Leveling can create splits in the remaining work: This can put some
tasks on hold for a period of time until resources are freed up for
work.

e Level resources with the proposed booking type: Booking type (pro-
posed or committed) relates to how firm you are in using that
particular resource. Allowing resource leveling to consider a
resource’s booking type means that committed resource assign-
ments are considered more sacred when Project goes about
making changes than proposed assignments.

e Level manually scheduled tasks: This allows Project to move the
task even if you've scheduled it manually.

7. Click the Level All button to have Project perform the leveling
<® operation.

To reverse leveling, choose Resource=>Clear Leveling.

To level or not to level?

This setting may delay some tasks, but it won't
delay your project completion date.

As both a process and a program feature,
resource leveling has pros and cons. It can
make changes that you may not want it to
make — for example, taking a resource off a
task where you absolutely need that person’s
unique skills. It frequently delays your project’s
finish date, which may not be acceptable to you
(or your boss).

If you just can't live with everything Resource
Leveling did, the capability to turn Resource
Leveling on and off is your best ally. You can
turn the feature on and look at the things it did
to resolve resource problems, and then turn it
off and manually institute the portions of the

The safest setting for Resource Leveling— that
is, the one that makes the least drastic changes
to your timing — is to level only within slack.

solution that work for you. Also remember that
the Multiple Undo feature allows you to make
several changes manually and undo them to get
back to where you started.

www.it-ebooks.info



http://www.it-ebooks.info/

226 Part lll: Well, It Looks Good on Paper...

Rescheduling the Project

Figure 10-20:
You can
reschedule
an entire
project that
was put on
hold.

From time to time, you really have to hit the brakes on a project. This happens
when you set up an entire project plan, and just as you're ready to get rolling,
the project is put on hold. It may be due to lack of budget, changing priorities,
having resources pulled to another project, or cold feet on the part of stake-
holders. It happens, but it also happens that projects have a way of coming
back to life. The good news for you is that if the essential facts of the project,
such as its scope and the resources you can use, haven’t changed, you can just
reschedule the entire project to start from a later date rather than rebuilding
the plan from scratch. This process reschedules both autoscheduled and man-
ually scheduled tasks, so you don’t even have to use your thinking cap.

To reschedule your project, follow these steps:

1. Choose Project=>Move Project.

The Move Project dialog box appears, as shown in Figure 10-20.

Move Project ==
Original project start date:  Tue 2/1§11
Mew project start dake: | Mon 47411 -
/| Move deadlines

Help Cancel

2. Enter the new project start date in the New Project Start Date box, or
choose a date from the drop-down calendar.

3. Deselect the Move Deadlines check box if you want Project to skip
moving any deadlines that are assigned to tasks.

4. Click the OK button.

Mixing Solutions Up

One final word about all the solutions suggested in this chapter to deal with
time, cost, and overallocation problems: To be most successful, you’ll prob-
ably have to use a combination of all these methods. Solving these problems is
often a trial-and-error process. Although you may initially look for one quick fix
(who doesn’t?), in reality, the best solution may come through making a dozen
small changes. Take the time to find the best combination for your project.
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Chapter 11

Making Your Project Look Good

In This Chapter

Showing the critical path in Gantt Chart view

Changing the look of task bars

Giving your Gantt chart a new style
Formatting Network Diagram task boxes
Modifying the layout of a view

Changing the gridlines in a view

Adding graphics to your project

A n old chestnut would have you believe that clothes make the man. Well,
in the same spirit, sometimes the look of your schedule makes the proj-
ect. Having a project that looks good serves two purposes. One, it impresses
people with your professionalism (sometimes to the point where they’ll over-
look a little cost overrun); second, it allows people looking at your project
both on-screen and on hard copy to easily discern what the different boxes,
bars, and lines indicate.

Project uses default formatting that’s pretty good in most cases. However, if
you have certain company standards for reporting — say, representing base-
line data in yellow and actual data in blue, or more frequent gridlines to help
your nearsighted CEO read Project reports more easily — Project has you
covered.

Whatever you need, Project provides tremendous flexibility in formatting
various elements in your plan.
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Putting Your Best Foot Forward

Microsoft has decided to capitulate to the artist in all of us by allowing you to
modify shapes, colors, patterns, and other graphic elements in your Project
plans. This gives you great flexibility in determining how your plan looks.

When you print Project views (covered in Chapter 16), you can print a legend
on every page. The legend helps those reading the plan understand the mean-
ing of the various colors and shapes that you set for elements.

One important thing to realize is that all the views and formatting choices
that Project offers you aren’t confined to the screen. You can print your proj-
ect or reports. What displays on-screen when you print a view is what will
print. So, knowing how to make all kinds of changes to what’s on your screen
allows you to present information to team members, managers, vendors, and
clients in hard copy too.

With all the improved methods of collaborating on projects, such as sharing
documents via Project Web App, a visually appealing schedule can be seen by
even more people across the Web.

Printing in color is useful because you can provide the full visual impact and
nuance of the various colors used for graphic elements (such as task bars
and indicators). If you print in black and white, you may find that certain
colors that look good on-screen aren'’t as distinct when you print. Being able
to modify formatting allows your project to look good in both color and black
and white, both on-screen and in print.

Getting to the Critical Stuff

The home-base view, Gantt Chart, doesn’t show the critical path by default.
All the subtask task bars appear blue, no matter what the specifics are sur-
rounding the task. To give the critical path visibility, you can have the bars
for critical paths appear in a nice, dark red. For example, in Figure 11-1, the
tasks in the Planning summary group and most of the tasks in the Lay Pavers
group are critical tasks, and they appear in red with the critical path
highlighted.

Displaying the critical path is a snap. Simply click the Gantt Chart Tools
Format contextual tab on the Ribbon, and then select the Critical Tasks check
box in the Bar Styles group. Whenever Critical Tasks is checked, Project
applies the special color to the critical task bars.
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Formatting Task Bars

Task bars are the horizontal boxes that represent the timing of a task in the
chart pane of Gantt Chart view. You can format each bar individually, change
formatting settings for different types of task bars, or apply a new style that
controls bar formatting for the entire chart.

You can change several things about task bars:

v The shape that appears at the start and end of the bar. You can change
the shape’s type and color. Each end can be formatted differently.

1+ The shape, pattern, and color of the middle of the bar.

v+~ The text that you can set to appear in five locations around the bar:
left, right, above, below, or inside the bar. You can include text in any
or all of these locations, but keep in mind that too many text items can
quickly become impossible to read. As a rule, use just enough text to
help readers of your plan identify information, especially on printouts
of large schedules where a task may appear far to the right of the Task
Name column that identifies it by name in the sheet area.
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NG/
$

Figure 11-2:
You can
modify the
look of task
bars and the
text you dis-
play along
with them.
|

When you track progress on a task, a progress bar is superimposed on the
task bar. You can format the shape, pattern, and color of the progress bar.
The goal is to contrast the progress bar with the baseline task bar so that
you can see both clearly.

By formatting task bars, you can help readers of your plan identify various ele-
ments, such as progress or milestones. If you make changes to individual task
bars, people who are accustomed to Project’s standard formatting may have
trouble reading your plan.

To create formatting settings for various types of task bars, follow these steps:

1. Right-click the chart area outside any single task bar and then choose
Bar Styles.

The Bar Styles dialog box appears, as shown in Figure 11-2.

Bar Styles ==
‘ [ cuthow | | pasterow | [ mnsertRow
Task -
Hame Appearance Show Far . Tasks Row Fram To
Tz Horrmal Active,Not Manually Schedule:  1iTask Start Task Finish
3pl .+ Mormal Split Active Not Manually Sche 1 Task Start Task Finish
Wil estone il estane Active,Not Group By Summal  1iTask Finish Task Finish
Summary o & summary Active Mot Manually Schedu! 1iTask Start Task Finish
Project Summary O " iproject Summary 1iTask Start Task Finish
*Group By Summary (3 Grup By Summary 1:Task Start Task Finish
*Rolled Up Task g d marmal,Rolled Up, Mot Summary,Not Mi 1 Task Start Task Finish
*RolledUp Split 1l Mormal,Rolled Up,$plitMot Summary 1iTask Start Task Finish
*Rolled Up Progress | S=——————=== ‘Normal Rolled Up,Not Surnmary 1iTask Start CompleteThrough
#Rolled Up Milestone <2 Milestone olled Up,Mot Summary 1Task Finish Task Finish
External Tasks e External Tasks,Not Wilestone 1 Task Start Task Finish
External Milestone i il estone, External Tasks 1iTask Finish Task Finish Z
« »
Text | Bars
Start Middle End
Shape: - Shape: ] - Shape: -
Type: - Pattern: ) ~ Type: -
coor: [ - o S - oo I -
Help Cancel

2. In the spreadsheet, along the top in the Name column, click the type
of task that you want to modify (Split, Progress, Milestone, and so on).

For example, if you want to modify the styles used for all summary tasks,
click Summary. The choices in the Bars tab in the bottom half of the
dialog box change based on the task type that you click.

3. Click in the Show for . . . Tasks column for the task type you want to
modify, and then select criteria for the task from the drop-down list
that appears, such as Critical or Finished.
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4. Click the Bars tab to display it, if necessary, and then do the following:

a. Click any of the Shape lists to modify the shape of either end or the
middle of the task bar.

Shapes on either end may be an arrow, a diamond, or a circle. The
shape in the middle consists of a bar of a certain width.

b. Click any of the Color lists to modify the color used on either end or
in the middle of the task bar.

Project now enables you to choose from various Theme Colors as
in the other Office applications.

c. Click either of the Type lists to modify the type of formatting for the
shape on either end of the task bar.

This setting controls how such a shape is outlined: framed with
a solid line, surrounded by a dashed line, or filled in with a solid
color.

d. Click the Pattern list to select another pattern for the middle of
the bar.

5. Click the Text tab (as shown in Figure 11-3), and then do the following:
a. Click any of the text locations.
An arrow appears at the end of that line.

b. Click the arrow to display an alphabetical list of possible data that
you can include, and then click a field name to select it.

¢. Repeat Steps 6a and 6b to choose additional text locations.

6. Click the OK button to accept all new task bar settings.
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3

If you want to make the same types of changes to an individual task bar
rather than to all task bars of a certain type, right-click the task bar and then
choose Format Bar. The Format Bar dialog box appears, offering the same
Text and Bars tabs found in the Bar Styles dialog box, without the options at
the top to select the type of item to format.

On the Gantt Chart Tools Format contextual tab, you can click the Format
button in the Bar Styles group to find commands for formatting individual bars
and bar styles.

Restyling Vour Gantt Chart

Figure 11-4:
Project 2010
offers
overall
Gantt Chart
styles.

Are the boring old red and blue Gantt bars cramping your style? Not to
worry; you can try a new look, including a different color scheme and differ-
ing bar styles, by applying a new Gantt Chart style. Working in Gantt Chart
view, just click the Gantt Chart Tools Format contextual tab. Then click the
More drop-down button in the Gantt Chart Style group to display the avail-
able styles (see Figure 11-4). Click the style that you want, and Project refor-
mats the whole project. It doesn’t get much simpler!
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<P Folks often want to format the sheet portion of Gantt Chart view, too. After
you select the cells to format, you can use some choices on the Gantt Chart
Tools Format contextual tab to apply changes. For example, you can click Text
Styles in the Format group to open a dialog box for changing text font, size,
and more. Or, you can use the Wrap Text button in the Columns group to con-
trol whether or not text automatically wraps in a particular cell or column.

Formatting Task Boxes

Network Diagram task boxes use different shapes to help you spot different
types of tasks:

1 Summary tasks use a slightly slanted box shape and include a plus or
minus symbol, depending on whether the summary task’s subtasks are
hidden or displayed. Click the symbol to hide or display subtasks.

v Subtasks show up in simple rectangular boxes.
1 Milestones are shown in diamond-shaped boxes with blue shading.
1+ Manually scheduled tasks have a diagonal pattern to distinguish them

from autoscheduled tasks.

You can change the formatting of each task box individually or by type. To
change the formatting of task boxes displayed in Network Diagram view,
follow these steps:

1. Display Network Diagram view.

2. Right-click the task box that you want to change and then choose
Format Box. Alternatively, right-click anywhere outside the task boxes
and then choose Box Styles to change the formatting for all boxes of a
certain style.

The Format Box or Box Styles dialog box appears (as shown in Figure 11-5).

3. To modify the border style, make your selection in the Shape, Color,
and Width lists.

4. To modify the background area inside the box, make a selection in
the Color list, Pattern list, or both (at the bottom of the dialog box).

5. Click the OK button to save your new settings.

QNING/ When you modify the formatting of individual boxes in Network Diagram view,
R the standard settings of slanted summary tasks and shaded milestones no
longer serve as a visual guide to all tasks. If you make changes and decide that
you’d like to put a task box back to its default setting, click the Reset button in
the Format Box dialog box.
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Adjusting the Layout

Figure 11-6:
The Layout
dialog box
for Calendar
view.
|

In addition to displaying particular columns and formatting task bars, you
can make certain changes to the layout of your view. These options vary
a great deal, depending on what view you’re working with. The layout of
Calendar and Network Diagram views is quite different than the layout
choices offered in Gantt Chart view, for example.

To display the Layout dialog box for a view, right-click the area (for example,
the chart area of the Gantt Chart view) or anywhere in Calendar view or
Network Diagram view, and then choose Layout from the menu that appears.
The appropriate dialog box appears. Figures 11-6, 11-7, and 11-8 show the
various layout choices available in the different views.

Layout

Method

@) Use current sort order

1D [Ascending] -

) Akkemnpt to fit as many tasks as possible

Show bar splits
[ aukamatic layout
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In general, the settings in these Layout dialog boxes deal with how the
elements on the page are arranged and how dependency link lines are
displayed.

Table 11-1 shows you the layout settings. You could probably spend a week
toying with all of these settings to see what they look like, and I could spend
a few days writing about the various options. The tools that Project offers to
modify the formatting of elements such as task bars and task boxes provide
wonderful flexibility.
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Table 11-1 Layout Options
Layout Type Option Use
Calendar Use Current Sort Project uses the latest sort order you've
view Order applied to tasks.
Attempt to Fit as Ignores the sort order and fits as many
Many Tasks as tasks in a date box as possible.
Possible
Show Bar Splits When a task includes a period of inactiv-
ity, that task can be shown as being split
into different parts over time.
Automatic Layout Project modifies the layout in response to
the insertion of additional tasks.
Network Layout Mode area Allows automatic or manual positioning.
Diagram Box Layout area The settings in this section arrange and
view align boxes, adjusting alignment, spac-
ing, and height, and also modify how
summary tasks are displayed.
Link Style area Modifies the style for dependency link
lines and labels.
Link Color area Sets the color for links both on and off
the critical path.
Diagram Options Controls the background color and
area pattern for boxes as well as how page
breaks and progress on tasks are
indicated.
Gantt Chart Links Style of lines indicating dependency
view links.

Date Format

Modifies the format of the date used to
label task bars.

Bar Height Sets the height of task bars in points.
Always Roll Up When selected, task bar details roll up to
Gantt Bars the highest-level summary task.

Round Bars to When you have portions of days, allows
Whole Days bars to represent the nearest whole-day

increment.

Show Bar Splits

When a task includes a period of inactiv-
ity, that task can be shown as splitinto
different parts over time.

Show Drawings

When you include drawings, they are
displayed on-screen and in the printout.
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Now that you’'ve seen the many options available for modifying view layouts,
I have some advice: Stick with the default settings unless you have a specific
reason to make a change (such as when you want to highlight certain types
of information for a project presentation). When you don’t need that layout
change anymore, go right back to the default settings. Or, if you want to make
changes, make them globally across your organization and stick to them.
That makes it much easier for those reading your project plan to interpret
the different kinds of information presented in views. Generally speaking, if
you tinker too often with the way that Project displays information, it just
makes your own learning curve steeper — and confuses those who know
Project’s default settings.

Modifying Gridlines

Just as phone numbers are broken up into several shorter sets of numbers
to help you remember them, visual elements are often broken up to help you
understand information in chunks. Tables use lines, calendars use boxes,
football fields use yard lines, and so on.

Several views in Project include gridlines to indicate certain things, such

as the break between weeks or the status date (that is, the date as of which
progress has been tracked on a project). These lines help the reader of your
plan discern intervals of time or breaks in information; for example, gridlines
can be used to indicate major and minor column breaks. You can modify
these gridlines in several ways, including changing the color and style of the
lines and the interval at which they appear.

To modify gridlines, use the Gridlines dialog box, as follows:

1. Right-click any area of a view that contains a grid (for example, the
chart area of Gantt Chart view or Calendar view) and then choose
Gridlines.

The Gridlines dialog box appears, as shown in Figure 11-9. Note that
you also can display the Gantt Chart Tools Format contextual tab, click
Gridlines in the Format group, and then click Gridlines to open the
dialog box.

2. In the Line to Change list, click the gridline that you want to modify.

3. Use the Normal Type and Color lists to select a line style and color.
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4. If you want to use a contrasting color at various intervals in the grid to
make it easier to read, do the following:
a. Select an interval at which to include a contrasting line.
This setting is typically used with a different style or color from
the Normal line setting to mark minor intervals for a grid. Note that
not all types of gridlines can use contrasting intervals.
b. Choose the type and color of that line from the lists.
5. Click the OK button to save your settings.
MBER . e -
é‘}“ You make choices for modifying gridlines one by one, and you have no Reset

button to put these settings back the way they were. Also note that gridlines
modified in one view don’t affect gridlines in any other view.

When a Picture Can Say It All

Words and numbers and task bars and task boxes are fine, but what if you
want to add something of your own? For example, you may want to draw
attention to a task by drawing a circle around it, or you may want to include a
simple drawing to show a process or working relationship in your plan.

You can use a drawing tool on the Gantt Chart Tools Format contextual tab of
the Ribbon to draw images in the chart area of Gantt Chart view. Follow these
steps to add a drawing:

1. Display Gantt Chart view.
2. Choose Gantt Chart Tools Format=>Drawing.

The menu of available shapes and commands appears, as shown in
Figure 11-10.

3. Click the drawing tool that represents the type of object you want to
draw, such as an oval or a rectangle.
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4. At the location on the chart where you want to draw the object, drag
your mouse until the item is drawn approximately to the scale you want.

5. Release the mouse button.

When you draw an object over an element such as a task bar, the drawn
object is solid white and covers up what’s beneath it. You have a couple of
choices if you want the item underneath to show through:

v Right-click the object, choose Properties, and click None under Fill in the

Format Drawing dialog box to remove the fill.

v Right-click the object, choose Arrange, and choose Send to Back to

move the object behind the chart elements.

At this point, you have a few options:

v Add text: If you drew a text box, you can click in it and then type what-

ever text you like.

1 Resize objects: Resize any object you've drawn by selecting it and then
dragging any of the resize handles (little black boxes) around its edges

outward to enlarge it or inward to shrink it.

v Move objects: Move the mouse over the object until the mouse pointer
becomes a four-way arrow. Then drag the object elsewhere on the chart.
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Part IV

Avoiding Disaster:
Staying on Track

T_he 5th Wave By Rich Tennant

BRATENNANT

David to come in out of the
hall. T found a way to adjust our
project budget estimate.”
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In this part . . .

nd behold, Murphy decreed: No project shall hap-

pen the way you thought it would. To head off proj-
ect manager’s frustration, this part shows you how to
save a baseline picture of your project and how to use it
as you track the ongoing struggle between actual activity
and your ideal plan. You get a look at tracking and report-
ing progress, see how to update the plan, pick up tips on
how to get back on track if the project goes off the rails,
and try out handy tools for using past data to make better
future project plans.
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Chapter 12
It All Begins with a Baseline

In This Chapter
Saving plan information with a baseline
Making use of multiple baselines
Setting a baseline

Saving interim plans

then you go on a diet (and I know you all have at one time or
another!), you step on the scale the first day to check your weight.
Then, as your diet progresses, you have a benchmark against which you can
compare your dieting ups and downs.

Project doesn’t have a weight problem, but it does have a method of bench-
marking your project data so that you can compare the actual activity that
takes place on your tasks against your original plan. This saved version of
your plan data is called a baseline, and it includes all the information in your
project, such as task timing, resource assignments, and costs.

Project also provides something called an interim plan, which is essentially a
timing checklist. It includes only the actual start and finish dates of tasks as
well as the estimated start and finish dates for tasks not yet started.

This chapter shows you when, why, and how to save a baseline and interim
plan for your project.

All about Baselines

Saving a baseline is like freezing a mosquito in amber: It’s a permanent
record of your estimates of time, money, and resource workload for your
project at the moment when you consider your plan final and before you
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begin any activity. A baseline is saved in your original Project file and exists
right alongside any actual activity that you record on your tasks.

You can use baselines to debrief yourself or your team at any point in a
project. This is especially useful at the end of a project, when you can com-
pare what really happened against your best guesses of those many weeks,
months, or even years ago. You can then become a much better user of
Project, making more accurate estimates up front. You can also use a base-
line and the actual activity that you track against it to explain delays or cost
overruns to employers or clients by using a wide variety of reports and
printed views.

Finally, you can also save and clear baselines for only selected tasks. So, if
one task is thrown way off track by a major change, you can modify your
estimates for it and leave the rest of your baseline alone. Why throw out the
baby with the bathwater?

What does a baseline look like?

Behind the scenes, some of the key data the baseline captures are baseline
start, finish, duration, work, and cost information for each task. After you
save a baseline and track some actual activity against it, you get baseline and
actual sets of data as well as visual indications of actual data.

Figure 12-1 shows Gantt Chart view for a project that displays a check mark
in the indicators column for every task marked as complete. The task bar for
the task with completed work displays a black progress bar along the middle
to illustrate the completion percentage. In the sheet area, you can display
the Variance table, with columns of data to compare baseline estimates and
actual activity, for example, baseline finish and actual finish.

Figure 12-2 shows Tracking Gantt view. This view is a little more complex. It
presents data for each task as a pair of task bars, as follows:

v Thin gray bar: This shows the baseline schedule for the task.

v+~ Upper solid bar: This shows the actual schedule for completed tasks.

v+ Upper shaded bar: This indicates the current schedule for any task that
is partially complete or hasn’t started.

1 Completion percentage: The marked or calculated completion percent-
age appears beside each task, as well as summary task bars.
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Figure 12-3:
This dia-

log box is
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baselines
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plans.
|

You can change how different graphic elements are represented by reformat-
ting. See Chapter 11 for more about formatting task bars and task boxes.

How do | save a baseline?

You can save a baseline at any time by displaying the Set Baseline dialog box.
One setting here — how Project rolls up data to summary tasks when you set
a baseline for part of the tasks — requires a little explanation.

By default, after you save a baseline the first time, a summary task’s baseline
data is updated if you make changes to a subtask below it, such as chang-
ing the schedule for or deleting a subtask. However, when you are saving
the baseline for only a selection of tasks, you can change that functionality
by making a choice about how the baseline rolls up data. You can choose to
have modifications rolled up to all summary tasks or only from subtasks for
any summary tasks that you select. This second option works only if you've
selected summary tasks but not selected their subtasks.

You can save a baseline by following these steps:
1. To save a baseline for only certain tasks, select them by dragging over
their task ID (row) numbers.
2. Choose Project=>Set Baseliner>Set Baseline.

The Set Baseline dialog box appears with the Set Baseline option
selected, as shown in Figure 12-3.

3. Select the Entire Project or the Selected Tasks radio button.

Baseling -
Set inkerim plan
Scheduled Start/Finish
Start 1 Finish1
For:
@ Entire project
Selected tasks
Roll up baselines:
Tor all surmmary tasks
Erom subtasks into selected summary task(s)

Set as Default

‘ Help QK ]l Cancel |
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Figure 12-4:
Each
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something
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last saved
date in this
list.
|

4. If you chose Selected Tasks in Step 3, make selections for how the
baseline rolls up, or summarizes, changes to task data.

You can have changed data summarized in all summary tasks or only for
the summary tasks that you select.

5. Click the OK button to set the baseline.

What if ] want more than one baseline?

[ know you love to hear about features in Project 2010 that you may never
take full advantage of. (Who doesn’t?) Here’s one: You can save your base-
line up to 11 times during the life of your project. That’s 11 potentially cata-
strophic events you can adjust for by resaving your baseline!

Although you may never use all 11 possible baselines, the ability to save mul-
tiple baselines can help you see the progress of your planning over the life

of a longer project. They are also a sneaky but effective way of showing your
boss that, yes, you really did anticipate that budget overrun, even though
you didn’t include it in your original saved plan. (I'm not advocating this, but
it works as long as your boss didn’t keep a copy of the original plan.) Just
keep in mind that the more baselines you save, the larger your Project file
becomes, and that can slow down performance.

The Set Baseline dialog box includes a list of these baselines, with the last
date each was saved, as shown in Figure 12-4. When you save a baseline, you
can save without overwriting an existing baseline by simply selecting another
one of the baselines in this list before saving.

Set Baseline

@) Set baseline

Baseline {last saved on Tue 10/6/09) -

d on Tue 10/6/09)

et Inker Rl
Baseline 1
Baseline 2
Baseline 3
Baseline 4
Baseline 5
Baseline &

For:
@ Entir

Eeel Baseline 7

Roll Baseline &
Baseling 9

Baseline 10
T S I e e ST s

Set as Default

‘ Help [s]4 ] | Cancel
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WING/

If you save multiple baselines or interim plans, you can view them by display-
ing columns in any sheet view for those plans. For example, if you want to
display information for a baseline you saved with the name Baseline 7, you
would insert the column named Baseline 7 in your Gantt Chart view sheet.

You can view multiple baselines at one time by displaying Multiple Baselines
Gantt view.

When calculating variances (whether the schedule is early or late or costs are
over or under), Project only uses the first baseline (the one named Baseline,
not Baselinel) saved. So, if the project schedule and other parameters change
dramatically, as when a project is put on hold and later revived, you will get
more valid variance data by clearing and resetting the baseline, as I describe
next.

How do | clear and reset a baseline?

Okay, if you read the first part of this chapter, you know that I said that a
baseline is intended to be a frozen picture of your project plan that you keep
sacrosanct and never change. Well, that’s the theory. In practice, things can
happen that make an original baseline so obsolete that it’s less than useful.
It’s not even worth keeping as one of your 11 possible baselines.

For example, if you have a project that takes four years from beginning to
end, you may want to save a new baseline every year because costs go up or
resources change. Then you can see incremental versions of your estimates
that reflect the changes you made based on changes in the real world.

In contrast, consider that you start your project with a wonderful, well-
thought-out baseline plan, but a week later, the entire industry shuts down
with a massive strike that goes on for three months. All your original esti-
mates of timing would be bogus, so it’s better to make adjustments to your
plan, save a new baseline, and move ahead after the strike is resolved.

To clear an existing baseline, follow these steps:

1. To clear the baseline for only certain tasks, select them.
2. Choose Project>Set Baseline~>Clear Baseline.

The Clear Baseline dialog box appears with the Clear Baseline Plan
option selected by default, as shown in Figure 12-5.

3. From the Clear Baseline Plan drop-down list, choose the baseline that
you want to clear.
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Figure 12-5:
Use this to
clear the
baseline or
interim plan.
|
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Clear interim plan Start1Finishl

For (@) Entire project Selected tasks

- Cancel

4. Select either the Entire Project radio button to clear the baseline for
the entire project or the Selected Tasks radio button for selected tasks.

5. Click the OK button.

The project baseline or selected tasks are cleared.

In the Interim

An interim plan is sort of like Baseline Lite. With an interim plan, you save
only the actual start and finish dates of tasks that have had activity tracked
on them as well as the baseline start and finish dates for all unstarted tasks.

Why save an interim plan rather than a baseline? An interim plan saves

only timing information. If that’s all you need, why save all the data about
resource assignments and costs and so on? (Keep in mind that you’ll end up
with a huge file if you save a large number of baselines.)

Another issue with a baseline is that because there’s so much data, the base-
line can become obsolete at some point. An interim plan can be saved to
record date changes but not overwrite your original baseline cost data.

Finally, although you’re allowed to save up to 11 baseline plans, if you need
more than that, consider using some interim and some baseline data to
expand the number of sets of data that you can save.

Do not go baseline and interim plan crazy. Even in a long project, saving too
many sets of plans can get confusing. When you do save a plan, print a copy
for your records and make a notation of when and why the plan was saved to
help you keep track.
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Figure 12-6:
You can
copy set-
tings from
any saved
baseline to
an interim
plan.
|

Saving an interim plan

Interim plans and baselines are saved via the same dialog box. The difference
is that with an interim plan, you have to specify where the data is coming
from. For example, if you want to save the start and finish dates from your
Baseline2 plan to the third interim plan, you copy from Baseline2 to Start/
Finish3. If you want the current scheduled start and finish dates for all tasks,
choose to copy from Start/Finish.

If you want to change currently scheduled start and finish dates in a baseline
but you don’t want to change all the other data typically saved in a baseline,
you can copy from Start/Finish to the baseline plan that you want to change.

Follow these steps to save an interim plan:

1. To save an interim plan for only certain tasks, select them.
2. Choose Project=>Set Baseliner>Set Baseline.

The Set Baseline dialog box appears, as shown in Figure 12-6.

Set Baseline

Set baseline

eline (last saved on Tue 10/5/09)
95 )
Copy:  Scheduled Start/Finish -
Into:  Skart1jFinish1 -
For:
@ Enfire project
Selected tasks
Roll up baselines:
To &l summary tasks
Erom subtasks into selected summary task(s)

Set as Default

[=]9

‘ Help ]l Cancel |

3. Select the Set Interim Plan radio button.

4. From the Copy drop-down list box, select the set of data that you want
to copy to the interim plan.

5. From the Into drop-down list box, select the fields in which you want
to store the interim plan data.

6. Select the appropriate radio buttons to save the plan for the entire
project or selected tasks.

7. If you choose to save the plan for selected tasks, use the check boxes
to indicate how roll up baseline options should work.

. Click the OK button to save the plan.
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By using the Copy and Into fields in the Set Baseline dialog box, you can save
up to ten interim plans based on baseline or actual data.

Clearing and resetting a plan

Ten interim plans may seem like a lot now, but in the thick of a busy and
ever-changing project, it may actually end up falling short of what you need.
Because you can save only ten interim plans, you may need to clear one at
some point and resave it.

Project piggybacks baseline and interim plan settings, so you actually choose
a Clear Baseline menu command to clear an interim plan. This can be fright-
ening to those who think that clicking a Clear Baseline command will send
their baseline into oblivion. Don’t worry — it won’t!

To clear an interim plan, follow these steps:

1. To clear only some tasks in an interim plan, select them.
2. Choose Project=>Set Baseline~>Clear Baseline.

The Clear Baseline dialog box appears, as shown in Figure 12-7.

Figure 12-7:
Clear and
reset interim
plans as
often as you

I|ke Cancel

Clear Baseline ==

Clear baseline plan | Baseline (last saved on Tue 10f6/09)

@ e mpian  StartliFinishi -

For (@) Enptire project Selected tasks

3. Select the Clear Interim Plan option, and then choose the plan that
you want to clear from the accompanying list.

4. Click to clear the specified interim plan for the entire project or for
any tasks you have selected.

5. Click the OK button to clear the plan.
You can now save a new set of information to that interim plan, if you like.
You may want to save a backup of various versions of your file with interim

and baseline data. If you clear a baseline or an interim plan, that data is gone
forever!
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Chapter 13

On the Right Track

In This Chapter

Using tracking tools

Recording actual activity on tasks

Specifying percentage of work complete

Updating fixed costs

Using Update Project to make big-picture changes
Moving a task

Consolidating multiple projects

A fter a project moves out of the planning stage and into action, it’s like a
constantly changing game in which there are rules, goals, and a general
time frame, but no one really knows which team will win (and sometimes
where the ball is) until it’s over.

Whether a task happens as planned or wanders off in an unexpected direc-
tion, your job at this stage of the game is to record that activity, an activity
referred to as tracking.

Tracking starts when your team reports their activity on the project. Then
you (or someone else assigned to deal with tracking) must manage inputting
that activity task by task.

When you track activity, you'll be amazed at what data Project returns to
you. Some of it will be good news and some bad, but all of it is useful in man-
aging your project throughout its lifetime.

Gathering Your Data

The first step in tracking progress on your project is to get information about
what’s been going on. The amount of data you collect will be determined by
what you need to track and at what level of detail. For example, some people
don’t even create and assign resources to tasks because they use Project
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only to create a timeline for their activities, not to manage resource time or
tally costs. Others use resources and want to track their total work on tasks,
just not to the level of detail that scrutinizes hourly work performed. For
some people, simply marking one task 50 percent complete and another 100
percent complete — and letting Project assume that all resources put in their
estimated amount of work — is fine. Your tracking method is determined by
the amount and type of information you need to monitor.

Therefore, the first thing you have to do is identify the best tracking method
for you.

A method to your tracking madness

Microsoft has identified four tracking methods:

v Task-total method
v Task-timephased method
v Assignment-total method

v Assignment-timephased method

You can begin to understand these by looking at the difference between task
and assignment tracking. You can track information at the fask level, indicat-
ing total work or costs for the task up to the present or as of a status date
you select. Or, you can track costs by resource assignment, which is the more
detailed way of tracking.

For example, suppose that the Test Electrical Components task is estimated
to take 12 hours of work, according to your project baseline. Three human
resources — Engineer, Electrician, and Assistant — are assigned at 100 per-
cent of their time. Tracking by task, you can simply note that the task is 75
percent complete, which translates into nine hours of work finished.

Project assumes that the three resources split that work equally. In reality,
however, the Engineer put in one hour, the Electrician put in six, and the
Assistant put in two. If you want more detailed tracking that shows you totals
of work for each resource assignment and accurately tracks them, you would
track the work at the resource-assignment level.

But here’s where the timephased variable comes in: Whether you choose to
track work on a task or the work done by individual resources on the task,
you can also track by specific time increments — which Microsoft calls time-
phased tracking.
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So, with the Test Electrical Components task, you can use a task approach of
tracking nine hours of work to date or use a timephased approach to record
those hours on a day-by-day basis. With a resource-assignment approach,
you can go to the very deepest level of tracking detail by tracking each and
every resource’s work hour by hour, day by day.

Finally, if you want Project to keep an eye on costs, be sure to track fixed
costs and material used on each task.

Going door to door

How do you get all the information about what work has been performed,
by whom, and when? Well, the first method is the one you’ve probably been
using for years: Hunt down the people on your project and ask them. Ask
them in the hallway, in your weekly one-on-one meeting, or over lunch. Give
each person a call or have everyone turn in a form.

This isn’t rocket science, but you still have to determine up front what
information you want, when you want it, and what form it should be in. The
simpler you can keep manual reporting of progress on a project, the better,
because people will actually do it. The more routine you can make it — such
as every Friday, on a set form turned into the same person, and so on — the
easier it will be.

If you need only a summary of where the task stands — say 25, 50, 75, or

100 percent complete — have the person in charge of the task give you that
informed estimate. If you need total hours put into a task to date, resources
can summarize their hours for you. If you need a blow-by-blow, hour-by-
hour, day-by-day report, you're likely to collect some form of timesheet from
resources.

If your company is set up to use Project Server, you can use Project Web App
to gather resource timesheets in one convenient location. (See Chapter 19 for
more about how to do this.)

You can probably get information about fixed costs that have been incurred
if you ask your accounting department for it, or by getting a copy of a pur-
chase order or receipt from the person who spent the money.

Consider a third-party add-on product such as Sage TimeSheet (http://
sagetimesheet . com) for reporting resource activity. You make TimeSheet
available to every resource on the project. The resources record their work
time on it, and you can use TimeSheet’s tools to automatically update your
project. If you're using Project Professional edition, TimeSheet’s features are
incorporated into Project Web App.

www.it-ebooks.info

Chapter 13: On the Right Track 255


http://www.it-ebooks.info/

256 Part IV: Avoiding Disaster: Staying on Track

You can use the Send as Attachment feature
from Backstage view to send your project to
others and have them update their own activity.

The challenge with this method is that you need
to manually incorporate the changes from the
various files into a single file. However, the

Let your project make the rounds

Compare Projects feature can help you with
this chore (see Chapter 17).

Generally, the best use of e-mail for updating
projects is simply to have team members send
an e-mail with their activity to the person updat-
ing the project and then let that person make all
the changes in one central location.

Where Does All This Information Go?

After you gather information about task progress, fixed costs, and resource
hours, you can input that information in several ways. You can use various
views and tables to enter information in sheets of data, you can input infor-
mation in the Task Information dialog box, or you can use the tracking tools
in the Schedule group of the Task tab on the Ribbon.

Doing things with the tracking tools

Sometimes it seems like Microsoft provides a handy button for everything, so
why should tracking be any different? You can use the tracking tools at the
top of the Schedule group on the Task tab to perform updates on selected

tasks in any sheet view. Figure 13-1 shows the tracking tools and other but-

tons in the Schedule group.

Figure 13-1:

Selecta

task and
clickone |FEFE&
ofthe | =
tools along
the top to
update it.
|
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=7 Respect Links
"

S | e 25
E — Inactivate

Schedule
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You can use these tools to make specific updates to selected tasks:

v By clicking a Percentage Complete tool (0% to 100%), you can quickly
mark a task’s progress using a calculation of the percentage of hours of
work completed.

1 Selecting a task and clicking the Mark on Track tool automatically
records activity to the status date as you scheduled in your baseline.
(The later section “Progress as of when?” explains how to set the status
date.)

v The Update Tasks tool, which you can find in the menu that appears
when you click the down arrow beside Mark on Track, displays a dialog
box that contains tracking fields that you may recognize from the Task
Information dialog box as well as some other fields you can use for
updating your project. For example, you can indicate whether a task’s
actual scheduled varied from its baseline.

You can use a few more tools found elsewhere in Project to track and illus-
trate progress:

v The Update Project tool enables you to mark all the tasks in a project
as complete through a status date. You also can use it to resched-
ule uncompleted work to a future time. The section “Update Project:
Sweeping Changes for Dummies,” later in this chapter, explains how to
perform overall updates.

v The Move Task tool in the Tasks group of the Task tab on the Ribbon
enables you to reschedule all or part of a selected task. You can move a
task forward or backward, or reschedule parts of it by the status date.
The “Moving a Task” section, later in this chapter, explains how to use
this tool.

v The Add Progress Line tool turns on a kind of drawing tool. When you
right-click the chart in Gantt Chart view and click Progress Lines, you
can use the Progress Lines dialog box that appears to set up progress
lines at particular dates. A progress line indicates which tasks are ahead
of schedule as well as which ones are behind schedule, by means of a
vertical line that connects in-progress tasks.

For everything there is a view

By now, you probably know that Project has a view for everything you

want to do. For example, Task Sheet view and Task Usage view (as shown

in Figures 13-2 and 13-3, respectively) allow you to update either task or
resource information easily. So many variations are available, you may think
that Microsoft charged by the view!
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Figure 13-2:
Task Sheet
view is a
great place
for tracking
work, start,
and finish
dates.
|

Figure 13-3:
Task Usage
view allows
you to enter
specific
resource
hours on
tasks day-
by-day on
your project.
|
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Depending on the method of tracking you need (see the section “A method
to your tracking madness,” earlier in this chapter), different views serve
different purposes. Table 13-1 shows the best view to use for each tracking

method.
Table 13-1 Tracking Views
Tracking Method Best View to Use Table or Column Displayed
Task Task Sheet Tracking table
Task-timephased Task Usage Actual Work row
Assignment Task Usage Tracking table
Assignment-timephased Task Usage Actual Work row

When you find the right view with the right columns displayed, entering
tracking information is as simple as typing a number of hours, a dollar
amount for fixed costs, or a start or finish date in the appropriate column for
the task you're updating.

Tracking Your Work for the Record

You need to input several types of information to track progress on your
project. First, you have to tell Project as of when you want to track progress:
By default, it records information as of the current date based on your com-
puter’s date and time settings. However, if you want to record progress as of,
say, the end of your company’s quarter, you can do that, too.

You can record actual start and finish dates for tasks, the percentage of a
task that is complete (for example, a task may be 75 percent complete), and
actual work performed (that is, the number of hours that resources put in
on each task). If you think that the task will take less or more time than you
anticipated, based on progress to date, you can modify the remaining dura-
tion for the task. You can also enter units of materials used and fixed-cost
information for expenditures incurred, such as equipment rental or consult-
ing fees.

Progress as of when?

If you don’t know what day of the week it is, you can’t very well gauge
whether you’re making the right amount of headway through your week’s
work. Well, tracking is like that: The first thing you have to do is establish a
status date, that is, the date as of which you are tracking progress.
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Figure 13-4:
Setthe
status date
here.
|

By default, Project uses the date and time setting of your computer as

the date when you enter actual activity information. However, sometimes
you’ll want to time-travel. For example, suppose that your boss asks for a
report that shows the status of the project as of the last day of the quarter,
December 31. You gathered all your resources’ timesheets up through that
date, but you didn’t get around to inputting those updates until three days
after the end of the quarter. You can deal with this situation by setting the
status date in Project to December 31 and then entering your tracking data.
Even better, some automated tracking tools work along with the status date.
For example, if you know that all the tasks in the project were on schedule as
of the status date, you can use the Update Project tool to mark all scheduled
work as complete up to the status date.

After you set the status date and enter information, Project uses that date

to make calculations such as earned value (the value of work completed to
date). Also, any task-complete or percentage-complete information records
as of that date and progress lines in the chart area reflect that timing. Any
reports or printouts of views that you generate give a picture of the status of
your project as of that date.

Here’s how to set the status date:
1. Click the Project tab, and then click the date below Status Date. The

Status Date tool is in the Status group of the tab.

The Status Date dialog box appears, as shown in Figure 13-4. When you
first open this dialog box, it shows the current date from your system’s
date and time settings.

Status Date ==

Select Date: | Mon 11j2/09] -

2. In the Select Date field, click the down arrow to display the calendar.

3. If you want to set the status date in another month, use the right or
left arrow at the top of the calendar to navigate to that month.

4. Click the date you want.
5. Click the OK button.

Now you’re ready to start inputting tracking data.
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It’s totally on track

If you make the rounds and find that a task was or will be on schedule as of
your status date, you can use an easy new tool to mark the task as partially
complete through the status date. Project calculates the completion percent-
age as of the status date and marks the completion percentage accordingly.
To use this tool, just select the task(s) to update and then click Mark on
Track in the Schedule group of the Task tab.

Percentage complete: How to tell?

When people ask me how to figure out whether a task is 25 percent, 50
percent, or even 36.5 percent complete, I usually refer them to their own
intuition. If your boss asks you how things are coming on that report, you
typically go through a quick internal calculation and come back with a rough
estimate with no problem. A rough estimate, based on your experience and
the information your resources provide you about their progress, is often
good enough.

You can also calculate percentage complete in more precise ways. For
example, if you estimate that a task should take ten hours of effort and your
resources report performing five hours of effort, you could say you're 50 per-
cent there. But be careful. Just because people have spent half the allocated
time doesn’t mean that they have accomplished half the work.

You could go by costs: If your original estimates said that your four
resources assigned to a four-day task would tally $4,000 of costs and the time
your resources report spending on the task adds up to $3,000, you could
guess that the task is 75 percent finished. But again, just because you've
spent three-quarters of the money doesn’t mean that you've accomplished
three-quarters of what you set out to do.

When a task’s deliverable is measurable, that helps a lot. For example, if you
have a task to produce 100 cars on the assembly line in four days and you’ve
produced 25 cars, you may be about 25 percent finished with the task. Or, if
you were supposed to install software on ten computers in a computer lab
and you’ve installed it on five of them, that’s an easy 50 percent.

But not every task can be calculated so neatly. The best rule of thumb is

to trust your instincts and review what your team is telling you about their
progress.
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Can tracking get too detailed?

Does it make sense to track 2.25 percent of
progress every other day on a two-month task?
Probably not. Except on the lengthiest tasks,
entering a percentage more finely broken down
than 25, 50, 75, and 100 percent complete prob-
ably isn't worth it. That's partly because tasks
longer than a few weeks should probably be
broken down into subtasks for ease of tracking,
and partly because one of the main purposes
of tracking is reporting. If your boss or board or

client could really care less about when you hit
your exact 33.75 percent-complete point, why
track it?

On the other hand, if (for some reason known
only to you) your project must include a six-
month task and you can't break it into subtasks,
you may use percentages such as 10, 20, 30, 40,
50, and so on to prevent having to wait a month
between updates with (apparently) no progress
to show.

The simplest and quickest way to update percent complete on a task is to
click the task to select it in any task-related view, and then click the 0%, 25%,
50%, 75%, or 100% button on the Task tab. Alternatively, you can double-
click any task to open the Task Information dialog box and then enter the
percent complete on the General tab there. You can also select a task, open
the Mark on Track drop-down list, and click Update Tasks to open the Update
Tasks dialog box and make the change there. If you want to enter a percent-
age in increments other than 25 percent, you’ll have to enter it in the Task
Information or Update Tasks dialog box or the Percent Complete column in
any sheet view.

When did you start? When did you finish?

If you note that a task is complete and don’t enter an actual start date,
Project (ever the optimist) assumes you started on time. If you didn’t start
on time and you want to reflect the actual timing, you should modify the
actual start date. If you finished late, you should enter the actual finish date.
However, be aware that if you don’t modify the task duration and enter an
earlier finish date, the start date will be calculated to have occurred earlier.

You have several options of where to track this information. You can use the
Update Tasks dialog box (shown in Figure 13-5), which you can open via the
Mark on Track drop-down list in the Schedule group on the Task tab. You can
also display a sheet view with Actual Start and Actual Finish columns, such
as Tracking Gantt or Gantt Chart view with the Tracking table displayed.
Then use the drop-down calendar in the Actual Start or Actual Finish column
to specify a date. If you need to change the actual start date, you must mark
the task as partially complete first. When you need to change both the actual
start and actual finish dates, mark the task as 100% complete before specify-
ing the dates.
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Figure 13-5:
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A few conditions could cause a warning message to appear when you enter an
actual start or finish date: for example, if the actual start date falls before the
start date for the project, or if it causes a conflict with a dependent task. When
this warning message appears, you have the following options:

v Cancel the operation
v Force the conflict to exist (or the task to start) before the project starts
If you want to cancel the change, correct what’s causing the problem (for

example, by modifying the project start date), and then go back and enter the
actual information, you can. Or you can force the conflict, and let it stand.

John worked three hours;

Maisie worked ten

If you want to get to the blow-by-blow level of tracking, you need to record
exactly how many hours each resource put in on your tasks. This can be
about as much fun as typing the New York City phone book into a database,
but it has some benefits. After you track actual hours, you can get tallies of
total hours put in by each resource in your project by day, week, or month.
If you have to bill clients based on resource hours (for example, if you're a
lawyer), you have a clear record to refer to. If you're tracking a budget in
detail, resource hours multiplied by their individual rates will tally an accu-
rate accounting of costs as finely as day by day.

If you don’t enter specific hours, Project just calculates the hours of work
done on the task as a percentage of the total hours assigned. It assumes that
each person assigned to the task has completed the same percentage of
work. For many people, that’s fine; for others, more detail is better. If you're
in the detail camp, specify actual resource hours as a total by task or day by
day through the life of each task.
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Figure 13-6:
Track
resource
activity day
by day in
this view.
|

To enter resource hours, follow these steps:

1. Display Task Usage view.

2. Scroll down to locate the task you want to track and its resource

assignments.

Each assigned resource is listed on a separate row underneath the task

name.

3. Enter the hours put in by the resource:

e If you want to enter only total hours. Insert the Actual Work column
into the sheet by right-clicking a column, choosing Insert Column,
and selecting the Actual Work column. Enter the total hours in the
newly displayed column.

e Jf you want to enter hours on the task day by day: Right-click the

chart pane, and then choose Actual Work to display the Act. Work
row. Figure 13-6 shows this row displayed in the Task Usage view.

Click the Act. Work cell for a day that the resource worked and

enter a number. Repeat this for each day that the resource worked
on that task.
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Automating updates via SharePoint Server

If your organization uses SharePoint Server,you  process helps automate your tracking. You can
can publish the project as a SharePoint Server  publish and sync the task list by selecting Share
task list and then sync status updates thatteam in the Outspace. Chapter 18 discusses working
members make back into your Project file. This  with SharePoint in more detail.

If the hours you enter for a resource total more or less than the baseline esti-
mate for that resource on that task, here’s what happens:

» When you enter an amount in the Act. Work row and press Enter, the
Actual Work column total recalculates to reflect the total hours worked
on that task.

v A little pencil symbol appears in the ID column for that task, indicating
that the assignment has been edited.

v A person icon appears in the Indicators column to the left of the task
name, indicating a resource overallocation.

You can change the entries in the Work column or timephased work row for
a task or assignment. If you do so, Project changes the task schedule accord-
ingly. Then if you mark actual work, it will be tracked compared with the
edited working hours.

<P Note that you can easily look up the total hours put in by each resource on
the project by checking the summary number of work hours listed next to
the resource in the Resource Name column of Resource Usage view, another
handy view where you can track assignments.

Uh-oh, we're into overtime

When you enter 16 hours of work on a single day for a resource, even though
that resource is based on a calendar with an 8-hour day, Project doesn’t rec-
ognize any of those hours as overtime. This is one case where you have to
lead Project by the hand and actually tell it to specify overtime work.

When you enter hours in the Overtime Work field, Project interprets that as

the number of total work hours that are overtime hours. So, if you enter 16
hours of work on a task in the Work column and then enter 4 in the Overtime

www.it-ebooks.info


http://www.it-ebooks.info/

266 Part IV: Avoiding Disaster: Staying on Track

Work column, Project assumes that there were 12 hours of work at the stan-
dard resource rate and 4 hours at the overtime rate.

To enter overtime hours, follow these steps:

1. Display Resource Usage view.

2. Right-click a column heading and choose Insert Column.
The list of columns appears.

3. Select Overtime Work in the list.

4. Click in the Overtime Work column for a specific assignment for a
resource, and then use the spinner arrows to specify the overtime
hours.

Note that if you specify overtime, Project assumes that effort-driven tasks are
happening in a shorter duration. After all, if the task was to take three 8-hour
days (24 hours of work) to complete and you recorded that the resource
worked 12 hours for two days in a row, Project figures that all the effort got
accomplished in less time. The duration for the task will actually shrink. If
that’s not what happened, you have to go in and manually modify the task
duration.

Specifying remaining durations
for autoscheduled tasks

Alot of tracking information for autoscheduled tasks has a weird and won-
derful relationship in Project. For example, Project tries to help you by cal-
culating durations based on other entries you make, such as actual start and
finish dates. In that particular case, Project figures out task duration accord-
ing to those dates. (This works in reverse, too: If you enter the task duration,
Project recalculates the finish date to reflect it.)

Sometimes you want to enter a duration rather than have Project base it on
other information you input. For example, you may have entered a start date
and 20 hours of work on a task that had a baseline of 16 hours of work. What
Project can’t know is that the scope of the task changed, and now the task

is not complete and will also take another 20 hours of work. You have to tell
Project about that.

To modify the duration of a task in progress or completed, follow these steps:

1. Display Gantt Chart view.
2. Choose Viewr>Tablesw> Tracking.
The Tracking table is displayed.
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3. Click in the Actual Duration column for the task you want to modify,
and then use the arrows to adjust the actual duration up or down.

4. If you want to enter a remaining duration, click in the Rem. Dur.
(Remaining Duration) column and type a number as well as an incre-
ment symbol.

For example, you may type 25d (where d is the increment symbol for
days).

If you enter a percentage of completion for a task and then modify the dura-
tion to differ from the baseline, Project automatically recalculates the per-
centage considered complete to reflect the new duration. So, if you enter 50%
complete on a 10-hour task and then modify the actual duration to 20 hours,
Project considers that 5 hours (50 percent of 10 hours) as only 25 percent of
the 20 hours.

Entering fixed-cost updates

Fixed costs are costs that aren’t influenced by time, such as equipment pur-
chases and consulting fees. Compared with the calculations and interactions
of percentage completions and start and finish dates for hourly resources,
fixed-cost tracking will seem like simplicity itself!

Here’s how to do it:

1. Display Gantt Chart view.
2. Choose View~>Tables>Cost.
The Cost table is displayed.
3. Click in the Fixed Cost column for the task you want to update.

4. Type the fixed cost, or a total of several fixed costs, for the task.

That’s it! However, because Project lets you enter only one fixed-cost amount
per task, consider adding a note to the task itemizing the costs that you've
included in the total. Also, no baseline fixed-cost column is available, so to
compare how your actual fixed costs outstripped your baseline estimates,
you have to do a little math to find the difference between baseline costs and
actual costs: Deduct nonfixed costs to get the variation in fixed costs.

Consider using some of the ten customizable Cost columns for itemized fixed-
cost entry. Rename one Equipment Purchase, another Facility Rental, and so
on, and then enter those costs in those columns. Of course, these columns of
data may not perform calculations such as rolling up total costs to the sum-
mary tasks in your project, but they’ll serve as a reminder about itemized
fixed costs.
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QgN\BEH In Project 2010, you can designate a resource type as Cost and assign a cost

& every time you assign that resource. The Cost column calculation of total cost
includes the amount spent for Cost resources on tasks. See Chapter 7 for more
about resource types.

Moving a Task

If you've ever been involved in managing subcontractors for any type of con-
struction project, you've probably heard the dreaded words, “My current
job is running long, so I'll get to your job in about a week.” What you’d rather
hear from subcontractors or any other type of resource is, “My schedule
opened up, so I can start work on this assignment a week early.” Project 2010
now makes it easier to reschedule an entire task or reschedule part of a task
as of the status date.

Here’s how to use the new Move Task tool:

1. Display Gantt Chart view.

2. If the task is partially complete and you want to move its uncompleted
portion, set a status date.

3. Select the task to move.
4. Click the Move Task button in the Tasks group on the Task tab.

The choices for rescheduling the task appear, as shown in Figure 13-7.
5. Specify how to move the task:

e If you want to move it forward or back by a default amount: Click 1
Day, 1 Week, or 4 Weeks under either Move Task Forward or Move
Task Back.

e [f you want to move the task by a custom time frame: Click the
appropriate Custom choice, specify the number of working days
by which to move the task in the dialog box that appears, and click
the OK button.

e [f you want to reschedule part of the task according to the status date:
Click Incomplete Parts to Status Date to split the task and move the
uncompleted portion to resume later, starting on the status date.
Click Completed Parts to Status Date to split the task and move the
completed portion earlier, before the status date.

e Jf you want to reschedule the task based on the availability of the
assigned resources: Click the appropriate Custom choice, specify
the number of working days by which to move the task in the
dialog box that appears, and click OK.
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Move a task
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schedule.
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Update Project:
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Changes for Dummies

If it’s been a while since you tracked activity and you want to update your
schedule, Update Project may be for you. It allows you to track chunks of
activity for a period of time. Update Project works best, however, if most
tasks happened pretty much on schedule.

This is not fine-tuned tracking: It’s akin to getting your bank balance, draw-
ing a line in your checkbook, and writing down that balance as gospel rather
than accounting for your balance check by check. (If you're like most of us,
you've done this at least once.) Doing so assumes that all your checks and
deposits probably tally with what the bank says as of that date; thus, going
forward, you're back on track.

Here are the setting choices Update Project offers you:
v Update Work as Complete Through: You can update your project
through the status date you specify in this box in one of two ways. The

Set 0% — 100% Complete setting lets Project figure out the percent
complete on every task that should have begun by that time. By making
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this choice, you tell Project to assume that the tasks started and pro-
gressed exactly on time. The Set 0% or 100% Complete Only setting
works a little differently. This setting says to Project, just record 100%
complete on tasks that the baseline said would be complete by now, but
leave all other tasks at 0% complete.

+* Reschedule Uncompleted Work to Start After: This setting reschedules
the portions of tasks that aren’t yet complete to start after the specified
date.

To use Update Project, follow these steps:

1. Display Gantt Chart view.
2. To update only certain tasks, select them.
3. Choose Project~>Update Project.
The Update Project dialog box appears, as shown in Figure 13-8.

I
Figure 13-8: | Update Project =
You can | @ ipdate work as compiste throughi: Man 82/10 .
u pd ate on |y @ Set 0% - 100% complete

Set 0% or 100% complete only
Sele Cted Reschedule uncompleted work o start after: | Mon &/2/10

tasks or the
entire
project.
|

For: (@) Entire project Selected tasks

4. Choose the Update method you prefer: Set 0% — 100% Complete or Set
0% or 100% Complete Only.

5. If you want a status date other than the one shown or did not previ-
ously set a status date, set the date to use in the field in the upper-
right corner.

6. If you want Project to reschedule any work rather than updating work
as complete, select the Reschedule Uncompleted Work to Start After
option and then select a date from the list.

7. Choose whether you want these changes to apply to the entire project
or only to selected tasks.

8. Click the OK button to save the settings and have Project make
updates.

If you want, you can use Update Project to make some global changes, such
as marking all tasks that should be complete according to baseline as 100
percent complete. Then go in and perform more detailed task-by-task track-
ing on individual tasks that are only partially complete.
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Tracking Materials Usage

Figure 13-9:
You also

can use the
Assignment
Information
dialog box
to enter
actuals.
|

Tracking the amount of materials used on tasks involves tracking actual units
at the material resource level. So, if you create a resource called rubber and
assign it to the Manufacture Tires task at 500 tons, but you actually used
only 450 tons (in other words, you made 450 tons of rubber streeeetch), you
would enter the actual units used.

This situation is akin to the way you track work resource hours on tasks. To
make it happen, just follow these steps:

1. Display Resource Usage view.

2. Locate the material resource in the list, and under the resource name,
double-click the assignment for which you want to enter the actual
units.

The Assignment Information dialog box appears (see Figure 13-9).

Assignment Information ==

General Tracking | Nates ‘

Elueprints

Blueprints
Work: 50 Bluep |- %o Work complete: | 0%
Actual work: | O Bluepri|— Remaining work: 50 Bluep
Actual stark:  MWA -
Actual finish: KA -

$0.00 Cast rate table: A

4

Cancel

3. Click the Tracking tab.
4. Enter the actual units used in the Actual Work field.
5. Click the OK button.

If you need to enter actual units for multiple assignments, you can use the
method I showed you earlier in the section “John worked three hours; Maisie
worked ten.” Right-click the right side of the view and choose Actual Work

to display the Act. Work row. You can then plug in your actual data there.
Just keep in mind that if you assign the material resource of, say, 500 tons to
a five-day task, Resource Usage view reflects that Project spread the usage
out — 100 tons for each of the five days of the task. If you don’t care on what
day of the task the materials were used, you can simply modify one of the set-
tings to be higher or lower to make up for any difference in actual usage.
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Tracking More Than One:
Consolidated Projects

a\\J

Often you'll have either projects that are related in some fashion (such as
sharing resources or having timing dependencies between them) or a series
of smaller projects that make up a larger project. In that case, you can con-
solidate those separate projects into one file, either as a series of summary
tasks or with all summary and subtasks included.

When you consolidate projects, you can choose to link to the source file.
When you do, any changes to the source file are represented in the consoli-
dated file.

If it’s your job to keep track of the big picture, you have to understand how
consolidated projects get updated.

Consolidating projects

Creating a consolidated project is sort of like going to a Chinese restaurant —
one from Column A, one from Column B, and so on, until you build yourself a
tasty meal. In Project, you open a blank file and then insert existing projects
to build a satisfying master project plan.

The neat thing about consolidated projects is that you have some choices
about how the consolidated project and the source files you insert in it inter-
act. For example, you can link to a source file so that changes made in the
source file will be reflected in the consolidated project. This is a great tool
for somebody who has to keep his or her eye on multiple phases or many
smaller projects.

You can also create dependencies between inserted projects in the consoli-
dated file. If you have (for example) one project that can’t start until another
one finishes, you can clearly see in the consolidated file how various separate
projects in your organization have an impact on each other.

The other thing you can do to relate consolidated projects to their source
files is to make your consolidated project a two-way street, allowing changes
in it to be reflected in the source files. You can also make the choice to have
the source files be read-only so that your changes won’t go mucking around
with other people’s files — whichever suits your purposes.
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Figure 13-10:
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Open a blank Project file and display Gantt Chart view.
Click in the Task Name column.

If you're inserting multiple projects, click the row in which you want
the inserted file(s) to appear. If you want to insert a project between
existing tasks, click the task beneath where you want the project to be
inserted.

. Choose Project=>Subproject. Subproject is in the Insert group.

The Insert Project dialog box, shown in Figure 13-10, appears.

. Using the navigation pane and file list, locate the Project file you want

to insert and select it.

. (Optional) Click the down arrow on the Insert button if you want to

change the default Insert setting to Insert Read Only.

. If you want to link the project in this file to the source file so that

whenever you open the consolidated file it updates automatically,
make sure that the Link to Project check box is selected.

. Click the OK button.

The project is inserted in your file with the summary task showing and
all subtasks hidden. To display all tasks in the inserted project, just click
the plus sign to the left of the summary task.
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If you want to insert multiple subprojects, leave them all collapsed. This will
ensure that they are all inserted at the topmost level of the outline in the con-
solidated project.

Updating consolidated projects

You have two ways to skin the cat called updating a consolidated project, and
the one you use depends on whether you linked to the source files when you
inserted them. If you linked the files and you inserted them without the read-
only setting, changes in source files are reflected in the consolidated file (and
vice versa). Updating is simply a matter of making sure that all the files are
available in their original linked locations (for example, in a folder on your
network), and then Project updates automatically.

If you haven’t linked the files, changes in source files won’t be reflected in
consolidated files, and the consolidated file information will have no effect
on the source information. You may create such an unlinked consolidated
file if you simply want to see a snapshot of how all projects are going at the
moment, and you don’t want to run the risk of having your settings changing
the source information. In this case, however, if you want to track progress,
you have to create a new consolidated project or manually enter all updates.

After you insert projects in a file, you can move them around using the Cut
and Paste tools. When you do, message windows may appear, offering you
options to resolve any conflicts that may occur because of dependency links
you've created between inserted projects.

Changing linking settings

Changing your mind is a project manager’s prerogative. So, if, after you have
inserted a source file in a consolidated file, you find that you didn’t initially
establish a link, you can go in and change that setting so that the files update
each other automatically.

Follow these steps to make changes to the inserted project:

1. Open the consolidated file.
2. Display Gantt Chart view.
3. Double-click the task name of the inserted project you want to update.

The Inserted Project Information dialog box appears (as shown in Figure
13-11).
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4. Click the Advanced tab.

5. Select the Link to Project check box and then click the Browse button.

The Inserted Project dialog box appears.

6. Use the Look In feature to locate the file that you want to link to and

select the file.
7. Click the OK button.

8. If you want the source file to be read-only, select that check box.

9. Click OK to save the link.
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Chapter 14

A Project with a View:
Observing Progress

In This Chapter

Seeing what your progress looks like with indicators and task bars
Seeing progress from various Project views

Examining cost and time variances

Understanding earned value

Modifying calculation options

S)me people use Project just to paint a pretty picture of what their proj-
ect will entail and then put the plan in a drawer. That’s a mistake. After
you enter all your project data, save a baseline, and then track actual activity
on your project, you get an amazing array of information back from Project
that helps you to stay on time and on budget.

After you track some actual activity on tasks, Project allows you to view base-
line estimates right alongside your real-time plan. Project alerts you to tasks
that are running late and also shows how the critical path shifts over time.

Project also provides detailed budget information. In fact, the information
that you can get about your costs may just make your accounting depart-
ment’s heart sing. The information is detailed and uses terms that accoun-
tants love (such as earned value, cost variance, and budgeted cost of work
performed, all translated in a later section of this chapter).

So keep that project file close at hand — and take a look at how Project can
make you the most informed project manager in town.

Seeing Where Tasks Stand

You diligently entered resource work hours on tasks, recorded the percent-
age of progress on tasks, and entered fixed costs. Now what? Well, all that
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information has caused several calculations to go on — and updates to be
reflected — in your project. It’s time to take a quick look at the changes that
all your tracking has produced in your Project plan.

Getting an indication

Alot of information in Project just sits there waiting for you to hunt it down
in obscure views or tables, but one tool that Project uses to practically jump
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up and down and say, “Look at this!” is indicator icons. You've seen these
icons in the Indicator column and probably wondered what the heck they
were for. Well, these little symbols give you a clue to important facts about
each task, sometimes alerting you to problems or potential challenges.

Figure 14-1 shows several of these indicators, some of which relate to the
results of tracking your project.

Indicator icons
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If you see an unfamiliar indicator icon crop up in your project, hold your
mouse pointer over the indicator. A box that describes its meaning appears.
To get alist of Project icons and their meanings, go to Help, click the Index
tab, and type icon in the Search box. Click Search and then click Indicator
Fields.

Lines of progress

Progress lines offer an additional visual indicator of how you're doing. As you
can see in Figure 14-2, a progress line zigzags among tasks and forms, show-
ing left- or right-pointing peaks. These peaks indicate late or early tasks (cal-
culated according to the status date you set for tracking or another date that
you specify). A progress line that points to the left of a task indicates that the
task is running late. Progress lines that point to the right show that, wonder
of wonders, you're running ahead of schedule. (Treasure these: They don’t
seem to appear often in projects!)

Progress line
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Figure 14-3:
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Displaying progress lines
By default, Project doesn’t display progress lines. You have to turn them on.
And while you're at it, you may as well specify when and how they appear.
Here’s how to make settings for and display progress lines:

1. Display Gantt Chart view.

2. Right-click the chart portion of the view and choose Progress Lines.

The Progress Lines dialog box appears, as shown in Figure 14-3.

Progress Lines (==

Dates and Intervals | Line Styles |

Current progress line Selected progress lines
V| Display: Display:
@) At project status date At current date

Recurring inkervals

Progress Line Dates

Display progress lines:
Daily weekly Manthly
weekly Delete

Every

IMan Tue Wed
Thu Eri Sat Sun
Display progress lines in relation to
Project start Thu 71100 @ actual plan Baseling plan
Help Cancel

3. If you want Project to always show a progress line for the current or
status date, select the Display check box under Current Progress Line
and then select At Project Status Date or At Current Date.

4. If you want progress lines to be displayed at set intervals, do the
following:

a. Select the Display Progress Lines check box under Recurring
Intervals, and then select Daily, Weekly, or Monthly.

b. Specify the interval settings.

For example, if you select Weekly, you can choose every week,
every other week, and so on, as well as which day of the week the
line should be displayed for on the timescale. Figure 14-4 shows a
project with progress lines at regular intervals.

5. Choose whether you want to display progress lines beginning at the
Project start or on another date.

To use the Project start date, simply select the Project Start option in
the Begin At section of the dialog box. To select an alternate start date,
select the second option and then select a date from the calendar drop-
down list.
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6. If you want to display a progress line on a specific date, select the
Display check box under Selected Progress Lines and then choose a
date from the Progress Line Dates drop-down calendar.

You can make this setting for multiple dates by clicking subsequent lines
in this list and selecting additional dates.

You can choose to display progress lines in relation to actual or baseline

information.

If a task has been tracked to show 50 percent complete and you choose
to have Project display progress lines based on actual information, the
peak appears relative to the 50 percent actual line, not the complete

baseline task bar.

7. Click the OK button to save your settings.

Formatting progress lines

In keeping with the almost mind-boggling array of formatting options that Project
makes available to you, you can modify how progress lines are formatted.

As with any changes to formatting, you’re tampering with the way Project
codes visual information for readers. You should be cautious about making
formatting changes that cause your plan to be difficult to read for those who
are used to Project’s default formatting.
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Figure 14-5:
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To modify progress-line formatting, follow these steps:

1. Right-click the chart portion of the view in Gantt Chart view and

choose Progress Lines.

2. Click the Line Styles tab, if necessary, to display the options shown in

Figure 14-5.

Progress Lines =]
Dates and Intervals | Lins Styles
Progress line type Line style
Current progress line: All other progress lines:
Line type: - -
Line colar: _ - Automatic -
Progress point shape: & - -
progress point color: [ ANDNDI ~ Automatic -
Date display
Show date for each progress line 1jzg/09, 1/29/09, ... Change Eont...
s o

3. In the Progress Line Type display, click a line style sample.

4. In the Line Type fields, click a style from the samples shown.

You can make two settings here: one for the current progress line and
one for all other progress lines.

. You can change the line color, progress point shape, and progress

point color by making different choices in those boxes.

. If you want a date to appear alongside each progress line, select the

Show Date for Each Progress Line check box and then select a date
from the Format field.

. If you want to change the font used for the displayed date, click the

Change Font button and make your changes.

. Click the OK button to save your settings.

When worlds collide: Baseline versus actual

One of the most obvious ways to view the difference between your baseline
estimates and what you've tracked in your project is through task bars. After
you track some progress on tasks, the Gantt chart shows a black bar
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superimposed on the task bar that represents your baseline. For example,
in Figure 14-6, Tasks 2 through 4 are complete; you can tell this by the solid
black bar that extends the full length of the task bar. Task 6 is only partially
complete; the black, actual task line only partially fills the duration for the
task. Task 7 has no recorded activity on it; you see no black actual line, only
the normal task bar.

= Ganttcha ‘ New Fitness Center Lacation PR Plan Tracked - Micrasoft Praject = @ Ox
Task Resaurce Project  View Farmat o @H =
j ,5 Calibri n - ossss jMarkunTra[k - % “?b‘[mpect' - e i' =] q:? 'ﬁv
Ga- | _ ., " Respect Links EE) Mave = 2-
P LI A ML Il Pt scnedute] A Mode < | 5 I | adk B
View | Cliphoard Fant Schedule Tasks Insert Properties Editing
B 1/30/11f i 2/27/11 -
E Start | | Finish =
B 211011 | 10111 2
@ [Task . Taskname . Duratior, start Jan 30,11 [Feb 6, '11 [Feb 15, 11 [Feb 20, 11 =
Mo § [M[ T [WeTT TF TS [M[T [WITTF 5[5 [T [WIT[F IS5 Wl [WITTFIs][=|
0 = = New Fitness Center  27.38  Tue 2/1/11 o
Location PR Plan days
Tracked
1 v o = Preparation 25days  Tue 2/4/11 =y
2 v P Planning meeting 4hrs Tue 2/1/11 Director PR,PR Assistant, PR Manager, VP Marketing
3 v % Budget development  2days  Tue 2/1/11 H%lnimum PR, PR Manager
1 L-N Carmpaign launch 0 days Thu 2/3/11 01—27‘37
5 LN =l video 20.38 days Thu 2/3/11 =
6 < Shoot footage Bdays  Thu2/3/11 ivﬁde Vendor,PR Manager
7 L-N Editing and review 10days  Tue 2/8/11 3H PR Manager, ¥
8 LN Approval 0days Tue 2/22/11 2/22
3 - Duping 2days  Tue 2/22/11 El\lidenh
I 10 < Distribution 1day Thu 2/24/11 | JE
11 LN Follow up 2 days wed 3/2/11
Figure 14_6: 12 ?9 = Media Release 14.88 days Tue 2/8/11 r
) 13 =Y Writing 2days Tue 2/8/11 IG), PR Manager
The solid _ ;
. 14 = Editing and review 4days  Thu2/10/11 T ...........oovvveierirs i) &=, PR an
line on task 15 LS Approval Ddays  Thu2/24/11 2/24
bars repre- 18 - Distribution 1day Thu 2/24/11 PRA
sents actual 1; = § F.Dl\uwu.p 2days  Fri /2511
=3 social Media 9.13 days  Wed 2/9/11 L. v
activity in 13 L-N s:;:new locationweb 3 days Thu 2/10/11 :l:n Manager
your pro'ect. "iﬂl_‘ = Fetahlich nmlina 1 A= TusnMEMT SIT] ‘Wl BB A ccictant »
— | e 2, Wew Tasks ¢ Auta Scheduled | IEEEES [} +

Studying by the Numbers

Visual indicators such as task bars and indicator icons are useful to alert
you to delays or variances between estimated and actual performance, but
they don’t provide any detailed information. To get the real lowdown on how
far ahead (or behind) you are, down to the day or penny, you need to give
the numbers a scan. The numbers that Project provides reveal much about
whether you’re on schedule and within your budget.
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Figure 14-7:
The
Variance
column
shows the
difference
between
the total
cost and the
baseline.
|

WMBER
@&
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Two tables you can display in Gantt Chart view bring your situation into bold
relief. The Cost table and Variance table provide information about dollars
spent and variations in timing between baseline and actual activity.

The Cost table is shown in Figure 14-7. Here you can review data that com-
pares baseline estimates of fixed costs and actual costs. These two sets of
data are presented side by side in columns. In the project shown in Figure
14-7, the current total cost based on tracked information is $297,670 and
your baseline estimate was $296,930, giving you a variance of $740 over your
budget.

= C ‘ Mesw Fitness Center Location Remodel Plan Location 1 Tracked - Microsoft Project = @ =X
Resource  Project  iew Format @& =
g = T ke —
B 5 calibri - emess EMarkunTra[k - H;_‘> Blupect - g i =] % 44 -
Ba- | — _ 52 Respect Links I Move - Y = 2-
Paste B|l7i U &d-A-|G & e s Auto — Task Information - Scrall
- & = - 7 S nactivate Schedule| 3 Mode - o & toTask 87
Clipboard Fant Schedule Tasks Insert Froperties Editing
Task Mame - |Fixed Cost _ Fixed CostAccrual , Total Cost . |Baseline . WVariance . Actual - - Jul 4,"10 -
TIF[s s [M[TW[T[=
= New Fitness Center $0.00 Prorated $297,670.00 i296,930.00  $740.00 $20,350.00 i277,32000 e
Location Remadel
Plan
= Location Selection $0.00 Prorated $32,190.00  $31,450.00 S740.00  $20,350.00  $11,810.00 P
Hire realtor 50,00 Prorated §7,40000  $7,400.00 3000 5740000 50.00 c
Review listings $0.00 Prarated $4,420.00  $4,440.00 $0.00  $4,440.00 $0.00 %
Visitlocations $0.00 Prorated §7,400.00  $7,400.00 3000 §7,400.00 $0.00
Select lacation 50,00 Prorated $2,22000  $1,480.00 5740000 $1,110.00  $1,110.00
Cantract $0.00 Prorated $4,42000  $4,440.00 $0.00 $0.00  $4,440.00
Financing $0.00 Prorated §5,920.00  $5920.00 $0.00 S0.00  $5,920.00
Closing 50,00 Prorated 5370.00 §370.00 50.00 50.00 §370.00
= Building Design $0.00 Prorated $93,920.00  $93,920.00 $0.00 $0.00  $93,920.00
& Hire architect $12,500.00 Prorated $20,660.00  $20,660.00 $0.00 §0.00  §20,660.00
P Determine 50,00 Prorated $12,74000  $12,740.00 50.00 $0.00  $12,740.00
g specifications
- Determine budget 30.00 Prorated §5100.00  $5100.00 30.00 $0.00  $5100.00
Design $0.00 Prorated $28,400.00  $28,400.00 $0.00 $0.00  $285400.00
Design review $0.00 Prarated $19,880.00 $19,880.00 $0.00 $0.00  $18,880.00
Blueprints 30.00 Prorated $6,430.00  $6,430.00 30.00 $0.00  $6,430.00
Design finalization 30,00 Prorated $710.00 §710.00 $0.00 &0.00 §710.00
= construction $0.00 Prorated  $171,560.00 $171,560.00 $0.00 $0.00 $171,560.00
Hire general contractor $0.00 Prorated §7,20000  $7,200.00 $0.00 $0.00  $7,200.00
Secure permits $0.00 Prorated $2,32000  $2,320.00 $0.00 $0.00  $2,320.00
Perfarm demolition $0.00 Prorated §1,08000  $1,080.00 $0.00 $0.00  $1,080.00
Order materials 30,00 Prorated $99,680.00  $39,680.00 $0.00 $0.00  $99,680.00
Order hardware $0.00 Prarated $15,680.00 $15680.00 $0.00 $0.00  $15,680.00 E
waste disnnsal snnn proraterd KRN N SANN N 2nnn &nnn SANN 0 —
P 4
Ready | D Mew Tasks : Auto Scheduled | IEEES 0 )

To display a table, choose Viewr>Tables and click the table name.
Figure 14-8 shows the Variance table. This table shows whether or not your

scheduling is on track or has variances, much like the Cost table shows cost
variances. It shows the variance between baseline start and finish dates and
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task durations, as well as the timing that actually occurred on tasks after
your project got going.

= ‘ MNesw Fitness Center Location Remodel Plan Location 1 Tracked - Microsoft Project o @ =
Resource  Froject  View Formsat @& =
- .
I —- e - PEEes P Mark on Track - u\_> Buopea- gy i &l C% [: -0
= Rl o 52 RespectLinks T Move ~ & = 2
Bl7 U & A- Sadg & = ch Auto | 2 Task Information .- Scrall
- S Inactivate Schedule| [ Mode - > B toTask BT
Clipboard Font schedule Tasks Insert Properties Editing
+ |Task Hame - Start - Finish - Baseline Start . BaselineFinish o Startwar. . Finishvar. o
= New Fitness Thu 7/1/10 Fri Thu7/1/10 Thu 10/28/10 0 days 1day
Center Location 10/29/10
Remodel Plan
= Location Selection Thu7/1/10  Mon8/2/10 Thu 7/1/10 Fri7/30/10 0 days 1day |
Hire realtor Thu7/1/10  wied 7/7/10 Thu 7/1/10 Wed 7/7/10 0 days Odays | CEOV
Review listings Thu 7/8/10 Mon 7/12/10 Thu 7/8/10 tan 7/12/10 0 days Odays | %
visit lacations Tue 7/15/10 Mon 7/13/10 Tue 7/13/10 Mon 7/15/10 0 days Qdays |
select |ocation Tue 7/20/10  Thu 7/22/10 Tue 7/20/10 wed 7/21/10 0 days 1 day
Contract Fri 7/28/10  Fri 7/30/10 Thu 7/22/10 Thu 7/28/10 1 day 1 day
Financing Tue 7/20/10 Thu 7/23/10 Tue 7/20/10 Thu 7/28/10 0 days 0 days
Closing Mon 8/2/10 Mon 8/2/10 Fri 7/30/10 Fri 7/30/10 1day 1 day
= Building Design Mon 8/2/10  Mon 9,/20/10 Fri 7/30/10 Mon 9/20/10 1 day 0 days
Hire architect Mon 8/2/10  Fri 8/8/10 Fri 7/30,10 Thu §/5/10 1 day 1 day
Determine Mon 8/2/10 WMon 8/16/10 NMen 8/2/10 fan 8/16/10 0 days 0 days
specifications
Determine budget Fri 8/6/10  Fri 5/13/10 Thu 8/5/10 Thu £/12/10 1 day 1 day
Design Mo 8/16/10 Fri 8/3/10 Ian 8/16/10 Fri 8/3/10 0 days 0days
Design review Fri 9/3/10  Thu 9/16/10 Fri 8/3/10 Thu 3/16/10 0 days 0 days
Blueprints Thu 97/16/10 Mon 5720710 Thu 5/16/10 Non 9/20/10 0 days 0 days
Design finalizatior  Mon 9/20/10  Won 8/20/10 Ian 8/20/10 fon 8/20/10 0 days 0days
= Construction Fri 8/13/10  Fri 10/29/10 Thu 8/12/10  Thu 10/26/10 1 day 1day
Hire general Fri 8/153/10  Won 5/23/10 Thu §/12/10 Fri 8/20/10 1 day 1 day
contractor
Secure permits Mon 8/23/10 Wed 8/25/10 Fri 8/20/10 Tue 8/24/10 Lday 1 day
Perform Wed 8/25/10 Mon 5/30/10 Tue 8/28/10 Fri 8/27/10 1day 1 day
dernolition
Qrder materials Mon 8/30/10  wed 8/8/10 Fri 8/27/10 Tue 8/7/10 1day 1 day
Order hardware  Mon 8/30/10 Fri 9/3/10 Fri 8/27/10 Thu 9/2/10 1 day Tday | - 3
waste disnnsal Mnn A730AN wed 91410 Fri /27010 Tue #7310 1 dav, 1 daw, B —
(I KA »
Ready | 25 Mew Tasks : Auto Scheduled | [EEEEC (&)

Another useful way to view variances is to show Tracking Gantt view. This
view by default has two thin task bars for each task. The bottom, gray bar
shows the baseline, while the top bar shows the current (scheduled) or
actual (tracked) schedule. The color of the top bar will vary depending on
whether it’s a critical task or not if auto scheduled, or whether it’s a manually
scheduled task. As shown in Figure 14-9, Tracking Gantt view enables you to
show and tell exactly where a project went off track or picked up steam.

If you created a slack task to help you deal with delays that may come up,
the total variance shown here will tell you how many days you may have to
deduct from the duration of the slack task to get back on track. Read more
about making adjustments in your plan to deal with delays and cost overruns
in Chapter 15 and about slack in Chapter 10.
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Figure 14-9:
Tracking
Gantt view
gives you

a graphi-
cal look at
baseline
and current
schedules.
|

Bl & 9 - I Gantt ¢ | New Fitness Center Location Remodel Plan Location 1 Tracked - Micrasoft Praject = @ =
Task Resaurce Project  View Farmat o @& =
j [ R B emess P Mark on Track ~ Q % T Inspect * - i | C% -

Ba- _ , "D RespectLinks ) Move + &> = -
P g BIT SARF (8B o | S sonede] Mo | I g s @
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= Camtract 6 days Fri 7/23/10
=, Financing & days Tue 7/20/10
- Closing 20 tion 8/2/10 - 0%
L-N =l Building Design FE25days  Men#/2/10
¥ LN Hire architect 4 days Wion 8/2/10 0%
] + Determinespecifications 10 days Wan 8/2/10
[ LN Determine budget Edays Frig/6/10
¥ LN Design 28w Wian 8/16/10
] =Y Design review 9 days Fri 9/2/10
LN Elueprints 2days Thu 8/16/10
- Design finalization 2n, wion 8/20710
=Y =l Coratruction S5 days Frigf13/10 v
af Hiregeneral contractar & days Frig/13/10 pu
=, Secure permits 243y wion 8/23/10
=Y Perfarm demalitian Fdays Wed 8/25/10
¥ LN Ordermaterials 4 days Won 8/30/10
=, Orderhardware 4days ion 8/30/10
=Y Waste disposal 2days hon 8/30/10
LN Framing S days Wed 3/1/10
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= Drwall 1335 days  Thu 8/16/10 - =
m 4 L] d
Ready | 2 Hew Tasks ; Auto Scheduled | IEE=ES! )

Acronym Soup: BCWP,
ACWP, EAC, and CU

In any view, you can insert several columns of data to give you some calcu-
lated analyses of what’s going on in your project budget. You also can find
this information in the Earned Value report. Chapter 16 gives you the low-
down on reporting. Much of this data will mean more to an accountant than
to most in-the-trenches project managers. If only to make your accountant
feel more comfortable, you should become familiar with some of the most
common calculations. Also, many organizations require information on these
specific numbers in project reports:

v EV- Earned Value, formerly known as BCWP (budgeted cost of work
performed): Earned value is essentially a calculation of the value of the
work that you've completed expressed in dollars. For example, if a task
has $2,000 of costs associated with it and you record that the task is 50
percent complete, the earned value for that task is $1,000 (50 percent of
the baseline estimated costs).

1 ACWP (actual cost of work performed): This calculation looks at actual
costs, including tracked resource hours or units expended on the task

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 14: A Project with a View: Observing Progress 28 7

plus fixed costs. Whereas earned value looks at the baseline value of
work, ACWP looks at actual tracked costs.

v EAC (estimate at completion): This is a total of all costs on a task. For a
task in progress, EAC calculates the actual costs recorded to date plus
the remaining baseline estimated costs.

v CV (cost variance): This represents the difference between planned costs
(that is, costs included in the baseline for a task) and the combination of
actual costs recorded to date plus any remaining estimated costs. This
number is expressed as a negative number if you're under budget and as
a positive number if you're like the rest of us (over budget).

Studying these numbers can help you see what it has cost to get where you
are today on your project.

Calculations behind the Scenes

A\

While you’re happily entering resource hours and fixed costs into your proj-
ect, Project is busy making calculations that can shift around task timing and
resource workload in your plan. These calculations relate to how tasks are
updated, how the critical path is determined, and how earned value is calcu-
lated. If you're a control freak, you’ll be happy to know that you can, to some
extent, control how Project goes about making these calculations.

Remember that the new Change Highlighting feature helps you see what effect
an individual change has on your project. See Chapter 10 for more about this
feature.

Going automatic or manual

By default, Project is on automatic as far as calculations go. When you make
a change to your plan, Project recalculates totals, the critical path, and so on
without you having to lift a finger. However, you can change that default set-
ting and have Project wait for you to initiate calculations manually. You do so
in the Project Options dialog box (File=>Options), in the Schedule category.
Figure 14-10 shows some of the settings available there.

If you change the Calculate Project After Each Edit setting to Off, you must
click the Calculate Project button in the Schedule group on the Project tab of
the Ribbon anytime you want Project to perform all its calculations. You also
have the choice here of setting different modes for only the current project
or for all open projects.
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Figure 14-10:
Click the Off
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So why would you choose to use manual calculation? You may want to make
a lot of changes and not have Project take the milliseconds required to recal-
culate between each change, slowing your entry work. You can put things on
manual, make all your changes, and then use the Calculate Project button to
make all the changes at once.

In addition, because even with Change Highlighting on, it’s not always easy
to spot all the items that have been recalculated when you make a series of
changes, it may be easier to make all the changes in manual mode, print your
Gantt Chart view, and then recalculate and compare the two. This approach
shows you the cumulative calculations that occurred when all your changes
were made so that you can see whether you're happy with the revised plan.
(This feature is especially useful for trying out what-if scenarios.)

In Project 2010, you can also take advantage of the Multiple Undo feature. This
means that you can leave your calculations on automatic, make changes, and
then undo them, thereby undoing the calculations in sequence. For more on
Multiple Undo, see Chapter 10.

Earned-value options

You’ve probably spent many sleepless nights wondering, “What do the set-
tings I can make to the earned-value calculation do to my project?” Well, start
by looking at Figure 14-11, which shows you the earned value calculation set-
tings in the Advanced category of the Project Options dialog box.
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Figure 14-11:
Here are
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value.
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The Default Task Earned Value Method setting provides two choices:

v % Complete: This setting calculates earned value using the percent com-
plete that you record on each task. This assumes that for a task that’s
halfway complete, half the work hours have been used.

1 Physical % Complete: Use this setting if you want to enter a percent of
completion that is not based on a straight percent-complete calculation.
For example, if you have a four-week task to complete a mail survey,

50 percent of the effort may happen in the first 25 percent of the dura-
tion of the project: designing, printing, and mailing the survey. Nothing
happens for two weeks while you wait for responses, and then you see
a flurry of activity when the responses come back. So a straight calcu-
lation that 50 percent of the task is completed 50 percent of the way
through wouldn’t be accurate. If your projects have a lot of tasks like
this, you may consider changing your settings to use this method. Then,
you can display the Physical % Complete column in your Gantt Chart
sheet and enter what you consider more accurate percent-complete
information for each task.

The second setting in the Earned Value Options for the Project section of

the Project Options dialog box is the Baseline for Earned Value Calculation
drop-down list. As | mention earlier, earned value is the value of work com-
pleted, expressed in dollars, according to the baseline: A $2,000 task at 50
percent complete (for example) has a $1,000 earned value of work performed.
Therefore, the baseline against which you calculate this value is hugely
important. Choose any of the 11 possible baselines you may have saved in
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your project here. After you make these two choices, click OK to close the
Project Options dialog box.

You should explore one more option in the Project Options dialog box that
concerns earned value calculation. The Edits to Total Task % Complete Will
Be Spread to the Status Date check box, which is not selected by default,
affects how Project distributes changes in your schedule. If this option is left
deselected, calculations go to the end of the duration of tasks in progress,
rather than up to the status date or the current date. If you do select this
option, calculations spread changes across your plan up to the status date or
the current date, and no farther. Selecting this choice helps you see changes
to your project in increments of time, rather than across the life of tasks in
progress.

If I were you, I'd leave the Edits to Total Task % option deselected for the most
accurate reflection of progress on your project.

How many critical paths are enough?

Three last Project Options settings that you may want to examine concern
critical path calculations.

The Inserted Projects Are Calculated Like Summary Tasks option, near the
bottom of the Schedule category, is straightforward. If you insert another
project as a task in your project, selecting this setting allows Project to
calculate one critical path for your entire project. If you don’t select it, any
projects you insert are treated like outsiders — that is, they’re not taken into
account in the master project’s critical-path calculations. If an inserted proj-
ect won’t have an effect on your project’s timing, you may want to deselect
this option.

If following one project’s critical path is too tame for you, try getting critical
with multiple paths. By selecting the Calculate Multiple Critical Paths check
box, near the bottom of the Advanced category, you set up Project to calcu-
late a different critical path for each set of tasks in your project. Doing so can
be helpful if you want to identify tasks that if delayed, will cause you to miss
your final project deadline or the goals of a single phase in your project.

Finally, you can establish what puts a task on the critical path by specifying
the number of days of slack critical tasks may have. By default, tasks with no
slack are on the critical path. However, you can change this situation if you
want to be alerted that tasks with only one day of slack are critical — figur-
ing that one day isn’t much padding and that these tasks are still in jeopardy.
The Tasks Are Critical if Slack Is Less Than or Equal to (x) Days setting is
found right below the Calculate Multiple Critical Paths check box in the
Advanced category.
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Chapter 15

You're Behind: Now What?

In This Chapter

Reviewing your plan versions and notes to understand what went wrong

Trying what-if scenarios
Understanding how getting more time or more people can help

Adjusting your timing going forward

n almost every project, there comes a time when you feel like the floor

dropped out from under you. Suddenly — and this one just snuck up on
you — you're $20,000 over budget. Or, you're going to miss that drop-dead
finish date by two weeks. All the aspirin in the world isn’t going to solve
this one.

Of course, you have a general idea of what happened because you're smart,
you kept in touch with your team, and you have Project and all its columns of
data. Still, somehow things are off track, and you need to take action at this
point. First, you have to justify what occurred (abbreviated CYA), and then
you have to fix things so that you can go forward and just maybe save your
project, your job, or both.

How do you save the day when things go off track? What you have to do at
this point involves analyzing your options and making some tough choices.
This is stuff you did before you ever heard of Microsoft Project. However,
Project can help you try some possible solutions and anticipate the likely
results. After you decide what to do, you have to implement your solutions in
Project.

Justifying Yourself: Notes, Baselines,
and Interim Plans

If you've kept interim plans, multiple baselines, and task notes in Project, it’s
much easier to explain how you got into this mess to the powers-that-be.
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Interim plans and multiple baselines demonstrate how you made adjustments
when major changes or problems occurred. Using these two items indicates
to your boss that you were on top of things all the way and probably kept
him or her in the loop by generating printouts or reports reflecting major
changes as they came up. (If you didn’t, print them now from the interim
plans or baselines you saved along the way — and let them paint a picture of
what happened.)

<MBER . . . . . ..
A baseline saves pertinent project data including start and finish dates, dura-

tion, work, and cost; an interim plan saves only the start and finish dates of

tasks in the project. Chapter 12 deals with interim plans and baselines.

To view or print information from various baselines or interim plans, follow
these steps:
1. Display Task Sheet view.

2. Scroll the sheet pane to the right and click the Add New Column
column heading.

The menu with the available fields appears, as shown in Figure 15-1.

% Complete -
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Actual Cost

Actual Duration
Actual Finish

Actual Overtime Cost

m
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Actual Start

Actual Work,
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Flgure 15-1; |passire Estimated Finish
Baseline Estimated Start
|nSe|’t aS | Baseline Finish

Baseline Fixed Cost
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. . Baseline1 Budget Cost
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A ) Baselinel Cost
view Wlth Q |Baselinel Deliverable Finish

Baselinel Deliverable Start

sheet pane. Baseline1 Duration

Baselinel Estimated Duration
EEE— Baselinel Estimated Finish

3. Scroll down, and click the field to insert.

For example, you may choose Start 1-10 and Finish 1-10 for any one of
your interim plans (or choose Baseline through Baseline 10 for baseline
data).
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4. If you need to, repeat Steps 2 and 3 to display additional columns.
Click the OK button to display the column(s).

In addition to interim plans and baselines, task notes should include informa-
tion about resource performance on a task, vendor problems, or late deliv-
eries. Notes that are especially important to add are those you make when
someone in authority over you has asked for a change and okayed more
money or time to make that change. (Don’t worry, this hardly ever happens.)

Multiple Baselines Gantt view by default shows the first three baselines that
you’ve saved — Baseline, Baselinel, and Baseline2. To show this view, click
the Task tab, click the bottom portion of the Gantt Chart button, and click
More Views on the menu. Click Multiple Baselines Gantt in the Views list of the
More Views dialog box, and then click the Apply button.

To add a note to a task, either display the Notes column in a task sheet
pane or double-click a task and add the note on the Notes tab of the Task
Information dialog box.

What 1f?
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Just as you can get too close to a problem to see a solution, you can get too
close to your project to recognize what you need to do. With Project’s filter-
ing and sorting features, though, you can slice and dice various aspects of
your project a little differently to get a fresh perspective.

You can also use tools such as resource leveling to solve resource conflicts.
Resource leveling may not always solve problems to your taste, but it’s a
good way to let Project show you one what-if scenario that can solve most
resource problems instantly.

See Chapter 10 for more information about how to use resource leveling.

Sorting things out

Sometimes when things won’t sort themselves out, it’s time to sort your
tasks. Project allows you to sort tasks by several criteria, including start date,
finish date, priority, and cost.

How can sorting help you? Well, here are a few examples:
1 To cut costs: Consider sorting tasks by cost. Then you can focus on the

most expensive tasks first to see whether there’s room to trim nice-to-
have-but-pricey items.
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1 To delete tasks to save time: Display tasks by priority, and then look at
the low-priority tasks as the first candidates for the waste bin.

v To review task timing: Sort by duration in descending order to see the
longest tasks first.

If you want to apply a preset sorting order, simply choose View=>Sort and
then choose an option from the submenu, such as By Start Date or By Cost.

If you want to see additional sort criteria — or sort by more than one crite-
rion — follow these steps:

1. Choose Viewr>Sort~>Sort By.

The Sort dialog box appears, as shown in Figure 15-2.

Sort =
- ascendn
Figure 15-2 - Qescendiig ILEEII
Sortby up | henby Reset
~ @ Ascendin
150 thre.e De;cegdiig &I
criteriain | .
ascending + @ ascendng
or descend- B
|ng Order Permanently renumber tasks
| Keep outline structure

2. In the Sort By list, select a criterion.

3. Select either Ascending (to sort from lowest to highest) or Descending
(to sort from highest to lowest).

With a date field, the sorting order would be soonest to latest and latest
to soonest, respectively; with a text field, alphabetical would be the
order.

4. (Optional) If you want a second criterion, click the first Then By box
and make a selection.

For example, if you choose to sort first by Cost and then by Type, tasks
are sorted from least expensive to most expensive, and then (within
each cost level) by type (Fixed Duration, Fixed Units, and Fixed Work).

5. (Optional) If you want to add a third criterion, click the second Then
By box and make a selection.

6. Click the Sort button.

To return to your original task order, choose View=>Sorte>By ID. Tasks are now
back in fask ID number order, which is Project’s standard sorting criterion.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 15: You're Behind: Now What? 295

<MBER
S

\\J

Filtering

Chapter 10 deals with how you create and apply filters in Project. Now is a
good time to call on your knowledge of those features. Especially in larger
projects, where it’s not always easy to scan hundreds of tasks and notice
which ones are running late or over budget, filters can home in on exactly
where your trouble lies.

You can choose to have tasks that don’t meet filter criteria removed from
your display or simply highlight tasks that meet the criteria on-screen.

Table 15-1 lists some filters that are useful when you’re trying to identify and
solve problems with your schedule. The first six filters are task filters. The
rest are resource filters.

Table 15-1 Filters to Isolate Problems

Filter Name What It Displays

Critical Tasks in the project that must be completed according to
schedule to make your final deadline (critical path)

Cost Overbudget Tasks that exceed budgeted expenditures

Incomplete Tasks Tasks that haven’t been marked as complete

Late/Overbudget Tasks assigned to a resource that you specify that are run-

Tasks Assigned To ning later than their baseline estimate and are over budget

Should Start By Tasks that should have started as of a specified date

Slipped/Late Tasks that are running late and have no progress recorded

Progress

Overallocated
Resources

Tasks with resources assigned that are overbooked at some
point during the life of the task

Slipping
Assignments

Tasks that involve resource work that should have begun
by now

Work Incomplete

Tasks that should have had all their work recorded by now

Work Overbudget

More work hours have been put in on the task than you had
estimated

Don’t see all these choices in the More Filters dialog box? Remember, when
you use this dialog box (choose Viewr>Filtered For=>More Filters), you have
to enable the Task option to see task-related filters and the Resource option
to see resource-related filters.

You may also consider exporting your Project information to a program such
as Excel so that you can use analysis tools, such as pivot tables, to figure out
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Figure 15-3:
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what’s going on. If that idea excites you, you may want to check out Excel
2007 Data Analysis For Dummies, by Stephen Nelson (published by Wiley). The
Save As Type drop-down list at the bottom of the Project Save As dialog box
enables you to choose the export format.

Examining the critical path

One of the most useful filters is the one called Critical. This displays or highlights
all tasks that are on the critical path. If you're running late, knowing which tasks
can’t slip helps you identify where there is no room for delay — and, conversely,
where you can delay noncritical tasks and still meet your deadline. You may use
the Critical filter to help you determine how to free overallocated resources or
get a task that’s running late back on track.

You can also ensure that the Gantt chart shows the Gantt bars for critical tasks
in red. To do so, click the Gantt Chart Tools Format tab on the Ribbon and make
sure that the Critical Tasks option is selected in the Bar Styles group.

You can look at the critical path in any Gantt Chart or Network Diagram view.
Figure 15-3 shows Gantt Chart view of a project with the critical path high-
lighted using a highlight filter. Figure 15-4 shows Network Diagram view with
the same filter applied.
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If you need a closer look at task timing, consider modifying the timescale dis-

play to use smaller increments of time, such as days or hours. To do so, right-
click the timescale itself and then choose Timescale.

Use resource leveling one more time

If you performed manual resource leveling earlier in your project to solve
resource conflicts, consider trying it again. With changes to tasks and

tracked activity, resource leveling may give you some new options to solve

conflicts.

If resource leveling is set to Automatic, Project automatically performs this
calculation every time you modify your schedule. To see whether this is set

to Automatic or Manual, choose ResourcerLeveling Options to open the
Resource Leveling dialog box, as shown in Figure 15-5. If the Manual radio
button is selected, click the Level All button to run resource leveling.
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What's driving the timing of this task?

The Task Inspector feature allows you to review what is causing tasks to

fall in a certain time frame, such as dependencies, a task calendar, or task
constraints. You simply select a task and then click the Inspect button in the
Tasks group of the Task tab, which displays a pane that lists all factors that
affect the timing of that task.

By using this feature, which you can read more about in Chapter 10, you
can determine whether a task that you’d like to happen earlier could do

so if you remove some dependency or constraint affecting it. For example,
early in your planning, you may have thought that the training task couldn’t
start until all the equipment was delivered, but now that half the equipment
is here, you realize that you could start the training now and complete it
later. By understanding what is driving the timing of the task, you can better
search for a solution if that timing is causing problems.

How Adding People or Time
Affects Vour Project

It’s part of corporate human nature to want to throw money and people

at problems; in some cases, that instinct is on target. However, you don’t
always have the ability to draw on endless supplies of resources or an end-
less amount of time to play with. Because of this, you may have to play
around with a combination of options that involve time and resources.
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Hurry up!

Saving time in Project means doing things faster or adjusting the timing of
things to use up slack. You are likely to find that making this adjustment is
like an intricate puzzle: Correct one thing, and something else pops up to
cause you aggravation.

To accomplish work faster, you have two options:

” Get more people to help with tasks that are autoscheduled. Adding
people adds money, so you may get back on track time-wise — but it will
cost you.

1 Modify the scope of tasks. Modifying the scope of the task may have an
effect on its quality. If you do two inspections instead of three or you
shorten your QA cycle by a week, you may run the risk of other types of
problems down the road.

Changing the timing of tasks and shifting dependencies use up slack to make
up for delays but may leave you with no wiggle room. The next time a prob-
lem comes up, you'll be up against the wall with no slack to save you.

In reality, combining small modifications for both time and money is often
what helps you save the day.

Throwing people at the problem

With effort-driven autoscheduled tasks, things get accomplished when the
specified amount of effort is expended. So, a task with a duration of 3 days
based on the Standard calendar requires 3 days x 8 hours per day to be com-
pleted (a total of 24 hours of effort). One resource performing this task work-
ing full time takes three days to complete it; three resources working full time
take one day to complete 24 hours of work. When you add resources to such
a task, Project automatically recalculates its duration.

If you want Project to reduce the duration of a task when you assign more
work resources to it, the task must be autoscheduled and have effort-driven
scheduling turned on, as well.

Changing how resources are assigned

Beyond simply adding resources to a task, you can also make modifications
to existing assignments. On any given project, you may have dozens (or
even hundreds) of resources working on tasks. All those people are working
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according to their working calendars, the percentage of resource time you
assigned to particular tasks, and their ability to do the job. Take a look at
how you assigned folks to begin with to see whether you could save some
time or money by modifying those assignments.

You can modify assignments in several ways:

v~ If someone is working at, say, only 50 percent capacity on a task, con-
sider upping the person’s assignment units.

v If you have someone available who could perform a given task more
quickly, switch resources on a task and then shorten its duration.
Remember, the new Team Planner view can be helpful when making
these types of switches.

v Consider having some people work overtime or be overbooked at vari-
ous points during the project. You may have modified an overbooked
resource’s assignments earlier to get rid of a conflict, but now you find
that there’s no choice but to have the resource work that occasional 12-
or 14-hour day!

Remembering the consequences

Before you get carried away making changes to resources, think a minute.
Adding resources to effort-driven autoscheduled tasks can shrink them, help-
ing your project get back on track. However, depending on the resources’
hourly rates, this approach may cost you more.

Remember that three people working on a task won’t necessarily geometri-
cally shrink the duration of the task. That’s because three people have to
coordinate their efforts, hold meetings, and generally do the things people
do when they interact that make their work a tad less efficient than when
they work alone. If you add resources, Project shrinks the task geometrically:
Consider going in and adding a little time to the task to accommodate the
inefficiencies of multiple resources.

The other concern about adding resources to tasks is that it could cause
more resource conflicts, with already-busy people getting overbooked on too
many tasks that happen in the same time frame. If you have the resources
and they have the skills and the time, though, beefing up the workforce is
definitely one way to perform some tasks more quickly.
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To add resources to a task, you can use the Resources tab in the Task
Information dialog box or choose the task and click the Assign Resources
button on the Resource tab of the Ribbon.

Shifting dependencies and task timing

Time is a project manager’s greatest enemy. There’s never enough time, and
what time there is gets eaten up like a bag of chips in a room full of hungry
Little Leaguers.

Here are some ways you can modify task timing to save time:

v Delete a task. You heard me. If a task represents a step that could be
skipped and there’s no actual work tracked for it, just get rid of it. This
doesn’t happen often, but sometimes — on rethinking your project — you
realize that a few things aren’t necessary or have already been handled by
someone else. If you're using Project Professional, you also can mark the
task as inactive.

v Adjust dependencies. Couldn’t the revision of the manual start a few
days before all the feedback comes back? Could the electrical and
plumbing go on at the same time instead of one after the other (assum-
ing that the electrician and the plumber can stay out of each other’s
way)? Use the Predecessors tab of the Task Information dialog box
shown in Figure 15-6 to modify dependencies. In the Lag column, you
can enter a negative number to allow tasks to overlap.

Task Information ==
General  Predecessors Resources| Advanced.\ Notes | Custorn Fields |
Mame: | Exterior landscaping Duration: | 2.2 wks | Estimated
Predacessors:
23 -
) (] Task Name Type Lag
mvvaste disposal Finish-to-Skart (FS) 20
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1 Modify constraints. Perhaps you set a task to start no earlier than the

first of the year because you don’t want to spend money on it until the
new fiscal year budget kicks in. To save time, consider whether you
could allow it to start a week before the end of the year but bill the costs
in January. Examine any constraints such as this — specifically, those
created to verify the timing logic.

1 Check external dependencies. If you've created an external link to a

task in another project and set dependencies with tasks in your proj-
ect, check with the other project manager to see whether he or she can
hurry up some tasks. Or, if the timing relationship isn’t absolutely criti-
cal, delete the link to the other project. It could be slowing you down
more than you realize.

1 Change the scheduling method or move the task. Remember that

Project usually cannot automatically reschedule a task based on depen-
dency changes if the task is manually scheduled. You can either change
the task to be autoscheduled using the Auto Schedule button in the
Tasks group of the Task tab on the Ribbon, or you can select a manually
scheduled task and then click the Respect Links button in the Schedule
group of the Task tab to move it to its proper time frame. Or, you can
use the Move drop-down list on the Task tab to reschedule a task to a
particular earlier or future time, or to a time when resources are
available.

If you've set resource leveling to automatic, Project may have delayed some
tasks until overbooked resources are freed up. Choose Resourcer>Leveling
Options and change the setting to Manual.

When All Else Fails
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Okay. You've monkeyed with resource assignments and shifted task depen-
dencies around to save time, and deleted tasks and assigned cheaper work-
ers to save money. Still, it’s not enough. This is the scenario where you have
to say to your boss, “You can have it on time, you can have it on budget, or
you can have quality work: Choose two.”

If your boss throws money at you, go ahead and add resources to tasks, as
discussed in the earlier section “Throwing people at the problem.” If she opts
for time or quality, read on.
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All the time in the world

If your boss is willing to give you more time, grab it. When you do, you have
to update your project in a few ways:

v~ Add to slack. If you have a Slack task, you can simply add to its dura-
tion, giving more waffle room to all other tasks. (See Chapter 10 for more
about slack.)

v Modify task durations. Take tasks that are running late and give them
more time to be accomplished. In Project, this means increasing their
durations or pushing out their start dates to a later time.

1 Review your task constraints. If you specified that some tasks couldn’t
finish any later than a certain date but now you’re moving your project
finish date out three months, you may be able to remove or adjust those
original constraints accordingly.

After you work in the extra time provided to you, make sure that the new
timing of tasks doesn’t cause new resource conflicts, review Resource Graph
view, and then reset your baseline to reflect the new schedule. You reset

a baseline by choosing Projecte>Set Baseliner>Set Baseline. When asked
whether you’re sure that you want to overwrite the existing baseline, reply
Yes. Or, choose Baseline 1-10 in the Save Baseline dialog box to save to a dif-
ferent baseline and preserve the original.

Don’t forget to inform your team members of the new timing and provide them
with an updated version of your plan. You can do that easily using Project
Web App, which I discuss in Chapters 18 and 19.

And now for something
completely different

If your manager tells you to cut some corners and sacrifice quality, you have
license to modify the scope of the project. You can cut out some tasks that
may ensure higher quality, such as a final proofreading of the employee
manual. You can hire cheaper workers. You can use cheaper paper or com-
puter equipment.

In Project, this means you have to do the following:
1~ Take less steps: Delete tasks. (Click the ID of the task in Gantt Chart

view and click Delete.) You also can mark the task as inactive in Project
Professional.
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Figure 15-7:
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1 Use less expensive resources: Delete one set of resource assignments
and assign other resources to tasks in the Assign Resources dialog box.

1 Use less expensive materials: Change the unit price for material
resources you've created in Resource Sheet view, as shown in Figure
15-7. Or, shop around for better pricing on items that are set up as cost
resources, and enter the lower prices for tasks to which you’ve assigned
those resources using the Cost column of the Assign Resources dialog
box, as shown in Figure 15-8.

You can also take a more sweeping approach: Just redefine the goal of the
project. If your goal was to launch a new product line, perhaps you can
modify your goal to simply manage the design of the new product and then
leave the launch to a later date or another project manager. If you were sup-
posed to produce 10,000 widgets, could your company get along with 7,500?
To make such changes, you may have to slice and dice entire phases of your
project — or even start from scratch and build a new plan.
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Architect wiark A External 100%  $100.00/hr 20.00/hr 40,00 Prorated standa
General Contractor  Work s External 100%  S0.00/hr  S0.00/hr $0.00 Prorated  Standa
Site Manager work s External 100%  $40.00/hr  50.00/hr S0.00 Prorated  Standa
Framers work F External 400% 320000/ $0.00/hr 2000 Prorsted  Standa
Electricians wiork E External 300%  $40.00/hr S0.00/hr $0.00 Prorated  Standa
Plumbers work [ External 300%  SS000/hr S0.007hr S0.00 Prorated  Standa
Drywallers work [} External 300%  $1S00/hr S0.00hr $0.00 Prorated  standa
Finish Carpenters  Work F External 200%  $40.00/hr  S0.007hr S0.00 Prorated  Standas
Painters work [ External 400%  S1S00/hr S0.007hr S0.00 Prorated  Standa
Labor work L External 100%  s10.00/hr S0.00hr $0.00 Prorated  standa
Permit Cost F Expense Frorated
Materials Cost [ Expense Prorated
Blueprints WMaterial Blueprint Pages B Expense | s15.00] $0.00 Prorated
—
d
Ready | 2, Mew Tasks : Auta Scheduled | | = mEE|
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Figure 15-8:
Use the
Assign
Resources
dialog box
to modify
the assign-
ment cost
for a cost
resource.
|
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Assign Resources

Task: Order materials
|T| Resource list options

Resources From Mew Fitness Center Location Remodel Plan Location 1 Tr...

Ex)

Hold dowen Cerl and click ko select mulkiple resources

$93,000.00 - Assign
Resource Mame RO Iniks Cosk
' |General Contractor 100%:  :40.00 | Remave
v |Materials +95,000,00 |
v |Project Assistant 1 100%  i4560.00 Feplace...
v Project Manager 1 100%: i$1,120.00
Architeck @raph
Blueprints
“Er | Close
Drwwallers | el
Electricians 2°p
Finish Carpenters 5

Consider saving your revised project plan with a new name to give you a head
start. Clear the baseline (choose Project=>Set Baseline~>Clear Baseline), make
your modifications, and then save a new baseline.

What Does Project Have
to Say about This?

One final word of caution: When you take certain steps, such as deleting
tasks or modifying dependency relationships, your action may just cause
Project to alert you to a potential problem you hadn’t thought of. If that hap-
pens, Project shows you a Planning Wizard dialog box like the one shown in
Figure 15-9. If you make changes on your own instead of using the Planning
Wizard, you may be more apt to back yourself into a problem situation.
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|
Figure 15-9:
Here the

wizard Planning Wizard ==
wants to be ‘Construction’ is a summary task, Deleting it will delete allits subtasks as well,

sure that | voucan:

you knOW @ Lonbinue, Delete 'Construction’ and its subtasks.:
that deleting Cancel. Don't delete any tasks.
a summary Ok ] ‘ Cancel ‘ | Help
Don't tell me about this again,

task takes

all its sub-
tasks with it.
|

These dialog boxes offer you options — typically to go ahead and proceed, to
cancel, or to proceed but with some modification. Read these alerts carefully
and consider the pros and cons of what will happen if you proceed.
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Chapter 16
Spreading the News: Reporting

In This Chapter

Generating standard reports

Creating custom reports

Dazzling people with Visual Reports
Using graphics and formatting in reports
Making printer settings

Sharing a snapshot of the Timeline
Using enhanced copy and paste

’{ere it is. The big payoff. The reward you get for inputting all those task
names, entering all those resource hourly rates, and tracking activity
on dozens of tasks during those late-hour sessions in the first hectic weeks of
your project. You finally get to print a report or other data, getting something
tangible out of Project that you can hand out at meetings and use to impress
your boss.

Reports help you communicate about your project, conveying information
about the schedule, resource assignments, how costs are accumulating, and
what activities are in progress or coming up soon. You can take advantage
of built-in reports or customize those reports to include the data that’s most
relevant to you. Project 2010 includes Visual Reports, which offers graphic
possibilities to help paint a picture of your progress. Other features, such

as the ability to customize and copy Timeline view and other features in the
project, enable you to incorporate Project data in reports in other programs.

Knowing that you’ll want to impress people, Project also makes it possible to

apply certain formatting settings to reports and to add drawings to help get
your point across.
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Off the Rack: Standard Reports

\\3

Figure 16-1:
From the
Overview
category,
you can
choose

one of five
reports.
|

Standard reports are already designed for you, offering a lot of choices
regarding the information you can include. You don’t have to do much more
than click a few buttons to generate them. Essentially, you select a category
of report, choose a specific report, and print it. If the plain-vanilla version of a
report isn’t quite right, you can modify standard reports in a variety of ways.

You can also print any view in Project; just display the view and click the Print
button. The entire project is printed in whatever view you have on-screen at
the time. Or, you can choose File>Print. In the Print dialog box that appears,
you can choose to print only certain pages of your project or only a specific
date range from the timescale. Any filters or grouping that you've applied
shows in the printed document.

What's available

Project has five categories of standard reports: Overview, Current, Costs,
Assignments, and Workload. Each category contains several predesigned
reports (as you can see in the Overview Reports dialog box, shown in Figure
16-1), for a total of 22 standard reports.

Overview Reports ==

Edit...

i

Close

Project Summary Top-Level Tasks Critical Tasks

Milestones Working Days

Standard reports vary in content, format (for example, a table versus a
columnar report), and sometimes page orientation (landscape or portrait).
You can edit each report to change its name, the time period it covers, the
table of information that it’s based on, and filters applied to it. You can also
sort information as you generate the report and add formatting, such as bor-
ders or gridlines.
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A\

|
Figure 16-2:
Choose a
report style
here.
|

Going with the standard

Any of the standard reports are simplicity itself. You could practically create
one in your sleep.

Better yet, you could create a macro to generate your reports with a single-
keystroke shortcut (read more about macros in Chapter 17).

Follow these steps to generate any standard report:

1. Choose Project=>Reports.

The Reports dialog box appears, as shown in Figure 16-2. All five catego-
ries of reports, plus a custom report category, are accessible through
the Reports dialog box.

Reports ==l

LN SRR, E ]
= - '§ Close

CvErview, . Current Zosts.,.

2

Assignments. ., workload. .. Custom,..

—
&7

2. Click the category of standard report you want, and then click the
Select button.

A dialog box named after the category of report you selected appears
(refer to Figure 16-1).

3. Click one of the standard reports shown here, and then click the
Select button.

A preview of the report, like the one of Unstarted Tasks shown in Figure
16-3, appears on Backstage view.

4. To print, click the large Print button above the print options in the
center of the window.

You can also click Page Setup to change page settings or use the choices
under Settings to change how your report previews.
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Figure 16-3:
Click the
report
preview to
zoom in so
that you

can read its
details.
|

\NG/
Vg,“

] AL 5|  Mew Finess Center Location Remodel Plan Location 1 Tracked - Microsoft Project B
Task Resaurce Project Wigwy Farmat O

I save

Print
(B save as =
) Copies: |1 =
[ Open Print
[ Close
Info Printer
/ HP Laserlet 4100 Series PCLE -

Becent WD ready
o Printer Properties

Setfings

Share

Print Enter Project

Print the project fram start to finish

Dates:  7/1/2010 > To: 10/28/2010 -

Help

Pages: 1 LT 4 =

21 options

4 Esit

5 Landscape Orientstion -

J Letter -
8.5"x11"

Page Setup

4 rows Leolumn

(&)@

Clicking another tab returns you to the previous view. You have to start all
over again if you do this.

When you click Print, an additional dialog box appears for some reports,
asking for a date range or other data specific to that report.

A standard report, with a twist

Some people are happy with the cookie-cutter standard reports that Project
provides; others like to add their own spin to their reports. That’s okay
because even though standard reports are prebuilt, you can still get under
the hood and tinker a little.

You can edit three categories of modifications for a standard report:

v Definition: This includes the report name, the time period, the table
of information, any filters applied, and whether summary tasks should
appear.

v Details: Details can be included for tasks (such as notes or predeces-
sors) and for resource assignments (such as notes or cost). You can also
choose to show totals and add a border around the report or gridlines
between details.
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v Sort: You can sort by up to three criteria in ascending or descending
order.

When modifying standard reports to create a custom report, you’ll encoun-
ter some variations. For example, when you try to edit a Project Summary
report, all you get is a text formatting dialog box. However, the majority of
reports are edited through one dialog box, as shown in the procedure that
follows.

To edit a standard report, follow these steps:

1. Choose Project->Reports.
The Reports dialog box appears.
2. Click Custom and then click Select.
3. Click a specific report and then click Copy.

Depending on the type of report you chose, the Resource Report, Task
Report, or Crosstab Report dialog box appears. The settings in these
dialog boxes are the same except for some default choices (for example,
which filter is applied). Figure 16-4 shows a Task Report dialog box.

Task Report ==
Definition | Details | sort |
Mame: Copy of Top Level Tasks
Period: Entire Project - Cancel
1 Text...
|
F' Table: Summary -
igure 16-4:
gu e 6 Eilcer: Top Level Tasks - Highlight Help
You can
V| Show summary tasks
make three ray bands
tabs’ worth
of settings.
|

4. Click the Definition tab, if it’s not already displayed, and make your
selections:

a. Select the contents of the Name field and type a name for the new
report.

b. In the Period box, choose the period of time you want the report to
reflect.

If you choose an increment of time from the Period field, such as
week (rather than choosing Entire Project), you can set the Count
counter to reflect the number of increments. For example, you
may set Count to 3 for three weeks, which provides a report on the
project covering data in three-week increments.
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Figure 16-5:
Some

of these
options may
be selected
already,
depending
on the
standard
report
you're
editing.
|

c. If you'd like a different table of information to be included, make a
choice from the Table field.

If you don’t change this setting, the table currently displayed in the
project is used.

d. If you want to apply a filter to tasks, choose one from the Filter field.

To highlight tasks that match the filter’s criteria, rather than
simply exclude those tasks that don’t meet the criteria from the
report, select the Highlight check box.

5. Click the Details tab (as shown in Figure 16-5) and make your
selections:

a. Select various check boxes to include different types of information,
such as task notes or resource assignment costs.

b. If you want a border around these elements, select the Border around
Details check box.

c. If you want gridlines in the report, select the Gridlines between
Details check box.

This gives your report more of the appearance of a table.

d. To include totals of dollar amounts or hours, select Show Totals. If
you use a currency other than dollars, you can set that by choosing
Tools=>Options and setting the currency on the View tab.

Task.
V| Motes
Obijects

Assignment

i §

Motes
Schedule
Cost
Wwork.

Cancel

Text...

Predecessors

]

SuCcessors

Border around details
Gridines between details

Shaw totals

6. Click the Sort tab and make your selections:

a. In the Sort By field, click a sort criterion, and then select either
Ascending or Descending to choose a sort order.

b. If you want to sort by additional criteria, repeat Step 6a with the Then
By boxes.
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7. Click the OK button to save your settings.

8. In the Reports dialog box, click the Select button to generate the
e\gN\BEB report preview.
&
You can find more details about sorting in Chapter 15.

Crosstabs: A different animal

Crosstab reports present slightly different settings when you edit them.
Figure 16-6 shows the Definition tab of the Crosstab Report dialog box. A
crosstab report tabulates a unique piece of data relative to column and row
definitions. Essentially, the cell formed by the column and row intersection
represents the unique data.

Crosstab Report
Definition |Deta\|s | Sart ‘

! §

I Mame: Copy of Who Does What When oK

Figure 16-6:
Here you | FRow
have to Resources  ~
choose V| and kask assignments Help
whichthree | gier Resources- work | Elhighic
elements
define the
crosstab.
|

Crosstah Cancel

[

Column: 1 || Days -

]

Text..

Work -

]

For example, you may have columns that list days and rows that list
resources. The piece of information where the column and row intersects is
resource work on a particular day. The report shows the hours of work by
each resource day by day.

When you edit a crosstab, you define the column, the row, and the piece of
data being compared. On the Details tab of the Crosstab Report dialog box,
you can make settings such as whether to include row or column totals, to
insert gridlines, and to display values of 0.

A Custom Job

Not impressed with the standard reports? Or perhaps none of those reports
quite fits your information needs? That’s okay. You can create as many
custom reports as your heart desires.
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A custom report starts with a report type, which can be task, resource,
monthly calendar, or crosstab. After you choose that basic category, you
simply work with the same Reports dialog box that you use to edit a standard
report.

Follow these steps to create a custom report:

1. Choose Project->Reports.
The Reports dialog box appears.
2. Click the Custom category and then click Select.

The Custom Reports dialog box appears, as shown in Figure 16-7. You
have two options: Edit an existing report or create a new custom report.

|
- Custom Reports ==
Figure 16-7: ‘
Reports:
The Custom Base Calendar S New,..
Reports | cahflow L
el o = [
Critical Tasks
'alog box: | ey 1o

lets you Earned value

. Milestones Organizer. ..
start W|th an Overallocated Resources

.. Overbudget Resources
EXIStIng set Overbudget Tasks =
of data.

‘ Preview ‘| Setup... |[ Print ]

Cancel

3. Decide whether you want to base your custom report on an existing
report or create a new report, and proceed accordingly:

a. If you want to base your custom report on an existing report: Choose
areport in the Reports list and then click the Copy button.

b. If you want to create a report that’s not based on any other report:
Click the New button, click one of the categories in the dialog box
that appears, and then click the OK button.

4. In the Report dialog box, make choices to define your new report and
then click the OK button.

The choices in this dialog box are discussed in detail in the section “A

NG/ standard report, with a twist,” earlier in this chapter.
@‘“\ !

If you create a custom report based on an existing report, be sure to give it a
unique name.
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Get a New Perspective on
Data with Uisual Reports

If you just love the capabilities that PivotTable reports in Excel and Visio
offer, you’ll be glad to know that the same capability has come to Project
2010 in the form of Visual Reports. Pivot tables allow you to view data from a
variety of perspectives beyond the Project standard report capabilities. Pivot
tables offer perspectives that are especially useful for data analysis.

The Visual Reports feature allows you to select the fields you want to view
and to modify your reports on the fly.

Getting an overview of what's available

Project offers six categories of Visual Reports as well as custom reports that
you can build yourself. Some are based on timephased data (data distributed
over time, such as allocations of resource time or costs), and some aren’t.
The report categories include

v Task Usage: Based on timephased data for tasks, this category of
reports gives you a peek at information such as cash flow and earned
value over time.

1 Resource Usage: Based on timephased resource data, these reports
include cash flow, resource availability, resource costs, and resource
work data.

v Assignment Usage: Also based on timephased data, this category of
reports provides information in areas such as baseline versus actual
costs and baseline versus actual work.

v Task Summary, Resource Summary, and Assignment Summary: These
three categories of reports provide diagram views of a variety of work
and cost data. These three categories are not based on timephased data.

Creating a Visual Report

Generating a Visual Report is simplicity itself: You simply choose a report,
decide whether you want to generate it in Excel or Visio, and view or print
the report.
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Depending on whether you are running the 32-bit or 64-bit version of Office
and Project, you may need to install other software to get visual reports to
work. As of this writing, one add on that is required is the Microsoft SQL
Server 2008 Analysis Services 10.0 OLE DB Provider, a free download from
www.microsoft.com/downloads/en/default.aspx. Visit the Microsoft
Project page at www.office.microsoft.com/project to get more infor-
mation if you hare having trouble using Visual Reports.

<P If you want to customize a Visual Report, you need some knowledge of pivot
tables in Excel or Visio. Because covering pivot tables in those products is
beyond the scope of this book, I heartily recommend Excel 2010 For Dummies
(by Greg Harvey) and Visio 2007 For Dummies (by John Paul Mueller) (both
published by Wiley).

Follow these steps to generate a standard Visual Report:

1. Choose Project=>Visual Reports.
The Visual Reports dialog box appears (see Figure 16-8).

2. Use the check boxes in the Show Report Templates Created In area to
specify whether the dialog box should show reports available in Excel
or Visio.

Visual Reports - Create Report =
Select Template

Show report templates created in:  [] Microsoft Excel V] Microsoft Yisio

‘ Task Summary I Resource Summary I Assignment Surmary ‘
All | Task Usage | Resource Usage I Assignrnent Usage ‘
@Base\me Cost Report @Resuurce i ity Re | pleylemnnlet o |
@Base\ma Report (Metric) IllEJResource Cost Summary W
@Base\ma Report (US) IllEJResource Remaining Wi = Eilom
@J Baseline Work Report @Resource Status Report Manage Template...
@J Budget Cost Report @Resnur(e Status Report Sample
@Budgetwork Report IllEJResnur(e Work Availabi i
@Cash Flow Report @Resnur(e Waork Summar
i cash Flow Report [Metric) K2 Task Status Report [Met

i cash Flow Report (US) 2] Task Status Report US)
E'_chiti(al Tasks Status Report (Metrig)
El_gcriti(al Tasks Status Report (US)
| | @Eamed\'alue Qver Time Report l l

El_g Resource Availability Report (Metric)

Figure 16-8:
. « I v
The Visual
Reports Select level of usage data to include in the report: yweeks -
d | a |og Include report templates from:
box offers adfy..
several cat-
egories of
reports. T S I pe—
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Figure 16-9:
A Visual
Report on
project
baseline
costs.
|

\\3

3. Click a report on the All tab to select it.
4. Click the View button.

The report is generated in the selected application (see Figure 16-9).

FIN® AR RIS adral [Compatibility Mode] - Microsoft Excel = @ =X
Home  Insert  Pagelayout  Formulas Data Review | iew a@o PR
f Page Break Preview P Formuta Bar X‘ ] E,-. ENewWindow spit 1) % 3
13 Custom Views o] = arange A T Hide EE) = =2
Normal Page Gridines [ Headings Zoom  100% Zoomto _ i Save Switch | Macros
Layout B Full Sereen Selection | Do Freeze Panes - I Unhide G workspace Windowse | -
WWorkbook Views Show Zoom Window Macros
- £ | =
-
Weskly Calendar
Baseline Cost Cost Actual Cost
Baseline Cost Report
alues
mBaseline Cost @Cost wActual Cost
350000
300000
250000
200000 -
150000
100000 1
50000 |
o |
New Fitness Center Location Build Plan
R Sl
M 4 v » | Chartl . Assgnment Usage %3 M4l [ »
Ready | |EEE 0% (D) ] ()

You can modify the Visual Reports templates or create your own templates

by using the New Template and Edit Template buttons in the Visual Reports
dialog box. Editing a template allows you to add or remove fields from it.
Creating a new template involves specifying the format (Excel or Visio), choos-
ing the data you want to report on, and selecting the fields to include.

Spiffing Things Up

These days, image is everything. You and your project may be judged to
some extent by how professional your printed information looks. Even if your
project is a million dollars over budget and four months behind, making your
reports or other printouts look good can make delivering bad news easier.
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WING/

To create impressive documents, make sure that you cross the ts of format-
ting text and dot the is of visual design.

Using graphics in Project

Wouldn’t your company logo look spiffy in the header of your report? Or
what about including a picture of the new product box in Gantt Chart view of
your New Product Launch project?

Graphics can add visual information or just plain make your plan look nicer.
You can insert graphics in your project file by using three methods. You can

v+ Cut and paste a graphic from another file. A graphic you cut and paste
essentially can’t be edited by you in Project.

v Insert a link to an existing graphics file. Linking keeps your Project file
smaller.

+* Embed a graphic. Embedding lets you edit the graphic’s contents in
Project, using the tools of an image program such as Paint.

You can’t add graphics willy-nilly, however. You can add graphics in only a
few places: the chart pane of any Gantt Chart view, a task note, a resource
note, or a header, footer, or legend used in reports or printouts of views.

For example, you may put pictures of resources in the resource note field so
that you can remember who’s who. Or you may include a photo of your cor-
porate headquarters in the header of your report.

Remember, graphics swell the size of your Project file like a sponge in a pail
of water. If you're thinking of using a lot of graphics, be sure that they don’t
detract from the main information in your printouts. Or, try linking to them
instead of inserting them in the file.

If you want to insert an existing graphics file in a notes box, follow these
steps:

1. Open the Notes tab of the Task Information or Resource Information
dialog box.
2. Click the Insert Object button.

The Insert Object dialog box (Figure 16-10) or an Insert Picture dialog
box appears.

3. Choose the Create from File option.
4. Click the Browse button to locate the file.
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Figure 16-10:
Browse to
locate a file
on a net-
work or your
hard drive.
|

3

Insert Object ==
e
Cancel

@ Create New:

m| s

Adobe Photoshop Image

Bitrap Image

Microsoft Equation 3.0

Microsoft Excel 97-2003 Worksheet

Create from File:

Microsoft Excel Binary Worksheet
Microsoft Excel Chart
Microsoft Excel Macro-Enabled Worksheet -

Display As Icon

Inserts a new object into wour document,

5. To link to the file, select the Link check box and then click the OK
button.

If you don’t select this option, the object is embedded in your file.
6. To insert the object as an icon, select the Display as Icon check box.

When you display the object as an icon, those viewing your project on a
computer can click the icon to view the picture.

7. Click the OK button.
The image appears in the location you selected in Step 1.

If you want to insert an existing graphics file in a header or footer, follow
these steps:

1. Open the header or footer tab of Page Setup (see the later section
“Working with Page Setup”).
2. Click the Insert Picture button.
The Insert Picture dialog box appears.
3. Navigate to the folder that holds the file to insert.
4. Click the file.
5. Click the Open button.
The image appears in the header or footer.
If you want to insert a new graphic that you create on the fly into a note
instead of inserting an existing graphics file, follow these steps:
1. In the Insert Object dialog box, select the Create New option.

2. From the Object Type list, choose the type of object that you want to
insert.

For example, you might select Bitmap Image or Microsoft Visio Drawing.
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3. If you want to insert the object as an icon, select the Display as Icon

check box.

When you display the object as an icon, those viewing your project on a
computer can click the icon to view the picture.

. Click the OK button.

You see a blank object box, along with tools, similar to the one in Paint
shown in Figure 16-11.

Figure 16-11:
Create a
graphic
here.
|

[=EEs
@
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Calor | Color
1 2
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Edit
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Colars

[i=} 10 1.00 % 1.00 in 100% (=) 1} *)

5.

Use the tools of the program from which you inserted an object to
make, draw, insert, or format the new graphic object.

When you close this window, you go back to your Project file.

You also can place a graphic object from a compatible program on the Gantt
chart. To get it done, follow these steps:

1.
2.

Open or create the graphic in its source program, such as Paint.
Select the entire object.

You can often press Ctrl+A or use a Select All command to select an
entire object.

. Copy the selected graphic by pressing Ctrl+C.
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4. Display the Gantt Chart or Tracking Gantt view in Project, and press
Ctrl+V.

The object is pasted on the chart.
5. Drag the object to the desired location and resize it.

You can use the resizing handles that appear to change the object’s
size or shape. Figure 16-12 shows an example graphic pasted onto the
Tracking Gantt chart.
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Formatting reports

You probably cut your computing teeth by formatting text in word proces-
sors, so formatting reports will be a breeze. You have all the usual formatting
options available to you whenever you generate a report in Project.

As with any other business document, your goal in formatting text should be

readability. Remember, in addition to dealing with neat columns of data, you
also may be dealing with labels of dates or resource names wedged alongside
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task bars in the chart pane. Keep the following points in mind when format-
ting Project text:
v Font: Choose simple sans serif fonts, such as Arial.

If you’re publishing your project on the Web, consider using Verdana,
which is a font created for readability online.

v Color: Will the printout be in color or black and white? Will the use of
too many colors become confusing for the reader? Will certain colors,
such as yellow, be difficult to read?

v~ Font size: Use a font size that is readable, without making it so big that
the task bar labels become too crowded.

v Effects: Avoid text effects that can make some text difficult to read (such
as bold, italic, or underlining). Use such effects only to call attention to a
few elements of your project.

To edit report text, just follow these steps:

1. Choose Project->Reports.
The Reports dialog box appears.
2. Click a report category and then click the Select button.

3. In the Reports category dialog box that appears, click the specific
report that you want to generate.

4. Click the Edit button.

The specific report dialog box opens. With some reports, the Text Styles
dialog box opens at this point because you can change no other settings
in those reports. If this happens, skip Step 5 and proceed with Step 6.

5. Click the Text button.

The Report Text dialog box appears, as shown in Figure 16-13.
6. In the Item to Change box, click the item that you want to format.
7. Make your selections in the Font, Font Style, Size, and Color fields.

8. If you want to format another item, select it in the Item to Change box
and repeat Step 7.

9. When you’re finished, click the OK button.

10. To view the report in preview, click the Select button.
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Call the Printer!

The proof of the report is in the printing, but you should see to several
adjustments before you click that button to print. With Project, it’s not just
margins or page orientation that you need to set (although you do have to
set those, too). You can also put useful information in headers and foot-

ers as well as se

t legends that help your reader understand the many bars,

diamonds, and other graphic elements that many Project views and reports

display.

Working

with Page Setup

The Page Setup dialog box can be used to control printouts of both reports

and any currently displayed Project view. You can get to this dialog box in a
few different ways:

v+ To make settings for printing the current view: Choose File=>Print=

Page Setup.

v To modify the page setup for a report: Select Page Setup from the
Backstage preview of the report. Choose Project=>Reports, double-click
areport category, and then click a specific report. When you click the
Select button to generate a specific report, the print preview appears.
Click the Page Setup link that appears there.

The Page Setup dialog box, as shown in Figure 16-14, contains six tabs. In the
case of reports, all tabs may not be available to you. For example, reports
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don’t contain graphic elements such as task bars, so you can’t set a legend
to appear on them. Also, you have access to the View tab only when you're
printing the currently displayed view.

Page Setup - Unstarted Tasks (7=

.‘Margins | Header | Footer | Legend | view |

Crientation

b,
Portrait @ Landscape

Scaling
| @ Adjust to; 90 | % normal size
Figure 16-14: Firko: |1 !
You can
control
how your
documentis
laid out and
printed.
|

Other

Paper Sige:  Letter -

First page nurmber: Auto

Print Preview, .. Qptions. .. || Print. .. ‘ [ oK ]l Cancel

When size is important

The Page tab contains some basic page settings that determine the orienta-
tion, the paper size, and the way the contents are scaled to fit the page. By
making these settings, you influence how much can fit on each page and how
many pages long your document will be.

Here are the choices you have on this tab (shown in Figure 16-14):

v Portrait or Landscape orientation: No doubt you’'ve dealt with these
before. Portrait is set up like the Mona Lisa with the short edge of the
paper running across the top of the page. Landscape is when the long
edge of the paper runs across the top instead.

v Scaling: You can use the Adjust To or Fit To settings. The Adjust To set-
ting is based on a percentage of the original size. The Fit To setting gives
you some control over scaling to fit to the width of a single page or the
height of a single page.

v Other: This area is a catchall for two options: Paper Size and First Page
Number. All the standard choices for paper size are available in the
Paper Size list, including index cards and envelopes. First Page Number
can be left as Auto (in which case the first page is numbered 1, the
second page is 2, and so on), or you can enter another number there
yourself.
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Keeping things within the margins

I won’t bore you by defining what a margin is. However, I will remind you that
margins serve the dual purpose of controlling how much information can

fit on each page and also creating a border of white space that frames your
document (making it cleaner looking and easier to read).

To set margins using the Page Setup dialog box, follow these steps:

1. Click the Margins tab, which is shown in Figure 16-15.

As you modify margin settings, the preview shows you where they will

appear on your page.

Page Setup - Unstarted Tasks

Fage Marglnsl Header | Faoter | Legend | view |

Left: Right:

07 0,75

Battom: | 0.5 |5 in.

Borders around
Every page
Quter pages

@ Maone

Print Preview. .. Options... || Print. .. ‘ [ QK

] | Cancel

2. Use the arrows to set the Top, Bottom, Left, and Right margins.

Click the up arrow for a wider margin and the down arrow for a nar-

rower margin.

3. If you want a border that represents the margin, use the Borders

Around options.

Here you can choose to print a border on every page, on only outer
pages (prints a border on the first and last pages only — available only
when printing a Network Diagram view), or on none of the pages.

Setting margins to be less than 14 inch (.25") could cause your printed output
to be cut off because printers can only print just so close to the edge of a

page.
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Putting all the right stuff in headers and footers

Throughout the life of a project, you’ll print many versions of your project,
many reports, and many types of information using various tables. Headers

and footers are great features to help you and your readers keep track of all
this information.

You can use the Header (as shown in Figure 16-16) and Footer tabs of the

Page Setup dialog box to set and preview header (top) and footer (bottom)
contents.

Page Setup - Unstarted Tasks
Page | Margins Header‘ Footerl Legend.‘ Wiew |

Preview:

Uta ned T gtz 3z o T 11710008
Mo Pl ez Camer wacanlon Bulkd Fl o

Left Center | Right
&[Report] as of &[Date]
&[Project Title]
&[Manager]

General: Page Mumber - Add

Project fields: % Complete -

add

Print Preview. .. Options. .. || print. .. ‘ [ OK

J |

Cancel

Here are the settings you can make on these tabs:

v Text location: Specify that the text you enter is to appear on the left, at
the center, or to the right of the header or footer by clicking the corre-
sponding tab and then typing the text.

+* Format text: Use the tool buttons, or quickly insert such things as the
page number, the date, or a picture file.

1 Select standard text: Insert additional text by using the General and
Project Fields lists. The General list includes such things as Total Page
Count, Project Title, and Company Name. The Project Fields list includes
all the fields available in Project. You may use these to alert the reader
to key fields to review or the nature of the printout. To add General or
Project Fields items, select them from their respective lists and then
click the Add button to add them to the Left, Center, or Right tab.

After you get familiar with reports, you may discover that some of them omit
header and footer information that you consider important, such as the name
of the resource for whom you’re generating a to-do list. Take advantage of
custom headers and footers whenever you need to fill in that kind of blank.
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Figure 16-17:
The legend
is printed
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the box to
the left of it.
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Working with a legend

A legend acts as a guide to the meanings of various graphic elements, as
shown in Figure 16-17. The Legend tab bears a striking resemblance to the
Header and Footer tabs, except that the legend is generated automatically, so
all you can specify here is the text that fits in the box to the left of the legend.

Page Setup - Tracking Gantt =)
Page | Marginsl Headerl Foater Lagendl Wigw |
Preview:
Left | Center |Right Legend on:
@ Every page
Legend page
MNone
e e — width| 2 =< in,
Al | 28 'a
General: Page Mumber - Add lw/
Project fields: % Complete - Add
Print Preview. .. Options. .. || Prink. .. ‘ [ 0K ]| Cancel ‘

The Legend tab of the Page Setup dialog box has only two settings that differ
from the Header and Footer tabs:

v You can print the legend on every page or on a separate legend page, or
you can decide to not print a legend.
»* You can establish the width of the text area of the legend (the area

where you can insert elements such as the page number or the date).

Unlike a header or footer, where you have to enter something to have any-
thing appear, a legend prints by default. If you don’t want a legend to print,
click this tab and then set the Legend On option to None.

What to print?

If you're printing a currently displayed view, the View tab of the Page Setup
dialog box is available to you, as shown in Figure 16-18.

You can make the following settings here:

v~ Print All Sheet Columns: Prints every sheet column in the view, regard-
less of whether it’s currently visible on-screen. With this option not
selected, only the columns that show in your view will print.

v~ Print First # Columns on All Pages: Allows you to control a specific
number of columns to print.
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Figure 16-18:
This tabis
not avail-
able if
you're print-
ing a report.
|

v+~ Print Notes: Prints every task, resource, and assignment note. These
items are printed on a separate notes page.

v Print Blank Pages: Choose this setting if you want to print blank pages.
For example, use this setting to print a page that represents a time in
your project when no tasks are occurring. If you want a smaller number
of pages in your printout, don’t choose this setting.

v~ Fit Timescale to End of Page: Scales the timescale to allow you to fit
more of your project on the page.

v Print Row Totals for Values within Print Date Range: Adds a column
that contains row totals. Pertains to printouts of Usage views.

v Print Column Totals: Adds a column that contains column totals.
Pertains to printouts of Usage views.

Page Setup - Tracking Gantt (7 ==
Page | Margins | Header | Footer | Legend \"IEW
Print: all sheet columns
Print first | 3 - columns on all pages
Print nokes
| Print blank pages
V| Fit timescale to end of page

Print row totals For values within print date range
Print column totals

Print Preview. .. Options... || Print. .. ‘ [ QK ]| Cancel

Get a preview

Granted, although software print previews aren’t quite as exciting as movie
previews, they help you get everything right before you print your project.
When you choose a report or choose Filew>Print to print a view, the preview
automatically appears in the Backstage. The buttons at the lower-right corner
of the preview enable you to modify the preview so that you can work with
the settings more effectively.

You can use the buttons in the Backstage preview to do the following:

v Move around the pages of the report by using the first four arrow but-
tons, as well as the horizontal and vertical scroll bars.
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v View more detail by clicking the Actual Size button and then clicking the
report.

v Focus on a single page or all the pages of your report by using the One
Page and Multiple Pages buttons.

So Let’s Print!

Last but not least, here’s how to actually print that document for which
you've made all the wonderful settings discussed in this chapter. For this,
you need to deal with the print settings to the left of the preview in the
Backstage. (See Figure 16-19 for a quick refresher.)

\E‘ s | Mesw Fitniezs Center Location Remodel Plan Location 1 Tracked - Microsoft Project o e =
Task  Resource  Project  View Format (7]
il save
Print
B save as =
. Copies: |1 =
[ Open Print
o close
Info Printer
7 HP Laserlet 4100 Series PCLG .
Recent ) ety
Printer Properties
New
Settings
Prin
I Print Enter Project .
s J Prinit the project fram start to finish
Dates:  7/1/2010 ¥ Tor 10/28/2010 -
Help
Pages: |1 = 8 =
1 options
3 Exit j Landscape Crientation -
J Letter .
85" x 11"
| Page Setup
Figure 16-19:
Control the
printer, the
number of
copies, and
what prints.
loff * o B3OE@
|

Here are the settings you encounter in this area:
v Click the Copies up arrow to print more copies or the down arrow to
print fewer (but not less than 1).

v The Printer area of this dialog box indicates the printer you will use. You
can choose a printer from the list and click the Printer Properties link to
control printer settings such as color quality and paper source.
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3

v The Settings area allows you to print the entire project or to select
another option from the drop-down list so that you can print specific
dates, print specific pages, or print custom dates and pages. The accom-
panying options change depending on your choice. You also can use the
Settings drop-down list to specify whether to print notes, all sheet col-
umns, or the left column of pages only (to print only the leftmost column
on every page).

v The remaining settings are for orientation and paper size, if you didn’t
make those choices elsewhere.

After you make all your settings and you're ready to print, just click the big
Print button in the upper-left corner.

Many users don’t have Project but want to see a project plan via e-mail. No
sweat. Choose Filec>Share=>Create PDF/XPS Document=>Create a PDF/XPS to
save the file in PDF format, which any user can open and view with the free
Adobe Acrobat Reader.

A Project Overview: The Timeline

Chapter 2 introduced you to the new Timeline view that appears by default at
the top of some of Project’s other views, such as Gantt Chart view. You may
have been wondering what the heck the Timeline is there for, and how you
might use it. Here’s the lowdown on it.

Hiding and redisplaying the Timeline

The Timeline gives sort of a 10,000-ft. overview of the project schedule. It
shows a graphical timeline spanning from the project’s start date to the end
date, and it highlights the period of time currently shown on the main view,
such as the specific dates shown on the Gantt chart. You can toggle the
Timeline on and off as needed. To do so, click the View tab of the Ribbon and
select the Timeline check box in the Split View group.

Adding tasks

The Timeline can give you even more detail when you add one or more sum-
mary or detail tasks to it. For example, consider that you have a couple of
tasks assigned to an outside contractor and that you want to show them
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where their tasks fall in the context of the overall schedule. To do that, add
the task or tasks to the Timeline. Simply right-click the task and choose Add
to Timeline.

As shown in Figure 16-20, the current portion of the schedule is highlighted in
a darker gray, with a schedule bar above it showing the start and finish dates
for that period. Tasks added to the Timeline appear by default as a bar on the
Timeline that shows the task name and schedule or a portion thereof.
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To remove a task from the Timeline, right-click it on the Timeline and choose
Remove from Timeline.

Copying the Timeline

Because that vendor you're trying to coordinate with doesn’t use Project,
you need to share the graphical Timeline information via another file format.
Project builds in the special capability to take a snapshot of the Timeline so
that you can paste it into an e-mail, presentation, or other program such as a
word processor.
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Follow these steps to copy and use the Timeline:
1. Right-click the Timeline, choose Copy Timeline, and then click the
desired format.

The available format choices are For E-Mail, For Presentation, or Full
Size.

2. Create the e-mail message or document where you want to use the
Timeline image.

3. Position the insertion point where you want the Timeline image to
appear.

4. Press Ctrl+V.

The image appears in the message or document, as in the example
shown in Figure 16-21.
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<P If you're a fan of the Copy Picture feature in Project, it’s still available in
Project 2010. Select the tasks to copy by dragging over their task IDs. Then
click the drop-down arrow beside the Copy button in the Clipboard group of
the Task tab. You can then click Copy Picture from the menu that appears.
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Dressing Up Your Input and Output
with Enhanced Copy and Paste

While it’s long been possible to copy and paste information to and from
Project and other Office applications, sometimes the results were, well, a
little messy. Now, copy and paste operations between the applications retain
much more information. For example, when you copy tasks from Project and
paste them into Word or Excel, you’ll automatically see outline-level format-
ting and column headings. And, formatting from information copied from
another application into Project is retained. There’s no need to reinvent the
wheel every time you need to copy data between apps — that’s a sweet,
sweet thing.
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Chapter 17
Getting Better All the Time

In This Chapter

Reviewing your successes and failures

Comparing versions of the same project
Creating a template for future projects
Developing macros to make things easier

Have you ever finished a project and then wondered how the heck
everything ended up the way it did? The total budget numbers mysti-
cally appear to be several thousand dollars over estimate, you missed your
final deadline by three weeks, and somewhere along the line, you lost track of
three people who were supposed to be working on tasks. But you delivered
your deliverables (somehow), and you can finally stuff your project file in the
bottom of your drawer. Or can you?

Don’t think of Microsoft Project as just a giant electronic to-do list; rather,
it’s a sophisticated tool that’s used to manage your projects. And the logical
by-product of that management is a fantastic treasure trove of information
that you can use to become a better Project user — and thus a better project
manager.

After you send the last memo on your project and accept your last kudos or
criticism from your boss, take a moment to look over your Project plan one
more time.

Learning from Your Mistakes

When I teach classes in using project management software, people are often
a bit overwhelmed at all that a product such as Project can do. They’re reel-
ing from all the data that they have to input as well as all the information
that Project throws back at them. They can’t see straight for all the views,
reports, tables, and filters that they can use to access information on their
projects.
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Here’s the secret that I tell them: You won’t understand every nuance of your
Project plan on your first project. You won’t even uncover all that Project
can do on your second project. But gradually, as you master the ins and outs
of Project and understand what you can get out of it, you’ll become better at
absorbing all that information — and at understanding how it can help you
avoid mistakes on your future projects.

The best way to gain that benefit is to review every project when it’s finished
to see what you did right and what you did wrong. Then you can use what
you discover to do better on your next project.

It was only an estimate

You know what they say: If you don’t study history, you're doomed to repeat
it. And repeating mistakes is the last thing you want to do where project man-
agement is concerned.

Consider these strategies to debrief yourself on what happened in your last
project:

1 Compare your original baseline plan against the final actual activity
(as shown in Figure 17-1). Even if you created interim or baseline plans
to adjust for drastic changes, look at the widest gap between what you
expected to happen in your initial plan and what did happen. This can
be the best way to see the areas where you tend to underestimate most
or where changes in the project’s scope caused dramatic changes.

1 Review the notes you made on your tasks to remind yourself of
changes or problems that came up along the way. Insert the column
named Notes on your Gantt Chart sheet and read through all the notes
at one sitting.

+* Note which resources delivered on their promises and which didn’t; if
you manage some of them, provide them with constructive feedback.
For those you don’t manage, keep some notes on hand about how well
or how fast they worked and make future assignments with those notes
in mind. Also note which outside vendors performed and which didn’t
(and consider crossing the latter off your vendor list).

1 Assess your own communications to others in saved e-mails or memos.
Did you give your team enough information to perform effectively? Did you
keep management informed about changes or problems in a timely way?

v Assess feedback from your boss, customers, and other stakeholders.
Did any of the overall constraints, such as the project budget or deliv-
erables, change dramatically during the course of the project? Were the
“end users” satisfied with the rate at which you completed the project
and what was ultimately delivered? How effective was your team’s perfor-
mance in their eyes? Would they rely on you to lead such a project again?
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Figure 17-1:
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Debrief your team

No project is the province of a single person. Even if no one else ever
touched your Project plan, your team still provided input for that plan
through the hours of activity they reported and the information they pro-
vided to you during the course of your project.

Consider these suggestions for refining your communications process:

1 Ask people how the process of reporting actual activity worked. Did
you use e-mail, schedule notes, route files, or use the Project Web App
tools such as TimeSheet to gather resource information? Should you
consider taking advantage of all the benefits of online collaboration for
your next project?

+* Would your team rate your communications as frequent and thorough
enough? Did you share enough of your project with resources, or did
you inundate them with too much information? Did you send an entire
Project file to people regularly when a simple report on a specific aspect
of the project would have served you and them better? Did your man-
agement team feel that your reporting on the project was sufficient for
their needs? Should you learn to take more advantage of other software,
such as Excel and Visio, accessed through Visual Reports?

v Did you integrate activity on various projects successfully so that
resources weren’t overbooked or underutilized? If people on your
team reported conflicts with other projects, consider using some special
Project tools, such as creating a deliverable-based plan or developing a
master project, which involves inserting several projects into a master
plan so that you can link tasks between them and view resource con-
flicts across them.
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Comparing Versions of a Project

Some project managers prefer to save new versions of a project plan rather
than working with interim plans. That approach can work, but it doesn’t
enable all the project history to be captured in a single project file. No
matter, Project’s Compare Versions feature enables it to show you the differ-
ences between two Project plan files. Those files can be either two different
versions of the plan for one project or files for two separate projects that
happen to be similar.

You can use this method either to review what happened on a completed
project or to compare similar new projects as you're building them. This
feature has been enhanced in Project 2010. The finished comparison report
shows you the project differences graphically and provides a legend to iden-
tify what the features in the report mean.

To compare two files in Project, follow these steps:

1. Open the file that you want to compare.
The file that is active is considered the current project.
2. Choose Project~>Compare Projects.
The Compare Project Versions dialog box appears, as shown in Figure 17-2.

3. If the file to compare doesn’t appear in the Compare the Current
Project (filename) to This Previous drop-down list, use the Brows
button select the appropriate file.

The file you selected here is considered the previous project.

4. To compare tables other than the default tables shown, select the
appropriate tables from the Task Table and Resource Table drop-
down lists.

5. Click the OK button.

6. If a message tells you there are too many columns to compare, click
OK to continue.

Project runs the comparison and displays the comparison report, as
shown in Figure 17-3. The comparison report appears in the upper pane,
and the individual project files show up in the two lower panes. The
legend at the left shows what the symbols in the Indicators column of
the report mean; for example, the Hire Realtor task (Task 2) has a plus
indicator, so it appears only in the current project. On the Gantt chart,
the narrow green bars represent the current project, and the blue bars
represent the previous project.
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7. Click Resource Comparison on the Compare Projects tab.

The Comparison Report pane changes to display resource information.
8. Click Close Comparison on the Compare Projects tab.

The comparison report file remains open.

9. Click the Close (X) button on the Legend for Comparison Report pane
to close the pane.

10. Save the comparison report file if desired and then close it.

Use the Save button on the Quick Access toolbar and name the file as
desired.

Compare Project Versions =)

Compare the current project {Mew Fitness Center Location Remodel Plan Location 2) ko this previous

- Browse, ..

Select the Figlds to be used in the comparison:

For each column in the specified tables, the report will display & column with the data From both versions and

| a column showing the difference between the values.
Figure 17-2:
Sele(:t flles Task Table: Entry -
to compare | ResourceTable: Entry -
here.
Canel
I

Don't forget to sit down and have a good talk
with yourself about what went on during your
project. Did your team give you the kind of
information you needed to operate efficiently,
or should you lay down more stringent ground
rules for reporting in the next project? Were
you swamped with work throughout the project,
and would it be wise to find someone to make
updating entries for you the next time around?
Did management give you information about

company changes in a timely way so that you
could make adjustments to keep your project
on schedule?

It's often the case that in the heat of the proj-
ect battle, many of us don't have time to stop
and change processes or get the help we need.
Review the notes you kept in the Project notes
areas to see what types of snafus made you pull
your hair out. Then institute changes before you
begin the next project.
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The com-
parison
report in the
upper pane
graphically
shows the
differences
between the
projects in
the lower
panes.
|

Bl & 9 - I= Micrasoft Project ‘ = @ =
Compare Prajects | Task Resaurce Project  Wiew Farmat > @
T ]
=< a8 NF Memst Alliems M
S| S8 e B
[ Columns: Data and differ ~
Task Resource Gota  Close
Comparison| Comparison Legend Ttem  Camparison
Viewr Show Compare
"3 Comparison Report [
Legend for Comparison Report X Harme Task Task -
c ¢ project: Hew F = = Mode: > Moder  ~ g [Jul 3,10 [ulis,10 _|=)
urrent project: New Fitness . — ERRREHEREEREERmE
Center Lacation Remoclel Plan - - ira 5 53 5011 80 53 ) i
s = Location Selection Auto sched Auto Sched ||
Previous version: New Fitness | = 5 Hire realtor Auto Schec e T —
Center Location R lel Pla —————
L:?}:&”:‘;‘ 1o emadetHan Review listings Auto Schec Auto Schec -
D —
'
bSheet view Wisit locations Auto Schec Auto Schec
Select location Auto Schec Auto Schec =

Se o w e e w e

- Comparison Report Contract
Only in cumrent Financing
project Closing
= Building Design
| Onlyin previous TN
project =

Auto Schec Auto Schec o

Auto Schec Auto Schec =

Auto Schec Auto Schec

Auto Sched Auto Sched 3

e ealemn en el |
4 [m ] » 53

Mew Fitness Center Location Rernodel Plan Location 1

MNew Fitness Center Location Remodel Plan Location 2

o o
£ 2
'E start | ] Finish E start | ] Finish
(= Thu 2/1/10 Thu 10/28/10 (= Thu 741410 Wed 9/29/10
(i) Task , Task Name + Duratior,, a Task . TaskMame + |Duratior,, |Jul 4,
ode Fdode S IM
0 = = New Fitness Center ~ 85.25 o E ~ New Fitness Center  64.25
Location Remodel days Location Remadel days
E Plan = Plan
£ _ £ -
; 1 =N ! Location Selection 21.25 days ; 1 = = Location Selection 16.25 days E—
é 2 e Hire realtor S days é 2 - Review listings 3 days CED,VP
3 =Y Rewiew listings 3 days 3 = Visit locations 5 days
4 =S Visit lacations 5 days 4 < Select |ocation 2 days
5 e Selectlacation 2 days 5 - Contract 6 days
5 S ontract £ da & = Financin da
Ready | 5 New Tasks : Manually Scheduled | IEE=ES: N

Building on Your Success

Although it’s human nature to focus on all the things that went wrong with a
project, the fact is that you probably did many, many things right. So before
you start planning your next project, take the good stuff and put it in a place

where you can find it easily later.

Create a template

One option is to create a template. Templates are simply files that you save
that contain certain settings. When you open a template, you can save it as a
Project document with a new name and have all those settings already built in.

Project contains its own templates for common projects (see Chapter 1 for
more about starting projects based on a template), but you can save any

of your projects as templates. If you often use the same set of tasks in your
projects — as people in many industries do — you’ll save yourself the time of

creating all those tasks again.
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If you work with Project Server and Project Web App on an enterprise level,
consider adding templates on a global level for use across your company. See
Chapters 18 and 19 for more about enterprise-level project management.

In addition to any tasks in the project, templates can contain any or all of the
following information for those tasks:

v~ All the information for each baseline

v Actual values

v Rates for all resources

v Fixed costs

v Notations of tasks that you publish to Microsoft Project Web App
You can save all this information or only selected items. For example, if you
created a lot of fixed costs (such as equipment) and resources with associ-

ated rates — and you’ll use those in most of your projects — you could save
a template with only fixed costs and resource rates.

To save a file as a template, follow these steps:

1. Open the file you want to save and then choose Filec>Save As.
The Save As dialog box appears, as shown in Figure 17-4.

Microsoft saves templates in a central folder called Templates.
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Figure 17-5:
Save
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2. In the Save As Type list, click Project Template.

Project selects the Templates folder as the Save In location, also illus-
trated at the top of Figure 17-4.

3. Click the Save button.
The Save As Template dialog box appears, as shown in Figure 17-5.

Choose which information about values and resource rates will be saved
with all the tasks in the project in the template.

Save As Template ==

‘You are about ta save a file as a template, You can choose to remove the
following data items from the template.

Select the type of data that you want ko remove from the kemplate;
¥ fines.

Actual Values

Resource Rates

Fixed Costs

Whether tasks have been published to Project Server

4. Select the check boxes for the information that you want to have
saved in the template.

5. Click the Save button.

The file is saved in the template format with the MPT extension.

When you open a new project and want to use a saved template, click My
Templates in Backstage view. The New dialog box appears, and any templates
you've saved appear in the list on the Personal Templates tab. Just open the
template, and then save it as a Project file with a new name.

Master the Organizer

Project has this marvelously flexible nature that allows you to customize

a lot of things. For example, you can create your own tables of data to dis-
play in views that contain sheet panes. You can also create your own filters,
reports, and calendars. If you have any kind of a life, you don’t want to spend
your evenings re-creating all that stuff for your next project. Instead, use the
Organizer to copy them to other Project files.
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The Organizer allows you to take information in one file and copy it to
another file. You can also rename the items. Some of the most commonly
used types of items you can copy with Organizer include

v~ Calendars

v Forms

v Tables

1 Reports

v Views

v Fields

v Groups

v Toolbars

v Filters
If you want a custom item that you've created in the current file to be available
for use in all your Project plan files, use the Organizer to copy the item into
the global template, G1lobal . MPT. Some items are copied to the Organizer by

default, but it never hurts to check and make sure something that you want to
save is saved there.

Follow these steps to use the Organizer:
1. Open the project that you want to copy things from and the project
that you want to copy things to.
2. In the file you want to copy to, choose File=>Info.
Backstage view opens, showing overall file choices.
3. Click the Organize Global Template button.

The Organizer dialog box appears, as shown in Figure 17-6.

Organizer
Views | Reports | Modules | Tables | Fikers | Calendars | Maps | Fields | Groups

"New Fitness Center Staffing':

Gantt Chart
Gantt with Timeline

‘Glabal MPT':

Copy ==
Descriptive Network Diagram
Detal Gantt

Gantt Chart

Garitt with Timeline
Leveling Gantt

Milestone Date Rolup
Milestons Rollup

Multiple Baselines Gantt

MY CUSTOM GANTT
Hetwork Diagram

Hetwork Diagram
Resource Sheet
Timeline:

m |

Cancel

Repame..,

]

|

Delete.

]

o Help

views avalsble in:
Global.MPT -

views avalable in:
New Fitness Certer Staffing -
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4. Click the tab for the type of information you want to copy.

5. Choose the fie to copy from in the left [Items] Available In list at lower

right.

By default, Project selects the G1lobal .MPT template for the list at left
and the file from which you open the Organizer for the list at right. If
you want to copy items from another open file, instead, choose it using
the drop-down list below the right file’s list. (Depending on the tab you
display, the drop-down list may be called Views Available In, Groups
Available In, Reports Available In, and so on.)

. Click an item in the list on the right that you want to include in the

Global.MPT file on the left and then click the Copy button.

The item appears in the list on the left.

. (Optional) To rename a custom item that you’ve created

a. Click it and then click the Rename button.

b. In the Rename dialog box that appears, enter a new name and then
click the OK button.

8. To copy additional items on the same tab, repeat Step 6.

9. To copy an item on a different tab, repeat Steps 4-8.

10.

When you finish copying items from one file to another, click the
Close (X) button in the upper-right corner.

It’s not a good practice to rename default items in the Organizer. This
can cause errors and malfunctions, such as the inability to display a par-
ticular view.

All the items are copied, and the Organizer dialog box closes.

Handy little timesavers: Macros

If you were paying attention, you noticed a lot of activities in your project
that you did again, and again, and again. No, I'm not talking about all those
cups of coffee you downed in the wee hours. I'm talking about things such as
generating a weekly report or inserting your five department projects into a
single master schedule, once every quarter, to review resource allocations.

You don’t have to reinvent the wheel to perform actions such as these.
Instead, you can create a macro — a combination of keystrokes, text entries,
and so on that you can record and play back anytime you like.
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For example, suppose that you generate and print a report on current activi-
ties every week. Doing so requires the following keystrokes and entries:

. Choose Project=>Reports.

. Click Cost.

. Click Select.

. Click Overbudget Tasks.

. Click Select.

. Click the File tab.

. Click Print to display the print choices in Backstage view.

@ N U e W N

. Click Print to print the report.

Time after time, you have to go through an eight-step process. But after these
steps are recorded, that process is reduced to one step when you play back
the macro:

1. Start your macro.

<P One great use I've seen for macros is to copy a range of tasks that is repeated
numerous times in my project — for example, a Q&A procedure that’s repeated
ten times throughout a project. In recording the macro, just select the absolute
range and copy it, and go to the first blank task and paste it, ten times. While the
macro’s running, you can go get yourself another cup of coffee.

Displaying the Developer tab

The tools for working with macros appear on a Ribbon tab that doesn’t nor-
mally appear: the Developer tab. Use Project’s options, accessible via the
Outspace, to show and hide this tab as needed.

Here’s how you display (or hide) the Developer tab:

1. Choose File=>Options.
The Project Options dialog box appears.

2. Choose Customize Ribbon in the list at the left.
The Customize the Ribbon options appear.

3. Select the Developer check box in the Main tabs list at the right (see
Figure 17-7).

When the box is selected, the Developer tab appears in Project. Coming
back and deselecting the check box hides the Developer tab.

4. Click the OK button.

The Developer tab appears (or is hidden) as specified.
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Recording a macro

Recording a macro is a simple process: You just start recording, do what-
ever you usually do to perform the action, and then stop recording. You

run macros by selecting them from a list of macros or by using a keystroke
shortcut. You can also edit them if you need a slightly different series of key-
strokes for a slightly altered sequence of steps.

Here’s how you record a macro:

1. Choose Developer->Record Macro.

The Record Macro dialog box appears, as shown in Figure 17-8. Macros
that you record can be played back by using a shortcut key that you
designate here.

2. In the Macro Name box, type a name.
Make the name descriptive of what the macro does.

3. In the Shortcut Key box, type a letter (numbers or symbols don’t
work).

When you press Ctrl plus that key, the macro plays back.
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4. If you like, edit or add to the description of the macro.
This is especially useful if you think others will use it.

5. Select whether row and column references will be relative or
absolute:

e Relative references: If you select (say) the task in the third row dis-
played in a sheet and perform an action on it, Project selects the
task in the third row whenever you run the macro.

e Absolute references: Project selects a specific, named task, no
matter what row it occupies.

6. Click the OK button to begin recording.

Every mouse selection or keystroke that you make during this time
becomes part of the macro.

7. After you complete your steps, choose Developer=>Stop Recording.

Here are some points to keep in mind about recording macros:

1 Naming: Macro names have to start with a letter and can’t contain
spaces. Use the underscore to separate words in a macro name
(Overbudget_Report, for example).

1 Keystroke presets: Several keystroke shortcuts are already reserved
by Project for use with built-in functions. For example, pressing Ctrl+K
inserts a hyperlink. Project displays a message that tells you this if you
choose such a shortcut and then gives you an opportunity to choose
another letter or number.

v Entering unique information: If what you record includes entering
specific information (such as a name or a date range), you're presented
with a prompt box into which you enter new information when you run
the macro — even if you entered information while recording the macro.
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Running and editing macros

To run a macro, your best bet is to use the shortcut key that you entered
when you created it. (See the preceding section.) This two-keystroke combi-
nation runs the macro, pausing for you to fill in any requested information.

Alternatively, you can do the following:

1. Choose Developer->View Macros.

2. Choose a macro in the list of macros shown in the Macros dialog box,
as shown in Figure 17-9.

Macros ==
Macro name:
Crwerbudget_Report
Overbudget _Report
Cancel
Step Into
Edit
|
Create
Figure 17-9: Delete
The Macros e
dialog box
||StS a” Macros in: Al Open Projects -

aVailable Description

H . Owerbudget_Report
macros in M:E:g R:SDrrduedgga_t ;IPIOZ';’DQ bry Mancy,
any open
projects.

3. Click the Run button.

To edit a macro, you may want to simply rerecord it, which is sometimes the
quickest way to do it. If you prefer to edit it instead, follow these steps:

1. Choose Developer->View Macros.

2. In the Macros dialog box that appears, choose the macro that you
want to modify and then click the Edit button.

The Microsoft Visual Basic editor opens; your macro is displayed in
Visual Basic code, as shown in Figure 17-10. Visual Basic code uses cer-
tain syntax to code keystrokes and text entry.

e To edit the code:

You can edit this code just as you edit text in a word processor—
generated document. Although you have to be familiar with

the Visual Basic for Applications programming language to
make most changes, you can make some edits without being a
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programmer. For example, any items in quotes are text entries
or names of things, such as reports. For example, it’s pretty easy
to change a macro that generates the report named "Tasks
Starting Soon" so that it generates the report "Tasks in
Progress". Just replace the existing report name (within the
quotation marks) with the new report name.

¢ To delete something within the code:

If you want to delete a piece of the process, you can usually figure
that out from the code. For example, if you see the line If proj-
ect is empty, alert the user and end the macro and
you don’t want the macro to include that step, just select it and
press Delete.

V?‘“\NG! Monkeying around with Visual Basic for anything much more complex could
S mess up your macro. Because I don’t want to write another book on Visual
Basic at this point, I suggest that you keep your life and mine simple: Delete
the first macro and walk through the procedure again, rerecording it as a new

macro.
#7 Microsoft Visual Basic - Global. MPT (===
i File Edit Wiew Insert Format Debug Run  Tools Adddns  Window  Help
H; =1 @l ey 0@ | & &% =@ | Ln2coll _
i 7]
x|
=] =] s
- = & < Global.MPT - Module3 (Code) EEEE
=& ProjectGlobal (Global.MF General ~1 [overbudget Report =
(2] Microsoft Project Object: ‘( g J ‘ getfep J
155 Modules Sub Owerbudget_Report () =1
-8 Modulet ' Macro Overbudget Report
- Modulez ' Macro Recorded Sat 9/12/08 by Nancy.
o Moduls3 ReportPrintPreviey Newe:="Overbudger Tasks”
% vBAProject (Fitness Cenl FilePrint

&% vBAProject (New Fitness End Sub

&% vBAProject (New Fitness

5
x|
Module3 Module 5

Aphabetic | Categorized |

ﬂﬂm Module3

Figure 17-10:
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|
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PartV
Working with
Enterprise Projects

The 5t \Wave By Rich Tennant
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OKkay people, remember — use your project
management software. Tv’s customizable,
so those of you collecting ‘juice’ will use a
slightly ditferent entry from those of you

doing shakedowins or fencing stolen goods.”
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In this part . . .

ere’s where Project Professional comes into its

own: Serving the enterprise via Project Server and
Project Web Application, you can get some serious online
collaboration going. You can share documents online with
your team, get perspective on your organization’s
resource pool to make efficient assignments, and get your
human resources to report their work time. This part
gives you a glimpse of what Project Server and Project
Web Application can do if your organization decides to go
the enterprise route with Project, and it also covers how
to publish and sync information with SharePoint Server.
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Project Web App for the
Project Manager

In This Chapter
Understanding Project Server and Project Web App
Looking at the tools Project Web App makes available to you
Reviewing resource availability and assignments
Building a team of resources in the Resource Center
Requesting status reports from Project team members

Sharing documents with your team

f you think that Project Server is like an add-on applet (a tiny application)

that works with Project, you're wrong. It’s actually a full-fledged software
product that enables you to take your project — and all its accompanying
resources, tracking, and reporting — into the world of the Internet.

Project Server comprises two main components: the Project Server that
manages project data and Project Web App (also called Project Web
Application), the browser-like interface that connects you and others to
the project information.

Note: To make life simple, I mostly simply refer to Project Web App going
forward because that’s the interface and set of tools you'll be working with.
However, Project Web App is useless without Project Server: Before you can
actually perform the steps in this chapter and use Project Web App, some-
body must install Project Server on your company network and configure it
for your company’s standards and requirements. This usually requires that
IT-type people stay up nights installing and configuring software and that
another team of people design the implementation. After all that is accom-
plished, you can actually perform the steps listed here and not just read
about them. Also note that Project Web App used to be called Project Web
Access, and depending on how your company’s environment is ultimately set
up, your screens may look slightly different than the ones in this chapter and
the next and may still read Project Web Access.
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With Project Web App (which works only with the Professional edition of
Microsoft Project), you can enhance communications, interactions, and
documentation for each and every project you undertake. This chapter looks
at who should use Project Web App as well as how it can help any project
manager.

Figuring Qut Whether Project
Sevver s for You

3

Just as you don’t need a Hummer to run to the corner grocery store for milk
once a week, Project Server and Project Web App can be too high-powered
a solution for some organizations. Implementing Project Server and Project
Web App involves not only money for product licenses but also requires
some other specific commitments:

v The need for project managers to be using the more expensive
Professional edition of Project (Project Standard cannot connect to
Project Server)

v Time to install and configure it
v~ Effort to standardize how Project is used across your organization
v Time and money to train people to use the tools

v Ongoing maintenance of the Project Server database

Therefore, before you jump in with both feet to the Project Server world, you
should be sure that the benetfits of using it outweigh the effort required.

Project Server is useful to organizations that have an enterprise orientation,
which means that they make the effort to centralize information online in some
fashion so that it’s standardized and available throughout the company.

Typically, this scenario is worthwhile for mid- to large-sized companies that
manage several projects at once across departments or disciplines. The fea-
tures accessed through Project Web App provide the managers of these com-
panies with a way to orchestrate resources more efficiently and also get a
broad perspective on the efficiency and success of their project management
efforts across the organization.

If you have Project Professional 2010 and your organization has a SharePoint
Server (or SharePoint Server access), you can take advantage of some proj-
ect collaboration without using Project Server and Project Web App. Project
Professional 2010 enables you to publish a project task list to SharePoint
Server. Resources can provide their task updates via the SharePoint location,
and then you can sync those changes back into your project plan. You also
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can publish the entire project file to SharePoint to make it available to other
users. If a project plan has already been sketched out as a SharePoint task
list, you can import that list and use it to create a new project plan file. The
benefits of using a Project Server and Project Web App solution include the
following:

v~ Standard formats, reports, and resource information that can be
accessed and shared by all project managers for consistency among
multiple projects

v The ability to see, on an enterprise-wide level, how resources are being
allocated so that you can assign resources with an eye to the big picture

v A perspective on all the projects in the company, which can help man-
agement prioritize and strategize overall enterprise efforts

v A greater capability to collaborate among projects

v The ability to make all project information for the company available
online through a company intranet

v The ability to take advantage of SharePoint functionality to monitor and
communicate information about a project’s workflow for its entire life
cycle, if your organization requires a workflow orientation

v More efficient methods for resources to track their time on project tasks
without requiring anyone to reenter the information in Project

If you have a company LAN or intranet, you can set up Project Server and
Project Web App to deliver all these benefits and more.

Not every member of your team has to have Project installed to interact with
projects on Project Server. Team members only need access to your LAN or
intranet, access to Project Web App, and appropriate network permissions.

The downsides to Project Server with Project Web App include the following:

v The cost for licenses
v The time to install and maintain the server as well as to train users

v The need for all project managers and team members to agree to and
adhere to a particular process and procedures before committing to
Project Server

v The need to ensure that projects are handled in a uniform way across
your enterprise (If you don’t do this, the information you receive
through Project Server may be inaccurate and out of date.)

If your most tech-savvy person whom you will call on to install and configure
Project Server needs some help, | recommend that you take a look at Microsoft
Project 2010 Bible (published by Wiley). Author Elaine Marmel does a stellar
job of walking you through Project Server issues (which I say not because
she’s a friend or a fellow Wiley author, but because she’s just plain good!).
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Getting a Handle on What You Can Do
with Project Server and Project Web App

Way back when the Internet didn’t exist, companies had to share informa-
tion by passing around memos. The guy in Manufacturing had no idea what
the people in Sales were up to until a handwritten purchase order was hand-
delivered to his desk and he realized that he didn’t have enough products on
hand to fill the order.

Computer networks and the Internet changed all that. Suddenly, information
could be shared in centralized online repositories. People could communicate
instantly through e-mail. An action in one part of the company could instantly
be seen in another, and that group could respond and act accordingly.

In a sense, Project Web App is to Project what the Internet is to stan-

dard business operations. Project Web App works with Microsoft Project
Professional to provide the centralized information and communications that
can keep projects on track in our I-need-it-now world.

Project Web App gives you an online Project Center that can be used by
people in your project to

1~ Stay ahead of the curve, by viewing daily tasks and requests on the
Project Web App Home page, as shown in Figure 18-1.

v+ Communicate online, exchanging updates on progress and sending sug-
gested new tasks to project managers.

1 Make, view, and accept or decline task assignments from a standard-
ized resource pool.

v~ Update activity on tasks by using a timesheet interface (as shown in
Figure 18-2).

1+ Send and request status reports and review project information.

1 Manage project documents, creating and comparing multiple versions
of projects and setting up document libraries.

v Attach important documents to a project. For example, you might
include a goal statement or Excel budget file with your project for others
to view online.

1 Create and refine draft projects. This feature allows you to begin to
build your project ideas before you're ready to commit the time to build-
ing a full-blown project plan. Team members can also submit project
proposals, which are a different feature that can be used by team mem-
bers as well as project managers.
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Planning to Use Project Server
and Project Web App

Before your administrator begins to install Project Server, you have to sit
down and do some thinking about how you’ll use it in your organization.
During the installation process, you have to make some design choices based
on how you want to use the product.

Tools for using Project Professional become available to you when Project
Server is installed and you have set up your Project Server account in Project.
This enables you to perform some of your work right from your copy of Project
Professional. For example, you can create, manage, and sync deliverables using
a tool that becomes available in the Insert group of the Task tab on the Ribbon.

Get a team together

First figure out who at your organization should be part of this process. For
example, you’ll probably need senior management input, end user (the people
on your project teams) input, the experience and expertise of all the project
managers in your company who use the enterprise features, and somebody
(or three or four somebodies) from your IT department who actually have to
set the thing up.

As with most network-oriented computing, everybody has a role to play and
has to be set up to use features on the network based on that role. Project
Server provides a user model with three types of participants, providing vari-
ous information and access requirements accordingly:

1 Managers, who oversee the day-to-day operations of a project

1+ Team members, who perform the work on the project

v Executives, such as clients, senior management, and other stakeholders
who require regular updating on project progress, often across several
projects in an organization

You should analyze how these roles relate to the functions in your project

teams and work with your IT folks to set up Project Server permissions
accordingly.

Gather information

Next, set up a process to research and come to an agreement on all the
enterprise-wide information you need to enter into Project Server, such as
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resources, their rates, and their calendars of availability; WBS (work break-
down structure) code structure; standard report formats; custom fields you'd
like to include in the Project Server Enterprise Global Template (kind of like
the Global Template in Project 2010, but available online); and filters, views,
tables, and so on.

The key word in this planning process is standardization. By standardiz-

ing the information in your projects and making that information available
online, you increase efficiency in building projects and provide mechanisms
for comparing projects in an apples-to-apples way.

Standardize processes

Pay special attention to the reporting process that different people use on
their projects. Standardizing reporting processes and formats ensures that
those who read reports about multiple projects can easily and quickly under-
stand what they’re looking at. Also, determine how project performance will
be assessed. For example, the way in which earned value is used in creating
tasks produces different measures of progress on projects.

You can bone up on reporting by going to Chapter 16.

Coordinate with IT

Finally, work with your IT people to identify the Project Server features that
you want to use in your organization. For example, if maintaining an online
discussion is important to your company, you may want to create discussion
boards on your Project Web App site.

Don’t forget the training!

Project Web App requires that different people  members require some training on the status
in your organization learn new tricks. Your IT  report and timesheet features in Project Web
people need time to get up to speed on set- App. Build in time and money to your imple-
ting up and maintaining the project on Project mentation process to make effective training
Server. Project managers have to learn to use  happen.

the timesheet reports to track projects. Team
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Planning for problems

One final word about implementing Project Server and Project Web App at
your organization: Because you will now be sharing resources and informa-
tion with others on a daily basis, put a little thought into how you’ll deal with
problems when they come up. For example, what happens if you want to use
aresource but another project manager already has that resource assigned
to a project? Or, how do various project managers make use of tools, such as
resource leveling, to resolve resource conflicts?

Make sure that everybody understands the rules of etiquette involved in work-
ing in an enterprise-wide fashion, sharing people, equipment, and information.

Looking Over the Project Web App Tools

SMBER
é‘,\“

So what goodies become available to you after your organization has been
through the somewhat daunting task of getting everything set up? It’s time
for a closer look at how you’ll use specific Project Web App features in your
projects.

Chapter 19 goes into more detail about how end users make use of various
Project Web App features.

Getting set up

Before you can begin, you have to create a Project Server account. You can
do this by following these steps:

1. In Project Professional, click the File tab, click Info, and then click the
Manage Accounts button next to Project Server Accounts.

2. Click the Add Button in the Project Server Accounts dialog box to
enter your account information.

3. After you create the account, exit and restart Project to log on to the
server.

4. Now you can create and save a project file, and then click the File tab
and use the Publish command in Backstage view to publish that proj-
ect to the server.

Figure 18-3 shows a published project in Project Web App. Ask your IT guy or
gal for some help on this, such as providing you with the proper server URL
and advising you on how you should access that server. Or, again, I recom-
mend Microsoft Project 2010 Bible, by Elaine Marmel, if you feel like tackling
this on your own.
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Figure 18-3:
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Once you’ve published a project to Project Server, the project is listed in the
Project Center that you can open in Project Web App by click Project Center
under Projects in the Quick Launch Pane at the left side of Project Web App.
Once you open a project from there, you can work with task schedules much
as you would in Project.
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Make assignments

Because the main focus of Project Web App is to help you interact with
your team members, one of its most useful features is the capability to post
resource assignments and delegate work on tasks.

When you add resources to projects, they come from the Enterprise Resource
Pool. This central repository of resources ensures consistency of resource cal-
endars, rates, and so on across your company’s projects. Adding the resources
from this pool to your project (using the Build Team dialog box, as shown in
Figure 184) makes them available to assign to your project tasks and also lets
you see where resources are overbooked on multiple projects.
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Figure 18-4:
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From the Resource Center, you can also view resource assignments and avail-
ability to help you plan your resource strategy. Figure 18-5 shows the current
assignments for one resource — a very busy guy!

After you make assignments and publish the assignments, the folks on your
team can see their new assignments on their Project Web App Home page,
and may receive e-mail notifications if your organization sets up Project that
way. Team members can reassign assignments to others on the team if that
feature is enabled. Then, the team member can review and approve status
reports on work performed on the task before sending those reports on to
the project manager.

Of course, you don’t want everyone on a project to be able to pass the buck
when it comes to assignments: The administrator can set Project Server up so
that only the project manager has control over who is assigned to tasks in a
project.

Track your progress

In Chapter 13, I tell you all about gathering resource-activity information and
entering it in your Project file to track progress. This can be a somewhat
tedious process. Wouldn't it be nice if your resources could just enter their
work in timesheets that could be automatically imported into Project to do
your tracking for you? Well,  have a surprise for you.
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One huge perk to using Project Web App is the functionality that it gives your
team members to track their activity on tasks and also report their progress
to you online. Project managers can request updates or send reminders
shortly before updates are due.

Team members can use the Microsoft Project Web App interface to enter
actual activity into a timesheet. Web App communicates directly with
Project on the project manager’s computer. As the project manager, you can
then make manual updates to your project plan or let Project make its own
updates automatically. You can also generate task update requests to help
you remind your team to keep you apprised of their activity and progress.

You can find out how to use features such as the tracking sheet in Chapter 19.
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Figure out what's going on with status reports

You can design and request status reports, which are essentially forms that
the people on your project can complete to explain the status of their tasks.
These aren’t used to track and record actual work performed. Instead, they
help team members describe various issues that come up and indicate how
the tasks are progressing. Figure 18-6 shows one of the forms used to set up a
status report.
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Figure 18-6:
You specify
exactly
what you
want to see
in a status
report.
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You can request status reports and then work with your team’s responses.
One of the nice things about status reports for you, as a project manager, is
that you can assemble all the individual reports into a complete status report
for the project. Then you can make that report available to shareholders to
update them on the latest news.

Working with the Gang Online

The following sections get you hands-on with Project Web App, where you
can try some of its tools for team interaction. This isn’t an exhaustive run-
down of all Project Web App has to offer, but it does get you working with the
interface and exploring the tools it offers. Depending on your projects and
your organization, you may take advantage of many other options.

Check resource availability and
assignments and add resources

One of the really cool things about Project Server is how it empowers project
managers to make resource assignments in a way that takes into account
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one set of shared resources across a whole organization. The Enterprise
Resource Pool, which the Project Server administrator from your IT group
can set up, can show the resources that have been identified as available to
work on your project based on what are known as RBS (Resource Breakdown
Structure) codes used to organize resources by function. By using the
Enterprise Resource Pool, you can make assignments without having to re-
create entries for all your resources every time you create a project.

Here are the steps involved in adding resources through Project Web App:
1. Log on to Project Web App, and click Project Center in the Quick
Launch pane at the left.
Project displays the Project Center.
2. Click the project name.
Project details appear.

3. On the Project Web App ribbon, click the Project tab and then click
Build Team in the Navigate group.

The Project Web App screen that appears shows you a list of resources
available to your project on the left side of the Build Team page (see
Figure 18-7). The right side of this page lists the resources that already
work on your project.
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Figure 18-8:
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of resources
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conflict.
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4. Select a check box to choose a resource in the left list.
5. Click the Add button.
6. Click the Save & Close button on the Team tab.

7. To view assignments or availability for a resource, click to place a
check mark beside the resource name in the list at the left, and then
click either the Resource Assignments or Resource Availability button
in the Navigate group of the Team tab on the Ribbon.

Refer to Figure 18-5 to see how reported assignment information looks.
Figure 18-8 shows you how the reported resource availability informa-
tion looks.

While viewing assignments, you can quickly view the taskbar for any task by
clicking it and then clicking the Scroll to Task button.

Once you've added the resources to the project using the process I just
explained, you can make assignments in Project just as you normally would.
The enterprise resources appear in Resource Sheet view. Then, you can
republish the Project, which updates the Enterprise Resource Pool with the
assignments you just made.
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Request a status report

In an ideal world, every resource on your project would report to you faith-
fully on his or her progress (and the news would all be good). In reality,

the news is often not so good, but there’s nothing Project or I can do about
that. However, Project Web App does provide a way for you to design status
reports — and regularly nudge your team to submit them to you.

You can design a status report and also request that your team submit these
reports at intervals by using a handy wizard.

To request a status report, follow these steps:
1. From the Project Web App Home page, click the Status Reports link
under Resources in the Quick Launch pane.
The Status Reports page appears.
2. In the Requests section, choose New=>New Request.
The Status Report Request page appears.

3. Complete the form by entering a report name, the frequency that the
report should be submitted to you, the start date for the report, and
the resources you want to have send it to you.

4. In the last area of the report titled Sections, click the Insert Section
button and type a name for the new section.

Repeat this for every section you want to be included in the report.
Refer to Figure 18-9.

5. Click the Send button.

The request for the report is sent to each of the resources you
indicated.

Share documents

One other great use of Project Web App is as a place to share docu-

ments with your team. Project Server can do this because it’s built on the
SharePoint Server collaboration platform. The Project Server administrator
must create a workspace for the project to enable document sharing. In some
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Figure 18-9:
Establish
sections for
your report.
|

cases, the project manager will have proper permission to set up a work-
space when publishing the project, as well. Follow these steps to work with

shared documents:

J—

2.

. Click the Project Center link in the Quick Launch pane.

Click in the Information column beside your project. Then, on the

Projects tab of the Ribbon, click Project Site in the Navigate group.

If a site exists for the project, a page for accessing SharePoint features

appears.
3.

In the Quick Launch pane at left, click the Project Documents link to

view the list of documents that are shared by the team.

The list of documents appears, as shown in Figure 18-10.

4.

You have a couple of options at this point:

e Click Add New Document. Use the Upload Document dialog box that
appears to select and upload the file.

e Click the document name. The document opens in the application

used to create it.
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Figure 18-10:
All docu-
ments you
share with
your team
are placed
here.
|
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A few more Project Web App features that are useful to your project team
are covered in Chapter 19. Project Web App is so feature rich that [ don’t
have the room to fully do it justice in this book. Fortunately, the interface
and tools are easy to use, and the Help information is actually quite helpful.
Explore the topics of interest to you, and you’ll be a Project Web App pro in
no time.
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Chapter 19

Project Web App for
the Team Member

In This Chapter

Using Timesheet to enter actual work
Looking at your assignments

Sending task updates

Sending a status report

project Web App is a marvelous tool for project managers to make
assignments, track progress, and communicate, but it also offers great
advantages to project team members.

Essentially, you can think of Project Web App as a metaphorical two-way
street. That is, project managers can post projects, notify resources of
assignments, and request status reports, but the members of your project
team can also initiate actions. For example, they can record the time they’ve
spent on tasks, take a look at project information, send status reports to man-
agers, and set up alerts and reminders to keep them on top of their
commitments.

Seeing Project Web App from
the User’s Perspective

Logging on to Project Server using Project Web App is as easy as browsing

to a Web page. Your project manager can give each team member the URL
for the Web database. Then, you can open Internet Explorer, type the URL in
the address box, and press Enter. Your Project Web App Home page appears,
and will look similar to the one in Figure 19-1. The actual appearance of the
Home page will vary depending on security and customization features set up
in your organization.
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Figure 19-1:
The Project
Web App
Home page
is filled with
various links
you use to
get around.
|
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You are alerted about new assignments here

- Project Weh Access - Windows Internet Explorer

[ T o /mass. cortoso.com/ Pt/ defauifasan =42 x [ bina Ll

57 Favorids |53 @] SuggestedSies ¥ &) Weh Sife Galery =

‘| e v Page~ Safely™ Toos™ @+ 7

- B -

- Project Web Access

Browse

A ;
< Project Web Afcess » Home -4 4
O Ilikelt Tags &
Nates
contoso
Project feb Access | Hame Search this site... P @

urn on Accessibility |

Show Debug Toolbar Remindsrs -
Projects Tasks
Project Center &, vouhave 14 new tasks assigned to you.
Warkflow Approvals Timeshests

@ Vo have 27 unsubmitted timeshests,

My Work

Status Reparts
Tasks [i1 vouhave no overdue status reparts.
Timeshest

. Issues and Risks
1ssues and Risks i
Gt vouhave no active risks assigned to you,

&8 vouhave no active issues assigned to you,
Rezources

Status Reports

Settings
Personal Settings _

Manage Timesheets

Documents

Shared Documents 2009 Microsoft Corporation, Al rights ressrved. =l

| . Trusted sites | Protected Mode: Off "j 4 \ H100% -

In the various categories shown on the left here (My Work, Projects,
Resources, Settings, and so on), you can view a wealth of project information.
You can also use the links in the Quick Launch pane along the left side of the
screen to move around the site.

By using the various categories in the Quick Launch pane, you can accom-
plish many things, including entering the hours you have spent on tasks,
viewing project information, getting reminders of what is coming due (or is
overdue), and communicating with other resources on your project.

For information about the features of Project Web App that are useful to a
project manager, see Chapter 18.
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Viewing Vour Assignments

After the project manager publishes the project and assignments, you will
see an alert on your home page if any of the new assignments apply to you.
You can click the link there or click Tasks under My Work to go to the My
Assignments page, as shown in Figure 19-2. To find out more about a par-
ticular task, click the task name. The task info appears on the assignment
details page, like the one shown in Figure 19-3. If you want to enter informa-
tion about work on individual tasks, you can do so in the locations shown in
Figure 19-2 and 19-3.
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Figure 19-3:
Reviewing
details
about the
selected
task.
|
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Reporting Work Completed

Okay, put aside your project manager hat (if you have one) and imagine for a
moment that you're working on a project team. Your project manager — I'll
call him Milt — has assigned you to tasks, and you have deadlines (way too
many in your humble opinion) to meet.

My Timesheet view, which you access through Project Web App, enables you
to view your tasks and enter information about the actual time you spent on
them. (Project Web App also offers a second view called My Work, where you
also can fill in your timesheet information.) Milt can check your timesheet
and track your progress automatically.

Here’s how to get to My Timesheet view:

1. Click Timesheet under My Work in the Quick Launch pane.

2. On the Timesheet tab of the Project Web App ribbon, click View in the
Data group and click My Timesheet.

My Timesheet view appears, as shown in Figure 19-4.
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/2 Timesheet - Project Web Access - Windows Internet Explorer [_[=]x]
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As you can see in Figure 19-4, My Timesheet view looks something like a
spreadsheet. To enter work on tasks, follow these steps:

1. Click the Actual row cell for the task and date you want to update.

\3
P If you need to go to the timesheet for another period to fill it out, click

the Select Period button in the Period group on the Timesheet tab of the
Ribbon.

N

Enter the actual time you spent on a task on that particular day.
Use a number (such as 3, for three hours) in the appropriate date field.
3. In the Submit group of the Timesheet tab, click the Save button.

You use Steps 1-3 as many times as needed to fill in your work for the
period of time represented by the timesheet. You can enter your work
information as you go or enter it all during a single sit-down. No matter
which method you choose, when you’ve entered all the work you did for
the period of time that the timesheet covers, you then need to submit
the timesheet for approval.
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3

4. In the Submit group of the Timesheet tab, click the Send Timesheet
button.

If you click the Send Timesheet button, a dialog box appears asking
you to choose the person you want to submit the timesheet to. Use the
Browse feature to choose the person and then click the OK button to
send the timesheet.

After you click the Save button, the changes that you make in the timesheet
get stored in the Project Server database, but they haven’t been used to
update the project yet. That’s up to Milt, your faithful project manager.
Clicking the Send Timesheet button causes Project Web App to send an e-mail
to your manager, who can accept or reject the updates in the project. Milt, the
project manager, can log on to Project Web App and then click the link under
Approvals in his list of Reminders. All timesheets are displayed. Milt can
accept or reject these as needed.

Viewing Project Information

Project team members often don’t have Project itself loaded on their comput-
ers, so they need a way to view the project plan. They can do that by using
Project Web App. (Viewing project information works pretty much the same
whether you’re wearing a project manager or a team member hat.)

To view a project, follow these steps:

1. Click the Project Center link in the Quick Launch pane.

All the projects you have access to — usually the ones you have assign-
ments in — are displayed, as shown in the example in Figure 19-5. This
is the default view, Projects by Phase, for the Project Center. You can
use the Views list box in the Projects tab Data group to navigate to other
views, if you need to.

2a. To find a project, click the icon in the Information column on the left
and then click Scroll to Project in the Zoom group of the Projects tab
of the Ribbon.

or

2b. To see assignment details, click a task name.
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Figure 19-5:
See an
overview

of projects
you're
working on
in Project
Center.
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Sending Task Work Updates

Your My Assignments page and timesheet are two of the locations from
which you can submit status updates after you’ve recorded work on tasks.
First, click to select a check box to the left of the name of any task for which
you want to send an update. Then click the Send Status button in the Submit
group on the Tasks or Timesheet tab of the Ribbon. Finally, specify whether
to send only selected updates.

Sending Status Reports

Chapter 18 explains how the project manager can send a status report
request, which is a gentle reminder for resources to provide information
about how things are going with assignments. Status report requests appear
among your reminders. You can either respond to a status report request,
or if you're proactive (and [ know that you are), send an unsolicited status
report to the project manager.
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Figure 19-6:
Review and
respond

to status
reports
here.
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You work with status reports on the Status Reports page, as shown in Figure
19-6. To get there, click the Status Reports link under Resources in the Quick
Launch pane. To respond to a report that’s been requested, click the status
report link. Or, to create your own report, click the Submit Unrequested
Report button. Then use the form that appears, as shown in Figure 19-7, to
specify what information appears in the report and which resources, if any,
will receive a copy. Then click the Send button.
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You also can work with documents pertaining to the project from Project Web
App. See the “Share documents” section in Chapter 18 to find out what you
can do with project documents and how to access them.

If you want to discover more about Project Web App, see Chapter 18, which
covers several tasks that a project manager may find useful.
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Part VI
The Part of Tens

The 5th Wave By Rich Tennant

|
%

“This isn’t a quantitative or a
qualitative estimate of the job.
This is a wish-upon-a-star
estimate of the project.”
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In this part . . .

Ten fingers, ten toes — things that come in tens are
just a natural! This part gives you two handy lists of
ten: Ten Golden Rules of Project Management and Ten
Project Management Software Products to Explore. The
first of these chapters offers new users of Project (as well
as seasoned veterans) some pointers on getting your
project to perform. The second chapter looks at add-on
products and supplemental software to enhance
Microsoft Project.
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Chapter 20

Ten Golden Rules of Project
Management

In This Chapter
Putting good project management practices to work using Microsoft Project
Creating and tracking Project schedules more efficiently

Learning from your mistakes

ou’ve heard this one: You can have your deliverable on time, on budget,

or done right: Choose two. That’s an example of some traditional proj-
ect management wisdom. But how does that wisdom translate to the use of
project management software?

Well, it’s simple: If you assign additional resources to a Project schedule, you
add costs and time to your schedule because resources have costs attached
and can work only according to their work calendars. So, clearly, making
changes that may improve quality — such as adding more or higher-priced
resources — affects the time and money needed for your project. That adage
about time being money is still true, but now you can clearly see the effect
that one action has on other aspects of your project (especially if something
you do tinkers with time or money) — and it’s all visible in Project’s many
views and reports.

So what project management adages should you be aware of as you begin to
use Project? Here are ten to tack up on your office wall.
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Don’t Bite Off More Than
Vou Can Manage
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As I mention elsewhere in this book (see Chapter 1), you must have an
understanding of the goal of your project as well as the scope of its activi-
ties before you start to build a Project schedule. Don’t plan a full marketing
campaign if all you can anticipate at this point is what the market-research
phase will look like. Because the additional elements of an actual market-
ing campaign hinge on that market research, do first things first: Build your
project in phases. That way, you’ll have less reworking of later tasks that
simply couldn’t be anticipated when you began. You’ll also have less need to
manipulate the baseline for those later tasks: If they’re too far in the future,
by the time you get there, their time demands won’t look anything like what
you originally set aside for them.

Don’t set tasks that are far in the future in stone too early in the game.
Here are some Project features that help you with this process:

v The capability to combine subprojects into a master project with linking

v Network Diagram view, which helps you visualize phases of your project
graphically

v The flexible nature of Project outlines, which allow you to hide or dis-
play different phases of a project

See Chapter 5 for more about the best ways to manipulate outlines.

Get Vour Ducks in a Row

Before you start creating your project, do your homework. If you don’t have
all the information that you need when you sit down at your computer to
work with Project, you’ll find yourself constantly stopping, mid-plan, and run-
ning off to find that information. This isn’t a very efficient way to work.

Here are some things to research before you sit down to build a project
schedule:

v Basic reality check: Based on your experience managing similar proj-
ects over time, are the deliverables, budget, and preliminary schedule
for the project within reason? Do you need to discuss changes to the
scope and budget to avoid a project that’s not realistic to begin with?
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” Resource information: For people, this includes the full name, contact
information, manager and manager’s contact information, skills, cost,
schedule, and timing conflicts. For equipment or facilities, find out their
availability and cost.

v Team structure: Does everyone do his or her own tracking, or does
someone else on the team input everyone’s progress? Who updates the
schedule for changes? Who gets copies of which reports? Should your
team have access to the master schedule online? Does everyone on the
team have the technology to communicate using collaborative features
such as Project Web App?

1 Management expectations: Does management expect to see basic
reports on a regular basis? Would they prefer that you use Visual
Reports, instead? Do you need to get budget approval at various phases
in your project planning; if so, from whom? Are cross-enterprise inter-
ests involved that require you to report to or get approval from multiple
sources? (See Chapter 16 for the lowdown on reports.)

v+ Company policies: These include company work policies regarding
resource hours and overtime, the holiday calendar, how your company
charges overhead costs or markups to projects, and what information
can — and can’t — be shared with clients or vendors.
N The enterprise resource features in Project 2010 help you call on company
information stored on your server, such as obtaining a list of enterprise
resources, for consistency across projects.

Now you’re ready to sit down and start inputting a Project project! (Is there
an echo in here?)

Plan for Murphy

You know he’s out there: Murphy and his darn law! Most projects don’t
happen on time or on budget. This is especially true of lengthier and more
complex projects. Your job is to do the most accurate planning that you
can — and make prudent adjustments whenever a wrench is thrown into
the works. Project gives you lots of tools to do that. But beyond all the auto-
mated features of Project, you can anticipate change by planning for it.

The critical path in a project is indeed critical. Every wise project manager
builds extra time, and even extra money, into schedules. When the project
comes in but a week late and $5,000 over budget, only the project manager
knows that it was really four weeks later and $25,000 costlier than what the
first schedule — the one with no allowance for Murphy — reflected. I intro-
duce you to the critical path in Chapter 6 and show you how to display it in
Chapter 11.
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Add time to the duration of every task if possible to account for shifts in sched-
ule. Also add a resource to every phase of your project to pad your budget just
a bit to help you deal with overages. If you want to introduce schedule-padding
time without adding resource costs, use lag time between tasks.

Instead of a work or material resource, use the cost resource type to add a
set amount to a task or phase. You can even name the extra cost resource
Murphy, if you like!

Don’t Put Off until Tomorrow

3

Project management software can make many aspects of your life easier, but
the thing that overwhelms most people when they begin to use Project is the
amount of time spent inputting data and keeping it up to date. True, those
tasks can be cumbersome, but what you can get back from those automated
updating and reporting capabilities more than makes up for the up-front work.

Don’t forget about the capability to import tasks from Outlook into Project.
This helps speed up some of that data entry in the planning phase.

However, if you don’t tend to the task of tracking progress on a project, you
can wind up behind the proverbial eight ball. Track just as often as you can —
at least once a week. This not only saves you from facing a mountain of track-
ing data to be entered, but it also means that you and your team can see the
true picture of your project at any point in time. That way, you can promptly
spot disaster coming and make adjustments accordingly.

Delegate, Delegate, Delegate!

Don’t try to do everything on a project yourself. Although creating and main-
taining your Project file on your own might seem to give you more control,
doing so is just about impossible in larger projects. Of course, you don’t want
dozens of people going in and making changes to your plan because you run
the risk of losing track of who did what and when. However, a few simple
practices make a few fingers in the project pie helpful, not harmful:

v Designate one person whose mission is to enter all tracking data into the
master file for you. Or, you can automate tracking by using the Request
Progress Information feature.

v Break your project into a few subprojects and assign people whom you
trust to act as managers of those phases. Let them deal with their own
tracking and adjustments, and then assemble the phase projects into a
master project so that you can monitor their changes.
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v Enlist the help of your IS/IT person(s) to set up Project Server with

Project Web App to provide enhanced collaborative features and share
documents with your team.

v Set uniform procedures for your team up front. Don’t have one person
report time on an interoffice memo sheet, somebody else e-mail you his
progress, and others stick the work they did on tasks into the timesheet

willy-nilly. Work up a strategy that uses Project features to communicate
consistently.

<P If you work in a large enterprise, begin practicing enterprise project manage-
ment techniques right away. By setting up portfolios of projects and designat-
ing resource pools, you can collaborate with other project managers for the
most efficient processes. See Chapter 19 for more about how to do this.

CVA (Document!)

Everyone knows the project management adage to CYA, but Project makes it
a lot easier. Try using these features to document the details of your project:

v Use the Notes area for both tasks and resources to make a record

of background information, changes, or special issues (as shown in
Figure 20-1). (See Chapter 4.)

v Use the e-mailing feature of Project to send schedules to people for
review. This builds an electronic paper trail of where information went
and who responded. (See Chapter 9.)

v Customize reports to incorporate all pertinent information and help you
document trends and changes. (See Chapter 16.)

Task Information ==

General | Predecessors | Resources | Advanced  Motes | Custom Fields |

Mame: | Turnover field 1 Duration: = [V]Estimated
Motes:

— “El%l%@

Tractor stopped working the day before
Figure 20-1:

Keep
track of
changes to
personnel,
budget, and
timing in
task notes. — | cancel |
|

Equiprent repair required two days.

www.it-ebooks.info


http://www.it-ebooks.info/

388 Partvi: The Part of Tens

v Try using the new Visual Reports to paint the picture of project status
for visually inclined stakeholders. (See Chapter 16.)

v Save multiple versions of your project, especially if you make changes
to your baseline in later versions. This provides a record of every step
in your project planning, which you can refer to when questions arise
down the road. (See Chapter 12.)

v Share updates to your plan through Project Web App so that nobody
can say he or she was out of the loop when some important change
came down. (See Chapter 18.)

Keep Your Team in the Loop

I've worked in offices where | spent more time wrestling with whom to keep
informed about what than I did working. If I didn’t include marketing and
finance in every e-mail on a new product launch, I'd be called on the carpet
the next day, or (worse) some vital action step would fall through the cracks
because someone didn’t know he or she was supposed to take action. Try
these methods of keeping communication channels open:

v Use Project features that allow you to integrate with Outlook or other
e-mail programs to send Project files or other communications.

v Build address lists in your e-mail program that are specific to your proj-
ect team so that every message goes to everyone, every time.

1 Review progress with your team by meeting regularly, whether in
person, over the phone, in an online chat area, or by using meeting soft-
ware. Make sure that each team member has the latest version of the
Project schedule to refer to during these meetings.

v In the Share choices in the Outspace, use the Sync with Tasks List or
Save to SharePoint commands to post the latest project information to a
SharePoint server so that others know what’s going on.

v Display the work breakdown structure code on reports so that you can
easily refer to specific tasks in large projects without confusion.

Measure Success

When you begin your project, you should have an idea of what constitutes
success and know a way to measure that success. Success can involve attain-
ing many goals, such as

v Customer satisfaction

v Management satisfaction
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Figure 20-2:
Milestones
provide
markers
along the
way that
give your
team a
feeling of
achieve-
ment.
|

Have

 Being on budget

v Being on time

When you start your project planning, know how you’ll measure your suc-
cess. Will success in budgeting mean that you don’t exceed your original
estimates by more than 10 percent? Will your project be considered on time
if you worked the estimated amount of weeks on it minus a two-month period
when you went on hold for a union strike, or is the total working time less
important than meeting a specific deadline? How will you measure customer
satisfaction? Will management satisfaction be a done deal if you get a promo-
tion or if your division receives more funding? Does a successful product
launch include high sales figures after the launch, or was your project suc-
cessful merely because you got it out the door?

Place milestones in your project (as shown in Figure 20-2) that reflect the
achievement of each type of success. When you reach each milestone, you
can pat your team on the back. Knowing what success looks like helps you
motivate your team to get there.

-3 =l Preparation 25days  Tue 2/1/11 =

+ Planning meeting 4hrs Tue 2/1/11 Director PRPR Assistant, PR Manager,V'P Marketing

< Budget development 2 days Tue 2/1/11 Director PR,PR Manager

< Campaign launch 0 days Thu 2/3/11 $52/3

b= = video 13days  Thu2/3/11 = P
-3 Shoot footage 3 days Thu 2/3/11 [s# Video Yendor, PR Manager

< Editing and review 5 days Tue 2/8/11 PR Manager,Video Vendor
b= approval 0 days Tue 2/15/11 2/15

L3 Duping 2days  Tue2/15/11 Video Vendor

= Distribution 1 day Thu 2/17/11 PR Assistant

< Follow up 2 days Fri 2/18/11 PR Assistaj
b= = Media Release 7 days Thu 2/3/11 P

= Wiriting Jdays  Thu2/3/11 [s# PR Manager

< Editing and review 2 days Man 2/7/11 PR Manager, PR Assistant

b= approval 0 days wWed 2/9/11 2/9

L= Distribution 1 day Wed 2/9/11

< Follow up 2 days Thu 2/10/11

a Flexible Strategy

Stuff happens. There’s never been a project that didn’t require accommoda-
tions for surprises along the way. The mark of a good project manager is that
he or she is alert to these changes and makes adjustments to deal with them
quickly.

This isn’t always easy: It’s really, really hard to be the messenger bearing bad
news. However, avoiding a problem in your project, hoping it will go away,
has a nasty habit of snowballing. The following tools can help you stay alert
to changes and make adjustments:
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Figure 20-3:
A critical
path can

be seen

in several
ways using
Project’s
views and
filters.
|

v The Resource Substitution Wizard with Project Server helps you make
changes when the one resource you counted on suddenly wins the lot-
tery and disappears.

v+ The Change Highlighting feature can help you see where changes to
your schedule pay off in a trimmer budget or faster schedule.

v Turn on critical path formatting (see Figure 20-3) to see the critical path
of your project and track how much slack you have left. Adjusting tasks
to efficiently use up their slack can keep you on schedule in a crisis.

Remember that Project 2010 offers features to help you try what-if scenarios
and determine what’s driving the timing of tasks (see Chapter 15). Use these
to figure out the best way to proceed.

| Mew Fitness Center Loc
Format

i — _
¢ ] Critical Tasks |:l,7 _z
5 v = Slack =T
Format Baseline Slippage
- Late Tasks - -

Bar Styles

Learn from Your Mistakes

One of the greatest gifts that Project offers you is the capability to look back
after you complete a project so that you can learn from your mistakes. You
can review your original schedule and every version after that to see how
well you estimated time and money and figure out how to do it better.

By using records of your project, you can spot trends. Where do you always
seem to miss on timing? Do you always allow way too little time on market
research and way too much time for Q&A? Do you always forget to budget
for temporary help during rush times, or do you overstaff early on when you
could get by with fewer people?

Use the wealth of information in Project schedules to educate yourself on

your own strengths and weaknesses as a project planner and manager and to
get better with each project you take on.
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Chapter 21

Ten Project Management
Software Products to Explore

In This Chapter

Looking at add-on software

Discovering software that integrates with Project-generated plans

Reviewing separate software products that help project managers with project-related
tasks

f you've followed this book to this point, you've probably figured out by

now that project management software — just like a project manager —
wears a lot of hats. Microsoft Office Project does everything from allowing
you to create tasks and assign resources to tracking progress, analyzing cost
overruns, and analyzing scheduling conflicts. It handles graphics, complex
calculations, and interactions with the Web.

Software designers always have to make trade-offs among features, decid-
ing which ones to include and how much functionality to give each feature.
Most Project features do everything you need, but others are less complete.
Some features may not quite get the job done as well as a more specialized
tool that you can use in conjunction with Project. Third-party software part-
ners work with Microsoft to create add-on software to provide Project with
greater functionality: for example, generating a greater variety of graphic
reports. In other cases, software handles specialized functions that Project
doesn’t incorporate, such as managing the hundreds of drawings involved in
construction projects.

Consider this the when-two-heads-are-better-than-one chapter. This chapter
describes ten interesting software tools that you can use with Project. Most
of the makers of these tools offer some kind of free demo of their product on
company Web sites. Plenty of products are out there, so use this chapter as a
starting point as you consider ways to extend Project’s functionality.
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DecisionEdge Chart and Report Products
Enhance Project’s Own Tools

The business intelligence software DecisionEdge for Microsoft Office Project
(www .decisionedge.com) offers reporting and graphics that add func-
tionality to Project. You can use these tools to help you visualize resource
challenges, get a handle on your project schedule status, and gauge how well
you're performing.

Go to the DecisionEdge Web site to see a sample gallery of charts and reports
that use a variety of graphic effects and colors to get your message across.
Check out the Dashboard charts, which show a combination of several differ-
ent charts in one report; these help your executives get a one-glance over-
view of your progress.

Even with the more graphical options in Project’s new Visual Reports
feature, you can benefit from the more advanced graphics capabilities of
DecisionEdge’s products.

Cobra Squeezes the Most
from Cost/Earned Value

Deltek (www.deltek.com), which makes its own complete project manage-
ment package called Deltek Open Plan, also produces Deltek Cobra, a cost/
earned value management software package that you can use with Project
plans. Cobra tools offer functionality in estimating, what-if modeling of costs,
and budget forecasting based on information in your Project schedule. I espe-
cially like the multiple-rate files feature that makes it easy to juggle several
resource rates within a single project.

Cobra not only allows you to define certain budget calculations yourself, but
it also offers more flexibility than some of Project’s costing features. In addi-
tion, the Chart Template Designer lets you play around with a variety of 3-D
charts, which you can manipulate and rotate in several ways, expanding your
options for presenting Project data in three dimensions.
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MindManuals Helps You Visualize
Project Information

MindManuals (www.mindjet .com) offers Mindjet MindManager, which is
a software product that helps you get your team thinking together in cre-
ative ways. This visual mapping software is touted as a visual thinking tool.
MindManager is also offered in a couple of specialized editions for CPAs
and sales professionals, and even has an iPhone version, Mindjet

for iPhone.

MindManager maps allow you to attach files, connect to RSS feeds, and more.
After you organize your ideas and information, you can use these details as
the basis for your Project file. As of this writing, you can download a free trial
to see all the power that MindManager offers.

Innate Integrates Projects
Large and Small

Innate Timesheets and Innate Resource Management from Innate
Management Systems (www . innateus.com) are especially helpful if you're
juggling multiple projects that range from small to large. You can use Innate
to manage the human resources who work on smaller projects in your organi-
zation and are also busy on larger projects that you plan in Microsoft Project.
Innate Timesheets can group resources in various useful ways.

The Innate Resource Management helps you scope out resource avail-
ability and prioritize resource assignments. Innate Timesheets is tracking
software, but it offers more than Project does in this area. You can do pro-
ductivity comparisons across several tasks or projects. You can also tap
in to sophisticated billing systems and integrate project information with
accounting and payroll systems in ways that enhance Project 2010 budget-
tracking features.
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PlanView Models Your
Workforce Capacity

PlanView, Inc. (www.planview.com) produces the software product
PlanView Enterprise Portfolio Management, which helps you sort through the
various layers in your organization. The role-modeling features in PlanView
allow you to analyze and manage risk, give priorities to strategies, and set up
scenarios to prepare for inevitable emergencies in your project.

The PlanView Project Portfolio Management product focuses on specific
project work, featuring easy-to-use dashboards for managing your project
portfolios.

PlanView is closely integrated with Microsoft Project, so you can share
information about processes and people on a project between the two
products. PlanView templates can also be used to give you a head start on
your Project plan.

Tenrox Streamlines Business Processes

The buzzword today is enterprise, and Tenrox (www . tenrox.com) puts the
focus on business processes, such as performance analysis, resource plan-
ning, purchasing, and revenue and cost accounting. One of the best uses of
this software for the Microsoft Project user is as a bridge to various enter-
prise and accounting packages such as SAP and ADP Payroll.

Project Portfolio Management and Professional Services Automation for ser-
vice delivery and invoicing are Web-based solutions that can be very useful
in a geographically diverse project team setting. You should take a look at
these packages also if you have a need for RFI, quotation, and evaluation
functions in your projects. Tenrox also offers a set of proposal management
tools to help you get the project off the ground in the first place.
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Project KickStart Gives Vour
Project a Head Start

Project KickStart from Experience In Software (www . experienceware.com)
is a simple-to-use program with a wizard-like approach that helps you lay
the groundwork for small to midsize projects. If you need a little help getting
started with a project, you can create your plan here in 30 minutes or less
and then use the hot link to port information to Microsoft Project.

Project KickStart is designed to help you figure out your project strategy as you
come up with a list of tasks. Planning icons remind you to map the goals of your
project and plan for obstacles. Libraries of typical goals and challenges make
building them into your plan simple, and you can add your own specific com-
pany or industry phrases to the libraries. Links to Outlook, Word, and Excel
also offer you some flexibility in sharing information among the Office family of
products, which includes Project. Check out the free trial download and online
demo to get an idea of what Project KickStart can do for your projects.

Project Manager’s Assistant Organizes
Drawings for Construction Projects

Originally created for the construction industry, Project Manager’s Assistant,
CS Project Lite, and CS Project Professional from Crest Software (www .
crestsoft.com) are useful for any industry that uses a lot of drawings.

Essentially, Project Manager’s Assistant helps you track drawings, issue copies,
develop production plans, and manage changes over the life of the project.
Although the product doesn’t integrate directly with Project, it’s an additional
software product that might prove useful to many project managers — and

it does integrate with any ODBC (open database connectivity) database. The
other two products provide project management capabilities.

Graphic designers and new product designers who generate drawings can
catalog them here. If you manage scientific or engineering projects, you may
also find this software useful for managing schematics or diagrams. By plac-
ing links to this database in your Project plan, you can make this information
available to your project team.
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TeamTrack Solves Mission-Critical Issues

TeamTrack from Serena Software, Inc. (www . serena . com) helps you identify
problems and defects that may crop up in your processes — and find solu-
tions. The software allows you to create visual maps for your processes and
share that data among your team members. The Web focus here means that
people can get to the process data online without having Project running.

One nice feature of this software is that it notifies you when a problem occurs
or deadlines have passed without activity. TeamTrack even helps you iden-
tify issues that may arise when “nontalking” systems communicate. In other
words, if you integrate two pieces of software to share data and data comes
into Project that causes a problem, you won’t even know it because you're
not inputting it. TeamTrack flags such problems to help you avoid missing a
critical situation before it’s too late.

Serena’s Web site offers a free evaluation download and online case studies
to help you decide whether TeamTrack is right for you.

EPK-Suite Eases Portfolio
Mangement Chores

EPK-Suite from EPK Group (www . epkgroup . com) is built on Project Server
and Windows SharePoint Services platforms and integrates through Project
Web App, so this technology works seamlessly with Project.

EPK-Suite offers portfolio management, resource and capacity planning,
timesheets, and collaboration features with an easy-to-use interface. Check
out the new features in version 4, including Web-based planning and resource
request/planning tools.
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24 Hours template for Base calendar, 57

o/ o

accessing
filters, 199
Gridlines dialog box, 237
KeyTips, 34
Layout dialog box, 234
new, blank project schedules, 24
Page Setup dialog box, 323
Project Information dialog box, 62-63
Resource Information dialog box, 146
Task Inspector pane, 207
templates from Backstage view, 28
actual activity, comparing to baselines,
336, 337
ACWP (actual cost of work performed),
286-287
Add Progress Line tool, 257
Adjust To setting (Page Setup dialog
box), 324
Adobe Acrobat Reader, 330
arrows on Ribbon, 34
As Late As Possible constraint, 92
As Soon As Possible constraint, 91, 92
Assign Resources dialog box
Cost column, 304
Graphs button, 222
opening, 221
work or material resources, 185-186
assigning priorities to projects, 26
assigning resources to tasks. See also
assignments
Assign Resources dialog box, 185-186
calendars and, 179
changing assignments, 299-300
communicating assignments, 189-193

custom fields, adding, 182
deleting or modifying assignments,
220-221

effort-driven tasks, 177-179

methods for, 183-184

overview of, 175

Resource column and, 184

Task Information dialog box, 186

task types and, 176-177, 178

Team Planner view, 188-189

tracking costs and, 254

types of resources and, 183

work contours and, 186187
Assignment Information dialog box

setting task contours, 187

tracking materials usage, 271
assignment reports

generating, 192-193

types of, 191
Assignment Reports dialog box, 192
Assignment Summary report category, 315
Assignment Usage report category, 315
assignments. See also assigning resources

to tasks

checking in Project Web App, 364-366

making in Project Web App, 361-362

viewing, 373-374
AutoFilter feature, 199-201
autoscheduling

adding resources to tasks and, 299-300

benefits of, 113

description of, 111

task types and, 176-177, 178

tracking information for, 266-267

warnings, suggestions, and, 208-209, 210
availability of resources

checking, 218-220, 364-366

cutting time from projects and, 216-217

estimating, 166-167

specifying, 167-168
Available Templates screen, 28-29
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Backstage view
description of, 35-36
opening templates from, 28
previewing reports in, 309, 310, 328-329
previewing templates in, 30
print settings, 329-330
Send as Attachment feature, 256
Bar Styles dialog box, 230-231
Base calendar templates
creating custom, 68-69
modifying for Resource calendars, 65
Base calendars
description of, 56
templates for, 57
Baseline for Earned Value Calculation
drop-down box (Project Options dialog
box), 289-290
baselines
black bar representing in Gantt Chart
view, 282-283
budgets and, 160
clearing and resetting, 248-249, 303, 305
comparing to actual activity, 336, 337
description of, 17, 243
elements of, 244-246
Gantt Chart view, 244, 245
interim plans compared to, 249
saving, 246-247
saving multiple, 247-248
scheduling problems and, 291-293
Tracking Gantt view, 244, 245
uses of, 243-244
Box Styles dialog box, 53
Budget report, 218
budget resources, creating, 173
budgets
cost resources and, 168-170
description of, 10
types of, 160
Build Team dialog box (Project Web App),
361, 362, 365
building projects
researching and planning before, 384-385
from scratch, 24-28
with templates, 28-30

oo

Calculate Multiple Critical Paths check box
(Project Options dialog box), 290
Calculate Project button (Ribbon), 287, 288
calculations
automatic compared to manual, 287-288
for critical paths, 290
earned-value options, 288-290
Multiple Undo feature and, 288
for tracking costs, 286-287
variances, 248
Calendar setting (Project Information
dialog box), 63
Calendar view
description of, 46-47
Layout dialog box in, 234
layout options in, 236
calendars. See also Base calendar
templates; specific calendars
assigning resources to tasks and, 179
Base, 56, 57
exceptions to working times, setting,
60-62
options for, 58-59
precedence and, 58
setting options for, 59-60
setting up, 26
settings for, 56-57
sharing copies of, 69-70
types of, 55-56
Change Highlighting feature, 211-212
Change Working Time dialog box
Base calendar templates and, 57
Nondefault Work Week legend item, 62
Resource calendars and, 66, 153-154
work resources and, 143
working times, changing, 61
chart area
description of, 38-39, 40
Gantt Chart view, 27-28, 40, 42
checking resource availability, 218-220
child tasks, 99
Clear Baseline dialog box, 248, 251
clearing
baselines, 248-249, 305
interim plans, 251
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closing Project, 36
Cobra software (Deltek), 392
code masks, 117-118
collaborating
with SharePoint Server, 354-355
with team online, 23
collapsing tasks, 113-115
collecting data for tracking progress,
253-254
color
printing in, 228
for reports, 322
columns of data
displaying in Gantt Chart view, 76
showing selected, 51-52
commands
adding to Quick Access Toolbar, 35
Backstage view, 35
mini-toolbar, 36
shortcut menu, 36
committed resources, 146
communication. See also Project Web App
about workload, 157
assessing, 336-338
conflict resolution, 157-158
project managers and, 18
with teams, 388
Compare Project Versions dialog box,
338, 339
Compare Projects feature, 256
comparing
baselines to actual activity, 336, 337
versions of projects, 338-340
conflict resolution, 157-158
conflicts of resources, 15-16
consolidated projects
changing linking settings, 274-275
creating, 272-274
updating, 274
consolidated resources, 149
constraints on tasks
description of, 13, 91
list of, 92
modifying, 302
reviewing when additional time
available, 303
setting, 92

copy and paste operations, enhancements
to, 333
Copy Picture feature, 332
copying
calendars from project to project, 69-70
Global .MPT file, 69
with Organizer, 342-344
range of tasks with macros, 345
Timeline, 331-332
Cost column (Assign Resources dialog
box), 304
Cost columns (Gantt Chart view), 267-268
Cost Overbudget filter, 295
cost resources. See also costs
assigning to tasks, 183
budgets and, 168-170
description of, 14, 143, 159
example of, 144
Cost table (Gantt Chart view), 163, 169, 284
cost variance (CV), 287
costs. See also cost resources; fixed costs
adding resources to tasks and, 300
assigning, and totaling, 160-161
associating with tasks, 161
calculations for tracking, 286-287
cutting, 304
estimating, 161-162
of material resources, 165
overtime rates and, 166
resources and, 140-141
tracking, 254
trimming, 217-218
of work resources, 163-165
costs per use, 163, 164
Create New Base Calendar dialog box, 68
Crest Software, Project Manager’s
Assistant, 395
Critical filter, 295, 296
critical paths
calculations for, 290
displaying, 228-229
evaluating for scheduling problems,
296-297
planning projects and, 385-386
critical-path tasks
description of, 133
filters and, 198
in Network Diagram view, 214
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cross-project links, creating, 130-131
Crosstab Report dialog box, 313
crosstab reports, editing, 313
Ctrl+Z (Undo), 93
Current Date setting (Project Information
dialog box), 63
Custom AutoFilter dialog box, 200
custom Base calendar templates, creating,
68-69
custom fields, adding, 182
Custom Fields dialog box, 171
custom filters, creating, 201-203
custom groups
creating, 204-206
deleting, 211
custom reports, creating, 313-314
Custom Reports dialog box, 314
custom templates, saving files as, 29,
341-342
custom text fields, creating in tables,
170-173
customers, 19
customizing
Ribbon, 211
views, 47-54
Visual Reports, 316
WBS codes, 117-119
cut-and-paste method
for inserting graphics, 318
for moving tasks, 111
cutting
costs, 217-218, 304
time from projects, 215-217, 299
CV (cost variance), 287

o) e

dates. See also finish dates; starting dates;
timescale
drop-dead, setting, 25
status, 25, 259-260
deadlines, setting, 93
debriefing
self, 336-337, 339
teams, 337-338

DecisionEdge software, 392
Default Task Earned Value Method setting
(Project Options dialog box), 289
Definition tab (Task Report dialog box),
311-312
delegation of tasks, 386-387
deleting
custom groups, 211
dependencies, 132-133
resource assignments, 220-221
tasks, 93-94, 217, 301
deliverables, dependencies compared
to, 131
Deltek Cobra software, 392
dependencies among tasks
causes of, 121
creating, 127-130
cutting time from projects and, 216
deleting, 132-133
deliverables compared to, 131
description of, 12-14
external, 130-131, 302
finish-to-finish, 125
finish-to-start, 124, 127
lag and lead time and, 126-127
setting up, 122-123
shifting for scheduling problems, 301-302
start-to-finish, 124
start-to-start, 125, 127
types of, 123-124
viewing, 133-135
dependency links, 122
Details box for modifying calendar settings
changing working times, 61-62
Resource calendars and, 67, 154-155
Details tab (Task Report dialog box), 312
Developer tab (Ribbon), 345-346
displaying. See also hiding
columns in Gantt Chart view, 76
critical paths, 228-229
deadlines, 93
Developer tab of Ribbon, 345
Multiple Baselines Gantt view, 293
preset tables of sheet data, 52
progress lines, 280-281
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Ribbon, 34
selected columns of data, 51-52
subtasks, 99
tables, 284
tasks, 113-115
Timeline, 330
View bar, 38
views not directly available on Ribbon, 38
WBS codes, 117
documentation about projects, 387-388
downloading
Microsoft SQL Server 2008 Analysis
Services 10.0 OLE DB Provider, 316
templates, 29
drag-and-drop method for moving
tasks, 110
drawing tool (Gantt Chart Tools Format
tab), 238-239
drop-dead dates, setting, 25
duration of tasks
assigning, 82-85
description of, 12
milestones and, 85-86
modifying, 303
resources and, 142, 144-145
slack, building in, 215
summary tasks, 102
tracking and, 266-267

oF o

EAC (estimate at completion), 287
earned value (EV)
calculation of, 286
description of, 260
options for, 288-290
Edit Lookup Table dialog box, 171, 172
editing
crosstab reports, 313
macros, 348-349
standard reports, 310-313
text in reports, 322-323
Visual Reports templates, 317
Edits to Total Task % Complete Will Be
Spread to the Status Date check box
(Project Options dialog box), 290

effects for text, 322
effort-driven scheduling
description of, 90-91
as turned off by default, 73
effort-driven tasks
adding resources to, 299-300
assigning resources to, 177-178
description of, 90-91
resource time and, 56
turning off, 178-179
e-mail attachments
sending project plans as, 330
sending project updates as, 256
sending projects as, 190-191
embedding graphics, 318
enabling buttons on Ribbon, 73
end users, 358
Enterprise Global template and RBS
codes, 116
enterprise orientation, 354
Enterprise Project Management (EPM)
collaboration and, 23
techniques for, 387
Enterprise Resource Pool (Project Web
App), 365, 366
enterprise resources, 144
Entry table (Gantt Chart view), 76
EPK-Suite software, 396
estimate at completion (EAC), 287
EV (earned value)
calculation of, 286
description of, 260
options for, 288-290
evaluating projects
comparing versions of, 338-340
learning from mistakes, 335-338
macros, recording and using, 344-349
Organizer, using, 342-344
templates, creating, 340-342
Excel
exporting projects to for analysis,
295-296
task lists, importing, 78-80
Excel 2007 Data Analysis For Dummies
(Nelson), 296
FExcel 2010 For Dummies (Harvey), 316
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exceptions (changes to calendars)
description of, 58
to working times, setting, 60-62
Exit command, 36
expanding tasks, 113-115
Experience In Software, Project
KickStart, 395
exporting projects to Excel for analysis,
295-296. See also importing
external dependencies, 130-131, 302

ofF e

F1 (Help), 31
F5 (Go To), 40-41
feedback, giving and assessing, 336
file formats
MPT, 29
PDF, 330
File tab (Ribbon), 35, 36
files
saving, 30
saving as custom templates, 29, 341-342
sharer, 150
source, changes in, and consolidated
projects, 274-275
source, linking to when creating
consolidated projects, 272
Filter Definition dialog box, 201, 202-203
filters
AutoFilter feature, 199-201
benefits of, 198
custom, creating, 201-203
for isolating problems, 295-296
predesigned, 198-199
Find dialog box, 180
Find feature, 180-181
Finish Date setting (Project Information
dialog box), 63
finish dates. See also starting dates
setting, 25, 88-89
tracking, 262-263
Finish No Earlier Than constraint, 92
Finish No Later Than constraint, 92
finish-to-finish dependencies, 125

finish-to-start dependencies, 124, 127
Fit Timescale to End of Page option (Page
Setup dialog box), 328
Fit To setting (Page Setup dialog box), 324
fixed costs
cutting, 217
description of, 141
entering, 162-163
entering updates to, 267-268
Fixed Duration tasks, 83, 176, 177
Fixed Units tasks, 83, 176
Fixed Work tasks, 83, 176-177
flexibility and success, 389-390
font and font size, choosing, 322
Footer tab (Page Setup dialog box), 326
footers, inserting graphics files in, 319
Format Bar dialog box, 232
Format Box dialog box, 233-234
formatting
critical paths, 228-229
drawings, adding to, 238-239
gridlines, 237-238
layout options and, 234-237
modifying, 228
Network Diagram boxes, 54
progress lines, 281-282
reports, 321-323
task bars, 229-232
text boxes in Network Diagram view,
233-234
Formatting toolbar, Indent and Outdent
tools, 82

oGo

Gantt bars for autoscheduled compared to
manually scheduled tasks, 72
Gantt Chart Tools Format tab (Ribbon)
displaying, 34
drawing tool, 238-239
Gantt Chart Style group, 232
text formatting options, 233
Gantt Chart view
baselines, 244, 245
black bar representing baselines, 282-283
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components of, 27-28
Cost columns, 267-268
Cost table, 163, 169, 284
creating tasks, 75-76
critical paths, 296
deleting dependencies, 132
dependency relationships, 122, 123
description of, 42
displaying critical paths, 228-229
Entry table, 76
Fixed Cost column, 162-163
formatting task bars, 229-232
Gantt Chart Tools Format tab, 34
Indicator column, 278
Layout dialog box, 235
layout options, 236
methodology related to, 19, 20
outline structure of, 11
overallocated resources, 221, 222
placing graphics, 320-321
Resource column, 184
styles, selecting, 232-233
Timeline and, 44, 45
Total Cost column, 140-141
Variance table, 244, 284-285
viewing dependencies, 134-135
Gantt charts, 19, 42
Generate WBS Code for New Task option
(WBS Code Definition dialog box), 119
generic resources, creating, 148-149
Global .MPT file
copying, 69
copying items into, 343-344
Go To feature, 40-41
goals for projects
defining, 104
redefining, 304
understanding, 384
graphics
creating, 319-320
inserting into files, 318-319
placing on Gantt charts, 320-321
Graphs button (Assign Resources dialog
box), 222
gridlines, modifying, 237-238

Gridlines dialog box, 237-238
Group Definition dialog box, 205
Group feature, 203
groups
custom, creating, 204-206
custom, deleting, 211
predefined, applying, 203-204
predefined, editing, 206
groups on Ribbon, 34

o/ o

Harvey, Greg, Excel 2010 For Dummies, 316
Header tab (Page Setup dialog box), 326
headers, inserting graphics files in, 319
Help features, 31, 279
hiding. See also displaying
columns, 51
Developer tab of Ribbon, 345
Ribbon, 34
tasks, 113-115
Timeline, 330
histograms, 21
Home page (Project Web App)
for project managers, 356, 357
for users, 371, 372
hours, tracking, 263-265
hovering mouse pointers, 279
hyperlinks, inserting into project outlines,
80-81

o]e

Import Outlook Tasks dialog box, 77-78
importing
Excel task lists, 78-80
resources from Outlook, 152-153
tasks from Outlook, 77-78
inactive, marking tasks as, 94, 301
Incomplete Tasks filter, 295
Indent Task tool (Ribbon), 108
Indent tool (Formatting toolbar), 82
indenting tasks in outline structure,
107-109
indicator icons, 278-279
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Innate Timesheets and Innate Resource
Management software, 393
Insert Hyperlink dialog box, 80-81
Insert Object dialog box, 318-319
Insert Project dialog box
creating consolidated projects, 273
inserting Project files into plans, 8§1-82
Inserted Project Information dialog box,
274-275
Inserted Projects Are Calculated Like
Summary Tasks option (Project
Options dialog box), 290
inserting
columns, 51
graphics into files, 318-321
hyperlinks into project outlines, 80-81
one project into another, 81-82
tasks in list of tasks, 77
interim plans
baselines compared to, 249
clearing and resetting, 251
description of, 243
saving, 250-251
saving multiple, 248
scheduling problems and, 291-293
Is Greater Than filter, 200

oo

keyboard shortcuts
Ctrl+Z (Undo), 93
F1 (Help), 31
F5 (Go To), 40-41
KeyTips, accessing, 34

o/ o

Lag column (Task Information dialog
box), 301
lag time
adding, 215
description of, 126
Landscape orientation, 324
Late/Overbudget Tasks Assigned To
filter, 295

Layout dialog box, 234-237
lead time, 126
learning from mistakes, 335-338, 390
Legend tab (Page Setup dialog box), 327
legends, printing with, 228, 327
leveling resources

for resource conflicts, 22, 223-225

for scheduling problems, 293, 297-298
linking

changing settings for, in consolidated

projects, 274-275
to graphics files, 318
to source files when creating
consolidated projects, 272

tasks in dependencies, 127-130
links

cross-project, creating, 130-131

dependency, 122

inserting into project outlines, 80-81
local resources, 144
logic diagrams. See Network Diagram view
lookup tables, 170-173

ol o

macros
description of, 344-345
Developer tab of Ribbon and, 345-346
recording, 346-347
running and editing, 348-349
Macros dialog box, 348
manual calculations, changing to, 287-288
manually scheduled tasks
formatting for in Network Diagram
view, 233
summary tasks, 111-113
user-controlled scheduling and, 72-74
Margins tab (Page Setup dialog box), 325
Mark on Track tool, 257, 261
Marmel, Elaine, Microsoft Project 2010
Bible, 355
material resources
assigning to tasks, 183
costs of, 165
description of, 14, 143
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example of, 144
tracking usage of, 271
measuring success, 388-389
merge keys, 80
Microsoft Office Project 2010 For Dummies
companion Web site, 5
Microsoft Project 2010 Bible (Marmel), 355
Microsoft Project Talk List Import
Template, 78-80
Microsoft SQL Server 2008 Analysis
Services 10.0 OLE DB Provider, 316
Microsoft Visual Basic, 348-349
milestones
description of, 12
formatting for in Network Diagram
view, 233
measuring success and, 389
setting, 85-86
Mindjet MindManager software, 393
Minimize the Ribbon button, 34
mini-toolbar, 36
mistakes, learning from, 335-338, 390
More Filters dialog box, 201, 202, 295
More Groups dialog box, 205
More Views dialog box, 38
mouse pointers, hovering, 279
Move Project dialog box, 226
Move Task tool, 257, 268-269
moving
drawn objects, 239
tasks forward or backward in schedules,
268-269, 302
tasks within outline structure, 109-111
MPT (Project template format), 29
Mueller, John Paul, Visio 2007 For
Dummies, 316
Multiple Baselines Gantt view
displaying, 293
uses of, 248
multiple progress lines, displaying,
280, 281
Multiple Undo feature
automatic calculations and, 288
description of, 209-211
resource leveling and, 225
Must Finish On constraint, 92

Must Start On constraint, 92

My Assignments page (Project Web
App), 373

My Timesheet view (Project Web App),
374-376

o\ o

naming
macros, 347
tasks, 76
navigation
changing views, 36-38
Go To feature, 40-41
scrolling, 38-40
Nelson, Stephen, Excel 2007 Data Analysis
For Dummies, 296
Network Diagram view
critical paths in, 296, 297
critical-path tasks in, 214
description of, 19, 20, 44-46
formatting boxes in, 54
Layout dialog box in, 235
layout options in, 236
modifying contents of boxes in, 52-53
task boxes, formatting, 233-234
viewing dependencies in, 133-134
Night Shift template for Base calendar, 57
Nondefault Work Week legend item
(Change Working Time dialog box), 62
nonworking time, 59
notes boxes, inserting graphics files in,
318-319
Notes column (sheet pane), 293
notes on tasks
entering, 95
reviewing, 336
scheduling problems and, 293

o () o

opening
filters, 199
Gridlines dialog box, 237
KeyTips, 34
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opening (continued)

Layout dialog box, 234

new, blank project schedules, 24

Page Setup dialog box, 323

Project Information dialog box, 62-63

Resource Information dialog box, 146

Task Inspector pane, 207

templates from Backstage view, 28
Organizer dialog box

sharing calendars and, 69-70

uses of, 342-344
orientation for printing, 324
Outdent Task tool (Ribbon), 108
Outdent tool (Formatting toolbar), 82
outdenting tasks in outline structure,

107-109

outlining structure for tasks

approaches to building, 107

collapsing and expanding, 113-115

description of, 11-12, 99-100

determining, 103-104

level of detail in, 105-107

levels in, 101

moving tasks within, 109-111

outdenting and indenting functions,

107-109

phases and, 100-101

project summary tasks, 101-103
Outlook

importing resources from, 152-153

importing tasks from, 77-78
Overallocated Resources filter, 295
Overallocated Resources reports, 191
overallocation of resources

assessing, 338

checking for, 218-220

estimating availability and, 166

filters and, 198

resolving, 220-222

searching for, 180

Team Planner view and, 188-189
Overbudget Work filter, 198
overtime

cutting, 218

hours of, entering, 265-266

rates, assigning to, 166

Resource calendars and, 67

Overtime Work column (Resource Usage
view), 266
Overview Reports dialog box, 308

oo

Page Setup dialog box
description of, 323-324
Footer tab, 326
Header tab, 326
Legend tag, 327
Margins tab, 325
Page tab options, 324
View tab, 327-328
Page tab options (Page Setup dialog box),
324
panes, resizing, 48-49. See also chart area;
sheet pane; Timeline
Paper Size option (Page Setup dialog
box), 324
parent tasks, 99
PDF format, 330
Percentage Complete tool, 257
percentage completed, tracking, 261-262,
267
PERT charts, 45. See also Network
Diagram view
phases of tasks, 11, 100-101
placeholder fields, renaming, 171
planning
for implementation of Project Server and
Project Web App, 358-360
projects, 384-385
Planning Wizard dialog box, 305-306
plans. See also baselines; interim plans;
schedules
description of, 33
elements of, 41
sharing by e-mail in PDF format, 330
PlanView Enterprise Portfolio Management
software, 394
Portrait orientation, 324
precedence, and calendars, 58
predecessors, 122
Predecessors tab (Task Information dialog
box), 301
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predefined groups
applying, 203-204
editing, 206
predesigned filters, 198-199
previewing
printouts, 35, 328-329
reports, 309, 310
templates, 29, 30
Print All Sheet Columns option (Page Setup
dialog box), 327
Print Blank Pages option (Page Setup
dialog box), 328
Print Column Totals option (Page Setup
dialog box), 328
Print First # Columns on All Pages option
(Page Setup dialog box), 327
Print Notes option (Page Setup dialog
box), 328
Print Row Totals for Values within Print
Date Range option (Page Setup dialog
box), 328
printing
Backstage view settings, 329-330
baselines, 292-293
interim plans, 249, 292-293
with legends, 228
Page Setup dialog box, 323-328
previewing, 328-329
views, 308
priorities, assigning to projects, 26
Priority setting (Project Information dialog
box), 64
problems, solving. See also scheduling
problems
autoscheduling warnings and
suggestions, 208-209, 210
Change Highlighting feature, 211-212
costs, cutting, 217-218
filters, 198-202
Groups feature, 203-206
multiple solutions for, 226
Multiple Undo feature, 209-211
Planning Wizard dialog box and, 305-306
rescheduling projects, 226
resolving overallocations, 218-222
resource leveling, 223-225

Task Inspector pane, 207-208
timing issues, 212-217
progress, monitoring. See progress lines;
tracking; viewing progress
progress bars, 230
progress lines
description of, 279
displaying, 280-281
formatting, 281-282
Progress Lines dialog box, 280-281, 282
Project calendars
description of, 56
setting options for, 62-64
working schedules in, 68
Project Information dialog box
setting calendar options, 62-64
starting projects from scratch, 24-26
Project KickStart software, 395
project management. See also project
managers
CYA (document!) rule of, 387-388
delegate, delegate, delegate rule of,
386-387
description of, 10
don’t bite off more than you can manage
rule of, 384
don’t put off until tomorrow rule of, 386
get your ducks in row rule for, 384-385
golden rules of, 383-390
have flexible strategy rule of, 389-390
keep team in loop rule of, 388
learn from mistakes rule of, 390
measure success rule of, 388-389
methodologies of, 19-22
plan for Murphy rule of, 385-386
reports, 16-17
resources, 14-16
tasks, 11-14
timing and, 11-14
tracking, 17-18
triple constraint of, 19
Project Management Professional (PMP)
certification, 18
project managers
Project Web App, Home page for, 356, 357
role of, 18-19
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sending task work updates, 377
sharing documents, 367-369

Project Manager’s Assistant software, 395
Project Options dialog box

Baseline for Earned Value Calculation
drop-down box, 289-290

Calculate Multiple Critical Paths check
box, 290

Default Task Earned Value Method
setting, 288-289

Edits to Total Task % Complete Will Be
Spread to the Status Date check
box, 290

Inserted Projects Are Calculated Like
Summary Tasks option, 290

manual calculations, 287-288

setting calendar options, 59-60

Tasks Are Critical if Slack Is Less Than or
Equal to (x) Days setting, 290

Project Server

account, creating, 360

description of, 353

evaluating benefits of, 354-355

planning to implement, 358-360

project sponsors, 18

Project Statistics dialog box, 26

project summary tasks, 101-103

Project template format (MPT), 29

Project 2010

benefits of, 22-23

terminology for, 56

Project Web App

checking resource availability and
assignments, and adding resources,
364-366

description of, 354

Home page, 356, 357, 371, 372

making assignments, 361-362

manual reporting of progress and, 255

My Timesheet view, 374-376

planning to implement, 358-360

Project Center of, 356

Project Server and, 353

pros and cons of, 355

published projects in, 360-361

Quick Launch pane, 361, 372

reporting work completed, 374-376

Resource Center, 362, 363

sending status reports, 377-379

status reports, 363-364, 367, 368
team interaction and, 190
timesheet entry form, 356, 357
tracking progress, 362-363
from users’ perspective, 371-372
viewing assignments, 373-374
viewing projects, 376-377
projects. See also evaluating projects;
goals for projects; scope of projects
building from scratch, 24-28
building with templates, 28-30
comparing versions of, 338-340
components of, 10
consolidated, 272-275
cutting time from, 215-217, 299
description of, 56
documenting details of, 387-388
exporting to Excel for analysis, 295-296
inserting hyperlinks to tasks in other,
80-81
inserting one into another, 81-82
Project Web App and, 360-361, 376-377
publishing to Project Server, 360-361
rescheduling, 226
researching and planning, 384-385
reviewing, 335-338
saving, 96-97
sending as e-mail attachments, 190-191
slack, adding to, 303
tasks, setting up for, 97-98
templates, creating from, 340-342
viewing in Project Web App, 376-377
proposed resources, 146
publishing projects in Project Server,
360-361

QQQ

quality, sacrificing, 303-305
Quick Access Toolbar (Ribbon)
description of, 34, 35
Undo button, 210-211
Quick Launch pane (Project Web App),
361, 372
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rates per hour for work resources, 163-165
RBS (resource breakdown structure)
codes, 116
recording macros, 346-347
Recurring Task Information dialog box,
86-87
recurring tasks, creating, 86-87
redisplaying. See displaying
rejoining split tasks, 89
renaming placeholder fields, 171
Replace dialog box, 181
Report Text dialog box, 322-323
reports. See also status reports in Project
Web App
assignment reports, 191-193
Budget reports, 218
comparison reports, 338, 340
custom, creating, 313-314
formatting, 321-323
graphics and, 318-321
overview of, 16-17, 22, 307
previewing, 309, 310
printing from Page Setup dialog box,
323-328
standard, 308-313
standardization of, 359
Visual Reports, 315-317
Reports dialog box, 309
Reschedule to Available Date option (Gantt
Chart view), 221, 222
rescheduling
projects, 226
tasks, 268-269
researching before building projects,
384-385
resetting
baselines, 248-249, 303
interim plans, 251
views, 54
resizing
drawn objects, 239
view panes, 48-49
resource breakdown structure (RBS)
codes, 116

Resource calendars
changing, 58
description of, 56
modifying Base calendar templates for, 65
modifying settings for, 65-67
setting options for, 153-155
uses of, 65
Resource Center (Project Web App),
362, 363
Resource Graph view
checking availability, 218, 219
description of, 16
overallocated resources, 220
overbooking resources, 157, 158
resource graphs, 21
Resource Information dialog box
Available From and Available To columns
of, 167-168
Booking Type field, 146
Budget check box, 173
cost-rate entries in, 164-165
creating resources in, 147-148
Resources Notes tab, 156
resource leveling
for resource conflicts, 22, 223-225
for scheduling problems, 293, 297-298
Resource Leveling dialog box, 223-225,
297-298
resource management, 21-22
Resource Names column (AutoFilter),
199, 200
resource pools, 150-152
Resource sheet, 15
Resource Sheet view
description of, 43
entering resource information in, 146
Resource Summary report category, 315
Resource tab (Ribbon), 34
resource usage charts, 21
Resource Usage report category, 315
Resource Usage view
checking availability, 218-219
grouping information, 204
overallocated resources, 220
Overtime Work column, 266
panes of, 38-39
tracking total hours, 265
uses of, 141-142, 188
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Resource Views group, 37
resources. See also assigning resources
to tasks; cost resources; material
resources; overallocation of resources;
work resources
adding, 365-366
committed and proposed, 146
conflicts and, 15-16
consolidated, 149
costs and, 140-141
creating, 146-148
description of, 10, 139-140
duration of tasks and, 142, 144-145
enterprise and local, 144
estimating, 145
feedback to, 336
finding, 180-181
flagging and finding, 156-157
generic, creating, 148-149
importing from Outlook, 152-153
leveling, 22, 223-225, 293, 297-298
managing, 18, 156-158
reporting activity related to, 255
setting availability for, 166-168
sharing, 149-153
types of, 14-16, 65, 142-143
workflow management and, 141-142
Resources Notes tab (Resource
Information dialog box), 156
reviewing projects
comparing versions of, 338-340
learning from mistakes, 335-338
macros, recording and using, 344-349
Organizer, using, 342-344
templates, creating, 340-342
Ribbon. See also Gantt Chart Tools
Format tab
adding buttons to, 211
Calculate Project button, 287, 288
description of, 34-35
Developer tab, 345-346
enabling buttons on, 73
File tab, 35, 36
Help button, 31
navigating with tabs on, 36-37

Outdent Task and Indent Task tools, 108
Quick Access Toolbar, 34, 35, 210-211
Resource tab, 34
Task tab, 36-37, 41, 356-357
View tab, 36-37, 41, 51

right-clicking for shortcut menus, 36

risk management, 21

running macros, 348

oS e

Sage TimeSheet, 255
Save As dialog box
files, saving under new names, 96-97
templates, saving, 341
Save As Template dialog box, 342
saving
baselines, 246-247
files, 30
files as custom templates, 29, 341-342
interim plans, 250-251
multiple baselines, 247-248
projects, 96-97
scaling for printing, 324
Schedule From setting (Project Information
dialog box), 63
Schedule group tracking tools, 256-257
schedules. See also plans; scheduling
automatic, 111
moving tasks forward or backward in,
268-269, 302
Timeline and, 331
viewing, 26-28
warnings and suggestions about,
208-209, 210
scheduling. See also scheduling problems
effort-driven, 73, 90-91
user-controlled, 72-74, 112-113
scheduling problems
adding people to tasks, 299-300
adding time to projects, 303
changing timing of tasks, 299
critical path and, 296-297
explaining with notes, baselines, and
interim plans, 291-293
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filtering options and, 295-296
quality, sacrificing, 303-305
resource leveling and, 297-298
shifting dependencies and task timing,
301-302
sorting options and, 293-294
Task Inspector pane and, 298
scope of projects
defining, 104
modifying, 303-305
understanding, 384
scope of tasks, modifying, 299
Scroll to Task button, 41
scrolling views, 38-40
Send as Attachment feature (Backstage
view), 256
Serena Software, Inc., TeamTrack, 396
Set Baseline dialog box, 246-247, 250-251
Share Resources dialog box, 151
SharePoint Server
automating updates using, 265
project collaboration with, 354-355
sharer files, 150
sharing
assignments, 189-193
copies of calendars, 69-70
documents with Project Web App,
367-369
files in PDF format, 330
resources, 149-153
sheet pane
description of, 38-39, 40
Gantt Chart view, 27, 40, 42
Notes column, 293
shortcut keys
Ctrl+Z (Undo), 93
F1 (Help), 31
F5 (Go To), 40-41
shortcut menu, 36
Should Start By filter, 295
showing. See also hiding
columns in Gantt Chart view, 76
critical paths, 228-229
deadlines, 93
Developer tab of Ribbon, 345

Multiple Baselines Gantt view, 293
preset tables of sheet data, 52
progress lines, 280-281
Ribbon, 34
selected columns of data, 51-52
subtasks, 99
tables, 284
tasks, 113-115
Timeline, 330
View bar, 38
views not directly available on Ribbon, 38
WBS codes, 117
slack
adding to projects, 303
allowing for, 213-215, 217
Slipped/Late Progress filter, 295
Slipping Assignments filter, 295
Slipping Tasks filter, 198
Sort dialog box, 294
Sort tab (Task Report dialog box), 312-313
sorting options, 293-294
source files
changes in, and consolidated files,
274-275
linking to when creating consolidated
projects, 272
splitting tasks, 89, 223
stakeholders, 18
standard reports
categories of, 308-309
description of, 308
editing, 310-313
generating, 309-310
Standard template for Base calendar, 57
standardization, 359
Start Date setting (Project Information
dialog box), 63
Start No Earlier Than constraint, 92
Start No Later Than constraint, 92
starting dates. See also finish dates
entering, 88-89
establishing, 87-88
setting, 24
tracking, 262-263
start-to-finish dependencies, 124
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start-to-start dependencies, 125, 127
Status Date dialog box, 260
Status Date setting (Project Information
dialog box), 63
status dates
setting, 25
tracking progress and, 259-260
status reports in Project Web App
requesting, 367, 368
sending, 377-379
setting up, 363-364
Status Reports page (Project Web
App), 378
styles for Gantt Chart view, selecting,
232-233
subprojects, inserting into projects, 81-82
subtasks
dependency links and, 128
description of, 99
formatting for in Network Diagram
view, 233
in outlining structure, 11-12
success
flexibility and, 389-390
measurement of, 388-389
success, building on
macros, recording and using, 344-349
Organizer, using, 342-344
templates, creating, 340-342
successors, 122
suggestions, 208-209, 210
summary tasks
description of, 99
formatting for in Network Diagram
view, 233
manually scheduled, 111-113
in outlining structure, 11-12
roll-up functionality of, 100-101

o o

tables
Cost, 163, 169, 284
custom text fields, creating in, 170-173
displaying, 284

in Gantt Chart view, 42, 162
Variance, 244, 284-285
tabs on Ribbon
description of, 34
navigating with, 36-37
task bars
elements drawn over, 239
formatting, 229-232
for viewing progress, 282-283
task boxes, formatting in Network Diagram
view, 233-234
Task calendars
changing, 58
description of, 56
modifying settings for, 64-65
task IDs, 41, 76
Task Information dialog box
Assign Resources dialog box, 221,
222-223
assigning resources, 186
creating tasks, 76-77
cross-project links, 131
deleting dependencies, 132-133
Effort Driven check box, 91
entering information, 28
Notes tab, 95
Predecessors tab, 301
setting calendar options, 64
setting dependency links, 129-130
setting task duration, 84-85
setting task type, 83-84
turning off effort-driven tasks, 178-179
Task Inspector pane
scheduling problems and, 298
task drivers and, 207-208
viewing dependencies, 133
task modes, changing, 73
Task Report dialog box, 311-313
Task Sheet view, 257-258, 259
Task Summary report category, 315
Task tab (Ribbon)
changing views with, 36-37
Scroll to Task button, 41
tracking tools, 256-257
Task Usage report category, 315
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Task Usage view
description of, 257-258, 259
resource hours, entering in, 264
Task Views group, 37
tasks. See also assigning resources to
tasks; dependencies among tasks;
duration of tasks; milestones; outlining
structure for tasks
adding people to, 299-300
adding to Timeline, 330-331
assigning durations to, 82-85
autoscheduled, 72-74
changing timing of, 299
child, 99
constraints on, 13, 91-92, 302-303
creating, 71, 75-77
critical-path, 133, 198, 214
cut-and-paste method for moving, 111
delegation of, 386-387
deleting, 93-94, 217, 301
dependencies in, 12-14
description of, 11
drag-and-drop method for moving, 110
effort-driven, 56, 90-91, 177-179, 299-300
entering notes on, 95
example of setting up for projects, 97-98
Fixed Duration, 83, 176, 177
Fixed Units, 83, 176
Fixed Work, 83, 176-177
identifying action items for, 74-75
importing from Excel, 78-80
importing from Outlook, 77-78
inserting hyperlinks to tasks in other
projects, 80-81
inserting in list of tasks, 77
manually scheduled, 72-74, 111-113, 233
marking as inactive, 94, 301
moving forward or backward in
schedules, 268-269, 302
naming, 76
notes on, 95, 293, 336
from one project, inserting into another,
81-82
parent, 99

phases of, 11, 100-101
project management, 11-14
project summary, 101-103
recurring, 86-87
scope of, modifying, 299
splitting, 89, 223
subtasks, 99, 128, 233
summary, 11-12, 99-101, 111-113, 233
timing relationships among, 11-12
tracking progress at level of, 254
type of, setting, 83-84
types of, 176-177
Tasks Are Critical if Slack Is Less Than
or Equal to (x) Days setting (Project
Options dialog box), 290
Team Planner view
assigning resources and, 188-189
description of, 43-44
teams. See also Project Web App
collaborating with online, 23
communication with, 388
debriefing, 337-338
for Project Web App implementation, 358
TeamTrack software, 396
templates
Base calendar, 57
building projects with, 28-30
for calendars, creating, 68-69
creating, 340-342
description of, 23
Global.MPT, copying, 69
Global.MPT, copying items into, 343-344
Microsoft Project Talk List Import
Template, 78-80
previewing, 29, 30
saving files as, 29
for Visual Reports, 317
Tenrox software, 394
text effects, 322
text fields, creating custom, in tables,
170-173
text in reports, editing, 322-323
Text tab (Bar Styles dialog box), 231
third-party software products, 391-396
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time frames, committing to, 212-213
Timeline
adding tasks to, 330-331
copying, 331-332
description of, 44, 45
hiding and displaying, 330
Network Diagram view and, 45-46
timephased tracking, 254-255
timescale
adding time to projects, 303
cutting time from projects, 215-217, 299
description of, 39, 40
Gantt Chart view, 27, 40
modifying, 49-50, 297
Network Diagram view, 45
reviewing, 212-213
slack, allowing for, 213-215, 217
Timescale dialog box, 49
timesheet interface (Project Web App),
356, 357
timing of tasks. See constraints on tasks;
dependencies among tasks; duration
of tasks; Timeline; timescale
timing relationships among tasks, 11-12
To-Do List reports, 191
tools
Add Progress line, 257
drawing, 238-239
Indent (Formatting toolbar), 82
Indent Task (Ribbon), 108
Mark on Track, 257, 261
Outdent (Formatting toolbar), 82
Outdent Task (Ribbon), 108
Percentage Complete, 257
tracking, 256-257
Update Project, 257, 260, 269-270
Update Tasks, 257
Total Cost column (Gantt Chart view),
140-141
tracking
collecting data for, 253-254
consolidated projects, 272-275
description of, 17-18, 253
entering data for, 259
fixed costs, 267-268

indicator icons and, 278-279
manual reporting of progress and, 255
Mark on Track tool, 261
materials usage, 271
methods for, 254-255
Move Task tool and, 268-269
overtime hours, 265-266
percentage completed, 261-262, 267
progress, 230, 362-363
resource hours, 263-265
start and finish dates, 262-263
status dates and, 259-260
timephased, 254-255
Update Project tool and, 269-270
Tracking Gantt view
baselines in, 244, 245
placing graphics in, 320-321
Resource column, 184
viewing variances, 285-286
tracking tools (Task tab), 256-257
training for Project Web App, 359
triple constraint of project management, 19
turning off
effort-driven tasks, 178-179
Resource Leveling, 225
24 Hours template for Base calendar, 57

olf o

Undo features

Multiple Undo, 209-211, 225

Undo command (Ctrl+Z), 93
unit rates, assigning, 165
Unstarted Tasks reports, 17, 309, 310
Update Project dialog box, 270
Update Project tool, 257, 260, 269-270
Update Tasks dialog box, 262, 263
Update Tasks tool, 257
updating consolidated projects, 274
user interface

Backstage view, 35-36

mini-toolbar, 36

Ribbon, 34-35

shortcut menu, 36
user-controlled scheduling, 72-74, 112-113
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Variance table (Gantt Chart view), 244,
284-285
variances
calculating, 248
viewing in Tracking Gantt view, 285-286
Verify Uniqueness of New WBS Codes
option (WBS Code Definition dialog
box), 119
versions of projects, comparing, 338-340
View bar, displaying, 38
View tab (Page Setup dialog box), 327-328
View tab (Ribbon)
changing views with, 36-37
Zoom command, 41
Zoom menu, 51
viewing. See also viewing progress
assignments, 373-374
baselines and interim plans, 292-293
multiple baselines or interim plans, 248
projects in Project Web App, 376-377
suggestions, 209
task dependencies, 133-135
viewing progress
calculations for, 286-287
in Cost table, 284
indicator icons and, 278-279
task bars for, 282-283
in Variance table, 284-285
views. See also chart area; sheet pane;
Timeline; specific views
changing, 36-37
customizing, 47-54
displaying selected columns of data,
51-52
displaying views not on Ribbon, 38
layout options for, 234-237
panes, resizing, 48-49
printing, 308
resetting, 54
scrolling, 38-40
Timeline and, 44
timescale, modifying, 49-50
for tracking progress, 257-259

Visio 2007 For Dummies (Mueller), 316
Visual Basic, 348-349

Visual Reports, 315-317

Visual Reports dialog box, 316

o/ o

warnings
about scheduling problems, 208-209, 210
Planning Wizard dialog box and, 305-306
WBS Code Definition dialog box, 118-119
WBS (work breakdown structure) codes
customizing, 117-119
description of, 115-117
displaying, 117
Web sites
Crest software, 395
DecisionEdge software, 392
Deltek Cobra software, 392
EPK-Suite software, 396
Innate Timesheets and Innate Resource
Management software, 393
Microsoft Office Project 2010 For Dummies
companion, 5
Microsoft SQL Server 2008 Analysis
Services 10.0 OLE DB Provider, 316
Mindjet MindManager software, 393
PlanView software, 394
Project KickStart software, 395
Sage TimeSheet, 255
TeamTrack software, 396
Tenrox software, 394
what-if scenarios and risk management, 21
Who Does What reports, 191, 192
Who Does What When reports, 191
work breakdown structure codes. See WBS
(work breakdown structure) codes
work contours, 186-187, 223
Work Incomplete filter, 295
Work Overbudget filter, 295
work resources
assigning to tasks, 183, 299-300
calendars and, 65
costs of, 163-165
description of, 14, 142-143
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work resources (continued) working times
example of, 143 description of, 59
hours, tracking, 263-265 setting exceptions to, 60-62
hours of overtime, entering, 265-266 workload of resources
overtime rates, assigning, 166 balancing, 157
scheduling problems and, 299-300 checking, 218-225
work contours and, 186-187, 223

workdays PY Z PY
changing length of, 59-60
description of, 56 Zoom command, 41

working calendars, setting up, 26 Zoom menu, 51
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